# SIMOTION D4x5-2

Commissioning and Hardware Installation Manual

Valid for SIMOTION D4x5-2, CX32-2, CBE30-2 and TB30

02/2012
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

⚠️ DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

⚠️ WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

⚠️ CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

⚠️ CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

⚠️ NOTICE
indicates that an unintended result or situation can occur if the relevant information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

⚠️ WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

Contents of this commissioning and hardware installation Manual

This document is part of the SIMOTION D documentation package.

Scope

The SIMOTION D4x5-2 Commissioning and Hardware Installation Manual is valid for the SIMOTION D4x5-2 control units as well as for the CX32-2, CBE30-2 and TB30 supplementary system components.

A separate SIMOTION D4x5 Commissioning and Hardware Installation Manual is available for the SIMOTION D425, SIMOTION D435 and SIMOTION D445/D445-1 devices including the CX32, CBE30 and TB30 system components.

Standards

The SIMOTION system was developed in accordance with ISO 9001 quality guidelines.

Information in this manual

The following is a description of the purpose and use of this Commissioning and Hardware Installation Manual:

- **Description**
  Provides information about the SIMOTION system and its integration in the automation environment.

- **Installing**
  Provides information on the various installation options for the device.

- **Connecting**
  Provides information about connecting and cabling the various devices, and about communications interfaces.

- **Commissioning (hardware)**
  Provides information on commissioning the device.

- **Parameter assignment / addressing**
  Provides information on configuring and parameterizing the various bus systems.

- **Commissioning (software)**
  Provides information on configuring and commissioning the system.

- **Service and maintenance**
  Provides information about service and maintenance procedures that must be performed on the device.
• Diagnostics
  Provides information about the available diagnostic information, how to interpret it, and its meaning.
• Appendices with factual information for reference (e.g. standards, approvals, and ESD guidelines).

SIMOTION Documentation
An overview of the SIMOTION documentation can be found in a separate list of references. This documentation is included as electronic documentation in the scope of delivery of SIMOTION SCOUT. It comprises 10 documentation packages.
The following documentation packages are available for SIMOTION V4.3:
• SIMOTION Engineering System
• SIMOTION System and Function Descriptions
• SIMOTION Service and Diagnostics
• SIMOTION IT
• SIMOTION Programming
• SIMOTION Programming - References
• SIMOTION C
• SIMOTION P
• SIMOTION D
• SIMOTION Supplementary Documentation
Hotline and Internet addresses

Additional information

Click the following link to find information on the following topics:

- Ordering documentation/overview of documentation
- Additional links to download documents
- Using documentation online (find and search in manuals/information)

http://www.siemens.com/motioncontrol/docu

Please send any questions about the technical documentation (e.g. suggestions for improvement, corrections) to the following e-mail address:

docu.motioncontrol@siemens.com

My Documentation Manager

Click the following link for information on how to compile documentation individually on the basis of Siemens content and how to adapt this for the purpose of your own machine documentation:

http://www.siemens.com/mdm

Training

Click the following link for information on SITRAIN - Siemens training courses for automation products, systems and solutions:

http://www.siemens.com/sitrain

FAQs

Frequently Asked Questions can be found in SIMOTION Utilities & Applications, which are included in the scope of delivery of SIMOTION SCOUT, and in the Service&Support pages in Product Support:

http://support.automation.siemens.com

Technical support

Country-specific telephone numbers for technical support are provided on the Internet under Contact:

http://www.siemens.com/automation/service&support
Disposal and recycling of the device

SIMOTION D is an environmentally friendly product. It includes the following features:

- In spite of its excellent resistance to fire, the flame-resistant agent in the plastic used for the housing does not contain halogens.
- Identification of plastic materials in accordance with ISO 11469.
- Less material used because the unit is smaller and with fewer components thanks to integration in ASICs.

The disposal of the products described in this manual should be performed in compliance with the valid national regulations.

The products can be largely recycled owing to their low pollutant content. To recycle and dispose of your old device in an environmentally friendly way, please contact a recycling company certified for electronic waste.

If you have any further questions about disposal and recycling, please contact your local Siemens representative. Contact details can be found in our contacts database on the Internet at:


Further information / FAQs

You can find further information on this manual under the following FAQ:

http://support.automation.siemens.com/WW/view/de/27585482

The following information sources are also available:

- SIMOTION Utilities & Applications: SIMOTION Utilities & Applications will be included in the SIMOTION SCOUT scope of delivery and, along with FAQs, also contain free utilities (e.g. calculation tools, optimization tools, etc.) as well as application examples (ready-to-apply solutions such as winders, cross cutters or handling)
- SIMOTION SCOUT online help
- Refer to the list of references (separate document) for additional documentation
Table of contents

1 Description ...................................................................................................................................................... 13

1.1 System overview ...................................................................................................................................... 13
1.2 System components ................................................................................................................................. 18
1.3 I/O integration ......................................................................................................................................... 23
1.4 Commissioning software ......................................................................................................................... 24
1.5 Safety information ................................................................................................................................... 26

2 Installing ............................................................................................................................................................. 27

2.1 Installation notes ....................................................................................................................................... 27
2.2 Installing the SIMOTION D4x5-2 ........................................................................................................... 27
2.2.1 Installing the SIMOTION D4x5-2 ........................................................................................................ 27
2.2.2 Mounting the SIMOTION D4x5-2 with spacers ................................................................................. 29
2.2.3 Mounting the SIMOTION D425-2 and D435-2 without spacers ..................................................... 30
2.2.4 Mounting the SIMOTION D445-2 and D455-2 without spacers (external air cooling) .................... 31
2.3 Installing supplementary system components ....................................................................................... 33
2.3.1 Installing the TB30 ........................................................................................................................... 33
2.3.2 Installing the CBE30-2 ..................................................................................................................... 34
2.3.3 Installing the CX32-2 ...................................................................................................................... 35
2.3.4 Removing the cover of the CX32-2 ................................................................................................. 40

3 Connecting ....................................................................................................................................................... 41

3.1 General Overview ...................................................................................................................................... 41
3.2 Safety information for wiring .................................................................................................................. 43
3.3 Opening the front cover ............................................................................................................................ 47
3.4 Power supply ............................................................................................................................................ 49
3.4.1 Safety rules ......................................................................................................................................... 49
3.4.2 Standards and regulations .................................................................................................................. 50
3.4.3 Mains voltage ..................................................................................................................................... 50
3.4.4 Connecting the power supply ........................................................................................................... 51
3.5 Connecting DRIVE-CLiQ components .................................................................................................... 52
3.5.1 DRIVE-CLiQ wiring .......................................................................................................................... 52
3.5.2 Connectable DRIVE-CLiQ components ......................................................................................... 54
3.5.3 Connecting the CX32-2 .................................................................................................................... 56
3.6 Connecting I/Os ......................................................................................................................................... 58
3.6.1 Creating a shield connection ............................................................................................................. 59
3.6.2 Connecting I/Os of the TB30 ............................................................................................................ 61
3.7 Connecting PROFIBUS/MPI .................................................................................................................... 63
3.7.1 PROFIBUS connection components ............................................................................................... 63
Table of contents

3.7.2 PROFIBUS cables and connectors ................................................................. 64
3.7.3 Length of PROFIBUS cables ........................................................................ 65
3.7.4 Rules for the laying of PROFIBUS cables .................................................... 65
3.7.5 Connecting PROFIBUS DP (interfaces X126 and X136) .............................. 66
3.7.6 Connection rules in the PROFIBUS subnet .................................................. 67
3.7.7 Operating the X136 interface as MPI............................................................. 69
3.8 Connecting Ethernet ........................................................................................ 72
3.8.1 Wiring Ethernet ............................................................................................. 72
3.8.2 Ethernet cables and connectors ................................................................. 73
3.9 Connecting PROFINET IO components .......................................................... 74
3.9.1 Wiring PROFINET ......................................................................................... 74
3.9.2 PROFINET cables and connectors ............................................................. 75
3.10 Routing ............................................................................................................. 77
3.10.1 Routing on SIMOTION D ............................................................................. 77
3.10.2 Routing on SIMOTION D (SINAMICS integrated) ....................................... 81
4 Commissioning (hardware) .................................................................................. 83
4.1 Requirements for commissioning ..................................................................... 83
4.1.1 Inserting the CompactFlash card ................................................................. 84
4.1.2 Checking the system .................................................................................... 86
4.1.3 Switching on the power supply ................................................................. 86
4.2 RESET button ................................................................................................. 89
4.3 User memory concept ...................................................................................... 89
4.3.1 SIMOTION D4x5-2 memory model ............................................................. 89
4.3.2 Properties of the user memory .................................................................... 90
4.3.3 Operations and their effect on the user memory .......................................... 94
4.3.4 Module replacement .................................................................................... 103
4.4 Fan .................................................................................................................. 106
4.4.1 Cooling the SIMOTION D4x5-2 ................................................................. 106
4.4.2 Fan/battery module .................................................................................... 107
4.4.3 Overview of states, fan/battery module .................................................... 108
4.4.4 Response to overtemperature ................................................................. 111
5 Parameter assignment / addressing .................................................................. 113
5.1 Software requirements .................................................................................... 113
5.2 Creating a project and configuring the communication .................................... 114
5.2.1 Creating a SIMOTION project and inserting a D4x5-2 ............................... 114
5.2.2 Configuring the PROFIBUS PG/PC interface ............................................ 116
5.2.3 Configuring the Ethernet PG/PC interface ............................................... 117
5.2.4 Representation of SIMOTION D4x5-2 in HW Config ............................... 120
5.3 Configuring PROFIBUS DP ............................................................................ 121
5.3.1 General information about communication via PROFIBUS DP ............... 121
5.3.2 Operating the SIMOTION D4x5-2 on PROFIBUS DP ............................. 122
5.3.3 Assignment of the PROFIBUS addresses in HW Config.................................... 124
5.3.4 Setting the DP cycle and system cycle clocks ......................................... 125
5.3.5 Cycle clock scaling of external PROFIBUS interface to internal PROFIBUS interface .......................... 126
5.3.6 Creating a new PROFIBUS subnet .......................................................... 128
5.3.7 Modifying the data transmission rate ....................................................... 129
5.3.8 Establishing a PG/PC assignment ................................................................. 130
5.4 Configuring the MPI bus .................................................................................. 131
5.4.1 Operating the X136 interface as MPI ............................................................ 131
5.4.2 MPI parameters ........................................................................................... 131
5.5 Configuring an Ethernet subnet ....................................................................... 132
5.5.1 Properties of the Ethernet interfaces .............................................................. 132
5.5.2 Configuring Ethernet addresses in HW Config .............................................. 136
5.5.3 Reading out IP and MAC address ................................................................. 137
5.6 Configuring PROFINET IO .............................................................................. 138
5.6.1 General information about communication via PROFINET IO ................. 138
5.6.2 Setting a send cycle clock and system cycle clocks ........................................ 142
5.6.2.1 Basic principles ....................................................................................... 142
5.6.2.2 Setting of the cycle clocks (one servo activated = default) ................... 145
5.6.2.3 Setting of the cycle clocks (two servos activated) .................................. 147
5.6.2.4 Using a second PROFINET interface ...................................................... 149
5.6.3 Properties of PROFINET ............................................................................. 151
5.6.4 Configuration tasks ..................................................................................... 151

6 Commissioning (software) .................................................................................. 153

6.1 Overview of commissioning ............................................................................ 153
6.1.1 Symbolic assignment / adaptation ................................................................. 153
6.1.2 Procedure when commissioning ................................................................. 157
6.1.3 Important functions for the project handling during commissioning ......... 158
6.2 Performing the configuration for the D4x5-2 offline ...................................... 159
6.2.1 Overview ................................................................................................. 159
6.2.2 Accessing the drive wizard ....................................................................... 160
6.2.3 Configuring components .......................................................................... 161
6.2.4 Downloading a project into the target system ........................................... 181
6.2.5 Downloading a project to the CompactFlash card .................................... 182
6.2.6 Loading a project, including sources and additional data ....................... 184
6.2.7 Archiving a project to the CompactFlash card (zip file) ......................... 185
6.3 Performing an online configuration for the D4x5-2 ....................................... 186
6.3.1 Overview ................................................................................................. 186
6.3.2 Establish an online connection ................................................................ 187
6.3.3 Starting automatic configuration ............................................................... 188
6.3.4 Editing SINAMICS components ............................................................... 192
6.3.5 Downloading a project to the SIMOTION D4x5-2 .................................... 192
6.4 Configuring a CX32-2 ................................................................................... 194
6.4.1 Overview ................................................................................................. 194
6.4.2 Basic principles of the CX32-2 ................................................................. 194
6.4.3 Preparing for configuration .................................................................... 196
6.4.4 Displaying the topology .......................................................................... 198
6.4.5 CX32-2 offline configuration ................................................................... 200
6.4.5.1 Loading a project created offline to the target system ....................... 200
6.4.5.2 Loading a project created offline to the CF card ................................. 201
6.4.6 Performing an online configuration for the CX32-2 ............................... 202
6.4.7 CX32-2 configuration information ............................................................ 204
6.4.7.1 CX32-2 power-up ............................................................................... 204
6.4.7.2 Interconnecting the infeed "Operation" signal on the CX32-2 ............ 204
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.7.3</td>
<td>Upgrading the CX32-2</td>
<td>207</td>
</tr>
<tr>
<td>6.4.7.4</td>
<td>Replacing the CX32-2</td>
<td>208</td>
</tr>
<tr>
<td>6.5</td>
<td>Additional information on configuring the SINAMICS Integrated</td>
<td>209</td>
</tr>
<tr>
<td>6.5.1</td>
<td>Settings for DP slave properties</td>
<td>209</td>
</tr>
<tr>
<td>6.5.2</td>
<td>Using vector drives</td>
<td>211</td>
</tr>
<tr>
<td>6.5.3</td>
<td>Setting the time of day</td>
<td>213</td>
</tr>
<tr>
<td>6.5.4</td>
<td>Backing up / restoring / deleting SINAMICS NVRAM data</td>
<td>217</td>
</tr>
<tr>
<td>6.5.5</td>
<td>SINAMICS diagnostic buffer</td>
<td>221</td>
</tr>
<tr>
<td>6.5.6</td>
<td>Acyclic communication with the drive</td>
<td>221</td>
</tr>
<tr>
<td>6.5.7</td>
<td>Control properties and performance features</td>
<td>223</td>
</tr>
<tr>
<td>6.5.8</td>
<td>Current controller cycle clocks &lt;= 125 µs / use of output cams and measuring inputs</td>
<td>224</td>
</tr>
<tr>
<td>6.6</td>
<td>Testing a drive with the drive control panel</td>
<td>226</td>
</tr>
<tr>
<td>6.7</td>
<td>Creating and testing axes</td>
<td>229</td>
</tr>
<tr>
<td>6.7.1</td>
<td>Overview of SIMOTION engineering</td>
<td>229</td>
</tr>
<tr>
<td>6.7.2</td>
<td>Creating an axis with the axis wizard</td>
<td>229</td>
</tr>
<tr>
<td>6.7.3</td>
<td>Testing the axis with the axis control panel</td>
<td>236</td>
</tr>
<tr>
<td>6.8</td>
<td>Activating the infeed (line module)</td>
<td>239</td>
</tr>
<tr>
<td>6.8.1</td>
<td>Infeed without DRIVE-CLiQ connection</td>
<td>239</td>
</tr>
<tr>
<td>6.8.2</td>
<td>Infeeds with DRIVE-CLiQ connection</td>
<td>241</td>
</tr>
<tr>
<td>6.8.3</td>
<td>Using one infeed for several CUs</td>
<td>242</td>
</tr>
<tr>
<td>6.9</td>
<td>Setting up addresses and message frames</td>
<td>243</td>
</tr>
<tr>
<td>6.9.1</td>
<td>Setting up communication for symbolic assignment</td>
<td>243</td>
</tr>
<tr>
<td>6.9.2</td>
<td>Message frame configuration</td>
<td>244</td>
</tr>
<tr>
<td>6.10</td>
<td>Linking an additional encoder (optional)</td>
<td>248</td>
</tr>
<tr>
<td>6.10.1</td>
<td>Basic principles</td>
<td>248</td>
</tr>
<tr>
<td>6.10.2</td>
<td>Additional encoders on the drive</td>
<td>249</td>
</tr>
<tr>
<td>6.10.3</td>
<td>Additional encoders via PROFIBUS/PROFINET</td>
<td>250</td>
</tr>
<tr>
<td>6.11</td>
<td>Symbolic assignment of I/O variables (PROFIdrive message frame / drive parameters)</td>
<td>251</td>
</tr>
<tr>
<td>6.11.1</td>
<td>Symbolic assignment of I/O variables to the PROFIdrive message frame of the TO axis</td>
<td>251</td>
</tr>
<tr>
<td>6.11.2</td>
<td>Symbolic assignment of I/O variables to drive parameters</td>
<td>252</td>
</tr>
<tr>
<td>6.12</td>
<td>Configuring drive-related I/Os (with symbolic assignment)</td>
<td>255</td>
</tr>
<tr>
<td>6.12.1</td>
<td>Configuration of the I/O terminals</td>
<td>257</td>
</tr>
<tr>
<td>6.12.1.1</td>
<td>Configuration of the D4x5-2 I/Os (terminal X122/X132)</td>
<td>258</td>
</tr>
<tr>
<td>6.12.1.2</td>
<td>Configuration of the D4x5-2 I/Os (terminal X142)</td>
<td>260</td>
</tr>
<tr>
<td>6.12.1.3</td>
<td>Configuration of the CX32-2/CU3xx/TB30/TMxx I/O terminals</td>
<td>261</td>
</tr>
<tr>
<td>6.12.1.4</td>
<td>Configuration of the TMC I/O terminals</td>
<td>261</td>
</tr>
<tr>
<td>6.13</td>
<td>Configuration of the technology objects and I/O variables</td>
<td>262</td>
</tr>
<tr>
<td>6.13.1</td>
<td>Configuration of global measuring inputs</td>
<td>262</td>
</tr>
<tr>
<td>6.13.2</td>
<td>Configuration of local measuring inputs</td>
<td>263</td>
</tr>
<tr>
<td>6.13.3</td>
<td>Configuration of output cams / cam tracks</td>
<td>264</td>
</tr>
<tr>
<td>6.13.4</td>
<td>Configuration of the I/Os (variables / TO axis)</td>
<td>266</td>
</tr>
<tr>
<td>6.14</td>
<td>DMC20/DME20 DRIVE-CLiQ hub</td>
<td>268</td>
</tr>
<tr>
<td>6.14.1</td>
<td>Hub properties</td>
<td>268</td>
</tr>
<tr>
<td>6.14.2</td>
<td>Creating a DMC20/DME20 DRIVE-CLiQ hub</td>
<td>269</td>
</tr>
<tr>
<td>6.15</td>
<td>TM41 terminal module</td>
<td>270</td>
</tr>
<tr>
<td>6.15.1</td>
<td>Overview</td>
<td>270</td>
</tr>
<tr>
<td>6.15.2</td>
<td>Configuring TM41 at SINAMICS Integrated</td>
<td>271</td>
</tr>
</tbody>
</table>
### Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.15.3 Configuring the TM41 using the axis wizard</td>
<td>272</td>
</tr>
<tr>
<td>6.16 Optimizing the drive and controller</td>
<td>273</td>
</tr>
<tr>
<td>6.16.1 Overview of automatic controller setting</td>
<td>273</td>
</tr>
<tr>
<td>6.16.2 Automatic speed controller setting</td>
<td>274</td>
</tr>
<tr>
<td>6.16.3 Automatic position controller setting</td>
<td>275</td>
</tr>
<tr>
<td>6.16.4 Measuring functions, trace, and function generator</td>
<td>277</td>
</tr>
<tr>
<td>6.16.5 Manual speed controller optimization</td>
<td>278</td>
</tr>
<tr>
<td>6.17 Loading and saving SIMOTION user data</td>
<td>283</td>
</tr>
<tr>
<td>6.18 Deleting data</td>
<td>285</td>
</tr>
<tr>
<td>6.18.1 Overview of data deletion</td>
<td>285</td>
</tr>
<tr>
<td>6.18.2 Memory reset of SIMOTION D4x5-2</td>
<td>285</td>
</tr>
<tr>
<td>6.18.3 Deleting user data on CompactFlash card</td>
<td>288</td>
</tr>
<tr>
<td>6.18.4 Restoring the default settings of SINAMICS Integrated</td>
<td>289</td>
</tr>
<tr>
<td>6.18.5 Setting SIMOTION D4x5-2 to the factory settings</td>
<td>289</td>
</tr>
<tr>
<td>6.19 Powering down the system</td>
<td>291</td>
</tr>
<tr>
<td>6.20 Configuring Safety Integrated functions</td>
<td>291</td>
</tr>
<tr>
<td>6.21 Quantity structures</td>
<td>298</td>
</tr>
<tr>
<td>6.22 Migration of SIMOTION D4x5 to SIMOTION D4x5-2</td>
<td>301</td>
</tr>
<tr>
<td>6.22.1 Changeover from SIMOTION D4x5 to SIMOTION D4x5-2</td>
<td>301</td>
</tr>
<tr>
<td>6.22.2 Permissible combinations</td>
<td>306</td>
</tr>
<tr>
<td>7 Service and maintenance</td>
<td>309</td>
</tr>
<tr>
<td>7.1 Overview</td>
<td>309</td>
</tr>
<tr>
<td>7.2 Replacing modules (spare part scenario)</td>
<td>313</td>
</tr>
<tr>
<td>7.2.1 Parts replacement for SIMOTION D4x5-2</td>
<td>313</td>
</tr>
<tr>
<td>7.2.2 Removal and replacement of the SIMOTION D4x5-2</td>
<td>314</td>
</tr>
<tr>
<td>7.2.3 Replacing DRIVE-CLiQ components</td>
<td>315</td>
</tr>
<tr>
<td>7.2.4 Replacing the CompactFlash Card</td>
<td>318</td>
</tr>
<tr>
<td>7.3 Adapting a project (Upgrading the project / Replacing the SIMOTION controller)</td>
<td>319</td>
</tr>
<tr>
<td>7.3.1 Creating backup copies (project/CF)</td>
<td>319</td>
</tr>
<tr>
<td>7.3.2 Backing up user data (backup variables)</td>
<td>320</td>
</tr>
<tr>
<td>7.3.3 Upgrading a user project to the new SCOUT version</td>
<td>322</td>
</tr>
<tr>
<td>7.3.4 Platform replacement via XML export/import</td>
<td>323</td>
</tr>
<tr>
<td>7.3.5 Preparing the device replacement</td>
<td>324</td>
</tr>
<tr>
<td>7.3.6 Device replacement in HW Config</td>
<td>326</td>
</tr>
<tr>
<td>7.3.7 Upgrading technology packages</td>
<td>327</td>
</tr>
<tr>
<td>7.3.8 Upgrading the device version of SINAMICS S120 control units</td>
<td>329</td>
</tr>
<tr>
<td>7.3.9 Upgrading a library</td>
<td>330</td>
</tr>
<tr>
<td>7.3.10 Save project, compile and check consistency</td>
<td>330</td>
</tr>
<tr>
<td>7.4 Performing a firmware and project update</td>
<td>331</td>
</tr>
<tr>
<td>7.4.1 Upgrading the firmware and project update</td>
<td>331</td>
</tr>
<tr>
<td>7.4.2 Update - preparatory measures</td>
<td>331</td>
</tr>
<tr>
<td>7.4.3 Upgrade via IT DIAG</td>
<td>332</td>
</tr>
<tr>
<td>7.4.4 Upgrade via device update tool (upgrading SIMOTION devices)</td>
<td>333</td>
</tr>
<tr>
<td>7.4.5 Update via CompactFlash card</td>
<td>337</td>
</tr>
<tr>
<td>7.4.5.1 Backup of the CompactFlash card data</td>
<td>337</td>
</tr>
<tr>
<td>7.4.5.2 Firmware update via CompactFlash card</td>
<td>339</td>
</tr>
</tbody>
</table>
# Table of contents

8 **Diagnostics** .................................................................................. 347

8.1 Diagnostics via LED displays .............................................................. 347
8.1.1 SIMOTION D4x5-2 and SINAMICS Integrated displays .......................... 348
8.1.2 LED displays of the PROFINET interface ........................................... 354
8.1.3 LED displays of the Ethernet interface .............................................. 357
8.1.4 LED displays of the CX32-2 controller extension ...................................... 357
8.2 Diagnostic data and non-volatile SIMOTION data ................................... 359
8.2.1 Overview ..................................................................................... 359
8.2.2 Backup of diagnostic data and non-volatile SIMOTION data ..................... 359
8.2.2.1 Diagnostic data ......................................................................... 359
8.2.2.2 Non-volatile SIMOTION data (retain data) ...................................... 360
8.2.2.3 Procedure for backing up during operation .................................... 361
8.2.2.4 Procedure for backing up during startup ....................................... 363
8.2.2.5 Storing data ............................................................................. 366
8.2.3 Diagnostics via websites ................................................................... 367
8.2.4 Deleting/restoring non-volatile SIMOTION data ................................... 368
8.2.5 Backing up diagnostics data and non-volatile SIMOTION data using IT DIAG .................................. 370
8.3 Additional service and diagnostics options .......................................... 372
8.3.1 SIMOTION Task Profiler application ................................................. 372
8.3.2 Diagnostics using IT DIAG .......................................................... 372

A **Configuration of drive-related I/Os (without symbolic assignment)** ............... 373
A.1 Overview ..................................................................................... 373
A.2 Local and global measuring inputs ....................................................... 374
A.3 Configuring local measuring inputs ....................................................... 376

B **Standards and approvals** ................................................................. 379
B.1 General rules ................................................................................ 379
B.2 SIMOTION D4x5 device-specific notes ................................................. 381
B.3 Safety of electronic controllers ............................................................. 382

C **ESD guidelines** .............................................................................. 385
C.1 ESD definition .............................................................................. 385
C.2 Electrostatic charging of individuals ...................................................... 386
C.3 Basic measures for protection against discharge of static electricity ............. 387

**Index** .............................................................................................. 389
Description

1.1 System overview

Overview

SIMOTION D is a drive-based version of SIMOTION based on the SINAMICS S120 drive family.

With SIMOTION D, the SIMOTION PLC and motion control functionalities as well as the SINAMICS S120 drive software run on shared control hardware.

SIMOTION D is available in two versions:

- SIMOTION D410-2 is a compact control unit predestined for single-axis applications. The control unit is snapped directly on to the SINAMICS S120 PM340 power modules in blocksize format and has an integrated drive control for either one servo, one vector or one V/f axis.
- SIMOTION D4x5-2 is a control unit for multi-axis applications in the SINAMICS S120 booksize format. The following performance versions are offered:
  - SIMOTION D425-2 (BASIC performance) control unit for up to 16 axes
  - SIMOTION D435-2 (STANDARD performance) control unit for up to 32 axes
  - SIMOTION D445-2 (HIGH performance) control unit for up to 64 axes
  - SIMOTION D455-2 (ULTRA-HIGH performance) control unit for up to 128 axes or applications with very short control cycles

The SIMOTION D4x5 2 is described in this manual. Separate manuals are available for the SIMOTION D410-2 and the D4x5/D410 predecessor modules.

Like SINAMICS S120, SIMOTION D also follows the Totally Integrated Automation (TIA) concept. TIA is characterized by integrated data management, configuration, and communication for all products and systems. Thus, an extensive toolbox of automation modules is also available for SIMOTION D.

Note

In order to cover all versions of SIMOTION D for multi-axis applications, the product will be referred to as "D4x5-2". Specific product designations will be used for information that applies only to one product version, e.g. D445-2 DP/PN.

SIMOTION D4x5-2 DP describes all PROFIBUS versions and SIMOTION D4x5-2 DP/PN all PROFIBUS/PROFINET versions of the SIMOTION D4x5-2 control units.
1.1 System overview

Application

The SIMOTION D4x5-2 is ideally suited to applications with many coordinated axes with high clock-pulse rates.

Typical applications include:

- Compact multiple-axis machines
- High-performance applications with short machine cycles
- Compact machines
  - Including the complete machine control in the drive
  - With extensive connection possibilities for communication, HMI and I/O
- Distributed drive concepts
  - Applications with many axes
  - Synchronization of several SIMOTION D control units using distributed synchronous operation

Versions

The control units are available in the versions SIMOTION D425-2 (BASIC performance), SIMOTION D435-2 (STANDARD performance), SIMOTION D445-2 DP/PN (HIGH performance) and SIMOTION D455-2 DP/PN (ULTRA-HIGH performance). The versions differ in their PLC performance and in their motion control performance. The main distinguishing features are:

Table 1- 1 Device versions and characteristics

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of axes</td>
<td>16</td>
<td>32</td>
<td>64</td>
<td>128</td>
</tr>
<tr>
<td>Minimum servo/interpolator cycle clock</td>
<td>0.5 ms</td>
<td>D435-2 DP: 0.5 ms D435-2 DP/PN: 0.5/0.25 ms</td>
<td>0.5/0.25 ms</td>
<td>0.5/0.25 ms</td>
</tr>
<tr>
<td>DRIVE-CLiQ interfaces</td>
<td>4</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
</tbody>
</table>

1) Explanation:
- 0.5 ms in connection with SINAMICS S120 (incl. SINAMICS Integrated / CX32-2)
- 0.25 ms in connection with Servo_fast and IPO_fast for fast I/O processing or high-performance hydraulic applications. The sensors and actuators are connected via high-speed PROFINET IO I/O modules.

The control units feature PLC and motion control performance (open-loop control and motion control) for up to 16, 32, 64 or 128 axes, as required.

The integrated drive computing performance of the control units allows up to six servo, six vector or twelve V/f axes on each D4x5-2 control unit (drive control based on CU320-2, firmware version ≥ V4.x).
The drive control supports servo control (for a highly dynamic response), vector control (for maximum torque accuracy) and V/f control.

The SIMOTION D4x5-2 control units and their CX32-2, CBE30-2 and TB30 supplementary system components are described in the following.

**Note**

With the SIZER configuration tool, you can easily configure the SINAMICS S110/120 drive family including SIMOTION.

It provides you with support for selecting and dimensioning the components required for a motion control task.

You can also determine the possible number of axes and the resulting load with SIZER in accordance with your performance requirements.

**Hardware components**

As the central hardware, SIMOTION D uses the SIMOTION D4x5-2 as control unit consisting of the SIMOTION runtime system and the SINAMICS drive control. The control unit uses the SINAMICS Integrated drive with various SINAMICS S120 drive modules (line and motor modules) to perform open-loop and closed-loop control of the axis grouping. A range of additional SINAMICS S120 components, such as SMx encoder systems or terminal modules can also be connected via DRIVE-CLiQ. With a few exceptions (e.g. no basic positioner EPOS, no basic operator panel BOP20, etc.), the drive control integrated in SIMOTION D has the same control characteristics and performance features as the SINAMICS S120 CU320-2 control unit. The EPOS functionality is provided by the SIMOTION technology functions. The functionality of SIMOTION D can be expanded with the distributed I/O via PROFIBUS or PROFINET IO.

The following figure shows a typical SIMOTION D axis grouping.
A SIMOTION D axis grouping generally consists of the following elements:

- **SIMOTION D** (control unit) (1)
  This unit contains the programmable runtime system of SIMOTION and the drive software of SINAMICS S120. In principle, SIMOTION D is capable of controlling multiple axes/drives.

- One **SINAMICS infeed** (line module) (2)
  This module generates a DC link from the supply system.

- **SINAMICS power units** (motor modules) (3)
  These modules are used to control motors.
  It is also possible to operate SINAMICS PM340 power modules with the SINAMICS control unit adapter (CUA). A separate infeed is then unnecessary.

- **DRIVE-CLiQ components** (4)
  In SINAMICS S120 / SIMOTION D, the individual components of the drive system communicate with each other via DRIVE-CLiQ. In addition to power components, encoder systems and special DRIVE-CLiQ I/O devices can also be linked via DRIVE-CLiQ.
Extension of the drive computing performance

The motion control performance of a SIMOTION D4x5-2 can be utilized in full by expanding the computing performance at the drive in two different ways:

- SINAMICS S110/S120 control units (e.g. CU320-2, CU305, etc.) complete with further drive components can be connected via PROFIBUS or PROFINET.
- With SIMOTION D4x5-2, the CX32-2 controller extension can be connected via DRIVE-CLiQ. This module is extremely compact, does not require a separate CompactFlash card and can control up to six servo, six vector or twelve V/f axes.

Software components

The basic functionality of SIMOTION D is supplied on a CompactFlash card containing the following:

The SIMOTION runtime system with the following functions:
- Freely programmable runtime system (IEC 61131)
- Various runtime levels (tasks)
- PLC and arithmetic functionality
- Motion control functions
- Communication functions

The SINAMICS S120 drive control with the following functions:
- Closed-loop current and torque control
- Closed-loop speed control
- Closed-loop infeed
1.2 System components

Central components

SIMOTION D4x5-2 communicates with automation components via the following interfaces:

- PROFIBUS DP
- Ethernet
- PROFINET IO
- DRIVE-CLiQ (DRIVE Component Link with IQ)

SIMOTION D features a SINAMICS Integrated drive element. The communication with the SINAMICS Integrated is performed via PROFIBUS mechanisms (DP Integrated), i.e. the communication is handled, for example, via PROFIdrive message frames.

Shorter cycle times and greater numbers of addresses for each node are achieved with the "DP Integrated" compared to the "external PROFIBUS DP".

The most important components of the system and their functions are shown below.

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMOTION D4x5-2</td>
<td>... is the central motion control module.</td>
</tr>
<tr>
<td>controller</td>
<td>This module contains the programmable SIMOTION runtime for the SIMOTION D4x5-2 and the SINAMICS S120 drive software.</td>
</tr>
<tr>
<td></td>
<td>You can use the integrated high-speed digital I/Os as:</td>
</tr>
<tr>
<td></td>
<td>• User-addressable process I/Os</td>
</tr>
<tr>
<td></td>
<td>• Homing inputs</td>
</tr>
<tr>
<td></td>
<td>• Inputs for measuring inputs</td>
</tr>
<tr>
<td></td>
<td>• Outputs for fast output cams</td>
</tr>
<tr>
<td></td>
<td>The measuring sockets can output any analog signals.</td>
</tr>
<tr>
<td>System software</td>
<td>The basic functionality of SIMOTION D is supplied on a CompactFlash card containing the following:</td>
</tr>
<tr>
<td></td>
<td>• SIMOTION runtime (kernel)</td>
</tr>
<tr>
<td></td>
<td>• Drive software of SINAMICS S120 - implements all drive functions</td>
</tr>
<tr>
<td>Power supply</td>
<td>... provides the electronic power supply for SIMOTION D, e.g. via the SITOP power supply.</td>
</tr>
</tbody>
</table>
The control unit can communicate with the following components via the PROFIBUS DP interfaces:

Table 1- 3 Components on PROFIBUS DP

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programming device (PG/PC)</td>
<td>... configures, parameterizes, programs, and tests with the &quot;SIMOTION SCOUT&quot; engineering system (ES)</td>
</tr>
<tr>
<td>SIMATIC HMI device</td>
<td>... is used for operating and monitoring functions. This is not an essential requirement for the operation of a control unit</td>
</tr>
<tr>
<td>Other controllers (e.g. SIMOTION or SIMATIC)</td>
<td>... e.g. higher-level controller (plant controller); modular machine concepts with multiple controllers, distributed across individual machine modules.</td>
</tr>
</tbody>
</table>

**Distributed I/O systems**

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC ET 200M</td>
<td>Modular I/O system for control cabinet installation and high channel density</td>
</tr>
<tr>
<td>SIMATIC ET 200S</td>
<td>Finely scalable I/O system for control cabinet configuration and particularly time-critical applications; including motor starters, safety technology and individual grouping of load groups.</td>
</tr>
<tr>
<td>SIMATIC ET 200pro</td>
<td>Modular I/O system with IP65/67 degree of protection for machine-related applications with no control cabinet; with features such as compact designs, integrated PROFlsafe safety technology, PROFINET connection and live module replacement.</td>
</tr>
<tr>
<td>SIMATIC ET 200eco</td>
<td>I/O system with IP65/67 degree of protection for cabinet-free use close to the machine with flexible and fast ECOFAST or M12 connection methods.</td>
</tr>
</tbody>
</table>

**Other PROFIBUS I/O**

<table>
<thead>
<tr>
<th>Gateways</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• DP/AS-Interface link 20E and DP/AS-Interface link Advanced for the PROFIBUS DP gateway to AS-Interface</td>
<td></td>
</tr>
<tr>
<td>• DP/DP coupler for connecting two PROFIBUS DP networks</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Drive interfaces</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• ADI4 (Analog Drive Interface for four axes) for connection of drives with analog ±10 V setpoint interface or for external encoders</td>
<td></td>
</tr>
<tr>
<td>• IM174 (interface module for four axes) for connection of drives with analog ±10 V setpoint interface, for external encoders, or for connection of stepper drives with pulse-direction interface</td>
<td></td>
</tr>
</tbody>
</table>

| Drive units with PROFIBUS DP interface (e.g. SINAMICS S120) | ... convert speed setpoints into signals for controlling the motor and supply the power required to operate the motors. Also can be operated as an isochronous slave on PROFIBUS DP. |

| Teleservice adapter | Remote diagnostics |
1.2 System components

Ethernet

The control unit can communicate with the following components via the Ethernet interfaces or be embedded in an automation environment:

Table 1- 4 Components on the Ethernet

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programming device (PG/PC)</td>
<td>... configures, parameterizes, programs, and tests with the &quot;SIMOTION SCOUT&quot; engineering system (ES)</td>
</tr>
<tr>
<td>Master computer</td>
<td>... communicates with other devices via UDP, TCP/IP</td>
</tr>
<tr>
<td>SIMATIC HMI device</td>
<td>... is used for operating and monitoring functions. This is not an essential requirement for the operation of a control unit.</td>
</tr>
</tbody>
</table>

PROFINET IO

The D4x5-2 DP/PN can communicate with the following components via the onboard PROFINET IO interface or via the Ethernet communication board (CBE30-2).

Table 1- 5 Components on the PROFINET IO

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programming device (PG/PC)</td>
<td>... configures, sets parameters, programs, and tests using the &quot;SIMOTION SCOUT&quot; Engineering System (ES).</td>
</tr>
<tr>
<td>SIMATIC HMI device</td>
<td>... is used for operating and monitoring functions. This is not an essential requirement for the operation of a control unit.</td>
</tr>
<tr>
<td>Other controllers (e.g. SIMOTION or SIMATIC)</td>
<td>... e.g. higher-level controller (plant controller); modular machine concepts with multiple controllers, distributed across individual machine modules.</td>
</tr>
<tr>
<td>Master computer</td>
<td>... communicates with other devices via UDP, TCP/IP.</td>
</tr>
</tbody>
</table>

Distributed I/O systems

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMC</td>
<td>Multi-channel, fast and isochronous I/O for mechanical engineering with PROFINET IO connection in a rugged SINAMICS S120 booksize compact format; direct connection of the I/O channels on the module or separately via wiring modules.</td>
</tr>
<tr>
<td>SIMATIC ET 200M</td>
<td>Modular I/O system for control cabinet installation and high channel densities.</td>
</tr>
<tr>
<td>SIMATIC ET 200S</td>
<td>Finely scalable I/O system for control cabinet configuration and particularly time-critical applications; including motor starters, safety technology and individual grouping of load groups.</td>
</tr>
<tr>
<td>SIMATIC ET 200pro</td>
<td>Modular I/O system with IP65/67 degree of protection for machine-related applications with no control cabinet; with features such as compact designs, integrated PROFIsafe safety technology, PROFINET IO connection and live module replacement.</td>
</tr>
<tr>
<td>SIMATIC ET 200eco PN</td>
<td>Compact block I/O with IP65/66/67 degree of protection for cabinet-free usage in machines with M12 connection method. Very rugged and resistant encapsulated metal enclosure.</td>
</tr>
</tbody>
</table>
1.2 System components

**Component Function**

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other PROFINET IO I/O devices</td>
<td></td>
</tr>
<tr>
<td>Drive units with PROFINET IO interface</td>
<td>... convert speed setpoints into signals for controlling the motor and supply the power required to operate the motors.</td>
</tr>
<tr>
<td>Gateways</td>
<td></td>
</tr>
</tbody>
</table>
| | • IE/AS-Interface link PN IO for the PROFINET IO gateway to AS-Interface  
| | • PN/PN coupler for connecting two PROFINET IO networks |

**DRIVE-CLiQ**

The DRIVE-CLiQ interfaces permit a fast connection to the SINAMICS drive components. DRIVE-CLiQ offers the following advantages within the DRIVE-CLiQ topology rules:
- Expandability of components
- Automatic detection of components by the control unit
- Standardized interfaces to all components
- Uniform diagnostics down to the components
- Complete service down to the components
- Simple mechanical handling

The controller can communicate with the following components via DRIVE-CLiQ:

<p>| Table 1-6 Components connected to DRIVE-CLiQ |  |</p>
<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control unit (SINAMICS S110/S120)</td>
<td>Central control module in which the open- and closed-loop control functions for the drive are implemented.</td>
</tr>
<tr>
<td>Line module (SINAMICS S120)</td>
<td>... generates a DC link from the supply system.</td>
</tr>
<tr>
<td>Motor module (SINAMICS S120)</td>
<td>... used to control motors (DC/AC inverters, booksize).</td>
</tr>
<tr>
<td>Power module (SINAMICS S110/S120)</td>
<td>... used to control motors (AC/DC converters, blocksize).</td>
</tr>
<tr>
<td>CX32-2 controller extension</td>
<td>... enables additional axes to be connected for SIMOTION D4x5-2.</td>
</tr>
<tr>
<td>CUA31/CUA32 control unit adapter</td>
<td>... enables a blocksize power module (PM340) to be connected to a booksize control unit D4x5-2, CX32-2 or CU320-2.</td>
</tr>
<tr>
<td>TM31 terminal module</td>
<td>... enables a terminal expansion via DRIVE-CLiQ (additional analog and digital I/Os).</td>
</tr>
<tr>
<td>TM41 terminal module</td>
<td>... enables a terminal expansion (analog and digital I/Os) and encoder simulation.</td>
</tr>
<tr>
<td>TM54F terminal module</td>
<td>... enables terminal expansion (secure digital I/Os) for controlling the secure motion monitoring functions of the integrated drives.</td>
</tr>
<tr>
<td>TM15, TM17 High Feature terminal modules</td>
<td>The terminal modules TM15 and TM17 High Feature are used to implement inputs of measuring inputs and outputs of output cams. In addition, these terminal modules provide drive-related digital inputs and outputs with short signal delay times.</td>
</tr>
</tbody>
</table>
1.2 System components

### Component Function

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMx sensor modules</td>
<td>... enable acquisition of encoder data from connected motors via DRIVE-CLiQ.</td>
</tr>
<tr>
<td>Motors with DRIVE-CLiQ interface</td>
<td>... allow simplified commissioning and diagnostics, as the motor and encoder type are identified automatically.</td>
</tr>
<tr>
<td>DMC20/DME20 DRIVE-CLiQ hub</td>
<td>… enables the number of DRIVE-CLiQ interfaces to be increased and the creation of a point-to-point topology.</td>
</tr>
</tbody>
</table>

### Note

You can find detailed information about components in the SINAMICS S110/S120 family of products in the SINAMICS S110/S120 manuals.

It is possible that older DRIVE-CLiQ components can no longer be used with SIMOTION D4x5-2/CX32-2. You can find detailed information on this in SIMOTION D4x5-2 Commissioning and Hardware Installation Manual at "Migration of D4x5 to D4x5-2" in Section "Permissible combinations".

### Optional components

The functionality of the D4x5-2 control unit can be expanded with the following components:

Table 1-7 Optional components

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
<th>D4x5-2 DP</th>
<th>D4x5-2 DP/PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBE30-2 Ethernet communication board</td>
<td>Communication via PROFINET IO with IRT and PROFINET IO with RT</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>TB30 terminal board</td>
<td>Terminal expansion, i.e. additional analog and digital I/Os</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The components are plugged into the option slot of the control unit.
1.3 I/O integration

Note

Note that not all modules in the ET 200 I/O family are approved for SIMOTION. Moreover, system-related functional differences can come into play when these I/Os or I/O systems are used on SIMOTION vs. on SIMATIC. For example, special process-control functions (e.g. HART modules, etc.) are not supported by SIMOTION for the ET 200M distributed I/O system.

A detailed, regularly updated list of the I/O modules approved for use with SIMOTION, as well as notes on their use, can be found on the Internet at: [http://support.automation.siemens.com/WW/view/en/11886029](http://support.automation.siemens.com/WW/view/en/11886029)

In addition to the I/O modules enabled for SIMOTION, in principle all certified standard PROFIBUS slaves (DP-V0/DP-V1/DP-V2) and PROFINET IO devices with RT and IRT real-time classes may be connected to SIMOTION D4x5-2. These modules are integrated using the GSD file (PROFIBUS) or GSDML file (PROFINET) provided by the relevant device manufacturer.

Note

Please note that in individual cases further boundary conditions must be fulfilled in order to integrate a standard slave/standard device into SIMOTION. Thus, a few modules require "driver blocks", e.g. in the form of function blocks, that permit (or simplify) integration.

For modules released with SIMOTION (e.g. SIMATIC S7-300 module FM 350-1, etc.), these driver blocks are part of the SIMOTION SCOUT engineering system command library.
1.4 Commissioning software

Requirement

To create and edit projects on your PG/PC, you need the SIMOTION SCOUT commissioning and configuration tool. For information on how to install SIMOTION SCOUT, refer to the SIMOTION SCOUT Configuration Manual.

Note

SIMOTION SCOUT contains the functionality of STARTER and SIMATIC S7-Technology. Simultaneous operation of SIMOTION SCOUT, STARTER and SIMATIC S7-Technology as a single installation on one PC/PG is not possible.

Integrated STARTER

You can insert a standalone drive (e.g. SINAMICS S120) with the "Insert single drive unit" element in the project navigator. It is commissioned using wizards in the working area of the workbench that contains the STARTER functionality.

SINAMICS Support Package (SSP)

The following SSPs are relevant for SIMOTION SCOUT:

- SSP "SINAMICS" for single drive units (e.g. CU3xx)
- "SIMOTION SINAMICS Integrated" SSP for the SINAMICS drives integrated into SIMOTION D.

You can find detailed information on the SSPs in the readme files and in the software compatibility list at Internet address [http://support.automation.siemens.com/WW/view/en/18857317](http://support.automation.siemens.com/WW/view/en/18857317).

Upgrading SIMOTION D4x5-2 projects and hardware

Projects that you have created for one SIMOTION D4x5-2 firmware version can also be converted for other firmware versions. You can also change the version of the SIMOTION D4x5-2. For example, a D445-2 DP/PN can be converted to a D455-2 DP/PN (and vice versa, insofar as the performance and quantity structure allow this). See, for example, Section Adapting a project (Upgrading the project / Replacing the SIMOTION controller) (Page 319).
IT DIAG

The SIMOTION D4x5-2 features an integrated Web server.

The web server supports the display of diagnostics and system data in standard Internet browsers, even in the absence of an engineering system, and the carrying out of project/firmware updates.

As of firmware version V4.2, it is no longer necessary to purchase licenses for SIMOTION IT DIAG and SIMOTION IT OPC XML-DA.

Additional references

For detailed information on working with projects, refer to the SIMOTION SCOUT Configuration Manual.

For detailed information about IT DIAG, see the SIMOTION IT Ethernet-based HMI and Diagnostic Functions Diagnostics Manual.
### 1.5 Safety information

Note the following safety information when working with the Control Unit and its components.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The 80 mm clearances above and below the components must be observed. The unit protects itself from overheating by shutting down.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>An option board may only be inserted and removed when the Control Unit and option board are disconnected from the power supply.</td>
</tr>
<tr>
<td>The CompactFlash card may only be inserted or removed when the Control Unit is disconnected from the power supply.</td>
</tr>
<tr>
<td>The SIMOTION D4x5-2 is in a de-energized state when all the LEDs are off.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safe, problem-free operation of SIMOTION D Control Units assumes proper transportation, storage, setup, and installation, as well as careful operation and maintenance.</td>
</tr>
<tr>
<td>In addition to the danger and warning information provided in the technical customer documentation, the applicable national, local, and plant-specific regulations and requirements must be taken into account.</td>
</tr>
<tr>
<td>Only safety extra-low voltage in accordance with EN/IEC 60950-1 may be connected to all connections and terminals.</td>
</tr>
</tbody>
</table>
2

Installing

2.1 Installation notes

Open components

These modules are open equipment. This means they may only be installed in housings, cabinets, or in electrical equipment rooms that can only be entered or accessed with a key or tool. Housings, cabinets, or electrical equipment rooms may only be accessed by trained or authorized personnel. An external fire-protection housing is required.

⚠️ DANGER
The system must be de-energized when you install the control unit.

2.2 Installing the SIMOTION D4x5-2

2.2.1 Installing the SIMOTION D4x5-2

Requirement

The control unit is installed in a control cabinet along with the SINAMICS components. The following requirements must be met for installing a control unit:
- The control cabinet has been installed and wired.
- The SINAMICS components should already have been installed and wired.
- Components and tools are available.

Designs

A D4x5-2 control unit is designed similar to a SINAMICS S120 booksize unit. It is mounted directly on the wall of the control cabinet, whereby a distinction is made between the following designs.
- Mounting the SIMOTION D4x5-2 with spacers
- Mounting the SIMOTION D425-2 and D435-2 without spacers
- Mounting the SIMOTION D445-2 and D455-2 without spacers (external air cooling)
The D425-2 and D435-2 control units do not have any cooling fins on the rear side of the module so that the spacers can be removed if required.

As the D445-2 and D455-2 control units have cooling fins, the spacers can be removed when external air cooling is used.

With external air cooling, the cooling fins are outside of the control cabinet. A seal is required so that the control unit can be hermetically mounted in the rear cabinet panel.

The fan/battery module can be mounted or replaced without having to disassemble the control unit. As the control unit is similar to the SINAMICS S120 family with regard to installation, please also refer to the information in the SINAMICS manuals.

The same installation instructions apply for the SIMOTION D4x5-2/CX32-2 control units as for the SINAMICS S120 CU320-2 control units with regard to EMC. For further information, see the SINAMICS manuals.

Mounting and installation aids

The control unit is designed for mounting in a control cabinet (IP20 degree of protection). All versions of SIMOTION D4x5-2 are supplied with pre-assembled spacers for installation on the wall of the control cabinet. The spacers can be removed if necessary.

See also

Mounting the SIMOTION D4x5-2 with spacers (Page 29)
2.2.2 Mounting the SIMOTION D4x5-2 with spacers

By using spacers, you can attach the control unit to a bare, metallic rear wall of a control cabinet with good electrical conductivity with two M6 screws.

Purpose of this type of installation

This type of mounting is needed if:

- The heat is to be dissipate within the control cabinet
- The mounting depth of the SINAMICS S120 booksize grouping is to be achieved

The spacers are included in the scope of delivery of a control unit and are preassembled.

Procedure

1. Mount the spacers on the control unit, if they have previously been removed.
2. Use two M6 screws to mount the control unit on the wall of the control cabinet (6 Nm tightening torque).

Result

The control unit is arranged flush with the grouping on the wall of the control cabinet.
2.2.3 Mounting the SIMOTION D425-2 and D435-2 without spacers

The control units are supplied with pre-assembled spacers. For mounting without spacers, proceed as follows:

1. Remove the upper and lower spacers (screws: M3, Torx T10)
2. There is a metal clip under the upper spacer; when shipped, the clip is pushed in and secured with three screws (M3, Torx T10) fixed. Loosen the screws and push the clip up until the upper hole extends beyond the housing.
3. Tighten up the three screws on the clip again (0.8 Nm tightening torque).
4. Mount the top and bottom of the control unit directly on the cabinet wall with two M6 screws (6 Nm tightening torque).

![Mounting the control unit without spacers](image-url)
2.2.4 Mounting the SIMOTION D445-2 and D455-2 without spacers (external air cooling)

Purpose of this type of installation

If you want to externally cool a control unit with cooling fins (D445-2 DP/PN and D455-2 DP/PN), it can be mounted directly on the rear wall of the control cabinet without spacers.

Requirements

- The bushing for the cooling fins (external heat sink) has been fitted in the rear wall of the control cabinet.
- Please ensure the area around the seal is both smooth and clean (please see figure titled "Panel cutout").
- Seal available (for the order number, see the SIMOTION D4x5-2 Manual, Section Spare parts and accessories)

![Panel cutout diagram](image)
Procedure

1. Remove the spacers (screws: M3, Torx T10).
2. Fit the seal around the cooling fins of the control unit.

3. Loosen the three M3 screws (screws: M3, Torx T10) on the upper clip and push the clip up until the upper hole protrudes beyond the housing.
4. Tighten up the three screws on the clip again (0.8 Nm tightening torque).
5. Push the control unit with the heat sink through the panel cutout.
6. Fasten the control unit directly on the rear wall of the control cabinet with an M6 screw at the top and bottom, tightening torque: 6 Nm (see ① in the "Panel cutout" figure).
2.3 Installing supplementary system components

2.3.1 Installing the TB30

Requirement

Note
The TB30 terminal board may only be inserted and removed when the D4x5-2 control unit and the terminal board are de-energized.

Procedure

The TB30 is installed in the option slot of the control unit.

Figure 2-6 Installation of the TB30 terminal board using the D445-2 DP/PN as an example
2.3 Installing supplementary system components

2.3.2 Installing the CBE30-2

A second PROFINET interface can be implemented for the SIMOTION D4x5-2 DP/PN with the CBE30-2 Ethernet communication board.

The CBE30-2 cannot be used with the SIMOTION D4x5-2 DP.

Requirement

Note

The CBE30-2 Ethernet communication board may only be inserted and removed when the D4x5-2 DP/PN control unit and the CBE30-2 are de-energized.

Procedure

A CBE30-2 is installed in the option slot of the control unit.

Figure 2-7  Installing the CBE30-2
2.3.3 Installing the CX32-2

Overview

The CX32-2 can be installed in several ways.

Mounting the CX32-2 directly on a line module in booksize format

The CX32-2 can be mounted on the side wall of a SINAMICS S120 line module. The mounting fixtures required for this are supplied with the SINAMICS S120 line module.

The SINAMICS S120 line module has five mounting fixtures on the left side. To mount the control unit, proceed as follows (the steps are shown in the figure):

1. Attach the CX32-2 to the left side of the SINAMICS S120 line module. Position the CX32-2 a few millimeters higher than the line module. The mounting fixtures fit exactly in the five cutouts on the module.

2. Push the two units together.

3. Press down on the module until the unit engages and is securely connected to the SINAMICS S120 line module.

The module is now flush with the line module at the top and front.

Figure 2-8 Steps in mounting the CX32-2 on a booksize line module
2.3 Installing supplementary system components

Mounting the CX32-2 on another CX32-2

A description with photos of opening the cover can be found in Section Removing the cover of the CX32-2 (Page 40).

<table>
<thead>
<tr>
<th>Opening the covers.</th>
<th>Unscrewing the screw (M3, Torx T10)</th>
<th>The bracket must be moved so that the pin is in the opening of the bracket. Tighten the screw (tightening torque 0.8 Nm).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounted bracket.</td>
<td>Closing the cover.</td>
<td></td>
</tr>
</tbody>
</table>

Table 2-1 Mounting a CX32-2 on another CX32-2
Mounting the CX32-2 next to D4x5-2

If the CX32-2 is mounted next to a D4x5-2, the two modules can be mechanically connected with the bracket.

1. Loosen the screw (M3, Torx T10).
2. Disassemble the bracket at its original position.
3. Mount the bracket at the shield clamp, as shown in the following figure (tightening torque 0.8 Nm).

Figure 2-9 Mechanical connection CX32-2 with D4x5-2
2.3 Installing supplementary system components

Mounting the CX32-2 directly on a mounting surface

A spacer is pre-assembled on the CX32-2. To mount the CX32-2 directly on a mounting surface, you must first disassemble the spacer as follows:

Table 2-2 Disassembling the CX32-2 spacer

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Loosen the screws on the mounting rail (M3, Torx T10) and remove the rail.</td>
</tr>
<tr>
<td>2</td>
<td>Loosen the screws of the spacer (M3, Torx T10) and remove the spacer.</td>
</tr>
<tr>
<td>3</td>
<td>Fasten the mounting rail to the CX32-2 again without spacer (tightening torque 0.8 Nm).</td>
</tr>
</tbody>
</table>
The CX32-2 can now be mounted directly on a mounting surface, e.g. a wall of the control cabinet. It is fastened with two screws M6 / 6 Nm.

Figure 2-10  Mounting the CX32-2 on a mounting surface
2.3 Installing supplementary system components

CX32-2 with spacers on a mounting surface

To achieve the correct mounting depth for a booksize line-up with internal air cooling, a spacer is pre-assembled on the CX32-2. The spacer must then be fixed to the mounting surface.

![Figure 2-11 Mounting a CX32-2 with spacers](image)

2.3.4 Removing the cover of the CX32-2

Actions to remove the cover of the CX32-2

Several steps are required to remove the cover:

- Release
- Swing open through approx. 45°
- Remove

Note that the cover can only be removed when it has been swung open through approx. 45°.

See also

Opening the front cover (Page 47)
Connecting

3.1 General Overview

Overview

The SIMOTION D4x5-2 has a number of interfaces that can be used for connecting the power supply and for communication with the other components of the system. To make these connections, the front cover of the SIMOTION D4x5-2 must be opened.

- The different SINAMICS components are interconnected via DRIVE-CLiQ.
- Actuators and sensors can be connected to the digital inputs/outputs.
- For communication purposes, the SIMOTION D4x5-2 can be connected to PROFIBUS DP, PROFINET IO with IRT/RT, MPI and Ethernet.
Connecting

3.1 General Overview

Overview of connections

The following overview shows examples of the various interfaces and their connection possibilities.

Figure 3-1 SIMOTION D4x5-2 DP and D4x5-2 DP/PN connection options
3.2 Safety information for wiring

Requirement

You have mounted the Control Unit in the control cabinet.

The SIMOTION D4x5-2 Control Unit has a connection for the protective conductor and a connection for the equipotential bonding conductor (M5 screw, Torx T25). Only one connection is available for the CX32-2 - this must be used both for the protective conductor and the equipotential bonding conductor.

Note

Requirements for functional safety for machines and systems; reliability and EMC are only guaranteed with original SIEMENS cables.

Note the following safety information:

⚠️ DANGER

De-energize the system/machine before you wire the Control Unit.

Protective conductor connection

SIMOTION D and the SINAMICS S120 drive system are designed for use in cabinets with a protective conductor connection.

All system components and machine parts must be incorporated in the protection concept. The drive line-up must be arranged on a common bright mounting plate ① in order to comply with the EMC limit values. The connection ② establishes a low-impedance connection to the mounting plate.

The mounting plate must be connected to the protective conductor connection of the control cabinet. For this purpose, a connection ③ must be established to the protective conductor bar ④. The protective conductor bar ④ must be connected to the protective conductor ⑤.

The protective connection (PE connection) that is used for the motors ⑥ must be established through the motor cable.

For EMC reasons, the motor cable shield must be laid flat at both the Motor Module (MM) / Power Module (PM) and motor.

A protective connection ⑧ must also be established for components that are not connected with low impedance (e.g. control cabinet door via hinges ⑦).

Example: Booksize axis grouping comprising Control Unit (CU), line module (LM) and motor modules (MM) as well as drive in blocksize format comprising a power module (PM) with snapped on Control Unit (CU)
Connecting

3.2 Safety information for wiring

Figure 3-2 Protective conductor connection, cabinet with mounting plate / equipotential bonding surface

The protective conductor connections must be dimensioned as follows:

Table 3-1 Conductor cross-section for copper protective connections

<table>
<thead>
<tr>
<th>Line supply cable in mm²</th>
<th>Copper protective connections in mm²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 16 mm²</td>
<td>The same as the line supply cable</td>
</tr>
<tr>
<td>From 16 mm² to 35 mm²</td>
<td>16 mm²</td>
</tr>
<tr>
<td>From 35 mm²</td>
<td>0.5 x line supply cable</td>
</tr>
</tbody>
</table>

For materials other than copper, the cross-section should be increased so that as a minimum, the same conductivity is attained.
Equipotential bonding

A mounting plate serves simultaneously as an equipotential bonding surface. This means that no additional equipotential bonding is required within the drive line-up. If a common bright mounting plate is not available, then equally good equipotential bonding must be established using cable cross-sections as listed in the table above or, as a minimum, with the same conductivity.

Communication links

Within the same control cabinet, no equipotential bonding conductor is required for fieldbus components if they installed as described above.

You have to ensure equipotential bonding for communication connections between remote components in a system (e.g. devices in different control cabinets) as well as between buildings or building sections.

If, for example, data cables (PROFIBUS, PROFINET, Ethernet or DRIVE-CLiQ) are routed through several control cabinets, equipotential bonding must be established with an equipotential bonding conductor. Install the equipotential bonding conductor together with the data cable.
The following minimum cross-sections are required according to IEC 60364-5-54:

- For copper, at least 6 mm²
- For aluminum, at least 16 mm²
- For steel, at least 50 mm²

**Note**

If this is not observed, high leakage currents can flow through the cable. This can result in a fault in the data connection or device defects.

Due to the maximum length of 100 m for PROFIBUS copper cable at 12 Mbit/s or for PROFINET copper cable and due to the electrical isolation, EMC protection and equipotential bonding aspects, it is recommended that fiber-optic cables be used for connections between buildings.

**Additional information**

Further information on the protective connection and equipotential bonding can be found in the following references:

- SINAMICS drive system: See the SINAMICS manuals
- PROFIBUS: See the following Internet address ([http://www.profibus.com/fileadmin/media/wbt/WBT_Assembly_V10_Dec06/start.html](http://www.profibus.com/fileadmin/media/wbt/WBT_Assembly_V10_Dec06/start.html))
- PROFINET: See the following Internet address ([http://www.profibus.com](http://www.profibus.com)) (at Downloads)
3.3 Opening the front cover

Introduction

The interfaces on the front side of the D4x5-2 and the CX32-2 have a cover. This is opened by swinging the front cover down; the interface connections are then accessible and can be wired.

A hinge connects the front cover to the front of the housing. Once opened, the cover can be removed. The front cover is closed by swinging it up; it automatically locks by means of a hook at the top of the device housing.

Note

The cover of the D4x5-2 and CX32-2 can only be removed when it has been swung open through approx. 45°.

Procedure for D4x5-2 and CX32-2

1. Release the latch at the top on the inside of the front cover by pushing down the hook (see the following figure).
2. Remove the front cover with a forward motion.

![Opening the front cover using the D4x5-2 as an example](image)
3.3 Opening the front cover

Note

All cables must be routed vertically upwards to the fullest extent possible so that the front cover can be closed. The front cover has an outlet for the upward routing of these cables.

See also

Removing the cover of the CX32-2 (Page 40)
3.4 Power supply

3.4.1 Safety rules

Basic rules

Because of the wide range of possible applications, only the basic rules for electrical installation are described in this section. At a minimum, you must comply with these basic rules to ensure problem-free operation.

Rules for safe operation

In order to ensure safe operation of your equipment, implement the following measures, adapting them to suit your conditions:

- An EMERGENCY STOP concept in accordance with the generally accepted rules of current engineering practice (e.g. European standards EN 60204, EN 418, and similar).
- Additional measures for end position limiting of axes (e.g. hardware limit switches).
- Equipment and measures for protection of motors and power electronics in accordance with the SINAMICS installation guidelines.

In order to identify hazards, we also recommend that a risk analysis be conducted on the entire system in accordance with the basic safety requirements set out in Appendix 1 of the EU machinery directive.

Additional references

- Guidelines on Handling Electrostatically Sensitive Devices (ESD), see Appendix.
- For configuring a system with SIMATIC ET 200 I/O (e.g. ET 200S, ET 200M, ...), refer to the manuals for the ET 200 I/O system.
- For further information on EMC directives, we recommend: EMC Installation Guide, Configuring Guide (HW), Order no.: 6FC5 297-0AD30-0AP2.
3.4.2 Standards and regulations

VDE guideline compliance

During wiring, you must observe the appropriate VDE guidelines, in particular VDE 0100 and VDE 0113 for tripping devices and short-circuit and overload protection.

System startup after certain events:

The following list identifies considerations required for startup of a system following certain events.

- If the system starts up again following a voltage drop or power failure, all hazardous operating states must be prevented from occurring. If necessary, force an EMERGENCY OFF.
- If the system starts up again after the EMERGENCY OFF apparatus is released, the startup must not be unchecked or undefined.

3.4.3 Mains voltage

Rules for the line voltage

The following list indicates what you must take into account for the line voltage:

- For stationary installations or systems that do not have all-pole line disconnect switches, the building installation must include a line disconnect switch or a fuse.
- For load power supplies and power supply modules, the rated voltage range set must correspond to the local line voltage.
- For all circuits, the fluctuation/deviation of the line voltage from the rated value must be within the permitted tolerance (see the technical data for the SIMOTION D and SINAMICS modules).

24 VDC supply

<table>
<thead>
<tr>
<th>For...</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buildings</td>
<td>External lightning protection</td>
</tr>
<tr>
<td>24 VDC supply lines, signal lines</td>
<td>Internal lightning protection</td>
</tr>
<tr>
<td>24 V supply</td>
<td>safe (electrical) isolation of the extra-low voltage</td>
</tr>
</tbody>
</table>
Protection against external electrical interference

The table below shows how you must protect your system against electrical interference or faults.

Table 3-2 External electrical phenomena

<table>
<thead>
<tr>
<th>For ...</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>All plant or systems in which the component is installed</td>
<td>The plant or system is connected to a protective conductor for the discharge of electromagnetic interference.</td>
</tr>
<tr>
<td>Supply, signal, and bus lines</td>
<td>The wiring arrangement and installation complies with EMC regulations.</td>
</tr>
<tr>
<td>Signal and bus lines</td>
<td>A cable or wire break cannot lead to undefined states in the plant or system.</td>
</tr>
</tbody>
</table>

Additional references

The same installation instructions apply for the SIMOTION D4x5-2/CX32-2 control units as for the SINAMICS S120 CU320-2 control units with regard to EMC. See the SINAMICS manuals.

3.4.4 Connecting the power supply

Wiring the screw-type terminal block

The required 24 VDC load power supply is connected to the screw-type terminal block. The terminal block must be screwed on tightly using a flat-bladed screwdriver.

⚠️ DANGER

The 24 VDC should be configured as functional extra-low voltage with safe isolation.

Supply system lines

Use flexible cables with a cross section of 0.25 to 2.5 mm² (or AWG 23 to AWG 13) for wiring the power supply.

If you only use one wire per connection, a ferrule is not required.

You can use ferrules without an insulating collar in accordance with DIN 46228, Form A long version.

Pin assignments

For the pin assignment of the screw-type terminal block, see the SIMOTION D4x5-2 Manual.
3.5 Connecting DRIVE-CLiQ components

3.5.1 DRIVE-CLiQ wiring

Introduction

The components of the SINAMICS S120 drive family and the SIMOTION D4x5-2 with CX32-2 are wired together by means of DRIVE-CLiQ. DRIVE-CLiQ is a communication system that enables the SIMOTION D4x5-2 to detect the connected components automatically. It provides a wiring tree whose topology can be visualized in SIMOTION SCOUT.

Note

For information on the number of DRIVE-CLiQ interfaces and their properties, refer to the SIMOTION D4x5-2 Manual.

Rules for the DRIVE-CLiQ wiring

The following rules must be followed for DRIVE-CLiQ wiring:

- Ring wiring is not permitted
- Components must not be double-wired
- For a motor module, the power line for the motor and the associated motor encoder must be connected.

Further information on DRIVE-CLiQ wiring can be found

- In the SINAMICS S120 Function Manual, Section Rules for wiring with DRIVE-CLiQ
- In the SINAMICS S120 Control Units and Supplementary System Components Manual
Example

The example in the following figure shows the rules for DRIVE-CLiQ wiring.

![DRIVE-CLiQ Wiring Diagram](image)

**Figure 3-5** DRIVE-CLiQ wiring using the D425-2 as an example
3.5 Connecting DRIVE-CLiQ components

3.5.2 Connectable DRIVE-CLiQ components

Components

As a general principle, all SINAMICS components approved for SIMOTION D can be connected directly to SIMOTION D or another DRIVE-CLiQ component using the DRIVE-CLiQ interface.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CX32-2 controller extension</td>
<td>The CX32-2 enables scaling of the drive-side computing performance of the SIMOTION D4x5-2. Each CX32-2 can operate up to six additional servo, six vector or twelve V/f axes.</td>
</tr>
<tr>
<td>Line modules</td>
<td>Line modules (e.g. Active line modules) provide the DC-link voltage and can be connected via DRIVE-CLiQ depending on the module type.</td>
</tr>
<tr>
<td>Motor modules</td>
<td>Motor modules are used to control motors. SMC modules for processing encoder signals, for example, can be connected to motor modules. Motor modules are available in the version:</td>
</tr>
<tr>
<td></td>
<td>• Single motor module (SMM) for connection of a motor</td>
</tr>
<tr>
<td></td>
<td>• Double motor module (DMM) for connection of two motors</td>
</tr>
<tr>
<td>Motors with DRIVE-CLiQ interface</td>
<td>Motors with a DRIVE-CLiQ interface allow simplified commissioning and diagnostics, because the motor and encoder type are identified automatically.</td>
</tr>
<tr>
<td>SMx modules</td>
<td>SMx sensor modules allow the acquisition of encoder data from the connected motors via DRIVE-CLiQ.</td>
</tr>
<tr>
<td>TM15 and TM17 High Feature terminal modules</td>
<td>The TM15 and TM17 High Feature terminal modules are used to implement inputs for measuring inputs and outputs for cam outputs. In addition, these terminal modules provide drive-related digital I/Os with short signal delay times.</td>
</tr>
<tr>
<td></td>
<td>• TM15: 24 isolated bidirectional digital I/Os, with measuring input and output cam functionality</td>
</tr>
<tr>
<td></td>
<td>• TM17 High Feature: 16 non-floating, bidirectional digital I/Os with measuring input and output cam functionality for the highest demands with respect to resolution, accuracy and short input delay times.</td>
</tr>
<tr>
<td>TM31 terminal module</td>
<td>TM31 provides 8 DI, 4 bidirectional digital I/Os, 2 relay outputs, 2 AI, 2 AO and 1 temperature sensor input (KTY84-130 or PTC).</td>
</tr>
<tr>
<td>TM41 terminal module</td>
<td>TM41 provides 4 DI, 4 bidirectional digital I/Os, 1 AI and 1 TTL encoder output.</td>
</tr>
<tr>
<td>TM54F terminal module</td>
<td>TM54F provides the following interfaces: 4 fail-safe DO (F-DO), 10 fail-safe DI (F-DI), 2 sensor power supplies with dynamic capability, 1 sensor power supply without dynamic capability and 4 DI to check the F-DO during a test stop.</td>
</tr>
<tr>
<td>DMC20/DME20</td>
<td>DRIVE-CLiQ hubs provide 4 more DRIVE-CLiQ interfaces. They can be used, for example, to establish point-to-point topologies.</td>
</tr>
<tr>
<td></td>
<td>• DMC20 is the hub for the control cabinet configuration</td>
</tr>
<tr>
<td></td>
<td>• DME20 is the hub for use without a control cabinet (IP67 degree of protection)</td>
</tr>
<tr>
<td>SINAMICS S120 power module (with CUA31/CUA32)</td>
<td>An AC DRIVE PM340 power module can be connected using the CUA31/CUA32 control unit adapter. You will find more information on the CUA31/CUA32 in the SINAMICS S120 AC Drive Manual.</td>
</tr>
</tbody>
</table>
Example of axis grouping

The following figure shows a possible DRIVE-CLiQ wiring scheme for an axis grouping.

![Diagram of DRIVE-CLiQ components]

Figure 3-6  Axis grouping with DRIVE-CLiQ using the D425-2 as an example

Restrictions

Some "older" DRIVE-CLiQ components can no longer be used with the SIMOTION D4x5-2/CX32-2. Refer to the Permissible combinations (Page 306) for details.
3.5 Connecting DRIVE-CLiQ components

3.5.3 Connecting the CX32-2

Installation/Mounting/Wiring

Information on installing, mounting and wiring the CX32-2 can be found in the SIMOTION D4x5-2 Manual.

CX32-2 DRIVE-CLiQ topology

In contrast to other DRIVE-CLiQ components (e.g. terminal modules), special rules apply when wiring the CX32-2.

- Only a point-to-point topology is possible between the CX32-2 and SIMOTION D. Each CX32-2 needs its own DRIVE-CLiQ port on the SIMOTION D control unit.
- When a CX32-2 is inserted in an existing DRIVE-CLiQ connection (target port for CX32-2 is occupied, e.g. by a TM31), this connection is disconnected and replaced by the CX32-2 connection. The component that is freed up is moved to the component archive of the SINAMICS topology overview. A notice is displayed indicating that the component has been moved to the archive. The components must then be reassigned.
- A CX32-2 is inserted via HW Config (see Section Configuration of a CX32-2 (Page 194)). Whereby the selection made for the PROFIBUS address automatically and permanently assigns the DRIVE-CLiQ port for connecting the CX32-2. Given that this assignment is permanent, the following points must be noted:
  - An inserted and configured CX32-2 cannot be connected to another DRIVE-CLiQ port without taking additional measures. Reconnecting a CX32-2 results in a discrepancy between the specified and actual topologies of the DRIVE-CLiQ components.
  - A cross-exchange of two occupied DRIVE-CLiQ ports is not permitted. Such an exchange results in inconsistencies in the specified-actual topologies.
  - Once it has been created in HW Config, the connecting port of a CX32-2 cannot be changed.
  - To change the connecting port of a CX32-2, the CX32-2 must be deleted from HW Config and recreated with another address.
  - To delete a CX32-2, it must be deleted from HW Config and then the configuration saved and compiled.
  - It is not possible to replace a control unit with six DRIVE-CLiQ ports (D435-2, D445-2 or D455-2) with a control unit with four DRIVE-CLiQ ports (D425-2) when a CX32-2 has been configured with address 14 or 15 (a control unit with four DRIVE-CLiQ ports does not have the DRIVE-CLiQ ports X104/X105 and consequently not the addresses 14 and 15).
  - The previous CX32 version cannot be used on a D4x5-2, see Section Permissible combinations (Page 306) in Migration of D4x5 to D4x5-2.
Connecting

3.5 Connecting DRIVE-CLiQ components

Figure 3-7  CX32-2 topology

See also

Quantity structures (Page 298)

Additional references

Further information on the CX32-2 can be found in the SIMOTION D4x5-2 Manual.
3.6 Connecting I/Os

Connection cables for the I/Os of the D4x5-2, CX32-2 and TB30

The following conditions apply to connection cables:

- Use flexible cables with a cable cross-section
  - of minimum 0.25 mm² and maximum 1.5 mm² (D4x5-2, CX32-2)
  - of minimum 0.25 mm² and maximum 0.5 mm² (TB30)
- Ferrules are not mandatory.
- You can use ferrules without an insulating collar in accordance with DIN 46228, Form A long version.

Note
To achieve optimum interference immunity, shielded cables must be used for connecting analog signals, measuring inputs or external zero marks.

Tools required
Screwdriver with 2 mm blade width.

Wiring inputs/outputs

1. Strip off 8 mm of cable insulation and, if necessary, press on a ferrule.
2. Wire the digital inputs and outputs for connection of the sensors and actuators.
3. Insert the cable into the appropriate spring-loaded terminal. This is easier when you use the screwdriver to push back the spring.

Additional references

For further information on cabling options (e.g. the use of rigid cables) and the pin assignment of the I/O interfaces, see the SIMOTION D4x5-2 Manual:

- Section "Interfaces" for the I/O interfaces of the D4x5-2
- Section "Supplementary system components -> Interfaces" for the I/O interfaces of the CX32-2/TB30
3.6.1 Creating a shield connection

Using shielded cables

The following options are available for the shield connection when using shielded cables:

- A shield connection using a shielding bus supplied separately
- Shield connection via shield connecting element on the top of the SIMOTION D4x5-2/CX32-2 housing

Using a shielding bus

If a shielding bus is used, proceed as follows:

1. Attach the cable shield to a grounded shielding bus after the cable entry point in the cabinet. To do this, expose the cable shield of the cable.
2. Continue routing the shielded cable as far as the module, but do not make a connection to the shield there.

Using the shield connection on the D4x5-2/CX32-2

1. Unscrew the holding clamp of the shield connection at the top of the D4x5-2/CX32-2 until there is a space below the clamp (M3 screw, Torx T10).
2. Insert the cable. To do this, expose the cable shield first.
3. Tighten the fixing bracket so that the cable shield and cable are pressed against the shield connection (tightening torque 0.8 Nm).

This figure shows where to attach the cables to the front panel connector and where to apply the cable interference suppression using the shield connecting element.
3.6 Connecting I/Os

Figure 3-8 Shield connection using the D4x5-2 DP/PN as an example

**Note**
With a CX32-2, the shield is connected in the same way as the D4x5-2. A CX32-2 only has the X122 terminal block and the shield connection element is narrower on a CX32-2 than on a D4x5-2.
3.6.2 Connecting I/Os of the TB30

Pin assignment

X424
Power supply for digital outputs

X481
Digital I/Os

X482
Analog inputs/outputs

Figure 3-9 Interface arrangement on the TB30

Additional references

Detailed information about the pin assignment of the X424, X481 and X482 interfaces can be found in the SIMOTION D4x5-2 Manual, Section "Supplementary system components".
Shield connection for TB30

The following figure shows the cable routing, cable connection and the connection of the I/Os on the TB30. The TB30 is inserted in a CU320-2 here.

![Shield connection for TB30](image)

The arrangement is similar when inserted in a D4x5-2, see also Section Creating a shield connection (Page 59) for more details.

The permissible bending radii for the cables must be maintained when the cables are being laid.
3.7 Connecting PROFIBUS/MPI

3.7.1 PROFIBUS connection components

Connection components

Individual nodes are connected by means of bus connectors and PROFIBUS cable. Remember to provide a bus connector with a programming port at the ends of the subnet. This will give you the option of expanding the subnet if required (for example, for a programming device or SIMATIC HMI device).

Use RS 485 repeaters for the connection between segments and to extend the cable.

Segments

A segment is a bus cable between two terminating resistors. A segment can contain up to 32 nodes. In addition, a segment is limited by the permissible cable length, which varies according to the transmission rate.

Terminating resistor

A cable must be terminated with its own surge impedance to prevent line disturbances caused by reflections. Activate the terminating resistor at the first and last node of a subnet or segment.

Make sure that the nodes to which the terminating resistor is connected are always supplied with voltage during power-up and operation.
3.7 Connecting PROFIBUS/MPI

3.7.2 PROFIBUS cables and connectors

Properties of PROFIBUS cables

The PROFIBUS cable is a two-core, twisted and shielded cable with defined properties:

Properties of the cables

Table 3-4 Properties of PROFIBUS cables

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristic impedance</td>
<td>Approximately 135 to 160 Ω (f = 3 to 20 MHz)</td>
</tr>
<tr>
<td>Loop resistance</td>
<td>≤ 115 Ω/km</td>
</tr>
<tr>
<td>Effective capacitance</td>
<td>30 nF/km</td>
</tr>
<tr>
<td>Damping</td>
<td>0.9 dB/100 m (f = 200 kHz)</td>
</tr>
<tr>
<td>Permissible conductor cross-section</td>
<td>0.3 mm² to 0.5 mm²</td>
</tr>
<tr>
<td>Permissible cable diameter</td>
<td>8 mm + 0.5 mm</td>
</tr>
</tbody>
</table>

Connector features

The bus connector is used to connect the PROFIBUS cable to the PROFIBUS DP interfaces (X126, X136), thus establishing a connection to additional nodes.

Only bus connectors with a 35° cable outlet should be used in order to ensure that the front cover can be closed.

See also

SIMOTION D4x5-2 Manual, Section "Spare parts and accessories which can be ordered"
3.7.3 Length of PROFIBUS cables

Cable lengths and baud rate

The baud rate determines the cable length of a subnet segment.

<table>
<thead>
<tr>
<th>Baud rate</th>
<th>Max. cable length of a segment (in m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>19.6 to 187.5 kbit/s</td>
<td>1000 1)</td>
</tr>
<tr>
<td>500 kbit/s</td>
<td>400</td>
</tr>
<tr>
<td>1.5 Mbit/s</td>
<td>200</td>
</tr>
<tr>
<td>3 to 12 Mbit/s</td>
<td>100</td>
</tr>
</tbody>
</table>

1) With isolated interface

Longer cable lengths

If you must implement longer cable lengths than permitted in one segment, you must use RS 485 repeaters. The maximum possible cable lengths between two RS 485 repeaters correspond to the cable length of a segment. You can connect up to nine RS 485 repeaters in series.

Note that an RS 485 repeater must be counted as a subnet node when determining the total number of nodes to be connected, even if it does not have its own PROFIBUS address.

3.7.4 Rules for the laying of PROFIBUS cables

Laying of bus cable

During laying of the PROFIBUS cable, you must:

- Not twist the cable
- Not stretch the cable
- Not squeeze the cable
3.7 Connecting PROFIBUS/MPI

Supplementary conditions

In addition, when laying a bus cable for indoor use, you must take into account the following supplementary conditions (dA = external cable diameter):

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Supplementary conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bending radius for a single bend</td>
<td>80 mm (10xdA)</td>
</tr>
<tr>
<td>Bending radius for multiple bends</td>
<td>160 mm (20xdA)</td>
</tr>
<tr>
<td>Permissible temperature range for cable routing</td>
<td>-5° C to +50° C</td>
</tr>
<tr>
<td>Temperature range for storage and stationary operation</td>
<td>-30° C to +65° C</td>
</tr>
</tbody>
</table>

Additional references

Length codes for prefabricated cables can be found in:

- Catalog PM 21; SIMOTION, SINAMICS S120, and Motors for Production Machines
- Catalog IK PI (Industrial Communication)

3.7.5 Connecting PROFIBUS DP (interfaces X126 and X136)

PROFIBUS cables are connected to the corresponding interface via a bus connector.

Connecting the bus connector

Proceed as follows to connect the bus connector:

1. Plug the bus connector into the corresponding interface of the control unit.
2. Screw the bus connector into place.

If the control unit is located at the start or end of a segment, you must switch on the terminating resistor ("ON" switch setting).

![Terminating resistor switched in and not switched in diagram]

Note

Make sure that the nodes at which the terminating resistor is located are always supplied with voltage during startup and operation.
Removing the bus connector

You can remove the bus connector with a looped-through bus cable from the PROFIBUS DP interface at any time without interrupting data traffic on the bus.

⚠️ WARNING

Data traffic error might occur on the bus!

A bus segment must always be terminated with the terminating resistor at both ends. This is not the case, for example, if the last node with a bus connector is de-energized. The bus connector draws its power from the node, and the terminating resistor is thus disabled.

Make sure that the stations at which the terminating resistor is connected are always energized.

See also

PROFIBUS cables and connectors (Page 64)
Length of PROFIBUS cables (Page 65)

3.7.6 Connection rules in the PROFIBUS subnet

Introduction

There are a number of rules for configuring and installing cables for PROFIBUS networks to ensure seamless communication over PROFIBUS. These rules apply to both configuring and cabling as well as address assignment for the different network nodes.

Connection rules

- **Before** you interconnect individual nodes in a subnet, you must assign a unique PROFIBUS address to each node.
- Narrow down the number of nodes by limiting the PROFIBUS addresses to the highest address in the network.
  
  Tip: Mark the address on the housing of all nodes in a subnet. Then you can always see which address is assigned to which node in your system.
- Connect all nodes in a subnet "in series". No spur lines may be routed to the PROFIBUS DP.
  
  In addition, integrate the programming devices and SIMATIC HMI devices for commissioning or servicing in the subnet in series.
- If you operate more than 32 nodes on a subnet, you must use RS 485 repeaters to connect the bus segments. More detailed information can be found in the description of the RS 485 repeater, see the S7-300 Automation Systems, Module Data Manual.

In a PROFIBUS subnet, all segments combined must have at least one DP master and one DP slave.
- Use RS 485 repeaters to connect ungrounded bus segments and grounded bus segments.
- The maximum number of nodes per bus segment decreases with each RS 485 repeater. This means that when a bus segment contains an RS 485 repeater, the bus segment can contain no more than 31 additional nodes. However, the number of RS 485 repeaters does not affect the maximum number of nodes on the bus.
- Up to 10 segments can be connected in a row (max. 9 repeaters).
- At least one terminator must be supplied with 5 V.

To accomplish this, the PROFIBUS DP connector with an activated terminating resistor must be connected to a device that is switched on.
- Before inserting a new node on the subnet, you must switch off its supply voltage.

The station must be inserted first and then switched on.

When a station is disconnected, the connection must first be deactivated and then the connector withdrawn.

- The bus line of a segment must be terminated at both ends. This is achieved by switching on the terminating resistor in the PROFIBUS DP connector at the first and last node and switching off the other terminating resistors.
3.7 Connecting PROFIBUS/MPI

Example

This illustration below shows an example configuration of a subnet with D4x5-2.

![Diagram of a subnet configuration with D4x5-2](image)

- **A**: Terminating resistor activated
- **M**: DP master
- **S**: DP slave
- **0...x**: PROFIBUS DP node addresses

Figure 3-12  Networking example for a D4x5-2

### 3.7.7 Operating the X136 interface as MPI

#### Applications

The X136 interface can also be operated as an MPI interface instead of a PROFIBUS DP interface. The typical (default) baud rate is 187.5 Kbaud. A baud rate of up to 12 MBaud can be set for communication with other CPUs. It should be noted, however, that a rate of 12 MBaud is not supported by all CPUs (e.g. smaller SIMATIC S7 CPUs).

The following list provides examples of when using MPI (multi-point interface) may prove effective:

- If a PG/PC is being used with an MPI interface
- If an OP/TP only has an MPI interface
  (newer devices have PROFIBUS or PROFINET interfaces)
- If SIMOTION and SIMATIC CPUs are coupled via XSEND/XRECEIVE
When communicating with XSEND/XRECEIVE, there is no need to configure the connection in NetPro. XSEND/XRECEIVE can be used via PROFIBUS or MPI.

- **Via PROFIBUS:** For communication between SIMOTION devices
- **Via MPI:** For communication between SIMOTION and SIMATIC S7 devices

The SIMOTION interface must be connected to the MPI interface of the SIMATIC S7 devices. Connection via PROFIBUS is not possible.

The baud rate of the SIMATIC S7 device must be set at the SIMOTION interface (see documentation for the relevant SIMATIC S7 devices).

**Operate MPI like PROFIBUS**

The information on wiring the connector (terminating resistors) and the rules for routing of cables for PROFIBUS apply to this interface as well. When carrying out this procedure, consult the relevant references.

**Connector features**

The bus connector is used to connect the MPI bus cable to the MPI interface (X136). This enables you to establish connections to additional nodes (e.g. PG or SIMATIC S7-CPU). Only bus connectors with a 35° cable outlet should be used in order to ensure that the front cover can be closed.

**Additional information**

See *SIMOTION D4x5-2 Manual, Section Available spare parts and accessories.*

**MPI bus cable**

The PROFIBUS cable specifications apply here as well; Please note the relevant information on setting up an MPI network.

**Setting up an MPI network**

Keep in mind the following basic rules when setting up an MPI network:

- When using the interface as an MPI interface, it is not possible to arrange additional control for a drive in isochronous mode or to connect distributed I/Os to this interface.
- An MPI bus line must be terminated at both ends. This is achieved by activating the terminating resistor in the MPI connector in the first and last station and deactivating the other terminating resistors.
- At least one terminator must be supplied with 5 V.

This means that an MPI connector with an activated terminating resistor must be connected to a device that is switched on.

- Spur lines (cables leading from the bus segment to the station) should be as short as possible, that is, < 5 m in length. Unused spur lines should be removed wherever possible.
● Every MPI station must be connected to the bus first and then activated.
   To disconnect the station, it must first be deactivated. Then, the station can be removed from the bus.

● Maximum cable lengths:
   - 200 m per bus segment
   - 2000 m total length with RS 485 repeaters

---

**Note**
You can also use intelligent DP slave functionality for PROFIBUS communication between CPUs.
3.8 Connecting Ethernet

3.8.1 Wiring Ethernet

Procedure

To the 8-pin RJ45 sockets

- X127 P1
- X130 P1
- X120 P1 (only for D4x5-2 DP)

you can connect Industrial Ethernet.

The interfaces support a transmission rate of 10/100/1000 Mbit/s. Suitable Ethernet cables and connectors must be used for the Ethernet connection.

![Connecting Industrial Ethernet](image)

**Figure 3-13 Connecting Industrial Ethernet**

**Note**

As of V4.3, the three Ethernet interfaces support the PROFINET basic services - they therefore have the designation PN/IE-NET, PN/IE-OP or PN/IE.

These PROFINET basic services (e.g. DCP, LLDP, SNMP) provide uniform functions for the address assignment and diagnostics, but do not provide PROFINET IO communication for the connection of drives, I/O modules, etc.
3.8.2 Ethernet cables and connectors

Characteristics of the cables
A shielded twisted pair cable is used for the networking. The transmission rate of the cable is determined as follows by the number of core pairs:
- 2 x 2 cores support 10/100 Mbit/s
- 4 x 2 cores support 10/100/1000 Mbit/s

Recommended connecting cables
The following cables are available:
- SIMATIC NET, Industrial Ethernet TP CORD RJ45/RJ45
  - TP cable prefabricated with 2xRJ45 connectors
  - Crossed send and receive cable
  - Order no.: 6XV1870-3R□□□ (□□□ - length code)
- SIMATIC NET, Industrial Ethernet TP CORD RJ45/RJ45
  - TP cable prefabricated with 2xRJ45 connectors
  - Uncrossed send and receive cable
  - Order no.: 6XV1870-3Q□□□ (□□□ - length code)

The autocrossing functionality of the Ethernet interfaces means crossed as well as uncrossed cables can be used.

Autocrossing
Per default, the Ethernet interfaces are set to "Automatic setting" in HW Config, so that autocrossing is available.

The settings can be found in the port properties (e.g. X127 P1) in the module rack of HW Config (SIMOTION < V4.3: Setting via HW Config "D4x5-2 Properties" > "Ethernet extended").

Autocrossing is deactivated with "Manual setting". As the Ethernet interfaces of the D4x5-2 are wired as Ethernet terminal, in this case you must use crossed cables for the networking with a PG/PC or another D4x5-2.

If the communication peer has autocrossing (e.g. PC, switch or hub), crossed and uncrossed cables can be used.

Additional references
For further information about the cables and connectors, see the Industrial Communication IK PI Catalog.
3.9 Connecting PROFINET IO components

3.9.1 Wiring PROFINET

Procedure

As standard, a SIMOTION D4x5-2 DP/PN has a PROFINET IO interface with three ports. The SIMOTION D4x5-2 DP/PN control units can be expanded by an additional PROFINET IO interface with four ports. For this purpose, a CBE30-2 must be inserted in the option slot of the control unit.

Suitable PROFINET cables and connectors must be used for the PROFINET connection. The autocrossing functionality of the PROFINET interfaces means crossed as well as uncrossed cables can be used.

![Figure 3-14 Connecting PROFINET IO](image-url)
### Mixed operation of IRT and RT

For mixed operation of IRT and RT, note that the IRT-capable devices must form a so-called IRT domain, i.e. there must not be any non-IRT devices on the data transmission link between the IRT devices.

![Figure 3-15  Mixed operation of IRT and RT](image)

### 3.9.2 PROFINET cables and connectors

#### Cable and connector types

**Note**

For connecting PROFINET IO to D4x5-2, a connector with a 145° cable outlet is recommended (IE FC RJ45 plug 145).

![Figure 3-16  RJ45 PN connector with a 145°cable outlet](image)
### 3.9 Connecting PROFINET IO components

#### Table 3-7 Connector types for PROFINET

<table>
<thead>
<tr>
<th>Connectors</th>
<th>Designation</th>
<th>Order number</th>
</tr>
</thead>
</table>
| IE FC RJ45 plug 145 | RJ45 FastConnect connector for Industrial Ethernet/PROFINET with 145° cable outlet | 6GK1 901-1BB30-0AA0  
• 1 pack = 1 unit  
• 1 pack = 10 units |

#### Table 3-8 Cable types for PROFINET

<table>
<thead>
<tr>
<th>Cable</th>
<th>Designation</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>IE FC Cable GP 2x2 (Type A)</td>
<td>4-wire, shielded TP installation cable for IE FC RJ45</td>
<td>6XV1 840-2AH10</td>
</tr>
<tr>
<td>IE FC Flexible Cable GP 2x2 (Type B)</td>
<td>4-wire, shielded flexible TP installation cable for IE FC RJ45</td>
<td>6XV1 870-2B</td>
</tr>
<tr>
<td>IE FC Trailing Cable GP 2x2 (Type C)</td>
<td>4-wire TP installation cable for trailing cable use</td>
<td>6XV1 870-2D</td>
</tr>
<tr>
<td>IE FC Trailing Cable 2x2 (Type C)</td>
<td>4-wire, shielded TP installation cable for connection to FC OUTLET RJ45, for trailing cable use</td>
<td>6XV1 840-3AH10</td>
</tr>
<tr>
<td>IE FC Marine Cable 2x2</td>
<td>4-wire, shielded marine-certified TP installation cable for connection to FC OUTLET RJ45</td>
<td>6XV1 840-4AH10</td>
</tr>
</tbody>
</table>

#### Table 3-9 Stripping tool for Industrial Ethernet / PROFINET

<table>
<thead>
<tr>
<th>Tool</th>
<th>Designation</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>IE FC Stripping Tool</td>
<td>Stripping tool for Industrial Ethernet / PROFINET</td>
<td>6GK1 901-1GA00</td>
</tr>
</tbody>
</table>

### Additional references

For further information about the cables, connectors and stripping tool, see the *Industrial Communication IK PI Catalog*. 

---

SIMOTION D4x5-2  
76  
Commissioning and Hardware Installation Manual, 02/2012
3.10 Routing

Routing describes the cross-network transfer of information from Network x to Network y.

3.10.1 Routing on SIMOTION D

Routing between the different interfaces

The Ethernet interfaces of the D4x5-2
- X127 P1 and X130 P1 (for D4x5-2 DP/PN) or
- X127 P1, X120 P1 and X130 P1 (for D4x5-2 DP)

each form a separate IP subnet.

The D4x5-2 DP/PN onboard PROFINET IO interface (X150, P1-P3) and the optional second PROFINET IO interface with CBE30-2 (X1400, P1-P4) also each form a separate IP subnet. All ports of a PROFINET IO interface always belong to the same IP subnet.

- IP routing from IP subnet to IP subnet is not supported. You can use an external IP router for this
- The S7 routing between PROFINET/Ethernet subnets and also to PROFIBUS is possible.

There are therefore the following options for connecting a PG/PC or HMI device to a SIMOTION D using S7 routing.
Engineering system / HMI to PROFINET

- S7 routing to the (master) PROFIBUS interfaces (only if configured)
- S7 routing to the PROFIBUS Integrated
- S7 routing to the Ethernet interfaces PN/IE (X127 P1) and PN/IE-NET (X130 P1) (for D4x5-2 DP also to PN/IE-OP (X120 P1))
- S7 routing to the second PROFINET IO interface with CBE30-2 (X1400, P1-P4)
- Access to the components on the same subnet via the switch functionality of the PROFINET IO interface
Engineering system / HMI to PROFIBUS

- S7 routing to the other (master) PROFIBUS interfaces (only if configured)
- S7 routing to the PROFIBUS Integrated
- S7 routing to the onboard PROFINET IO interface (X150, P1-P3)
- S7 routing to the second PROFINET IO interface with CBE30-2 (X1400, P1-P4)
- S7 routing to the Ethernet interfaces PN/IE (X127 P1) and PN/IE-NET (X130 P1) (for D4x5-2 DP also to PN/IE-OP (X120 P1))
Engineering system / HMI to Ethernet

- S7 routing to the other (master) PROFIBUS interfaces (only if configured)
- S7 routing to the PROFIBUS Integrated
- S7 routing to the onboard PROFINET IO interface (X150, P1-P3)
- S7 routing to the second PROFINET IO interface with CBE30-2 (X1400, P1-P4)
- S7 routing between the Ethernet interfaces
3.10.2 Routing on SIMOTION D (SINAMICS integrated)

S7 routing to the internal PROFIBUS on SINAMICS Integrated

All SIMOTION D have an integrated SINAMICS drive control. In order to be able to access drive parameters, the message frames must be routed from the external SIMOTION D interfaces to the internal PROFIBUS DP. S7 routing can be used to access the integrated PROFIBUS. Here, the internal PROFIBUS DP forms a separate subnet. This must be especially taken into account for the communication to several routing nodes.

Additional references

Further information about routing and the differences between IP and S7 routing can be found in the Communication System Manual.
Commissioning (hardware)

4.1 Requirements for commissioning

Requirements

The following requirements must be satisfied for the initial commissioning of the SIMOTION D4x5-2 and the SINAMICS S120 modules required for operation (SINAMICS S120 line modules and SINAMICS S120 motor modules):

- Your system with SIMOTION D4x5-2 has been installed and wired.
- Your PG/PC has been connected to the SIMOTION D4x5-2 via the PROFIBUS, Ethernet or PROFINET IO interface.

Commissioning steps

Commissioning the hardware involves the following steps:

1. Inserting the CompactFlash card (Page 84)
2. Checking the system (Page 86)
3. Switching on the power supply (Page 86).

Additional references

For information on installing/mounting and commissioning the SINAMICS S120 components, refer to the SINAMICS S120 Commissioning Manual.
4.1 Requirements for commissioning

4.1.1 Inserting the CompactFlash card

Properties of the CompactFlash card

The CompactFlash card is essential for operation of the SIMOTION D4x5-2. The SIMOTION Kernel (SIMOTION D firmware) and the software used to control the drives (SINAMICS firmware) are contained on the CompactFlash card.

To load the SIMOTION Kernel, the CompactFlash card must be inserted when the SIMOTION D4x5-2 is powered up.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CompactFlash card may only be inserted or removed when the SIMOTION D4x5-2 control unit is disconnected from the power supply. The SIMOTION D4x5-2 is in a de-energized state when all the LEDs are off.</td>
</tr>
</tbody>
</table>

Procedure

To insert the CompactFlash card, carry out the following steps:

1. The direction of insertion of the CompactFlash card is indicated by an arrow located on both the plug-in slot and the CompactFlash card. Align the CompactFlash card with the arrows.

2. Gently insert the CompactFlash card into the empty plug-in slot of the SIMOTION D4x5-2 until it clicks into place.
   If correctly inserted, the CompactFlash card is flush with the housing.
Two arrows must be visible when inserting the CF card

Figure 4-1  Inserting the CompactFlash card
4.1.2 Checking the system

Procedure

Check the final installed and wired system one more time before it is switched on, keeping in mind the safety points in the following check list:

- Have you observed all ESD measures when handling the components?
- Have all screws been tightened to their specified torque?
- Have all connectors been properly inserted and locked/screwed?
- Are all components grounded and have all shields been attached?
- Have you taken the load capacity of the central power supply into consideration?

⚠️ DANGER

The SIMOTION D4x5-2 Control Units must not be operated without a fan/battery module.
The SIMOTION D4x5-2 Control Units will not power up without a fan/battery module.

4.1.3 Switching on the power supply

Switching on the external power supply

Power is supplied to the SIMOTION D4x5-2 via an external power supply unit, e.g. via a SITOP power supply.

Switch on this power supply.

⚠️ CAUTION

It is essential to ensure that the external 24 VDC power supply to the D4x5-2 is not interrupted for longer than 3 ms. After a longer interruption, the SIMOTION D4x5-2 shuts down and can only be restarted with OFF/ON.

You will find further information in Section Properties of the user memory (Page 90).
Power-up of Control Unit

Once the power supply has been switched on, the SIMOTION D4x5-2 begins to power up:

1. At the start of the power-up, all LEDs are briefly illuminated in yellow for a short LED test. The LEDs on the SIMOTION D4x5-2 enable you to track the progress of the power-up. Any errors are displayed.

2. Power-up of the SIMOTION Kernel.

3. All DRIVE-CLiQ connections (e.g. with the SINAMICS S120 Active line module) are also detected automatically.

Note

As long as the RDY LED continues to flicker, power-up is not complete and it is not possible to go online.

During commissioning the firmware of the components is upgraded or downgraded automatically based on the FW version on the CompactFlash card and the FW version on the SINAMICS components (DRIVE-CLiQ components, TB30, CBE30-2, PM340, etc.).

The update can take several minutes and its progress is tracked by corresponding messages appearing in the alarm window of SIMOTION SCOUT.

SIMOTION D4x5-2/CX32-2/DRIVE-CLiQ components:

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red and green:

- FW update running: RDY LED flashing slowly (0.5 Hz)
- FW update complete: RDY LED flashing quickly (2 Hz)

These flashing patterns are also displayed on the yellow RDY LED on the SIMOTION D/CX32-2, and indicate that a FW update is being carried out on components connected to the SIMOTION D/CX32-2 or that all components have completed the FW update.

Go offline once all the FW updates are complete, POWER ON the upgraded/downgraded components.

CBE30-2 option board:

During the firmware update, the OPT LED of the SIMOTION D module and the SYNC LED of the CBE30-2 flash green.

4. The first time it is switched on, the SIMOTION D4x5-2 goes to STOP operating state following power-up.

Following power-up, the SIMOTION D4x5-2 is in a state in which it can be configured.
Fan/battery module defective or not mounted properly on a SIMOTION D4x5-2

While the SIMOTION D4x5-2 is powering up, a test is performed to check whether the fan/battery module is functioning properly. If the fan/battery module is missing or faulty, the kernel is not loaded and the RDY LED flashes red/yellow (2 Hz). Switch off the power supply and correct the fault before switching on the power supply again.

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the SIMOTION D4x5-2 Control Unit needs to be cooled (thermostatically controlled fan) and this is not possible due to a fan/battery module having been removed or being faulty, the module state will change to reset after approximately 1 minute. This state can only be reset with a switch-off.</td>
</tr>
</tbody>
</table>
4.2 RESET button

Layout

The RESET button is located behind the blanking cover on the SIMOTION D4x5-2.

Performing a reset

A reset causes the entire system to be reset and forces the system to power up again. This operation is comparable with a "Power on Reset" but does not require the disconnection of the 24 V power supply (e.g. in order to exit the F state).

4.3 User memory concept

4.3.1 SIMOTION D4x5-2 memory model

The following figure provides an overview of the memory model of SIMOTION D4x5-2.

![SIMOTION D4x5-2 memory model](image_url)
4.3 User memory concept

The SIMOTION Kernel (SIMOTION D firmware) contains the functions required for virtually all applications, and essentially acts as a PLC featuring an IEC 61131-3-compliant command set as well as system functions for controlling various components, such as inputs and outputs.

The SIMOTION Kernel can be expanded by loading technology packages (TPs), e.g. for motion control or temperature controllers.

In the following sections, you will find information about the user memories and the steps involved in certain operations.

4.3.2 Properties of the user memory

Non-volatile data

Non-volatile data make it possible to retain relevant data for the user and the system even when the SIMOTION D4x5-2 has been switched off. Information about the area which can be used for non-volatile data is available in the SIMOTION D4x5-2, Technical Data Manual.

A SIMOTION device has the following non-volatile data:

Table 4-1 Non-volatile data contents

<table>
<thead>
<tr>
<th>Non-volatile data</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kernel data</td>
<td>Last operating mode</td>
</tr>
<tr>
<td></td>
<td>IP parameters (IP address, subnet mask, router address)</td>
</tr>
<tr>
<td></td>
<td>DP parameters (PROFIBUS DP address, baud rate)</td>
</tr>
<tr>
<td></td>
<td>Diagnostics buffer</td>
</tr>
<tr>
<td>Retain variables</td>
<td>Variables in the interface or implementation section of a unit declared with VAR_GLOBAL RETAIN</td>
</tr>
<tr>
<td></td>
<td>Global device variables set with the &quot;RETAIN&quot; attribute</td>
</tr>
<tr>
<td>Retain TO</td>
<td>Absolute encoder offset</td>
</tr>
<tr>
<td>DCC blocks</td>
<td>SAV blocks and user-defined blocks with retain behavior (&quot;SAV = SAVE&quot;, blocks for the non-volatile data backup).</td>
</tr>
<tr>
<td>NVRAM (SINAMICS)</td>
<td>For the SINAMICS Integrated, CX32-2 and SINAMICS S120 CU310-2/CU320-2, data protected against loss at power failure is called NVRAM data or non-volatile data.</td>
</tr>
</tbody>
</table>
Note

DCC SIMOTION blocks with retain behavior act like retain variables in terms of copying RAM to ROM, resetting memory, downloading, backing up non-volatile SIMOTION data \(_\text{savePersistentMemoryData}\) and backing up data.

For the SINAMICS Integrated and CX32-2, the data backup of the SINAMICS retain data (and therefore also for SINAMICS DCC) is performed via the NVRAM (D4x5-2) or the FRAM (CX32-2). SINAMICS data is not saved with \(_\text{savePersistentMemoryData}\). The non-volatile SINAMICS data (NVRAM data) is backed up by setting the CU parameter p7775 to 1.

For further information on DCC, see the DCC Programming Programming Manual.

The non-volatile data of the SIMOTION D4x5-2 has the following properties:

Table 4-2 Non-volatile data and real-time clock properties

<table>
<thead>
<tr>
<th>Properties</th>
<th>Non-volatile data</th>
<th>Real-time clock (RTC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>The non-volatile data is located</td>
<td>The real-time clock is backed up maintenance-free via a SuperCap or a battery.</td>
</tr>
<tr>
<td></td>
<td>• For a D4x5-2 in an NVRAM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• For a CX32-2 in an FRAM</td>
<td></td>
</tr>
<tr>
<td>Back-up battery</td>
<td>No</td>
<td>Optional (for longer backup time)</td>
</tr>
<tr>
<td>Backup time</td>
<td>There is no maximum backup time</td>
<td>• SuperCap: At least 4 days</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Battery: At least 3 years</td>
</tr>
</tbody>
</table>

If the buffer time is exceeded on the real-time clock, the time is reset.

Fan/battery module

If the backup time for the real-time clock (RTC) is not sufficient, a battery can be connected by means of an external fan/battery module. The backup time when a battery is used is at least three years.

A 3 V lithium SN: 575332 battery type (with cable lug and connector) is used. The battery can be replaced without data loss, because the real-time clock is backed up internally via the SuperCap.

A fan/battery module is always required for SIMOTION D4x5-2 and therefore is always supplied with the module (see the SIMOTION D4x5-2 Manual).
CompactFlash card

The CompactFlash card contains the following data:

- SIMOTION Kernel (SIMOTION D firmware)
- Technology packages (TP)
- User data (units, configuration data, parameter settings, task configuration)
- IP parameters (IP address, subnet mask, router address)
- DP parameters (PROFIBUS DP address, baud rate)

It may also contain:

- User data saved with `_savePersistentMemoryData` and `_export/_saveUnitDataSet`
- SINAMICS non-volatile data (NVRAM data) of the SINAMICS Integrated or a CX32-2 backed up with CU parameter p7775 = 1
- Data from SIMOTION IT
- Archived SCOUT project

With the `_savePersistentMemoryData` system function, the user program can back up the contents of the non-volatile SIMOTION data to the CompactFlash card. This ensures that the retain variables and the absolute encoder position are backed up in the event that a spare part is used.

For the SINAMICS Integrated, CX32-2 and SINAMICS S120 CU310-2/CU320-2, the non-volatile SINAMICS data (NVRAM data) is backed up by setting the CU parameter p7775 to 1.

Note

**IP and DP parameters in the non-volatile data**

If the CompactFlash card contains a configuration, the IP and DP parameters are loaded from the CompactFlash card during power-up and used by the SIMOTION device. The SIMOTION D4x5-2 uses the addresses defined in these parameters to go online. During power-up, the IP and DP parameters on the CompactFlash card are also written to the non-volatile data. If the SIMOTION device is then powered up with a CompactFlash card with no configuration, the IP and DP parameters are retained in the non-volatile data and are used by the device. Thus, the SIMOTION device can continue to go online if a configuration was loaded with SIMOTION SCOUT at least once or if the SIMOTION device is powered up with a CompactFlash card containing a configuration.
Volatile SIMOTION data (RAM / current data RAM)

The volatile SIMOTION data is defined by the following properties:

- The volatile SIMOTION data is located in the RAM memory of the SIMOTION device.
- The download data of SIMOTION SCOUT is written to this memory.
- This data is lost when the SIMOTION D4x5-2 is switched off.
- The "volatile SIMOTION data" area contains the following data:
  - SIMOTION Kernel (D4x5-2 firmware)
  - Technology packages (TP)
  - User data (programs, configuration data, parameter settings)

Figure 4-3  Configuration data and system variables in the volatile memory (memory concept, principle)

Further information about memory management for SIMOTION is available in the *SIMOTION SCOUT Basic Functions* Function Manual.
4.3 User memory concept

4.3.3 Operations and their effect on the user memory

The operations marked with arrows in the figures entitled "SIMOTION D4x5-2 memory model" and "Configuration data and system variables in the volatile memory" and their effects on the user memory is described below.

SIMOTION SCOUT download

The following data is transferred with "Download project to target system" or "Download CPU drive unit to target device" from the engineering system to the "volatile SIMOTION data" area:

- User data (units, configuration data, parameter settings, task configuration)
- Technology packages (TPs)

In addition, the IP and DP parameters are saved to the "non-volatile SIMOTION data" area. The retain variables are set to their initial values, but this depends on the settings in SIMOTION SCOUT. If the SIMOTION D4x5-2 is switched off following the download, the volatile SIMOTION data is lost.

Copy RAM to ROM

The Copy RAM to ROM menu command saves the following data via the engineering system to the CompactFlash card:

- Technology packages and user data (units, configuration data, parameter assignments, task configuration) from the "volatile SIMOTION data" area
- Current values are copied to the "volatile SIMOTION data" area, depending on the settings in SIMOTION SCOUT.

Note

The "Copy RAM to ROM" menu command does not save the current values of the retain variables to the CompactFlash card. Use the system function _savePersistentMemoryData for this purpose.

Note

The "Copy RAM to ROM" function is also available for drive units and saves the volatile SINAMICS data to the non-volatile memory (CompactFlash card).
Current RAM

If you change the system variable values, these take immediate effect in the current RAM. New configuration data values are initially stored in the Next memory. Configuration data that takes immediate effect is automatically transferred to the current RAM. Configuration data that will only become active following a RESTART on the technology object (set the restartactivation system variable to the ACTIVATE_RESTART value) is not written to the current RAM until after the RESTART.

To save the configuration data changed online to the offline project, you must first transfer the content of the current data RAM to the RAM using the menu command "Target system" > "Copy current data to RAM".

Once you have done this, the configuration in SCOUT will no longer be consistent with the configuration in the target device, as a consistency check is performed on the RAM data. Read the data from the RAM using the menu command "Target system" > "Load" > "Load CPU / drive unit to PG" (for the configuration data only) to re-establish a consistent system state.

Use the "Target system" > "Copy RAM to ROM" menu command to save the configuration to the non-volatile memory on the CompactFlash card.

Note

The "Copy current data to RAM" command does not transfer the values of the system variables to the RAM memory. This means that "Save to memory card (Copy RAM to ROM)" or "Save in the engineering project (Load CPU / drive unit to PG)" is not possible.

In order to ensure that system variable values can also be saved to the engineering project and memory card, the system variable values must be changed OFFLINE and then downloaded to the target device and saved.

SIMOTION D4x5-2 power-up

During power-up of the SIMOTION D4x5-2, the SIMOTION Kernel is loaded from the CompactFlash card to the "volatile SIMOTION data" area.

When the SIMOTION D4x5-2 is switched off, the contents of the "volatile SIMOTION data" area are lost. When the SIMOTION D4x5-2 is powered up again, the following data is loaded from the CompactFlash card:

- Technology packages and user data to the "volatile SIMOTION data" area
- IP and DP parameters to the "non-volatile SIMOTION data" area
Backing up non-volatile SIMOTION data

You have the following options for backing up non-volatile SIMOTION data on the CompactFlash card:

- In the user program:
  With the _savePersistentMemoryData system function, the user program can back up the non-volatile SIMOTION data content to the CompactFlash card. This ensures that the retain variables and the absolute encoder position are backed up in the event that a spare part is used. The contents are saved to the "PMEMORY.XML" backup file in the "USER\SIMOTION" directory.

- Via switch/button (Service selector switch or DIAG button of the SIMOTION D4x5-2) or IT DIAG. See Section Diagnostic data and non-volatile SIMOTION data (Page 359). The contents are saved to the "PMEMORY.XML" backup file in the "USER\SIMOTION\HMI\SYSLOG\DIAG" directory.

On the system side, this system function ensures that a consistent overall image of the non-volatile SIMOTION data is always available the next time the unit is switched on, even if there is a power failure during backup. An already existing backup file is renamed to "PMEMORY.BAK" before a new backup file is generated. If the save operation to the new backup file fails (e.g. because the capacity of the CompactFlash card is insufficient), this backup copy of the backup file is used the next time an attempt is made to restore the non-volatile SIMOTION data content. If the new file is successfully created, the backup copy of the backup file is deleted.

**NOTICE**

Non-volatile SIMOTION data that is not backed up to the CompactFlash card will be lost if a spare part is installed (in the event of a module defect). For example, failing to back up the current values of the retain variables will result in them being lost and reset to their initial values.

If an absolute encoder overflow occurs after _savePersistentMemoryData, the actual position value is no longer correct after the non-volatile SIMOTION data is restored. In this case, homing (absolute encoder adjustment) must be repeated.

With the SCOUT functions "Save variables" and "Restore variables", you also have the option of backing up to your PC and restoring data that was changed during operation and only stored in the runtime system.
Reloading non-volatile SIMOTION data

SIMOTION data backed up on the CompactFlash card with _savePersistentMemoryData is reloaded in the following scenarios:

1. After a module replacement, see Section Module replacement (Page 103)
2. After a memory reset, see Section SIMOTION D4x5-2 memory reset (Page 285)
3. Via switch position, see Section Deleting/restoring non-volatile SIMOTION data (Page 368).

If you want to restore data backed up via the switch / button / IT DIAG, you may have to delete existing PMEMORY.XML and PMEMORY.BAK backup files in the \USER\SIMOTION\ directory on the CompactFlash card. See also Section Deleting/restoring non-volatile SIMOTION data (Page 368).

Backing up / reloading non-volatile SINAMICS data

Requirement: As of SIMOTION V4.3 / SINAMICS V4.5

For the SINAMICS Integrated, CX32-2 and SINAMICS S120 CU310-2/CU320-2, as of SINAMICS FW version V4.5, the non-volatile SINAMICS data (NVRAM data) is backed up by setting the CU parameter p7775 to 1.

The reloading

- Is performed automatically in the event of a module replacement
  A module replacement is detected on the basis of the serial number.
- Can be performed manually
  The reloading can be initiated manually by setting the CU parameter p7775 to 2.

For more information, see Section Backing up / restoring /deleting SINAMICS NVRAM data (Page 217).

Power failure

With a power failure, the real-time clock is backed up by an internal SuperCap and, if available, a battery in the fan/battery module.

The non-volatile data is backed up on the D4x5-2 permanently and maintenance-free in an NVRAM. In this way, the Control Unit is immediately ready for operation without data loss after a power failure.
Power-up and non-volatile SIMOTION data

The table below lists the cases that can arise during power-up in conjunction with the non-volatile SIMOTION data and explains how they are handled.

Table 4-3 Cases: Power-up with non-volatile SIMOTION data

<table>
<thead>
<tr>
<th>Case</th>
<th>Initial condition</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The non-volatile SIMOTION data is valid.</td>
<td>SIMOTION D4x5-2 powers up with the non-volatile SIMOTION data, i.e. with the PROFIBUS address in the non-volatile data.</td>
</tr>
<tr>
<td>2</td>
<td>The non-volatile SIMOTION data is invalid and there is no backup file (PMEMORY.XML) and no backup copy of the backup file (PMEMORY.BAK).</td>
<td>SIMOTION D4x5-2 copies the default settings to the non-volatile SIMOTION data and powers up with this data. In this case, for example, the default PROFIBUS address is used.</td>
</tr>
<tr>
<td>3</td>
<td>The non-volatile SIMOTION data is invalid, backup file (PMEMORY.XML) exists and is valid.</td>
<td>SIMOTION D4x5-2 copies the backup file contents to the non-volatile SIMOTION data and powers up with this data.</td>
</tr>
<tr>
<td>4</td>
<td>The non-volatile SIMOTION data is invalid, the backup file is invalid and there is no backup copy of the backup file (PMEMORY.BAK).</td>
<td>SIMOTION D4x5-2 copies the default settings to the non-volatile SIMOTION data and powers up with this data, in which case, for example, the default PROFIBUS address is used.</td>
</tr>
<tr>
<td>5</td>
<td>The non-volatile SIMOTION data is invalid; a backup file exists, but it is invalid; a backup copy of the backup file exists and is valid.</td>
<td>SIMOTION D4x5-2 copies the backup file contents to the non-volatile SIMOTION data and powers up with this data.</td>
</tr>
</tbody>
</table>

Non-volatile SIMOTION data diagnostics

The user can determine the status of the non-volatile SIMOTION data and the battery using the diagnostics buffer, system variables, and PeripheralFaultTask.
Evaluating via the diagnostics buffer

When they are issued, the following messages are entered once in the diagnostics buffer:

Table 4- 4   Messages of the diagnostics buffer

<table>
<thead>
<tr>
<th>Entry</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 1 battery voltage warning ¹</td>
<td>Battery voltage below prewarning level.</td>
<td>Replace battery in the fan/battery module</td>
</tr>
<tr>
<td>Level 2 battery voltage warning ¹</td>
<td>The battery voltage is below the warning level, backup of real-time clock (RTC) can no longer be guaranteed.</td>
<td>Replace battery in the fan/battery module</td>
</tr>
<tr>
<td>Battery voltage for data backup in permissible range</td>
<td>The battery voltage is in the permissible range for the backup of the real-time clock (RTC).</td>
<td>Replace battery in the fan/battery module or charge SuperCap by energizing it for a longer period.</td>
</tr>
<tr>
<td>Non-volatile data memory voltage error</td>
<td>The buffer voltage of the SuperCap or the battery was too low after Power On. Possible data loss in the real-time clock.</td>
<td>-</td>
</tr>
<tr>
<td>Non-volatile data loaded from a file (Persistent Data File Loading done)</td>
<td>Non-volatile SIMOTION data has been successfully restored from the backup file on the CompactFlash card.</td>
<td>-</td>
</tr>
<tr>
<td>Non-volatile data loaded from the backup file (Persistent Data Backup File Loading done)</td>
<td>Non-volatile SIMOTION data has been successfully restored from the backup copy of the backup file on the CompactFlash card.</td>
<td>-</td>
</tr>
<tr>
<td>Error while loading non-volatile data from a file (Persistent Data File Loading Failure)</td>
<td>Backup file or backup copy of backup file could not be loaded. Possible causes: • Backup file or backup copy of backup file does not exist • Data in backup file is invalid</td>
<td>Use the _savePersistentMemoryData system function to generate a backup file with valid contents.</td>
</tr>
<tr>
<td>Device with battery module</td>
<td>Fan/battery module is present.</td>
<td>-</td>
</tr>
<tr>
<td>Device without battery module</td>
<td>Fan/battery module is not present.</td>
<td>Connect fan/battery module</td>
</tr>
<tr>
<td>Module replacement detected - NVRAM has been initialized</td>
<td>A module replacement has been detected on the basis of the serial number. The non-volatile SIMOTION data on the controller will be deleted and the data from the CompactFlash card transferred to the controller.</td>
<td>-</td>
</tr>
<tr>
<td>Module replacement not detected - NVRAM has not been initialized</td>
<td>An error has occurred. The non-volatile SIMOTION data on the controller will not be deleted. Possible causes: • Incorrect controller type • File system of the CompactFlash card corrupt</td>
<td>-</td>
</tr>
</tbody>
</table>

¹ These warnings are only signaled when the fan/battery module has been inserted.

Refer to the SIMOTION SCOUT Configuration Manual for information about how to read out the contents of the diagnostics buffer.
4.3 User memory concept

Evaluating via PeripheralFaultTask

Battery status changes in RUN are reported to the user program by calling PeripheralFaultTask. Changes can be evaluated here using TaskStartInfo:

- **TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205)**
- **TSI#details = 16#00000040**

If no battery is used during the transition of the operating state to RUN, no PeripheralFaultTask will be triggered (application case: D4x5-2 should generally be operated without a battery).

References

Detailed information on setting up TaskStartInfo(#TSI) can be found in the SIMOTION SCOUT Basic Functions Function Manual.

Evaluating via system variables

The system variables in the `device.persistentDataPowerMonitoring` structure indicate the status of the non-volatile SIMOTION data and the battery.

Table 4-5 Status of the non-volatile SIMOTION data and battery

<table>
<thead>
<tr>
<th>System variable</th>
<th>Designation</th>
<th>State</th>
<th>Updating</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>powerFailure</code></td>
<td>Buffer voltage (SuperCap or battery) too low, possible data loss of the real-time clock</td>
<td>NO (91)</td>
<td>“YES” was set at too low a buffer voltage when powering up; status needs to be reset to “NO” via the application; the status remains even after power off/on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YES (173)</td>
<td></td>
</tr>
<tr>
<td><code>rtcFailure</code> (as of V4.3)</td>
<td>Indicates that the clock contents (RTC) are invalid (clock must be set again)</td>
<td>NO (91)</td>
<td>Is updated once during power-up; status must be reset to “NO” via the application; the status is retained even after power off/on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YES (173)</td>
<td></td>
</tr>
<tr>
<td><code>retainDataFailure</code> (as of V4.3)</td>
<td>Indicates a checksum error of the non-volatile SIMOTION data; can be an indication of defective HW</td>
<td>NO (91)</td>
<td>Is updated once during power-up; status must be reset to “NO” via the application; the status is retained even after power off/on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YES (173)</td>
<td></td>
</tr>
<tr>
<td><code>persistentDataState</code></td>
<td>Reading the persistent data</td>
<td>See the table below, “State of non-volatile data following power-up”.</td>
<td>During power-up</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 4.3 User memory concept

<table>
<thead>
<tr>
<th>System variable</th>
<th>Designation</th>
<th>State</th>
<th>Updating</th>
</tr>
</thead>
<tbody>
<tr>
<td>warningBatteryVoltage Level1</td>
<td>Battery voltage below the prewarning level</td>
<td>NO (91) YES (173)</td>
<td>During a status change, remains set if Level 2 is reached</td>
</tr>
<tr>
<td>warningBatteryVoltage Level2</td>
<td>Battery voltage below the warning level</td>
<td>NO (91) YES (173)</td>
<td>During a status change</td>
</tr>
</tbody>
</table>

1) Both battery warning levels are set under the following conditions:
- The fan/battery module is present and the battery has been inserted, but the battery voltage is below warning level 2
- The fan/battery module is present, but no battery has been inserted
- The fan/battery module is not present (not permissible on D4x5-2)

The system variable `device.persistentDataPowerMonitoring.powerFailure` = YES indicates that the buffer voltage of the SuperCap or the battery was too low after switching on.

With `.powerFailure = YES` and `.persistentDataState = FROM_RAM`, only a possible data loss of the real-time clock displayed for the SIMOTION D4x5-2 (and not also a possible loss of the non-volatile SIMOTION data as for the SIMOTION D4x5). The non-volatile SIMOTION data is not lost, but the data from the NVRAM will still be used.

As of SIMOTION V4.3, a data loss of the real-time clock is signaled via the system variable `device.persistentDataPowerMonitoring.rtcFailure` = YES.

The system variable `device.persistentDataPowerMonitoring.persistentDataState` indicates the state of the non-volatile SIMOTION data after power-up.

<table>
<thead>
<tr>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>FROM_RAM (1)</td>
<td>Non-volatile SIMOTION data in the SIMOTION device is used</td>
</tr>
<tr>
<td>FROM_FILE (2)</td>
<td>Non-volatile SIMOTION data is restored from the backup file</td>
</tr>
<tr>
<td>FROM_BACKUP (3)</td>
<td>Non-volatile SIMOTION data is restored from the backup copy of the backup file</td>
</tr>
<tr>
<td>INVALID (4)</td>
<td>Data in the non-volatile SIMOTION data and in the backup file / backup copy of backup file is invalid or non-existent/deleted. The SIMOTION device has copied the default settings to the non-volatile SIMOTION data and used this data to power up.</td>
</tr>
</tbody>
</table>
Requirement/availability of the battery

System variables can be used to evaluate:

- Whether a battery is required for the operation of the device (or not)
- Whether a battery is available (or not)

Table 4-7  System variable batterynecessary/batteryexisting

<table>
<thead>
<tr>
<th>System variable on the device</th>
<th>States</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.batterynecessary of the struct battery type (the system variables are of the enum battery type)</td>
<td>MANDATORY</td>
<td>Battery is required for the backup of the non-volatile data and the real-time clock (RTC) of the device. .batteryexisting can be used to query whether a battery is available.</td>
</tr>
<tr>
<td>OPTIONAL</td>
<td></td>
<td>The non-volatile data and the real-time clock (RTC) are backed up via SuperCap. A battery can be used as an option to extend the backup time. .batteryexisting can be used to query whether a battery is available.</td>
</tr>
<tr>
<td>OPTIONAL_RTC 1)</td>
<td></td>
<td>A battery is not required for backing up the non-volatile data. Only the real-time clock (RTC) is backed up via SuperCap. A battery can be used as an option to extend the backup time of the real-time clock. .batteryexisting can be used to query whether a battery is available.</td>
</tr>
<tr>
<td>NOT_MANDATORY 1)</td>
<td></td>
<td>A battery is not required for backing up the non-volatile data. The real-time clock (RTC) is backed up via SuperCap. Example: D410-2</td>
</tr>
<tr>
<td>.batteryexisting 2)</td>
<td>EXISTING</td>
<td>EXISTING is only displayed when .batterynecessary is set to: MANDATORY or OPTIONAL or OPTIONAL_RTC and a battery is available.</td>
</tr>
<tr>
<td>NOT_EXISTING</td>
<td></td>
<td>Battery is not available.</td>
</tr>
</tbody>
</table>

1) If the SuperCap is discharged, the contents of the real-time clock (RTC) are lost.

2) The value for SIMOTION D4x5-2 is updated dynamically.
4.3.4 Module replacement

SIMOTION module replacement

A module replacement is detected automatically as of SIMOTION V4.3.

During a module replacement, a CompactFlash card that contains the non-volatile SIMOTION data backed-up with \_savePersistentMemoryData, is inserted in a new device of the same type.

A module replacement is detected by the SIMOTION D4x5-2 on the basis of the serial number. The data backed up on the CompactFlash card with \_savePersistentMemoryData is then automatically transferred to the new device.

Note

As an additional option, you can back up the non-volatile data by setting the Service selector switch, with the DIAG button or via IT DIAG, see Section Diagnostics data and non-volatile SIMOTION data (Page 359).

Initial power-up with the CompactFlash card

Requirement: CompactFlash card (no device serial number stored)

If the SIMOTION D4x5 2 powers up successfully with a new CompactFlash card, the serial number of the device is stored on the CompactFlash card. In this case, a module replacement cannot be detected.

Note

The serial number stored on the CompactFlash card remains unaffected by the following actions:

- Copy RAM to ROM
- Project download
- Writing the CompactFlash card via the SCOUT function "Load to file system"
- FW/project update via device update tool

If the CompactFlash card contents are copied to another CompactFlash card, the serial number is also copied.

A serial number stored on the CompactFlash card can only by removed by deleting the CompactFlash card contents.
SIMOTION D4x5-2 power-up with the CompactFlash card (no module replacement)

Requirement:
- The same CompactFlash card
- The same controller

If the device powers up successfully, the serial number stored on the CompactFlash card is compared with the serial number of the device.

If the serial numbers are identical, there has been no module replacement.

The device powers up. In the non-volatile SIMOTION data present in the device is valid, then this is used (for details, see Table 4-3 Cases: Power-up with non-volatile SIMOTION data (Page 98)).

SIMOTION D4x5-2 power-up with the CompactFlash card (module replacement)

Requirement:
- The same CompactFlash card
- Different device (e.g. replacement because of defect)

If the device powers up successfully, the serial number stored on the CompactFlash card is compared with the serial number of the device.

If the serial numbers are not identical, there has been a module replacement.

This means:
- The serial number of the new module is stored on the CompactFlash card.
- The non-volatile SIMOTION data is deleted in the device.
- A diagnostic buffer entry is issued which signals that a module has been replaced.
- The non-volatile SIMOTION data stored "on the CompactFlash card" is transferred to the device (for details, see Table 4-3 Cases: Power-up with non-volatile SIMOTION data (Page 98)).

**NOTICE**

A module replacement is detected only on the basis of the changed serial number. If you unintentionally insert an incorrect CompactFlash card with stored device serial number into the D4x5-2, this has following consequences:
- The non-volatile data on the device is permanently deleted
- The IP/DP address set in the device is deleted, i.e. you can no longer go online via the IP/DP address set originally.
Error scenarios
In the event of an error, a diagnostic buffer entry signals that it was not possible to determine whether a module has been replaced.

Possible reasons are:
- The serial number of the device cannot be determined.
- The serial number saved on the CompactFlash card cannot be determined, for example, due to a corrupt file system.
- The controller has not powered up.
- The new serial number could not be transferred to the CompactFlash card, for example, due to a corrupt file system.

Restart after reloading
The system variable `device.startupData.operationMode` is used to define whether the SIMOTION D4x5-2 control unit goes into the RUN state or the last operating state after a power-on/restart.

Possible values of `device.startupData.operationMode`:
- `LAST_OPERATION_MODE [0]` (default setting)
- `RUN [1]`

With `LAST_OPERATION_MODE [0]`, the module remains in the STOP state after reloading the non-volatile SIMOTION data and must be switched manually to the RUN state with SCOUT, IT DIAG or the mode selector switch.

With `RUN [1]`, the module goes automatically into the RUN state after reloading.

SINAMICS module replacement
A module replacement is detected as of SINAMICS V4.5.

For the SINAMICS Integrated, CX32-2 and SINAMICS S120 CU310-2/CU320-2, a module replacement is also identified via the serial number. Non-volatile SINAMICS data (NVRAM data) backed up previously via the CU parameter p7775 on the CompactFlash card, is then automatically transferred to the control unit.
4.4 Fan

4.4.1 Cooling the SIMOTION D4x5-2

Overview

A fan/battery module is always required for cooling the SIMOTION D4x5-2 Control Unit.

Table 4-8 Fan/battery module for SIMOTION D4x5-2

<table>
<thead>
<tr>
<th>Property</th>
<th>SIMOTION D425-2 DP</th>
<th>SIMOTION D435-2 DP</th>
<th>SIMOTION D445-2 DP/PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fan/battery module</td>
<td>Always required (double fan/battery module included in the D425-2’s scope of delivery)</td>
<td>Always required (double fan/battery module included in the D435-2’s scope of delivery)</td>
<td>Always required (double fan/battery module included in the scope of delivery of the D445-2 DP/PN and D455-2 DP/PN)</td>
</tr>
<tr>
<td>Fan/battery module included in the D4x5-2 scope of delivery</td>
<td>Double fan/battery module 6FC5348-0AA02-0AA0</td>
<td>Double fan/battery module 6FC5348-0AA02-0AA0</td>
<td>Double fan/battery module 6FC5348-0AA02-0AA0</td>
</tr>
<tr>
<td>Usable fan/battery modules</td>
<td>Only type 6FC5348-0AA02-0AA0 (double fan)</td>
<td>Only type 6FC5348-0AA02-0AA0 (double fan)</td>
<td>Only type 6FC5348-0AA02-0AA0 (double fan)</td>
</tr>
<tr>
<td>Max. permissible supply air temperature</td>
<td>55° C</td>
<td>55°C</td>
<td>55° C</td>
</tr>
<tr>
<td>Fan control</td>
<td>Temperature-controlled fan unit will be switched on depending on supply air temperature and CPU load</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The fan/battery modules are usually supplied with a backup battery.

Fan faults

Fan faults are indicated as follows:

- Entry in diagnostics buffer
- In the event of fan failure (both fans in the double fan/battery module failed) the RDY LED flashes red/yellow at 2 Hz
- Indicated via system variable
- Call to the PeripheralFaultTask

For further information on the evaluation of fan faults, see Section Overview of the fan/battery module states (Page 108).
4.4.2 Fan/battery module

A fan/battery module is always required for operation of the SIMOTION D4x5-2 Control Unit. A corresponding module including a backup battery is therefore included in the scope of delivery of the SIMOTION D4x5-2 Control Unit.

For increased availability a double fan/battery module is used as standard on SIMOTION D4x5-2.

The double fan/battery module also guarantees sufficient cooling with just one functional fan.

If one of the fans fails, the remaining fan continues under full load. The fan failure is signaled by the generation of an event in the PeripheralFaultTask. In this case it is strongly recommended that the double fan/battery module is replaced at the next available opportunity.

Checks are performed during power-up to determine whether the double fan/battery module on the SIMOTION D4x5-2 Control Unit is functioning correctly (i.e. at least one of the two fans is working). If a double fan/battery module is missing or faulty, the kernel is not downloaded and the RDY LED flashes red/yellow (2 Hz). Switch off the power supply and eliminate the fault. Then switch the power supply back on.

---

**Note**

If the SIMOTION D445-2 DP/PN or D455-2 DP/PN needs to be cooled (fan switches on with temperature control) and this is not possible due to a fan/battery module having been removed or being faulty, the module state switches to RESET after approximately 1 minute (7-segment display shows "8"). This state can only be reset with a switch-off.

If only one fan in the double fan/battery module fails, the module is still regarded as functional, although it should be replaced as soon as possible. If neither of the fans is working, the double fan/battery module is identified as defective.
### 4.4.3 Overview of states, fan/battery module

The states that can occur during operation are described in the following.

#### Table 4-9 Overview of states

<table>
<thead>
<tr>
<th>State</th>
<th>Fan</th>
<th>PeripheralFaultTask</th>
<th>System variables</th>
<th>System variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure of one fan during STOP, then RUN</td>
<td>Single fan</td>
<td>PeripheralFaultTask: Is not called</td>
<td>_cpuDataRW.fanWarning</td>
<td>_cpuDataRW.redundantFanWarning 2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diagnostics buffer entry: Fan on the module is defective</td>
<td>= YES</td>
<td>= NO</td>
</tr>
<tr>
<td></td>
<td>Double fan</td>
<td>PeripheralFaultTask: Is not called</td>
<td>= NO</td>
<td>= YES</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diagnostics buffer entry: Fan on the module is defective</td>
<td>= YES 1)</td>
<td>= NO</td>
</tr>
<tr>
<td>Failure of both fans during STOP, then RUN</td>
<td>Double fan</td>
<td>PeripheralFaultTask: Is not called</td>
<td>= YES 1)</td>
<td>= NO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diagnostics buffer entry: Fan on the module is defective</td>
<td>= YES 1)</td>
<td>= NO</td>
</tr>
<tr>
<td>Failure of one fan during RUN</td>
<td>Single fan</td>
<td>PeripheralFaultTask: TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205) TSI#details = 16#00000080</td>
<td>= YES</td>
<td>= NO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diagnostics buffer entry: Fan on the module is defective</td>
<td>= NO</td>
<td>= YES</td>
</tr>
<tr>
<td>Failure of both fans during RUN</td>
<td>Double fan</td>
<td>PeripheralFaultTask: TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205) TSI#details = 16#00000080</td>
<td>= YES</td>
<td>= NO</td>
</tr>
</tbody>
</table>

1) SIMOTION D4x5-2 switches to the RESET state after approximately 1 minute.
2) Maintenance: Replace double fan/battery module at the next available opportunity.
3) The "YES" value must be reset to "NO" by the application.
4) Single fans are only supported by SIMOTION D4x5 and D4x10-2.
Fan faults are detected if through

- A cyclic fan test
- Or when the fan is switched on

a malfunction is detected (fan does not turn or fan turns at too low a speed).

**Note**

If the "redundant fan" is already defective in a double fan/battery module when the system is powered-up, this is detected as a single fan/battery module depending on the type of defect (e.g. a wire breakage).

You should, therefore, also set the `.fanexisting` system variable to the "SINGLE" state to alert the personnel operating the machine to the fact that no is redundancy available.

**Diagnostics buffer entry**

The diagnostics buffer entries have the following meanings:

- Fan on the module is defective
  - All of the fans in a fan/battery module have failed
- There is no redundant fan available
  - This message only occurs in the case of modules that support double fan/battery modules with a redundant fan.
    - The message occurs:
      - If it is only the redundant fan that has failed on a double fan/battery module or
      - If a single fan/battery module is connected but the module also supports a double fan/battery module in principle (this is only the case for D445-1; with D4x5-2, only double fan/battery modules are permitted)

**Requirement/availability of a fan**

System variables can be used to evaluate:

- Whether a fan is required for the operation of the device (or not)
- Whether a fan is available (or not)
### 4.4 Fan

#### Table 4-10 System variable fanecessary/fanexisting

<table>
<thead>
<tr>
<th>System variable on the device</th>
<th>States</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fanbattery of the structfanbattery type (the system variables are of the enumfanbattery type)</td>
<td>MANDATORY</td>
<td>Fan is required for operation of the device. .fanexisting can be used to query whether a fan is available. Examples: D410-2, D4x5-2</td>
</tr>
<tr>
<td>.fanecessary</td>
<td>OPTIONAL</td>
<td>Fan can be used optionally. .fanexisting can be used to query whether a fan is available. Examples: D425, D435</td>
</tr>
<tr>
<td>.fanexisting</td>
<td>NOT_MANDATORY</td>
<td>Fan is not required for operation of the device.</td>
</tr>
<tr>
<td>.fanexisting ¹)</td>
<td>SINGLE</td>
<td>Single fan is available. Examples: D410-2</td>
</tr>
<tr>
<td></td>
<td>REDUNDANT</td>
<td>Double fan is available. Examples: D4x5-2</td>
</tr>
<tr>
<td></td>
<td>NOT_EXISTING</td>
<td>No fan available. Example: D425 and D435 without optional fan</td>
</tr>
</tbody>
</table>

¹) Value for SIMOTION D4x5-2 is updated dynamically

#### References

Detailed information on setting up TaskStartInfo(#TSI) can be found in the SIMOTION SCOUT Basic Functions Function Manual.
4.4.4 Response to overtemperature

Operation at overtemperature reduces the module service life and can result in damage to the module.

Causes

Cause of problems in the heat dissipation of the module can be, for example:

- Violation of the maximum permissible air intake temperature
- Free convection is not ensured (clearances are not maintained, pollution, convection is prevented by cables)
- Impermissible mounting position of the module

Temperature thresholds

The internal module temperature is monitored via two module-specific temperature thresholds:

- Overtemperature is signaled when the first (lower) temperature threshold is exceeded.
- When the temperature falls below the first temperature threshold again (minus a hysteresis of approx. 5° C), "Normal temperature" is signaled.
- When the second (higher) temperature threshold is exceeded, the module shuts down in order to protect itself.

Response to overtemperature

Table 4-11 Response of the temperature monitoring

<table>
<thead>
<tr>
<th>Temperature...</th>
<th>Response</th>
</tr>
</thead>
</table>
| ... exceeds the 1st temperature threshold (overtemperature) | Call of the PeripheralFaultTask:  
  - TSI#Interrupt = _SC_PC_INTERNAL_FAILURE (= 205)  
  - TSI#details = 16#00000002  
  Diagnostics buffer entry:  
    "Temperature exceeded in the housing" |
| ... falls below the 1st temperature threshold minus a hysteresis of approx. 5° C | Call of the PeripheralFaultTask:  
  - TSI#Interruptid = _SC_PC_INTERNAL_FAILURE (= 205)  
  - TSI#details = 16#00000004  
  Diagnostics buffer entry:  
    "Temperature in the housing has returned to normal" |
| ... exceeds the 2nd temperature threshold | Module goes into permanent RESET to protect itself (7-segment display shows "8", RDY LED flashes red/yellow at 2 Hz).  
  Diagnostics buffer entry (as of V4.3): "Temperature in the housing too high, self-protection function of the module activated" |
4.4 Fan
5.1 Software requirements

SIMOTION SCOUT engineering system

The following SCOUT Version must be installed on your PG/PC for the commissioning of the SIMOTION D4x5-2:

- As of V4.2 for the SIMOTION D445-2/D455-2/CX32-2
- As of V4.3 for the SIMOTION D425-2/D435-2/CBE30-2

Please note the information on the latest SIMOTION SCOUT DVD.

For information on how to install SIMOTION SCOUT on your PG/PC, see the SIMOTION SCOUT Configuration Manual.
5.2 Creating a project and configuring the communication

5.2.1 Creating a SIMOTION project and inserting a D4x5-2

Procedure

Proceed as follows to create a new project in SIMOTION SCOUT and insert a SIMOTION D4x5-2:

1. Select the Project > New... menu command.
2. In the "New Project" dialog box, assign a name and confirm with "OK."
   A new folder with the name of the project will be created in the project navigator.
3. In the project navigator, double-click "Insert SIMOTION device". The "Insert SIMOTION Device" dialog box is opened.
4. In the "Insert SIMOTION Device" dialog box, select the device, its version and the SIMOTION version.

Figure 5-1 Insert SIMOTION device
5. If required, make further settings:
   - SINAMICS: Select either a "SINAMICS S120 Integrated" or a "SINAMICS SM150 Integrated" (only for D445/D445-1/D455-2)
   - SINAMICS version: Select the SINAMICS Integrated version if several drive versions are available for a SIMOTION version
   - Insert a CBE30-2: Selection of a CBE30-2 (only for D4x5-2 DP/PN)

6. The "Open HW Config" option can be used to select whether HW Config should be opened in the next step (e.g. in order to insert a CX32-2 controller extension).

7. Confirm the "Insert SIMOTION Device" dialog with "OK".

**SINAMICS Integrated type**

The following selection options are available for SIMOTION D445/D445-1/D455-2:

- SINAMICS S120 Integrated
- SINAMICS SM150 Integrated for applications with medium-voltage converters

A separate SIMOTION D firmware is available for each of the two versions.

**Version of the SINAMICS Integrated**

Depending on the selected SIMOTION version, several versions are available for the SINAMICS Integrated. Please note that a separate SIMOTION D firmware is available for each version of the SINAMICS Integrated.

**Configuring the PROFINET interface**

After you have acknowledged the "Insert SIMOTION Device" dialog with "OK", the "Properties - Ethernet Interface" dialog box opens in the case of a D4x5-2 DP/PN.

If you are using the PROFINET interface, set the interface properties in the "Properties - Ethernet Interface" dialog box.

To this end, proceed as follows:

1. Click the "New" button.
   The "New Subnet Industrial Ethernet" dialog box opens. Rename the new subnet, or accept the default name by clicking "OK".

2. Select the new Ethernet subnet which is now displayed in the "Properties - Ethernet Interface" dialog box.

3. Enter the required addresses in the "IP address" and "Subnet mask" fields of the "Properties - Ethernet Interface" dialog box. Change to the "Network node" field and define whether you are going to use a router and, if yes, enter the router address. Confirm with "OK".

**Result**

If you have not yet configured a PG/PC in your project, you can select the interface for the PG/PC connection now.
5.2 Creating a project and configuring the communication

5.2.2 Configuring the PROFIBUS PG/PC interface

Requirements

The following requirements must be satisfied in order to configure the PG/PC interface:

- You have completed the "Insert SIMOTION Device" dialog box with "OK".
- A PG/PC has not yet been configured in the project.

If these requirements have been satisfied, you can configure the interface for the PG/PC connection in the "Interface Selection - D4x5" dialog box.

Proceed as follows to configure the PROFIBUS DP interface:

Procedure

1. In the "Interface Selection - D4x5" dialog box, select the entry "PROFIBUS DP/MPI (X136)".

![Selecting a PROFIBUS interface](image)

Figure 5-2 Selecting a PROFIBUS interface

2. Select the interface parameter assignment that you would like to use to go online, and confirm with "OK".

The dialog box is closed, the SIMOTION D4x5-2 is created in the project navigator and HW Config is started automatically (if parameterized).
A PROFIBUS subnet with factory settings (1.5 Mbit/s transmission rate) is created automatically.
The PG/PC is now connected to the SIMOTION D4x5-2 via PROFIBUS. You can configure and parameterize your system.

**Note**
If you do not use the factory settings, you must configure the PROFIBUS interfaces in **HW Config**. Please make sure that the S7 online access has been activated (PG/PC connection must be yellow and bold in NetPro).

**Inserting a further SIMOTION device**

If you insert a further SIMOTION device using "Insert SIMOTION device", the PG/PC interface selection dialog box is not displayed. A further SIMOTION device is automatically connected to the PG/PC via PROFIBUS and a new unique IP address (address 4, 5, etc. until 125 is reached) is calculated.

**Additional references**

Further information on the topic of "Going online" can be found:

- In the online help via the "Contents" tab at
  - "Diagnostics" > "Overview of service and diagnostics options" > "Part III" > "Go online"
  - "Insert device and connect to target system" > "Go online/offline"
- On the Internet at (http://support.automation.siemens.com/WW/view/en/22016709)
- In SIMOTION Utilities & Applications, FAQ "Online connections to SIMOTION devices"

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.

**See also**

Establishing a PG/PC assignment (Page 130)

**5.2.3 Configuring the Ethernet PG/PC interface**

**Requirement**

The following requirements must be satisfied in order to configure the PG/PC interface:

- You have completed the "Insert SIMOTION Device" dialog box with "OK".
- A PG/PC has not yet been configured in the project.

If these requirements have been satisfied, you can configure the interface for the PG/PC connection in the "Interface Selection - D4x5" dialog box.
Parameter assignment / addressing

5.2 Creating a project and configuring the communication

Proceed as follows to configure the Ethernet interface:

Procedure

1. In the "Interface Selection - D4x5" dialog box, select the entry "Ethernet PNxIE (X127)".

![Figure 5-3 Configuring the Ethernet interface](image)

2. Select the interface parameter assignment that you would like to use to go online, and confirm with "OK". The dialog box is closed, the SIMOTION D4x5-2 is created in the project navigator and **HW Config** is started automatically (if parameterized).

An Ethernet subnet with factory settings is created automatically. (Factory settings, see Section Properties of the Ethernet interfaces (Page 132.).)

The PG/PC is now connected to the SIMOTION D4x5-2 via Ethernet. You can configure and parameterize your system.

**Note**

If you want to change the default settings for IP addresses and the transmission rate, you must configure the Ethernet interfaces in **HW Config** and **NetPro**. Please make sure that the S7 online access has been activated (PG/PC connection must be yellow and bold in NetPro).
Inserting a further SIMOTION device

If you insert a further SIMOTION device using "Insert SIMOTION device", the PG/PC interface selection dialog box is not displayed. The second SIMOTION device is automatically connected to the PG/PC via Ethernet and a new unique IP address (last digit + 1, up to 255) is calculated.

Additional references

Further information on the topic of "Going online" can be found:

- In the online help via the "Contents" tab at
  - "Diagnostics" > "Overview of service and diagnostics options" > "Part III" > "Go online"
  - "Insert device and connect to target system" > "Go online/offline"
- On the Internet at (http://support.automation.siemens.com/WW/view/en/22016709)
- In SIMOTION Utilities & Applications, FAQ "Online connections to SIMOTION devices".

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.
5.2 Creating a project and configuring the communication

5.2.4 Representation of SIMOTION D4x5-2 in HW Config

Once you have created a project and inserted a SIMOTION D4x5-2 as module, HW Config opens automatically (if parameterized).

In HW Config the SIMOTION D4x5-2 units are shown with the SINAMICS Integrated and the interfaces.

![Representation of a D4x5-2 in HW Config](image-url)

Figure 5-4 Representation of a D4x5-2 in HW Config
5.3 Configuring PROFIBUS DP

5.3.1 General information about communication via PROFIBUS DP

Definition of PROFIBUS DP

PROFIBUS DP is an international, open field bus standard specified in the European field bus Standard EN 50170 Part 2. PROFIBUS DP is optimized for high-speed, time-sensitive data transfer at field level.

Components communicating by means of PROFIBUS DP are classified as master or slave components.

- Master (active bus node):
  Components that represent a master on the bus define data transfer along the bus, and are therefore known as active bus nodes.
  Masters components are divided into two classes:
    - DP master class 1 (DPMC1):
      Central master devices are thus designated, which exchange information with the slaves in specified message cycles.
      Examples: SIMOTION D445-2 DP/PN, C240, P350, SIMATIC S7, etc.
    - DP master class 2 (DPMC2):
      These are devices for configuration, commissioning, and operator control and monitoring while the bus is in operation.
      Examples: Programming devices, operator control/monitoring devices

- Slaves (passive bus nodes):
  These devices may only receive, acknowledge and transfer messages to a master when so requested.
  Examples: SINAMICS drives, I/O modules

Functions on PROFIBUS DP

The functional scope can differ between DP masters and DP slaves. The functional scope is different for DP-V0, DP-V1 and DP-V2.

These functions on the PROFIBUS DP are characterized by:

- Configurable, equidistant, isochronous PROFIBUS DP cycle
- Synchronization of slaves by the master by means of a global control message frame in each cycle clock
- Independent maintenance of the isochronous cycle clock by the slaves in the event of a short-term communication failure.

Additional references

You will find additional information about PROFIBUS DP in the SIMOTION Communication System Manual.
Parameter assignment / addressing

5.3 Configuring PROFIBUS DP

5.3.2 Operating the SIMOTION D4x5-2 on PROFIBUS DP

PROFIBUS DP interface (X126, X136)

SIMOTION D4x5-2 has two interfaces for connection to the PROFIBUS DP. Transmission rates up to 12 Mbit/s are possible. Both interfaces can be operated isochronously.

The X136 interface can also be used as an MPI interface.

As supplied, both PROFIBUS DP interfaces are preset as a master with address 2 and a transmission rate of 1.5 Mbit/s. The PROFIBUS DP network is automatically created for this setting.

However, other settings can also be configured. This requires that you configure the network manually using HW Config and NetPro.

Note

Communication with the SINAMICS Integrated of a D4x5-2 or CX32-2 is always isochronous. Here, SIMOTION D4x5-2 is the master and the SINAMICS Integrated drives are slaves.

Master-slave configuration

The master/slave configuration can be used, for example, to establish hierarchical PROFIBUS networks that can be used to implement a modular machine concept.

Table 5-1 Master-slave configuration

<table>
<thead>
<tr>
<th>X126 DP</th>
<th>X136 DP/MPI</th>
<th>Remark</th>
<th>Actions in the application</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP slave, isochronous</td>
<td>DP master, isochronous</td>
<td>Application synchronized to DP master (X136), application controls synchronization to DP slave (X126) Internal drive is synchronous with external cycle clock Cycle clock X126 = cycle clock DP Integrated</td>
<td>DP master / DP slave synchronization mechanisms</td>
</tr>
<tr>
<td>DP master, isochronous</td>
<td>DP slave, isochronous</td>
<td>Application synchronized to DP master (X126), application controls synchronization to DP slave (X136) Internal drive is synchronous with external cycle clock Cycle clock X126 = cycle clock DP Integrated</td>
<td>DP master / DP slave synchronization mechanisms</td>
</tr>
<tr>
<td>DP slave, isochronous</td>
<td>DP master, not isochronous</td>
<td>Application synchronized to DP slave (X126) (can be monitored by the application) Internal drive is synchronous with X126</td>
<td>DP slave synchronization mechanisms</td>
</tr>
<tr>
<td>DP master, not isochronous</td>
<td>DP slave, isochronous</td>
<td>Application synchronized to DP slave (X136) (can be monitored by the application) Internal drive is synchronous with X136</td>
<td>DP slave synchronization mechanisms</td>
</tr>
<tr>
<td>DP master, isochronous</td>
<td>DP master, isochronous</td>
<td>Application synchronized to DP master (X126, X136) Internal drive is synchronous with external cycle clock Cycle clock X126 = cycle clock X136 = cycle clock DP Integrated</td>
<td>None</td>
</tr>
</tbody>
</table>
### 5.3 Configuring PROFIBUS DP

<table>
<thead>
<tr>
<th>X126 DP</th>
<th>X136 DP/MPI</th>
<th>Remark</th>
<th>Actions in the application</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP master, isochronous</td>
<td>DP master, not isochronous</td>
<td>Application synchronized to DP master (X126) Internal drive is synchronous with X126 Cycle clock X126 = cycle clock DP Integrated</td>
<td>None</td>
</tr>
<tr>
<td>DP master, isochronous</td>
<td>DP slave, not isochronous</td>
<td>Application synchronized to DP master (X126) Internal drive is synchronous with X126 Cycle clock X126 = cycle clock DP Integrated</td>
<td>None</td>
</tr>
<tr>
<td>DP master, not isochronous</td>
<td>DP master, isochronous</td>
<td>Application synchronized to DP master (X136) Internal drive is synchronous with X136 Cycle clock X136 = cycle clock DP Integrated</td>
<td>None</td>
</tr>
<tr>
<td>DP slave, not isochronous</td>
<td>DP master, isochronous</td>
<td>Application synchronized to DP master (X136) Internal drive is synchronous with X136 Cycle clock X136 = cycle clock DP Integrated</td>
<td>None</td>
</tr>
<tr>
<td>DP master, not isochronous</td>
<td>DP master, not isochronous</td>
<td>Application synchronized to internal drive cycle clock</td>
<td>None</td>
</tr>
<tr>
<td>DP slave, not isochronous</td>
<td>DP master, not isochronous</td>
<td>Application synchronized to internal drive cycle clock</td>
<td>None</td>
</tr>
<tr>
<td>DP master, not isochronous</td>
<td>DP slave, not isochronous</td>
<td>Application synchronized to internal drive cycle clock</td>
<td>None</td>
</tr>
<tr>
<td>DP slave, not isochronous</td>
<td>DP slave, not isochronous</td>
<td>Application synchronized to internal drive cycle clock</td>
<td>None</td>
</tr>
<tr>
<td>DP slave, isochronous</td>
<td>DP slave, not isochronous</td>
<td>Application synchronized to DP slave (X126) (can be monitored by the application) Internal drive is synchronous with X126</td>
<td>DP slave synchronization mechanisms</td>
</tr>
<tr>
<td>DP slave, not isochronous</td>
<td>DP slave, isochronous</td>
<td>Application synchronized to DP slave (X136) (can be monitored by the application) Internal drive is synchronous with X136</td>
<td>DP slave synchronization mechanisms</td>
</tr>
</tbody>
</table>

For detailed information about controlling synchronization across the application, see the *Basic Functions for Modular Machines* Description of Functions.

Alternatively, the X136 interface can be used as an MPI interface with a transmission rate of 19.2 kbit/s up to 12 Mbit/s.
5.3 Configuring PROFIBUS DP

5.3.3 Assignment of the PROFIBUS addresses in HW Config

Assigning PROFIBUS addresses

In order for all devices to communicate with each other, you must assign a PROFIBUS address to each device before connecting them:

Note
Before you assign any PROFIBUS addresses, please remember that all addresses must be unique on the PROFIBUS subnet.

You set these PROFIBUS addresses individually for each device with the PG/PC using HW Config. Some PROFIBUS DP slaves have a switch for this purpose.

Note
The PROFIBUS addresses set at the devices using these switches must correspond with the address settings in HW Config.

Recommendation for PROFIBUS addresses

Reserve PROFIBUS address "0" for a service programming device and "1" for a service HMI device, which will be connected to the subnet if required.

Recommendation for the PROFIBUS address of the SIMOTION D4x5-2 in case of replacement or service:

Reserve address "2" for a SIMOTION D4x5-2. This prevents duplicate addresses when installing a SIMOTION D4x5-2 with a default setting on the subnet (e.g. when a SIMOTION D4x5-2 is replaced). You should therefore assign addresses greater than "2" to additional units on the subnet.
5.3.4 Setting the DP cycle and system cycle clocks

All cycle clocks for the SIMOTION D4x5-2 are based on the DP cycle of SINAMICS Integrated, which must be set in HW Config.

To do so, click the SINAMICS block on the integrated PROFIBUS. The "DP Slave Properties" dialog box opens. You can adjust the DP cycle of the SINAMICS Integrated on the "Isochronous mode" tab.

Table 5-2 SIMOTION D4x5-2 value range

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DP cycle</td>
<td>≥ 0.5 ms (DP internal) ≥ 1.0 ms (DP external)</td>
<td>≥ 0.5 ms (DP internal) ≥ 1.0 ms (DP external)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grid</td>
<td>0.125 ms</td>
<td>0.125 ms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min. IPO cycle</td>
<td>≥ 0.5 ms</td>
<td>≥ 0.5 ms</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

External DP interfaces can only be operated with a DP cycle of ≥ 1 ms.

SINAMICS Integrated always runs in isochronous mode. The DP cycle setting of the SINAMICS Integrated is displayed as the "Bus data cycle" in the "System Cycle Clocks" dialog box. In SIMOTION SCOUT, select the SIMOTION D control unit and then select the "Set system cycle clocks" option in the "Target system" > "Expert" menu.

The table below shows the possible ratio settings for the SIMOTION D4x5-2 system cycle clocks based on the bus cycle clock.

Table 5-3 Ratios of system cycle clocks

<table>
<thead>
<tr>
<th>Servo cycle clock: Bus cycle clock</th>
<th>IPO cycle clock: Servo cycle clock</th>
<th>IPO2 cycle clock: IPO cycle clock</th>
</tr>
</thead>
<tbody>
<tr>
<td>As of V4.3: 1 … 4, 8</td>
<td>1 … 6</td>
<td>2 … 64</td>
</tr>
<tr>
<td>V4.2: 1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

As of V4.3, a reduction ratio for the servo cycle clock to the DP cycle clock is possible. The reduction ratio is only permitted when PROFINET IO with IRT has not been configured.

If the DP interfaces (X126/X136) are configured as isochronous master interfaces, you must set both DP cycles equal to the bus cycle clock of the SINAMICS Integrated in HW Config.

If the DP interfaces (X126/X136) are operated as the master, the system cycle clocks are obtained from an internal cycle clock of the module. Of the two DP interfaces (X126/X136), no more than one can also be operated as an isochronous slave interface. In this case, the system cycle clocks are obtained from the cycle clock of the slave interface.

As a result, the task system of SIMOTION and SINAMICS Integrated runs synchronously to the slave cycle clock. This assumes that a slave cycle clock exists and synchronization with the slave cycle clock has been achieved. If this is not the case, the system cycle clocks are acquired from an internal replacement clock.

When the project is downloaded, the cycle clock configuration is downloaded to the SIMOTION D4x5-2 and automatically set according to the specifications.
5.3.5 Cycle clock scaling of external PROFIBUS interface to internal PROFIBUS interface

Definition
Cycle clock scaling means that an external PROFIBUS interface of the SIMOTION D4x5-2 (X126/X136) can be operated in an integer multiple of the internal PROFIBUS interface. This reduces the CPU load, thereby allowing you to operate more axes, for example. The settings of the scaled cycle clocks for the external DP interfaces are made in **HW Config**.

Supplementary conditions
The following supplementary conditions are applicable to cycle clock scaling:

- An external DP interface of the D4x5-2 is used as an isochronous slave interface. Only in this case can an **integer** cycle clock scaling of isochronous external DP slave interface to internal interface be specified. This is checked during compilation and an error message is output in the event of noncompliance. If the external DP interfaces are configured as equidistant interfaces but none are configured as slaves and cycle clock scaling is specified for these interfaces, an error is output during compilation.

- For SERVO, IPO, and IPO2, settings can also be made for all permissible cycle clocks. Master and slave axes can run in different IPO levels. Different cycle clocks and phase offsets are tolerated by the system.

**Note**
The IPO cycle clock of the IPO in which the synchronous operation technology object runs must be set equal to the cycle clock of the isochronous external DP slave interface.

- The second external DP interface can be operated as an isochronous master (while the other is an isochronous slave) in order to operate external drives, for example. In this case, the cycle clock must be the same as the cycle clock of the internal PROFIBUS DP. If this condition is not satisfied, an error message is output during compilation.

- One or both external DP interfaces can also be operated as non-isochronous, free-running interfaces. In this case, there is no effect on the cycle clock settings.
Application example

The system consists of a synchronous master (DP master) and at least one SIMOTION D4x5-2 synchronous slave (DP slave). The synchronous master contains the master axis; the synchronous slave contains the following axes:

- The axes in the SINAMICS Integrated of the D4x5-2 synchronous slave must exhibit high performance with a servo cycle clock of 1 ms and an internal DP cycle of 1 ms. This requires that the internal fast PROFIBUS DP be decoupled from the slower external PROFIBUS DP.
- The PROFIBUS DP has, for example, a cycle time of 4 ms due to the quantity framework on the bus; in all cases, its cycle time exceeds that of the cycle clock of the internal DP interface.
- The master values are transmitted via the DP bus. Further nodes can also be connected to the DP bus, e.g. DP drives, distributed I/Os, etc.

![Diagram of PROFIBUS DP system](image)

Figure 5-5  Example of a cycle clock scaling for PROFIBUS DP
5.3 Configuring PROFIBUS DP

5.3.6 Creating a new PROFIBUS subnet

Introduction

SIMOTION SCOUT is used to network the SIMOTION D4x5-2. During the configuration process, the desired bus parameters can be set for the PROFIBUS DP interfaces.

Note

If a hardware configuration is loaded without a PROFIBUS network (X126 or X136) being configured on the CPU, a new PROFIBUS address that was previously set in HW Config or NETPro will not be accepted by the CPU.

Requirement

You have created a project and have inserted a SIMOTION D4x5-2.

Procedure

To create a new subnet, proceed as follows:

1. In the project navigator, double-click the SIMOTION D control unit to call HW Config.
2. In the SIMOTION D4x5-2 representation, double-click the interface for which you want to create a PROFIBUS subnet.
   The "DPx Properties" dialog box is opened.
3. Click "Properties" to show the "PROFIBUS Interface DPx" dialog box.
4. Click "New" to call the "Properties - New PROFIBUS Subnet" dialog.
5. Name the new subnet and enter the properties of the new subnet, such as transmission rate, on the "Network settings" tab.
6. If the PROFIBUS interface is to be operated isochronously, click "Options". Activate the "Activate isochronous bus cycle" option in the "Options" dialog box and set the DP cycle. Confirm with "OK" to exit the "Options" dialog box.
7. Confirm with "OK" again to exit the "Properties - New PROFIBUS Subnet" dialog box and accept the settings.

The new subnet is now displayed in the "Properties - PROFIBUS Interface DPx" dialog. You can now connect the new subnet to the corresponding PROFIBUS interface.

Follow the same steps to configure the second PROFIBUS interface.

A graphical representation of the PROFIBUS subnet you have created is shown in HW Config.

Note

PROFIBUS DP functionality is both equidistant and isochronous in nature. As such, it can guarantee that bus cycles will have exactly the same length and ensures deterministic behavior.

Applications: Connecting drives or synchronized I/O devices.
5.3.7 Modifying the data transmission rate

Introduction

You can modify the transmission rate in a PROFIBUS subnet in HW Config according to your requirements.

Procedure

1. Open the project in SIMOTION SCOUT.
2. Double-click the device whose PROFIBUS subnet you want to configure.
   HW Config is displayed showing the settings for this device.
3. In HW Config, double-click in the graphical display on the PROFIBUS network whose transmission rate you want to configure.
   The "Properties - DP Master System" dialog is displayed.
4. Click on "Properties" to display the "PROFIBUS Properties" dialog.
5. Select the required transmission rate on the "Network settings" tab.
   If you wish to activate an isochronous, equidistant bus cycle, the setting can be made under "Options".
6. Confirm with "OK".
7. Save and compile the new hardware configuration, and load it on the SIMOTION D.

Note

If you modify the transmission rate of the subnet over which you are operating the PG/PC, the PG/PC loses its active designation. You must then reconfigure it manually in NetPro or else you will no longer be able to go online by means of this PG/PC.

Note

PROFIBUS DP functionality is both equidistant and isochronous in nature. As such, it can guarantee that bus cycles will have exactly the same length and ensures deterministic behavior.

Applications: Connecting drives or synchronized I/O devices.

See also

SIMOTION SCOUT Basic Functions Function Manual, Section "Isochronous I/O processing on fieldbus systems".
5.3.8 Establishing a PG/PC assignment

Introduction
A PG/PC is required to create projects for a SIMOTION D4x5-2 and download them to the target device. The interface that can be connected via the PG/PC will be automatically queried during the communications configuring. If you change these settings, you must reestablish the active designation of the PG/PC in NetPro (the PG/PC connection must appear yellow and bold in NetPro).

Procedure
1. Open the project in SIMOTION SCOUT.
2. Click the "Open NetPro" button.
   NetPro is accessed, and the configured network is graphically displayed. The PG/PC connection to the configured network is shown in bold in a color other than yellow.
3. Double-click the PG/PC you would like to configure.
   The "Properties - PG/PC" dialog will be displayed with the "Assignment" tab in foreground.
4. Select the interface in the "Assigned" field and activate S7ONLINE access by clicking the appropriate checkbox.
5. Click "OK" to accept the settings.
   The PG/PC connection to the configured network is displayed again in bold and yellow.
6. Save and compile the changes and download them to the SIMOTION D4x5-2.
   You can now go online via the PG/PC once again.

Alternatively, you can make the assignment in SIMOTION SCOUT by clicking the "Assign PG/PC" button. This calls the properties window for PG/PC assignment, where you can modify the assignment and "activate" it (S7ONLINE access).
5.4 Configuring the MPI bus

5.4.1 Operating the X136 interface as MPI

The X136 interface can also be used as an MPI interface, for example, to connect to an external PG/PC.

When the X136 interface is used as an MPI bus, additional activation of a drive on this interface is not possible.

![Diagram](image)

Figure 5-6 Connection of the D4x5-2 to MPI bus components

5.4.2 MPI parameters

**MPI bus addresses and data transmission rate**

Every node on the MPI bus must have a bus address in the range 0 to 31.

The data transmission rate on the MPI bus can be set to any value for the SIMOTION D4x5-2.

**Communication attempt unsuccessful**

If communication cannot be established at all, or if it cannot be established with individual nodes on the MPI bus, check the following:

- Is the transmission rate setting for the D4x5-2 used for all nodes?
- Are there any loose plug connections?
- Are all bus segments terminated properly?

Bus segments that are not terminated properly will disrupt communication on the MPI bus.
5.5 Configuring an Ethernet subnet

5.5.1 Properties of the Ethernet interfaces

Properties

SIMOTION D4x5-2 has several onboard Ethernet interfaces:

- X127 P1 PN/IE (on the front of the module)
- X120 P1 PN/IE-OP (under the front flap, only for D4x5-2 DP)
- X130 P1 PN/IE-NET (under the front flap)

You can connect an Industrial Ethernet with a transmission rate of 10/100/1000 Mbit/s to the 8-pin X127 P1, X120 P1 and X130 P1 RJ45 sockets.

As the X127 is easily accessible on the front of the module, this should preferably be used for the PG/PC connection.

Note

As of V4.3, the three Ethernet interfaces support the PROFINET basic services - they therefore have the designation PN/IE-NET, PN/IE-OP or PN/IE.

The interfaces do not have any HUB/switch functionality, i.e. message frames are not forwarded from one interface to the other. As a rule, the interfaces belong to separate S7 subnets. SIMOTION D4x5-2 does not have any IP router functionality; it does not forward the message frames from one IP subnet to another.

The features of the Ethernet interfaces are as follows:

- TCP/IP timeout parameters can be set jointly for all Ethernet/PROFINET interfaces (HW Config: Double-click the D4x5 module, "Ethernet extended" tab).
- The transmission rate / duplex can be set separately for all interfaces
- The interfaces have autocrossing functionality.

Ethernet communication

SIMOTION D4x5-2 offers the following functions via Industrial Ethernet:

- Communication with STEP 7, SIMOTION SCOUT and SIMATIC NET OPC via a PG/PC
- Communication via UDP (user datagram protocol) with other components, e.g. other D4x5-2 devices
- Communication with other devices via TCP/IP
- Connection of SIMATIC HMI devices, such as MP27x, MP37x or PC-based HMIs
Parameter assignment / addressing

5.5 Configuring an Ethernet subnet

- IT communication (SIMOTION IT DIAG, SIMOTION IT OPC XML-DA; as option: SIMOTION IT Virtual Machine)
- PROFINET basic services (e.g. DCP, LLDP, SNMP)
  These PROFINET basic services provide uniform functions for the address assignment and diagnostics, but do not provide PROFINET IO communication for the connection of drives, I/O modules, etc.

_setIPConfig / _getIPConfig

The following interface assignment applies for the system functions _setIPConfig / _getIPConfig:

<table>
<thead>
<tr>
<th>Ethernet Interface</th>
<th>Availability of the interface</th>
<th>Interface assignment _setIPConfig / _getIPConfig (EnumInterfaceID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>X120 P1 PN/IE-OP</td>
<td>x</td>
<td>- 1)</td>
</tr>
<tr>
<td>X127 P1 PN/IE</td>
<td>x</td>
<td>x IE_01 (0)</td>
</tr>
<tr>
<td>X130 P1 PN/IE-NET</td>
<td>x</td>
<td>x IE_02 (1)</td>
</tr>
</tbody>
</table>

1) For D4x5-2 DP, _setIPConfig / _getIPConfig is only available for the interfaces X127 and X130.

Routing

"Services via TCP" are supported for all Ethernet interfaces.
From the two Ethernet interfaces, S7 routing is possible to the
- PROFIBUS interfaces and
- PROFINET interfaces
- As well as between the Ethernet interfaces

IP routing from one Ethernet interface to another, as well as from the PROFINET interface to the Ethernet interface and vice versa, are not possible.

You can find the MAC addresses on the type plate located on the front of the SIMOTION D4x5-2.

See also

Further information about routing and the differences between IP and S7 routing can be found in the Communication System Manual.
5.5 Configuring an Ethernet subnet

Default Ethernet addresses

The following addresses are assigned per default:

Table 5-5  IP address assignment for a SIMOTION D4x5-2

<table>
<thead>
<tr>
<th>Interface</th>
<th>Use case</th>
<th>Default address</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>IP address:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subnet mask:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Router address:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Automatic private IP address</td>
</tr>
<tr>
<td>X127 P1 PN/IE</td>
<td>Insert SIMOTION device or HW Config</td>
<td>169.254.11.22</td>
</tr>
<tr>
<td></td>
<td></td>
<td>255.255.0.0</td>
</tr>
<tr>
<td></td>
<td>D4x5-2 as delivered</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>X120 P1 PN/IE-OP</td>
<td>Insert SIMOTION device or HW Config</td>
<td>192.168.213.1</td>
</tr>
<tr>
<td></td>
<td>(only for D4x5-2 DP)</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td></td>
<td>D4x5-2 DP as delivered</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>X130 P1 PN/IE-NET</td>
<td>Insert SIMOTION device or HW Config</td>
<td>192.168.2.1</td>
</tr>
<tr>
<td></td>
<td>D4x5-2 as delivered</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0.0.0</td>
</tr>
</tbody>
</table>

Note

The IP addresses 192.168.215.240 to 192.168.215.255 are reserved for internal communication in the SIMOTION D4x5-2 (subnet mask 255.255.255.240). When configuring the external Ethernet interfaces (X127 P1, X120 P1 and X130 P1), make sure that the internal addresses are not inside their network. (In IP, the network is defined as an AND link of IP address and subnet mask.)

Note

If you want to go online via Ethernet, you have to make sure that the connection from PG/PC to SIMOTION D4x5-2 is active. You can check this in NetPro. A description of how to switch a connection to active again can be found in the Section Establishing the PG/PC assignment (Page 130).
Separate Ethernet interfaces

The Ethernet interfaces are entirely separate and are generally connected to different networks.

The Ethernet interfaces support:
- S7 routing
- No IP routing

SIMOTION D4x5-2 can, therefore, be connected to the machine user's internal company network with one interface and the second interface can be used, for example, by the machine manufacturer for the purpose of remote maintenance.

The Ethernet connection of the D4x5-2 can be configured in HW Config. Proceed as follows to do this:

1. Open your project.
2. Open HW Config. Double-click the Ethernet port (e.g. X127 P1) to open the "Properties PNxIE ..." dialog box.
3. You can configure the Ethernet connection in the "Options" tab. Recommendation: Use the default setting "Automatic setting". With Automatic setting, the baud rate and duplex operating mode are automatically aligned with the connection partner. The autocrossing functionality is also available so that you can use crossed and uncrossed cables.
4. Close the "Properties PNxIE ..." dialog box with "OK".
5. Save and compile the modified hardware configuration.
6. Load the new hardware configuration to the SIMOTION D4x5-2 via PROFIBUS DP / PROFINET IO / Ethernet.

Shielded twisted pair cables are used for the networking.
- 4- and 8-wire cables can be used for 10/100 Mbit/s
- 8-wire cables must be used for 1000 Mbit/s

**Note**

With SIMOTION < V4.3, the settings are made via HW Config by double-clicking the D4x5-2 module. The "Properties - D4x5 2" dialog box opens. You can configure the Ethernet connection in the "Extended Ethernet" tab.

For additional information, refer to the SIMATIC NET Industrial Twisted Pair and Fiber Optic Networks Manual. See the list of references for the order number (this is a separate document).

For further information about the cabling spectrum for Ethernet, see the Industrial Communication IK PI Catalog.
Parameter assignment / addressing

5.5 Configuring an Ethernet subnet

5.5.2 Configuring Ethernet addresses in HW Config

Requirement

For configuration using Industrial Ethernet, SIMOTION D4x5-2 must be provided with an IP address, the subnet mask, and the router address.

Note

Only one router may be configured.

Procedure

To configure and transfer Ethernet addresses to the D4x5-2, proceed as follows:

1. Open your project.
2. Open HW Config. Double-click the interface to be configured (e.g. X127) to open the "Properties" dialog box.
3. On the "General" tab, click the "Properties" button of the Ethernet interface. The "Properties - Ethernet Interface" dialog is displayed.
4. Click the "New" button. The "New Industrial Ethernet" subnet dialog is displayed. In this dialog box, you can change the name of the new subnet or confirm the default setting with "OK".
5. The newly created Ethernet subnet is now displayed under "Subnet" in the "Properties - Ethernet Interface" dialog box and must be selected.
6. In this dialog box, enter the required addresses for "IP Address" and "Subnet". Under "Router", choose whether a router is to be used. If using a router, enter the router address.
7. Confirm this dialog box with "OK".
8. Close the "Properties" dialog by clicking "OK".
9. To configure another Ethernet interface, open the "Properties" dialog box of the other interface and repeat Steps 3 to 7.
10. Save and compile the modified hardware configuration.
11. Load the new hardware configuration to the SIMOTION D4x5-2.
5.5.3 Reading out IP and MAC address

Requirement

To read out the IP and MAC addresses, the following requirements must be met:

- SIMOTION D4x5-2 is wired.
- You have assigned the communication parameters.
- You are online.

Procedure

The IP addresses and MAC addresses of SIMOTION D4x5-2 can be displayed as follows via SIMOTION SCOUT.

1. Right-click the module.
2. Select "Target device" > "Device diagnostics" in the context menu.

The addresses are displayed as follows, e.g. for SIMOTION D4x5-2 DP/PN:

**X127 P1 (PN/IE)**
- Active MAC Address: 08-00-06-73-25-3E
- IP address: 169.254.11.22
- Subnet mask: 255.255.0.0
- Standard gateway: No router used

**X130 P1 (PN/IE-NET)**
- Active MAC address: 08-00-06-73-25-3F
- IP address: 192.168.2.1
- Subnet mask: 255.255.255.0
- Standard gateway: No router used

As an alternative, you can determine the IP address as follows:

- By selecting "Project" > "Accessible nodes" in SIMOTION SCOUT or
- By calling "Target system" > "Ethernet" > "Edit Ethernet node..." in HW Config and browsing to "Online accessible nodes"
- Using the system function _getIpConfig

Note

The MAC address is listed on the nameplate on the front of the module.
5.6 Configuring PROFINET IO

5.6.1 General information about communication via PROFINET IO

Communication cycle

In PROFINET, the communication cycle is subdivided into different, time-specific intervals. The first interval is used for isochronous real-time communication (IRT), followed by real-time communication (RT) and standard TCP/IP communication. The bandwidth reservation for IRT ensures that RT communication and standard communication have no effect on the transmission of IRT message frames, which are important for motion control applications.

The following figure shows how the PROFINET communication cycle is divided into isochronous real-time communication (IRT), real-time communication (RT), and standard TCP/IP communication.

![PROFINET communication cycle diagram](image)

Figure 5-7 PROFINET communication cycle

Isochronous real-time Ethernet

STEP 7 can be used to configure PROFINET devices supporting data exchange via isochronous real-time Ethernet (IRT). IRT message frames are transmitted deterministically via planned communication paths in a defined sequence to achieve the best possible synchronism and performance.

IRT requires special network components supporting a planned data transmission.
Isochronous operation and mode

Equidistant mode and isochronous mode function similar for PROFINET IO as for PROFIBUS DP.

For PROFIBUS DP, in isochronous operation all nodes are synchronized using a Global Control Signal created by the DP master.

In PROFINET IO with IRT, a sync master generates a signal to which sync slaves synchronize themselves. Sync master and sync slaves belong to a sync domain which is assigned a name via configuration. The role of the sync master can in principle be played by an I/O controller as well as an I/O device. A sync domain has exactly one sync master.

Context: Sync domain and I/O systems

An important fact is that sync domains do not need to be limited to one PROFINET IO system: The devices of several I/O systems can be synchronized by a single sync master, provided they are connected to the same Ethernet subnet.

The following applies the other way around: An I/O system must only belong to a single sync domain.

Signal propagation delays not negligible

For the extremely exact synchronization interval, line lengths, namely the associated delay times, must be taken into consideration. You can use a topology editor to enter the properties of the lines among the ports of the switches. STEP 7 uses this data and the other configuration data to calculate the optimized process of the IRT communication and the resulting updating time.

IRT runs in parallel to real-time and TCP/IP communication

Apart from IRT communication, for which a defined bandwidth is reserved within the update time, RT communication and TCP/IP communication are also permitted within the update time.

With RT communication (real-time communication), the cyclic data is transmitted between I/O controller and I/O device, but without "best possible synchronism".

With non-synchronized I/O devices, data is exchanged automatically via RT communication.

Due to the fact that TCP/IP communication is also possible, other data, e.g. non-real-time data, configuration data or diagnostic data, can be transported.

PROFINET IO controller

Typically, the function of a PROFINET IO controller is taken on by controllers (e.g. SIMOTION C/P/D, SIMATIC S7 CPUs, ...).

The PROFINET IO controller takes on the master function for I/O data communication of the distributed field devices. The function is comparable to a PROFIBUS DP master class 1.
**PROFINET IO device**

Distributed field devices such as I/Os, drives (e.g. SINAMICS S120) or operator terminals are designated as I/O devices. The function is comparable to a PROFIBUS DP slave.

**Delivery condition**

In the delivery condition, the onboard PROFINET IO interface does not have an IP address or a subnet mask.

**Media redundancy (MRP), as of V4.3**

It is possible to establish redundant networks via the Media Redundancy Protocol (MRP). Redundant transmission links (ring topology) ensure that an alternative communication path is made available when a transmission link fails. The PROFINET devices that are part of this redundant network form an MRP domain.

MRP guarantees media redundancy in the event of a problem in the ring. The switchover of the ring is performed by the Redundancy Manager.

The switchover times depend on:

- The actual topology
- The devices used and
- The network load in the relevant network

The typical reconfiguration time of the communication paths for TCP/IP and RT frames in the event of a fault is < 200 ms.

In most systems, the switchover time of MRP is far above the PROFINET update time for cyclic data, so that a failure for cyclic data is detected. The PROFINET connection therefore fails and is reestablished after the switchover by the Redundancy Manager. In this way, an error can be corrected in the network, while the system continues to run with bumps.

**Note**

Both during the interruption of the ring, as well as when correcting the interruption (e.g. repair of the defective cable), there is a brief failure of the communication.

**Ring ports**

A SIMOTION/SINAMICS device may only be inserted in an MRP ring as a node with MRP-capable ports. For SIMOTION D, the first two ports of the PROFINET IO interfaces are designed as ring ports.

These two ports are marked with an "R" in the module rack in HW Config.

**Note**

Only devices with MRP-capable ports may be inserted in an MRP ring. If MRP-capable ports are not used, the reconfiguration times can be in the seconds range.
Bumpless media redundancy (MPRD), as of V4.3

MRRT is a procedure for bumpless media redundancy for PROFINET IO with IRT. MRRT also requires MRP.

The combination of MRP with MRRT provides bumpless PROFINET operation for short cycle times in the event of a fault in the ring. MRRT is based on IRT and ensures bumpless operation by the provider sending the cyclic data in both directions which the consumers then receive twice. If the ring is interrupted at one position (e.g. through the failure of a ring node), receipt of the cyclic data via the problem-free side of the ring is still guaranteed.

Bumpless media redundancy MRRT always requires the activation of MRP in the individual rings.

A maximum of two Ethernet nodes may be between the sync master and the redundant sync master. If the redundant sync master is used together with MRRT, it is recommended that the redundant sync master be connected directly to the sync master and the two nodes located in a common control cabinet so that the cable connection between both nodes is protected.

If there is an interruption in the link between the sync master and the redundant sync master, the system continues to run without bumps, but after switching off and on again faults can occur.

Too high a network load or too-rapid coming and going of faults can also result in unfavorable cases in the failure of the PROFINET connection with activated MRRT because of delayed or incomplete switchover actions of MRP/MRRT.

For example, with two consecutive faults at different points in the ring, bumpless operation is only ensured when there is approx. three seconds between the two faults.

Additional information

You will find additional information about media redundancy in the SIMOTION Communication System Manual.
5.6 Configuring PROFINET IO

5.6.2 Setting a send cycle clock and system cycle clocks

5.6.2.1 Basic principles

Basic cycle clock

For the SIMOTION D4x5-2, the basic cycle clock depends on:

- Whether a second servo task has been activated for the runtime system.
- Whether a second PROFINET interface (=CBE30-2) is used for the SIMOTION D4x5-2 DP/PN.

Per default, one servo task and two IPO tasks (IPO, IPO_2) are used. The IPO_2 cycle clock can be set as a multiple of the IPO cycle clock. In this way, the IPO_2 cycle clock can be used for lower priority technology objects (e.g. axes with less dynamic response).

Second servo task

A second servo task is only required for applications with special requirements, e.g.:

- For fast I/O processing via PROFINET IO (for particularly short sampling times and response times).
- If in addition to the electric axes (e.g. servo drives), hydraulic axes with particularly high-performance pressure/position control are implemented.
- If the electric axes have to be split into two performance classes on the servo level (fast servo - slow servo).

Note

If the axes have to be split into two performance classes, usually a split on the IPO level (IPO, IPO_2) is sufficient, a split on the servo level (Servo, Servo_fast) is only required in exceptional circumstances.

- The reference variable calculation / motion profile calculation of the axes is performed in the IPO level.
- The position control and monitoring of the axes is performed in the servo level.

Note that an additional Servo_fast/IPO_fast places an extra load on the SIMOTION runtime system.

In addition with DSC (Dynamic Servo Control) for servo axes, the dynamically effective part of the position controller in the drive is performed in the frequency of the speed control loop (i.e. for SINAMICS S120 usually with 125 µs). If symbolic assignment with automatic message frame determination is used, DSC is activated automatically.
### Table 5-6  Comparison of the task system with one or two servos

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>One servo (default)</th>
<th>Two servos</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available servo tasks</td>
<td>- Servo</td>
<td>- Servo_fast</td>
</tr>
<tr>
<td></td>
<td>- Servo</td>
<td>- Servo</td>
</tr>
<tr>
<td>Available IPO tasks</td>
<td>- IPO</td>
<td>- IPO_fast</td>
</tr>
<tr>
<td></td>
<td>- IPO_2</td>
<td>- IPO</td>
</tr>
<tr>
<td></td>
<td>- IPO_2</td>
<td>- IPO_2</td>
</tr>
<tr>
<td>Basic cycle clock</td>
<td>• PROFINET cycle clock for servo, IPO, IPO_2, if PROFINET is isochronous</td>
<td>DP cycle of the SINAMICS Integrated for - Servo, IPO, IPO_2, if PROFINET is not isochronous</td>
</tr>
<tr>
<td></td>
<td>• DP cycle of the SINAMICS Integrated for servo, IPO, IPO_2, if PROFINET is not isochronous</td>
<td>PROFINET cycle clock (interface X150) for - Servo_fast, IPO</td>
</tr>
<tr>
<td>Basic cycle clock when using a second PROFINET interface (= CBE30-2)</td>
<td>Both PROFINET interfaces use the same basic cycle clock</td>
<td>DP cycle of the SINAMICS Integrated = PROFINET cycle clock (X1400 interface, CBE30-2) for Servo, IPO, IPO_2</td>
</tr>
<tr>
<td>DP cycle</td>
<td>≥ 0.5 ms (DP internal)</td>
<td>≥ 0.5 ms (DP internal)</td>
</tr>
<tr>
<td></td>
<td>≥ 1 ms (DP external)</td>
<td>≥ 1 ms (DP external)</td>
</tr>
<tr>
<td>PN cycle</td>
<td>≥ 0.5 ms</td>
<td>≥ 0.25 ms</td>
</tr>
<tr>
<td>Grid 1)</td>
<td>0.125 ms</td>
<td>0.125 ms</td>
</tr>
<tr>
<td>Position control cycle clock</td>
<td>≥ 0.5 ms</td>
<td>Servo_fast / Servo</td>
</tr>
<tr>
<td>- D425-2 DP</td>
<td>≥ 0.5 ms</td>
<td>--- 2)</td>
</tr>
<tr>
<td>- D425-2 DP/ PN</td>
<td>≥ 0.5 ms</td>
<td>--- 2)</td>
</tr>
<tr>
<td>- D435-2 DP</td>
<td>≥ 0.5 ms</td>
<td>--- 2)</td>
</tr>
<tr>
<td>- D435-2 DP/ PN</td>
<td>≥ 0.5 ms</td>
<td>≥ 0.25 ms / ≥ 0.5 ms</td>
</tr>
<tr>
<td>- D445-2 DP/ PN</td>
<td>≥ 0.5 ms</td>
<td>≥ 0.25 ms / ≥ 0.5 ms</td>
</tr>
<tr>
<td>- D455-2 DP/ PN</td>
<td>≥ 0.5 ms</td>
<td>≥ 0.25 ms / ≥ 0.5 ms</td>
</tr>
<tr>
<td>IPO cycle clock</td>
<td>≥ 0.5 ms</td>
<td>IPO_fast / IPO</td>
</tr>
<tr>
<td>- D425-2 DP</td>
<td>≥ 0.5 ms</td>
<td>--- 2)</td>
</tr>
<tr>
<td>- D425-2 DP/ PN</td>
<td>≥ 0.5 ms</td>
<td>--- 2)</td>
</tr>
<tr>
<td>- D435-2 DP</td>
<td>≥ 0.5 ms</td>
<td>--- 2)</td>
</tr>
<tr>
<td>- D435-2 DP/ PN</td>
<td>≥ 0.5 ms</td>
<td>≥ 0.25 ms / ≥ 0.5 ms</td>
</tr>
<tr>
<td>- D445-2 DP/ PN</td>
<td>≥ 0.5 ms</td>
<td>≥ 0.25 ms / ≥ 0.5 ms</td>
</tr>
<tr>
<td>- D455-2 DP/ PN</td>
<td>≥ 0.5 ms</td>
<td>≥ 0.25 ms / ≥ 0.5 ms</td>
</tr>
<tr>
<td>Notes regarding the drives</td>
<td>In Servo_fast/IPO_fast, only drives that are</td>
<td>In Servo_fast/IPO_fast, only drives that are connected</td>
</tr>
<tr>
<td></td>
<td>connected via PROFINET IO can be operated.</td>
<td>via PROFINET IO can be operated.</td>
</tr>
</tbody>
</table>

1) If there are IO devices with RT class "RT" in a sync domain, it is only possible to set the send cycle clocks 0.25 ms (for two servos), 0.5 ms, 1 ms, 2 ms and 4 ms.

2) Servo_fast and IPO_fast are only provided on modules with PROFINET interface and as of performance class D435-2.
Note
The DCC tasks T1...T3 are always assigned to Servo, IPO or IPO_2.

You can also display the basic cycle clock used in HW Config. You can also activate the Servo_fast/IPO_fast there, when required.

Proceed as follows to do this:

1. Open HW Config. Double-click the D4x5-2 module to open the "Properties - D4x5-2" dialog box.

2. You can activate use of the Servo_fast/IPO_fast in the "Isochronous tasks" tab. The basic cycle clock for the Servo and (if parameterized) the basic cycle clock for the Servo_fast is displayed.

3. Close the "Properties - D4x5-2" dialog box with "OK".

4. Save and compile the modified hardware configuration.

5. Load the new hardware configuration to the SIMOTION D4x5-2 via PROFIBUS DP / PROFINET IO / Ethernet.

The setting of the cycle clocks is described in the following.

See also
Detailed information on the system cycle clocks can be found in the SIMOTION SCOUT Basic Functions Function Manual and in the Communication System Manual.

Detailed information on the configuration of axes can be found in the SIMOTION TO Axis, Electric/Hydraulic, External Encoder Function Manual.
5.6 Configuring PROFINET IO

5.6.2.2 Setting of the cycle clocks (one servo activated = default)

Setting the DP cycle in HW Config

To set the DP cycle of the SINAMICS Integrated, double-click the SINAMICS block on the integrated PROFIBUS in HW Config.

The "DP Slave Properties" dialog box is opened. You can adjust the DP cycle of the SINAMICS Integrated on the "Isochronous mode" tab. See also Additional information on configuring the SINAMICS Integrated (Page 209).

Table 5-7 SIMOTION D4x5-2 value range

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DP cycle</td>
<td>≥ 0.5 ms (DP internal)</td>
<td>≥ 0.5 ms (DP internal)</td>
<td>≥ 0.5 ms (DP internal)</td>
<td>≥ 1.0 ms (DP external)</td>
</tr>
<tr>
<td></td>
<td>≥ 1.0 ms (DP external)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grid 1)</td>
<td>0.125 ms</td>
<td>0.125 ms</td>
<td></td>
<td>0.125 ms</td>
</tr>
</tbody>
</table>

If, in addition to the drives on the SINAMICS Integrated / CX32-2, external drives are also to be connected via isochronous PROFIBUS, the DP cycle must be ≥ 1 ms.

Setting the send cycle clock in HW Config

The send cycle clock for PROFINET IO must be set in the "Domain Management" dialog in HW Config. To do this, select the "Edit" > "PROFINET IO" > "Domain management ..." menu command in HW Config and set the desired cycle clock.

The PROFINET interface can be operated with a send cycle clock in the range of 0.5 ms ≤ send cycle clock ≤ 4 ms when one servo is used. The smallest configurable grid is 0.125 ms.

If there are IO devices with RT class "RT" in a sync domain, it is only possible to set the send cycle clocks 0.5 ms, 1 ms, 2 ms and 4 ms.

Cycle clock scaling

As of V4.3, a reduction ratio for the PROFIBUS cycle clock to the Servo cycle clock is possible. The reduction ratio is only permitted when PROFINET IO with IRT has not been configured. A reduction ratio for the PROFINET send cycle clock to the PROFIBUS cycle clock is also possible.

Example:
PROFINET send cycle clock = 0.5 ms
PROFIBUS cycle clock = servo cycle clock = 1 ms

The PROFIBUS cycle clock can be operated relative to the PROFINET send cycle clock at a ratio of 1:1 to 16:1.

The table below shows the possible ratio settings for the SIMOTION D4x5-2 system cycle clocks based on the DP cycle of the SINAMICS Integrated or PROFINET send cycle clock.
Table 5-8  Ratios of the system cycle clock (when one servo is used)

<table>
<thead>
<tr>
<th>Cycle clock name</th>
<th>Settable factors</th>
<th>Reference cycle clock</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFIBUS DP bus cycle clock</td>
<td>1, 2, 3, 4, 6, 8, 10, 12, 14, 16</td>
<td>PROFINET I/O send cycle clock</td>
</tr>
<tr>
<td>Servo</td>
<td>As of V4.3: 1, 2, 3, 4, 8&lt;sup&gt;1)&lt;/sup&gt; V4.2: 1</td>
<td>PROFIBUS DP bus cycle clock</td>
</tr>
<tr>
<td>IPO</td>
<td>1, 2, 3, 4, 5, 6</td>
<td>Servo</td>
</tr>
<tr>
<td>IPO_2</td>
<td>2, 3, 4, 5, ..., 64</td>
<td>IPO</td>
</tr>
</tbody>
</table>

<sup>1)</sup> Always "1" if PROFINET with IRT has been configured

Setting the cycle clock ratios

The set bus cycle clock is displayed in SIMOTION SCOUT as the "Bus data cycle" in the "System Cycle Clocks - D4x5-2" dialog box. Select SIMOTION D4x5-2 and then select the "Set system cycle clocks" option in the "Target system" > "Expert" menu.

Set the required cycle clock ratios for the servo, IPO and IPO_2 in the "System Cycle Clocks - D4x5-2" dialog box.

![System Cycle Clocks - D4x5-2](image)

Figure 5-9  D4x5-2 system cycle clocks (one servo activated)
5.6.2.3 Setting of the cycle clocks (two servos activated)

Requirement

Supported control units: SIMOTION D435-2 DP/PN, D445-2 DP/PN and D455-2 DP/PN

If Servo_fast and IPO_fast are used, the PROFINET must be operated isochronously.

A reduction ratio for the PROFINET cycle clock to the Servo_fast-cycle and the PROFIBUS cycle clock to Servo cycle clock is not possible.

Cycle clock ratios and conditions

The table below shows the possible ratio settings for the SIMOTION D4x5-2 system cycle clocks based on the DP cycle of the SINAMICS Integrated or PROFINET send cycle clock.

<table>
<thead>
<tr>
<th>Cycle clock name</th>
<th>Settable factors</th>
<th>Reference cycle clock</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servo_fast</td>
<td>1</td>
<td>PROFINET IO send cycle clock</td>
</tr>
<tr>
<td>IPO_fast</td>
<td>1, 2, 4</td>
<td>Servo_fast</td>
</tr>
<tr>
<td>Servo</td>
<td>1</td>
<td>PROFIBUS DP bus cycle clock</td>
</tr>
<tr>
<td>IPO</td>
<td>1, 2, 4</td>
<td>Servo</td>
</tr>
<tr>
<td>IPO_2</td>
<td>2, 3, 4, 5, ... 64</td>
<td>IPO</td>
</tr>
</tbody>
</table>

Note

• If illegal settings are made in the "D4x5-2 System Cycle Clocks" dialog box, an error is signaled during the consistency check.

• If the required isochronous busses have not be configured, "???", is displayed under cycle time in the "D4x5-2 System Cycle Clocks" dialog box.

The following conditions must also be satisfied when using two servos:

• PROFIBUS DP bus cycle clock = N x PROFINET send cycle clock (N = 2, 4, 8, 16)

• IPO ≥ IPO_fast

• Servo_fast and IPO_fast are always assigned to the PROFINET interface

• The PROFINET interface can only be operated as sync master (consequently with distributed synchronous operation via PROFINET, the D4x5-2 cannot participate as sync slave when Servo_fast/IPO_fast is used)

If the PROFINET interface is configured as sync slave, the faulty configuration is indicated via a diagnostic buffer entry and the controller goes into starting inhibit.
5.6 Configuring PROFINET IO

Setting the bus cycle clocks

See Section Setting of the cycle clocks (one servo activated = default) (Page 145). This procedure is described in:

- Setting the DP cycle in HW Config or
- Setting the send cycle clock in HW Config

Setting the cycle clock ratios

The set bus cycle clocks are displayed in SIMOTION SCOUT as the "Bus data cycle 1" and "Bus data cycle 2" in the "System Cycle Clocks - D4x5-2" dialog box. Select SIMOTION D4x5-2 and then select the "Set system cycle clocks" option in the "Target system" > "Expert" menu.

Set the required cycle clock ratios for the Servo_fast/IPO_fast as well as the Servo/IPO/IPO_2 in the "System Cycle Clocks - D4x5-2" dialog box.

![System Cycle Clocks - D4x5-2 dialog box showing cycle clock ratios](image)

Figure 5-10 D4x5-2 system cycle clocks (two servos activated)
5.6.2.4 Using a second PROFINET interface

With the SIMOTION D4x5-2 DP/PN control units, optionally a second PROFINET interface is available as of V4.3 in addition to the onboard PROFINET interface (X150) with the Ethernet communication board (CBE30-2, X1400).

The CBE30-2 can only be operated in the D4x5-2 DP/PN control units, use in the D4x5-2 DP control units is not possible.

Applications

A CBE30-2 can be used, for example, for the following applications:

- The second PROFINET interface is used
  - In order to increase the maximum number of connectable devices.
  - In order to increase the available I/O address space.
- Devices are to be operated with different send cycle clocks and assigned different isochronous tasks (Servo and Servo_fast).
- Devices are to receive an independent IP address area or NameOfStation (e.g. higher-level network as plant network; local network for machine module; nodes in the "local network" can be addressed separately from the nodes in the "plant network").
- Devices and controller are to be operated isochronously at the same time.

If one PROFINET interface is operated simultaneously as I device and controller, either only the I device or only the controller can be operated isochronously (i.e. with IRT). With two PROFINET interfaces, it is possible to operate a PROFINET IO controller and an I device isochronously on a D4x5-2 DP/PN at the same time.

Rules for two PROFINET interfaces

The following rules must be taken into account when using two PROFINET interfaces, if both interfaces are to be operated isochronously (an isochronous device or an isochronous I device or data exchange broadcast is configured at the interface):

- Both interfaces can be configured as a PROFINET IO I device and/or as a controller.
- A higher-level controller must always be connected isochronously via the CBE30-2.
  This applies both for the controller-controller communication and also for the I device communication to a higher-level controller. Lower-level isochronous drives/I/Os should be connected via the onboard PROFINET interface.
- The onboard PROFINET interface must be configured as sync master.
- The CBE30-2 can be configured as sync master or sync slave.
An F-CPU can only be connected to one of the two PROFINET interfaces, because fail-safe I/O transfer areas can only be configured either on the I device on the onboard PROFINET interface or on the CBE30-2.

The PROFIsafe message frames are routed to the following drives:
- Drives on the SINAMICS Integrated and CX32-2
- Drives on the onboard PROFINET interface (X150 interface)
- Drives on the CBE30-2 (X1400 interface)

The maximum quantity structure for PROFIsafe on PROFINET is therefore not increased by using a second PROFINET interface.

- If Servo_fast is not used, the servo isochronous devices can be assigned to both PROFINET interfaces.
- A redundant sync master is not permitted in the SYNC domain of the onboard PROFINET interface if both PROFINET interfaces are operated isochronously and the CBE30-2 is configured as a sync slave or IRT I device.

**Rules for Servo_fast**

The following rules apply for the onboard PROFINET interface (X150) assigned to the Servo_fast:

- The interfaces are permanently assigned:
  - Servo/IPO/IPO_2 to the CBE30-2 (or DP and DP Integrated)
  - Servo_fast and IPO_fast to the onboard PROFINET interface

- If the Servo_fast is used, only one CACF (Controller Application Cycle Factor) = 1 is permitted for Servo and Servo_fast, i.e. it must be set:
  - Servo cycle clock = send cycle clock of the PROFINET interface X1400 (CBE30-2)
  - Servo_fast cycle clock = send cycle clock of the PROFINET interface X150 (onboard interface)

- The Servo_fast must have a reduction ratio to the Servo of 2, 4, 8, or 16.

**Additional information**

For further information, see the *SIMOTION Communication System Manual*. 
5.6.3 Properties of PROFINET

Properties

The onboard PROFINET IO interface supports the parallel operation of:

- **IRT** - isochronous real-time Ethernet
  - Operation of IRT I/O (e.g. ET 200S)
  - Operation of a SINAMICS S120 as IRT device
- **RT** - real-time Ethernet
  - Operation of RT I/O (e.g. ET 200S, ET 200pro, etc.)
  - Operation of a SINAMICS S120 as an RT device
- **TCP/IP, UDP, HTTP, …** standard Ethernet services

**Note**

For mixed operation of IRT and RT, make sure that the IRT-compatible devices form what is referred to as an IRT domain; i.e. there must not be any non-IRT devices on the data transmission link between the IRT devices.

Additional references

You will find an overview of the specific properties of PROFINET IO on SIMOTION D in the SIMOTION Communication System Manual.

5.6.4 Configuration tasks

Configuration of PROFINET involves the following steps:

1. Insert the SIMOTION D4x5-2.
2. Configure the onboard PROFINET IO interface in **HW Config**.
3. Create a topology: Here, you specify how the individual ports of the PROFINET IO devices are interconnected.
4. Configure the sync domain: Here, you specify which PROFINET nodes are sync masters (clock generators) and sync slaves.
5. Specify the send clock: Describes the time during which a PROFINET IO device exchanges user data with the PROFINET IO controller.
6. Configure the direct data exchange: The direct data exchange specifies which address areas are to be used for sending and receiving respectively.

Additional references

You will find a detailed description of each configuration step in Section "Configuring PROFINET IO with SIMOTION" of the SIMOTION Communication System Manual.
Parameter assignment / addressing

5.6 Configuring PROFINET IO
6.1 Overview of commissioning

Requirements

The following requirements must be fulfilled in order to commission the SIMOTION D:

- The system has been connected and wired.
- The SIMOTION D has been switched on and powered up (STOP mode).
- SIMOTION SCOUT (with integrated STARTER) has been installed and powered up on the PG/PC.
- The communication and networks have been configured.
- You have created a project and inserted a SIMOTION D in the project.

Note

The order numbers (MLFB) of the SINAMICS S120 components must be available. You need these order numbers when setting up a SIMOTION project to verify that the components selected from the hardware catalog in the HW Config application correspond to the ones used in the system.

6.1.1 Symbolic assignment / adaptation

Symbolic assignment

As of V4.2, SIMOTION supports the symbolic assignment on SINAMICS drive objects (DOs) during the configuration of technology objects (TO) and I/Os. This simplifies the configuration of the technological relationships including the communication between controller and drive.

With the symbolic assignment:

- Only suitable assignment partners are offered in an assignment dialog box.
- Communication between axis and drive is set up automatically by the engineering system and the required PROFldrive axis message frames as well as the used addresses set up.
- Message frames are extended and interconnections created automatically in the drive depending on the selected TO technology (e.g. SINAMICS Safety Integrated).
Axis and drive configuration can initially be carried out independently of one another.

Communication connections are established automatically during the configuration of I/O variables on SINAMICS I/Os (message frames are set up automatically, the I/Os interconnected to the message frame and the addresses set up).

Apart from the symbolic assignment, no further configuration is required for the communication. As addresses no longer have to be configured, the connection is retained even with address offsets.

Note

During the configuration of drive objects (DO drive, DO encoder, ...) as well as in the Message Frame Configuration dialog box (see Section Message frame configuration (Page 244)), you can deactivate the automatic message frame configuration and the automatic message frame adaptation.

As many of the previously described advantages are lost through a deactivation, we recommend that a deactivation only be performed in exceptional circumstances.

The symbolic assignment enables an independent configuration of the axes on the SIMOTION side and the drives on the SINAMICS side.

This enables, for example:

- The PLC and motion control functions to be completely configured by a programmer even without drive know-how using technology objects (e.g. TO axis) and loaded to the device.
- The drives to be separately configured and optimized by a drive expert.
- The technology objects to be symbolically assigned later to the drive objects via an interconnection dialog box.

Note

The previous methods of drive, axis and I/O configuration are still available. The symbolic assignment must be deactivated for these methods.

For newly created projects, the symbolic assignment is used per default. If projects < V4.2 are upgraded, the symbolic assignment is deactivated per default and must be activated when required.

The symbolic assignment can be activated/deactivated in SIMOTION SCOUT via the menu "Project" > "Use symbolic assignment".
Activating the symbolic assignment later

The symbolic assignment simplifies the configuration of the technological relationships including the communication between controller and drive significantly. The names of the symbolic assignments in plain text is also advantageous for project maintenance. The symbolic assignment is therefore recommended for new projects as of V4.2 and is automatically active.

If symbolic assignment is used in a project, message frames, interconnections and addresses are automatically created by the engineering system per default.

The engineering system sets the "optimal" PROFIdrive message frames and message frame extensions for the system, makes the required BICO interconnections and determines the addresses.

It is also possible to change upgraded projects to symbolic assignment and must be decided individually, as follow-up work may be required.

Extensive follow-up work is usually required particularly for free message frame configurations (e.g. for TB30, TM15 DI/DO, TM31).

Note

If symbolic assignment is subsequently activated for a project in which message frames have already been configured and interconnected, these can be changed together with the BICO interconnections!

For this reason, make a backup copy of your project before activating the symbolic assignment.

Further details can be found in the SIMOTION SCOUT Basic Functions Function Manual.

Assigning a drive later

You can create an axis in SIMOTION SCOUT and assign it later to a drive. You can thus load your user program to the controller and (with the exception of the non-existent drives) test it.

Compared to a procedure with temporarily created "virtual axes", "axes without assigned drive" have the advantage that the configuration data is completely available and do not require a "virtual axis -> real axis" reconfiguration.

Simulation of axes

The axis simulation can also be used to test the user program.

You can find a script for switching the axis simulation on and off in SIMOTION Utilities & Applications, which is part of the scope of delivery of SIMOTION SCOUT.

For further details, see also TO Axis Electric/Hydraulic, External Encoder Function Manual.
Adaptation

In addition to the symbolic assignment, the **automatic adaptation** facilitates the configuration of SINAMICS S110/S120 data as of SIMOTION V4.2. During power-up of the SIMOTION devices, reference variables as well as drive and encoder data of the SINAMICS S110/S120 are automatically taken over for the configuration data of the SIMOTION technology objects "TO axis" and "TO externalEncoder". This data no longer has to be entered in SIMOTION.

For additional information, see the following sources:

- **SIMOTION SCOUT Basic Functions Function Manual**
- **TO Axis Electric/Hydraulic, External Encoder Function Manual**

Requirement

The symbolic assignment is supported by the TO axis, TO externalEncoder and the TO outputCam, TO camTrack and TO measuringInput. The onboard I/Os of a SIMOTION D, of a SINAMICS S110/S120 control unit as well as from a TB30 and selected terminal modules can be interconnected symbolically.

Table 6-1  Control units that support a symbolic assignment

<table>
<thead>
<tr>
<th>Module</th>
<th>Supports symbolic assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMOTION D410-2</td>
<td>As of SIMOTION V4.3</td>
</tr>
<tr>
<td>SIMOTION D410</td>
<td>As of SIMOTION V4.2</td>
</tr>
<tr>
<td>SIMOTION D4x5-2</td>
<td>As of SIMOTION V4.2</td>
</tr>
<tr>
<td>SIMOTION D4x5</td>
<td>As of SIMOTION V4.2</td>
</tr>
<tr>
<td>Controller extension</td>
<td></td>
</tr>
<tr>
<td>• CX32-2</td>
<td>As of SIMOTION V4.2</td>
</tr>
<tr>
<td>• CX32</td>
<td></td>
</tr>
<tr>
<td>SINAMICS S110 CU305</td>
<td>As of SINAMICS V4.3</td>
</tr>
<tr>
<td>SINAMICS S120</td>
<td></td>
</tr>
<tr>
<td>• CU310-2</td>
<td>As of SINAMICS V4.4</td>
</tr>
<tr>
<td>• CU310</td>
<td>As of SINAMICS V2.6.2</td>
</tr>
<tr>
<td>• CU320-2</td>
<td>As of SINAMICS V4.3</td>
</tr>
<tr>
<td>• CU320</td>
<td>As of SINAMICS V2.6.2</td>
</tr>
</tbody>
</table>

See also

Only the drive configuration by means of symbolic assignment is described in this documentation.


For further information on the configuration of the TO axis and TO externalEncoder, refer to the **TO Axis Electric/Hydraulic, External Encoder Function Manual**.
6.1.2 Procedure when commissioning

Commissioning steps

This section shows you how to configure a system and test the configured drives and axes. The commissioning steps are listed below. The sequence is only an example and can vary depending on the supplementary conditions.

1. Configuring the SINAMICS Integrated:
   You can configure the integrated drives (SINAMICS Integrated) offline or online:
   - Offline configuration:
     Performing D4x5-2 offline configuration (Page 159) and Performing CX32-2 offline configuration (Page 200)
     For offline configuration, all of the components and their order numbers must be known.
   - Online configuration:
     Performing D4x5-2 online configuration (Page 186) and Performing CX32-2 online configuration (Page 202)
     During online configuration, you can download all of the information from the connected DRIVE-CLiQ components to your user project.
   **Note:**
   The next two sections describe how a SIMOTION D4x5-2 including SINAMICS Integrated is configured. The described procedure also applies when CX32-2 controller extensions are used.
   The Section Configuring a CX32-2 also describes the step-by-step commissioning with a CX32-2 controller extension. The advantage of a step-by-step configuration is that the location and cause of an error are easier to identify.

2. Testing a drive with the drive control panel (Page 226)
3. Creating an axis with the axis wizard (Page 229)
4. Testing an axis with the axis control panel (Page 236)
5. Activating the infeed (line module) (Page 239)
6. Setting up addresses and message frames (Page 243)
7. Linking an additional encoder (optional) (Page 248)
8. Configuring drive-related I/Os (with symbolic assignment) (Page 255)
9. Configuring the technology (Page 262)
10. Optimizing the drive and controller (Page 273)

This section also contains additional configuration information, e.g. for vector drives, Safety Integrated, etc.
6.1.3 Important functions for the project handling during commissioning

The following functions are very important for the project handling and commissioning:

Table 6-2 Buttons for operator control

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Function</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Save project and compile changes</td>
<td>Select Save project and compile changes to save the entire project and compile the project data (e.g. programs) in an executable code. Only the changes are compiled. Unchanged code is retained.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Connect to selected target devices</td>
<td>The online connection is established to the selected target devices. Under &quot;Target system&quot; &gt; &quot;Select target devices&quot;, you can set which target devices are to go online.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Download project to target system</td>
<td>Downloading programs to the SIMOTION device and performing configuration for the SINAMICS Integrated and any connected CX32-2 modules.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Download CPU / drive unit to target device</td>
<td>The configuration is only loaded to the device selected in the project tree (which means that the function needs to be performed separately for each D4x5-2/CX32-2 and each SINAMICS Integrated).</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Load CPU / drive unit to PG</td>
<td>The unit's configuration is only loaded to the PG selected in the project tree (which means that the function needs to be performed separately for each D4x5-2/CX32-2 and each SINAMICS Integrated).</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Copy RAM to ROM</td>
<td>Copying from RAM to ROM is only performed for the device selected in the project tree (which means that the function needs to be performed separately for each D4x5-2/CX32-2 and each SINAMICS Integrated).</td>
</tr>
</tbody>
</table>

Note

Tips for going ONLINE:

In online operation, SCOUT attempts to conduct online operation with all hardware components contained in the project. This means that the time needed for going online increases.

We recommend that you make settings for SCOUT so that online operation is made only with those components currently needed. The setting can be found at "Target system > Select target devices..." in the menu. The selection and deselection of the devices in the online state can be made via the "Connect target device" context menu on the device.

This procedure is also advantageous when the configuration of the drive unit is completed. Without going completely offline, the connection can be simply deselected via the context menu on the drive unit.
6.2 Performing the configuration for the D4x5-2 offline

6.2.1 Overview

Introduction

In the offline configuration, the project is created without all the hardware components (especially drives) being available. In this way, a SIMOTION project in the office environment can be created up to a point where a basic project specification including a program exists. You can then load the finished project to the SIMOTION D4x5-2 later and test it with the drives.

Requirements

- For offline configuration, all of the components and their order numbers must be known.
- You have created a project in SIMOTION SCOUT and inserted a SIMOTION D4x5-2 into the project in the hardware configuration.
- You have configured the communication between the SIMOTION D4x5-2 and the PG/PC. See Section Creating a project and configuring the communication (Page 114).

Procedure

The offline configuration involves the following steps:

- Accessing the drive wizard (Page 160)
- Configuring components (Page 161)
- Downloading the project to the SIMOTION D4x5-2 by means of one of the following options:
  - Downloading to the target system (Page 181)
  - Downloading to the CompactFlash card (Page 182)
  - Downloading incl. sources and additional data (Page 184)
  - Archiving on the CompactFlash card (zip file) (Page 185)

Note

During offline configuration, you can also configure the option board (TB30) and terminal modules, e.g. TM41.
6.2 Performing the configuration for the D4x5-2 offline

6.2.2 Accessing the drive wizard

Integrated drive

The SIMOTION D4x5-2 contains an integrated SINAMICS S120 drive unit, which is automatically inserted together with the SIMOTION D4x5-2 control unit in the project navigator. The integrated drive must be operated in equidistant, isochronous mode using PROFIdrive-compliant message frame types.

The drive wizard for the integrated STARTER is available in SIMOTION SCOUT for configuring the integrated drive and its associated modules (e.g. SINAMICS S120 active line modules and SINAMICS S120 motor modules).

Note

To configure the drive components of a CX32-2 controller extension, the same procedure should be used as for the integrated drive of the SIMOTION D4x5-2 control unit.

Note

Take note of all the necessary safety precautions and rules governing connections, which can be found in the latest SINAMICS S120 documentation on the SIMOTION SCOUT DVD.

Requirement

You have already created a project and have inserted a SIMOTION D4x5-2.

Procedure

To call the drive wizard for the configuration of your drive unit, double-click "Configure drive unit" below "D4x5-2" > "SINAMICS Integrated" in the project navigator.

You can configure the following components:

- Infeed (e.g. SINAMICS S120 active line module)
- Drive
- Power unit (e.g. SINAMICS S120 motor module)
- Motor
- Encoder
- Option module
6.2.3 Configuring components

Requirement

You have inserted a SIMOTION D4x5-2 into the project, configured the communication and called the drive wizard by double-clicking "Configure drive unit" in the project navigator.

Note

An overview of permissible configurations, quantity structures and DRIVE-CLiQ topologies can be found in the SINAMICS S120 Commissioning Manual and in Section Quantity structures (Page 298).

It should be noted, for example, that mixed operation of servo and vector is not possible, although mixed operation of servo and vector  is possible. Failure to comply with the rules listed in this manual will result in errors that are not output until the download is performed, rather than at the configuration stage.
Commissioning (software)

6.2 Performing the configuration for the D4x5-2 offline

Procedure

While executing the wizard you will be prompted to perform, for example, the following configuration steps:

1. In the "Option Module" dialog box, select whether you want to use a TB30 as option module.

![Option Module dialog box](image)

**Figure 6-1** Selecting an option module

**Note**

The TB30 is displayed as drive object below the control unit in the project navigator and can be configured there.
2. In the "Insert Infeed" dialog box, select whether you want to use an infeed with or without a DRIVE-CLiQ connection. If the DC link has an external supply, select "No" (no DRIVE-CLiQ connection).

![Configuration - SIMATIC Integrated - Insert Infeed](image)

**Note**

If you have selected an uncontrolled infeed without a DRIVE-CLiQ connection, omit steps 3 to 6 below.
3. In the "Infeed Configuration" dialog box, enter a name for the drive object and select a type for your infeed (e.g. Active Infeed).

Figure 6-3  Selecting the infeed type
4. Using the order number, select an infeed from the list. You can filter the information to limit the number of infeeds displayed, by using "Type", for example.

![Selecting an infeed](image)

**Figure 6-4** Selecting an infeed
5. You can make additional settings for the infeed in the "Infeed Drive Object - Additional Data" dialog box.

![Configuration dialog box](image)

Figure 6-5 Making settings for the infeed

Commissioning (software)

6.2 Performing the configuration for the D4x5-2 offline
6. The communication for the control of the infeed is configured in the following dialog box. It is recommended that these settings be made automatically by the engineering system. You can also make the settings manually for the process data exchange by selecting "User-defined".

If the automatic communication setting has been selected, SIMOTION SCOUT uses PROFIdrive message frame 370 per default. This message frame is also used by the system function _LineModule_control to control the infeed.

You can find further information on control of the infeed in Section Activating the infeed (line module) (Page 239).

If you are using a CX32-2 controller extension, also refer to the information in Section Interconnecting the infeed "Operation" signal on the CX32-2 (Page 204).
7. Now configure the drive.

Figure 6-7 Configuring a drive
8. Enter a name for the drive and select the type of drive object (servo or vector).

![Figure 6-8 Drive properties](image)

Figure 6-8  Drive properties
9. In the "Control Structure" dialog, you can select the function modules and the control type. Here, you can select the \( V/f \) control for drive objects of the "vector" type.

Figure 6-9  Control structure
10. In the "Power Unit" dialog box, use the order number to select your motor module from the list.

![Configuration - SINAMICS Integrated - Power unit](image)

**Figure 6-10** Selecting a power unit
11. If you have selected an infeed without a DRIVE-CLiQ connection in step 2, a message prompting you to wire the operation signal will appear. The next dialog allows you to select the source of the infeed’s operation signal.

Figure 6-11 Selecting the infeed operation signal
12. In the case of double motor modules, you need to specify the terminal to which the motor is connected.

You specify the motor in the following dialog boxes:

- Either by selecting a standard motor from the list
- Or by entering the motor data
- Or by automatically identifying the motor (motor with DRIVE-CLiQ interface)

**Note**

Motors with DRIVE-CLiQ interface have an integrated encoder evaluation that is connected to the motor module via a fully digital communication interface (DRIVE-CLiQ).

In this way, motor encoder and temperature signals as well as electronic rating plate data, such as unique ID numbers, rated data (voltage, current, torque) can be transferred directly to the control unit.
Figure 6-13 Selecting a motor (2)
13. Select a motor holding brake (if installed).

![Motor holding brake configuration screenshot]

**Figure 6-14 Motor holding brake**
14. If you are using a motor that is not equipped with a DRIVE-CLiQ interface, select the encoder order number in the "Encoder Selection via Motor Order Number" dialog box.

![Figure 6-15 Selecting a motor encoder (1)](image1)

![Figure 6-16 Selecting a motor encoder (2)](image2)
Note

If required, you can configure a second or third encoder in the "Encoder" dialog box. You can transfer a maximum of two encoder values to SIMOTION via the axis message frame.

In the case of motors with a DRIVE-CLIQ interface, the motor encoder is identified automatically. It is not necessary to enter encoder data in such cases (the dialog for selecting Encoder 1 is grayed out and, therefore, inactive).

15. The communication for the control of the SINAMICS drive is configured in the following dialog box.

It is recommended that these settings be made automatically by the engineering system. You can also make the settings manually for the process data exchange by selecting "User-defined".

Information about the manual setting options can be found in the online help and in the manuals for the SINAMICS S120 drive system.

Figure 6-17  Configuring the process data exchange
After you have configured all of the settings in the drive wizard, the "Summary" dialog displays a list of all settings. You can accept these settings with "Finish" or edit the configuration of individual components using the "Back" button.

Figure 6-18  Finishing the drive
The configured drive is displayed in the project navigator.

Figure 6-19 Representation in the project navigator
You will find an overview of the configured SINAMICS components under "SINAMICS_Integrated" > "Topology".

See also

If you configure the message frames for the infeed and drive manually, you can find detailed information on the respective message frame types in the following:

- *Motion Control, TO Axis Electric/Hydraulic, External Encoder* Function Manual
- *SINAMICS S120* Function Manual
6.2.4  Downloading a project into the target system

Requirement

You have configured the hardware. You now need to download the hardware configuration and the entire SIMOTION project to the target system.

If you have not yet configured your SIMOTION project (i.e. created ST programs, assigned execution levels, etc.), complete this step first.

Note

You can only perform a project download in the STOP operating mode and for all target devices with which you are ONLINE. You cannot download to drives that cannot be configured in SCOUT, e.g MASTERDRIVES. The project data is loaded to all the devices connected ONLINE and their subordinate drive units (provided these are selected in the Target Device Selection dialog box). This can only be done in the STOP operating mode.

Procedure

1. Save and compile the project.
2. Go online.
3. To load the project, perform "Download project to target system". The data must also be saved on the CompactFlash card to ensure that the project is retained in the event of a power failure. The following options are available:
   - Perform the "Copy RAM to ROM..." function manually on the D4x5-2 and all drives (SINAMICS Integrated, CX32-2, etc.).
   - In the "Download to Target System" dialog box, select the option "After loading, copy RAM to ROM". You can change the default setting for this dialog box in "Options" > "Settings" > "Download".

![Download to Target system (WW85:824)](image)

Figure 6-21  Download project to target system
6.2 Performing the configuration for the D4x5-2 offline

The SIMOTION project is downloaded to the target system and the online connection to the drives established automatically.

**Note**

Online access to the drives is not possible if HW Config is not loaded at the time you initially connect to the target system.

Download HW Config first to enable online access to the drives. During the "Download to target system" process, SIMOTION SCOUT automatically attempts to establish an online connection to SINAMICS Integrated.

**Note**

If you have deselected the "Drives" option under "Tools" > "Settings" > "Download" in SIMOTION SCOUT, you must download the configuration separately to each drive (SINAMICS Integrated, CX32-2, etc.).

To do this, select the drive (e.g. SINAMICS Integrated) in the project navigator and perform "Download CPU / drive unit to target device". For fast operation, we recommend that, in principle, the drives be deselected and a download only performed when required.

4. To save the parameter calculations of the drive in the project, perform "Target device" > "Load CPU / drive unit to PG" for each drive.

**6.2.5** Downloading a project to the CompactFlash card

**Requirement**

Loading a project created offline to the CompactFlash card has the advantage of being faster than a download.

It should be noted, however, that the first system power-up will take longer, as the SINAMICS Integrated and CX32-2 controller extension will perform one-off parameter calculations. These are automatically backed up on the CompactFlash card.

**Note**

In order to save the project data via the PG/PC, you need a CompactFlash card adapter in which you can insert the CompactFlash card. The CompactFlash card must be displayed as a removable storage device with any drive letter in Windows Explorer.

If the CompactFlash card is not displayed, check the CompactFlash card adapter and contact the hotline if necessary.
Procedure

You can use a card adapter to write the entire project to the CompactFlash card, even in offline mode. In SIMOTION SCOUT, you can call the "Load to file system" function in the context menu of the SIMOTION device.

1. Save and compile the project.
2. Switch the SIMOTION D4x5-2 off.
3. Remove the CompactFlash card and insert it into a card adapter. The card adapter must be connected to a PG/PC.
4. In the SCOUT project, select the SIMOTION D4x5-2 device that you want to download to the CompactFlash card.
5. Click "Load to file system" in the context menu. A dialog box opens.
6. In the "Load to File System" dialog box, select the "Save normally" option and click the "Select target" button.
7. Select the target drive.
8. Confirm your entries with "OK". The data is written to the CompactFlash card.
9. Remove the CompactFlash card and insert it into the slot on the D4x5-2.
10. Switch the D4x5-2 on. The D4x5-2 powers up with the downloaded project.

Note

The components' firmware is upgraded or downgraded automatically based on the FW version on the CompactFlash card and the FW version on the SINAMICS components (DRIVE-CLiQ components, CBE30-2, TB30, PM340, etc.).

The update can take several minutes and its progress is tracked by corresponding messages appearing in the alarm window of SIMOTION SCOUT.

A FW update on DRIVE-CLiQ components is indicated by the RDY LED flashing red/green:

- FW update running: RDY LED flashes slowly (0.5 Hz)
- FW update complete: RDY LED flashes quickly (2 Hz)

These flashing patterns are also displayed on the yellow RDY LED on the SIMOTION D/CX32-2 and indicate that a FW update is being carried out on components connected to the SIMOTION D/CX32-2 or that all components have completed the FW update.

Go offline once all the FW updates are complete. Perform a POWER ON for the upgraded/downgraded components.

CBE30-2 option board:

During the firmware update, the OPT LED of the SIMOTION D module and the SYNC LED of the CBE30-2 flash green.
6.2.6 Loading a project, including sources and additional data

Overview

It is possible to download additional data (e.g. sources) to the target device when saving a project to the CompactFlash card or downloading to the D4x5-2. This data is required for:

- Online object comparison (e.g. additional properties)
- Various detailed comparisons (e.g. ST source file comparison)
- Synchronization with online objects

In order to be able to load a project's sources and additional data to the PG, this must be specified in the project under "Options" > "Settings" > "Download" > "Store additional data on the target device". Alternatively, this setting can also be made when the data is loaded to the target device/target system.

If the sources and additional data have been saved on the CompactFlash card, the option described in the sections that follow becomes available.

Project comparison

You intend to carry out servicing work on a commissioned system and have brought a project on your PC/PG. This project is not consistent with the project on the D4x5-2 in the system. In order to analyze the differences, perform an object comparison via "Start object comparison".

You have the following options in terms of re-establishing consistency:

- In the object comparison, you can establish consistency for sources and technology objects on an object-granular basis.
- Consistency can be established for the entire Control Unit by loading from the CompactFlash card via "Target system" > "Load" > "Load CPU / drive unit to PG...".

Additional references

Detailed information on "loading data to the target device" can be found in the SIMOTION SCOUT Basic Functions Function Manual.
6.2.7 Archiving a project to the CompactFlash card (zip file)

Procedure

In SIMOTION SCOUT, you can save the project as a zip file to the CompactFlash card. Proceed as follows to archive the SIMOTION project on the CompactFlash card:

1. Open SIMOTION SCOUT and select the "Project" > "Archive" menu command.
2. In the "Archive" dialog box, select the SIMOTION project and save it to your drive (PG/PC).
3. Open the project.
4. Go online with the SIMOTION D4x5-2.
5. In the project navigator, select the SIMOTION D4x5-2 and select the "Target system" > "Load" > "Save archive project on card ..." menu command.
6. In the dialog that is displayed, select the project and click "Open". This saves the project to the CompactFlash card as Project.zip in the following directory: USER\SIMOTION\HMI\PRJLOG

Note

If you want to load the current project from the card, select the "Target system" > "Copy archived project from card to PG/PC ..." menu command.

Prerequisite is that you have backed up the project with "Save archive project on card..." each time a change was made.

Additional references

Detailed information on loading data to the target device can be found in the SIMOTION SCOUT Basic Functions Function Manual.
6.3 Performing an online configuration for the D4x5-2

6.3.1 Overview

Introduction
You can configure the plant in online mode after having completed its wiring. You can load the data of SINAMICS components connected via DRIVE-CLiQ to your PG/PC using the "Automatic configuration" function. However, this is only possible for initial commissioning.

Note
Components without DRIVE-CLiQ connection must be edited in offline mode. You may need to edit DRIVE-CLiQ components which were detected in the course of automatic configuration (for example, adding encoder data if using SMC modules).

Requirements
- Your system has been mounted and wired
- You have created a project in SIMOTION SCOUT and inserted a SIMOTION D4x5-2 in the project
- You have configured the communication between the SIMOTION D4x5-2 and the PG/PC. See Section Creating a project and configuring the communication (Page 114).

Procedure
The online configuration involves the following steps:
- Establish the online connection (Page 187)
- Starting automatic configuration (Page 188)
- Reconfiguring SINAMICS components (Page 192)
- Downloading a project to the SIMOTION D4x5-2 (Page 192)
6.3.2 Establish an online connection

Requirement
You have created a project.

Procedure
This section outlines the procedure for initial commissioning.

To perform an online configuration, you must establish an online connection to the SIMOTION D4x5-2. In this case, no connection can yet be established to the SINAMICS Integrated. An appropriate message is output. Once the hardware configuration has been loaded to the target device, an online connection to the SINAMICS Integrated is established automatically. Proceed as follows:

1. Save and compile the project.
2. Establish an online connection.
3. Select the SIMOTION D4x5-2 device in the project navigator.
4. Use the "Download CPU / drive unit to target device" function to download the SIMOTION D4x5-2 to the target device. The connection to the SINAMICS Integrated is established automatically.

Result
Now you can perform the automatic configuration on the SINAMICS Integrated. See Section Starting the automatic configuration (Page 188).

Additional references
Further information about establishing an online connection to the programming device/PC can be found in the following documentation:

- SIMOTION SCOUT Configuration Manual
- SIMOTION SCOUT Online Help
- SIMOTION Utilities & Applications FAQs

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.
6.3.3 Starting automatic configuration

Requirements

You have activated the online connection with the SINAMICS Integrated.

Procedure

1. In the project navigator, open the "Automatic Configuration" dialog box by selecting "SINAMICS Integrated" > "Automatic configuration".

![Automatic Configuration](image)

2. Click the "Configure" button.

3. If the drive unit is not in the "First commissioning" state, the factory settings are restored after acknowledging a prompt.
4. The drive object types can now be selected via a further dialog box.

![Automatic Commissioning](image)

**Figure 6-23** Selecting the drive object type

5. Select whether a servo- or vector-type drive object is to be used.

6. Click "Create" to start the automatic configuration. As soon as automatic commissioning has been run through, an upload operation (Load to PG) is performed automatically.
**Note**

The components' firmware is upgraded or downgraded automatically based on the FW version on the CompactFlash card and the FW version on the SINAMICS components (DRIVE-CLiQ components, TB30, CBE30-2, PM340, etc.).

The update procedure can take several minutes and is indicated in the "Automatic Configuration" dialog box by the following message:

**State of the drive unit: Automatic FW update of DRIVE-CLiQ components**

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red and green:

- FW update running: RDY LED flashes slowly (0.5 Hz)
- FW update complete: RDY LED flashes quickly (2 Hz)

These flashing patterns are also displayed on the yellow RDY LED on the SIMOTION D/CX32-2 and indicate that a FW update is being carried out on components connected to the SIMOTION D/CX32-2 or that all components have completed the FW update.

Go offline once all the FW updates have been completed. POWER ON the upgraded/downgraded components.

**CBE30-2 option board:**

During the firmware update, the OPT LED of the SIMOTION D module and the SYNC LED of the CBE30-2 flash green.

7. At the end of the automatic configuration, you are prompted whether you want to "Go OFFLINE" or "Stay ONLINE" with the drive unit.

![Automatic Configuration](image)

**Figure 6-24 Automatic configuration completed**

8. Execute the "Copy RAM to ROM ..." function on the D4x5-2 and on the SINAMICS Integrated. This saves the project on the CompactFlash card so that it does not need to be reloaded after switching off and on.
Result

The DRIVE-CLiQ components loaded to the user project by means of automatic configuration are displayed in the project navigator.

![Project navigator with real configuration](image)

Figure 6-25 Project navigator with real configuration

You must then

- If required, reconfigure SINAMICS components (e.g. components without a DRIVE-CLiQ interface, such as an encoder connected via SMCxx).
- Assign the "TO axis" to "Drive"
6.3.4 Editing SINAMICS components

Requirement

- You have loaded all connected DRIVE-CLiQ components to your user project.
- You have shut down the connection to the target system (offline mode).

Procedure

You can now adapt your components to the application.
Run through the wizard for all the DRIVE-CLiQ components to be adapted and perform the required reconfigurations.
This procedure corresponds with the description in Performing the configuration for the D4x5-2 offline (Page 159).
The amount of editing work involved depends on the components used. For example, in the case of a motor with a DRIVE-CLiQ interface, the motor and encoder type are identified automatically.

6.3.5 Downloading a project to the SIMOTION D4x5-2

After you have performed the reconfigurations, you must download the configuration to the SIMOTION D4x5-2 (incl. SINAMICS Integrated).

1. Save and compile the project.
2. Go online.
3. To load the project, perform "Download project to target system".
   The data must also be saved on the CompactFlash card to ensure that the project is retained in the event of a power failure. The following options are available:
   - Perform the "Copy RAM to ROM..." function manually on the D4x5-2 and all drives (SINAMICS Integrated, CX32-2, etc.).
   - In the "Download to Target System" dialog box, select the option "After loading, copy RAM to ROM". You can change the default setting for this dialog box in "Options > "Settings" > "Download".
The SIMOTION project is downloaded to the target system and the online connection to the drives established automatically.

**Note**
Online access to the drives is not possible if HW Config is not loaded at the time you initially connect to the target system.

Download the data to HW Config in order to enable online access to SINAMICS Integrated. During the "Download to target system" process, SIMOTION SCOUT automatically attempts to establish an online connection to SINAMICS Integrated.

**Note**
If you have deselected the "Drives" option under "Tools" > "Settings" > "Download" in SIMOTION SCOUT, you must download the configuration separately to each drive (SINAMICS Integrated, CX32-2, etc.).

To do this, select the drive (e.g. SINAMICS Integrated) in the project navigator and perform "Download CPU / drive unit to target device".
For fast operation, we recommend that, in principle, the drives be deselected and a download only performed when required.

4. To save the parameter calculations of the drive in the project, perform "Target device" > "Load CPU / drive unit to PG" for each drive.

The drive has been assigned parameters and commissioned. You can now test the drive via the drive control panel.
6.4 Configuring a CX32-2

6.4.1 Overview

The SIMOTION CX32-2 controller extension is a component in SINAMICS S120 booksize format and enables scaling of the drive-side computing performance of the SIMOTION D4x5-2 control units. Each CX32-2 can operate up to six additional servo, six vector or twelve V/f drives.

The CX32-2 controller extension offers the following advantages:

- With a width of only 25 mm, the CX32-2 is extremely compact.
- The CX32-2 is connected to the SIMOTION D4x5-2 via DRIVE-CLiQ, so that high-performance, isochronous closed-loop control of the drives is possible without the need for additional modules.
- The communication interfaces on the SIMOTION D4x5-2 remain available for other connections.
- The data for the CX32-2 is stored exclusively on the SIMOTION D4x5-2 CompactFlash card, which means that no action needs to be taken when the module is replaced.
- The "Control operation" signal from an infeed connected to the SIMOTION D4x5-2 is particularly easy to interconnect to the drives of a CX32-2.
- SIMOTION CX32-2 is automatically also upgraded when the SIMOTION D4x5-2 is upgraded.

6.4.2 Basic principles of the CX32-2

Each CX32-2 is entered as a separate DRIVE object in the project navigator on the level of SINAMICS Integrated. In principle, a CX32-2 can be configured the same way as SINAMICS Integrated.

Communication

With CX32-2 (as with the SINAMICS Integrated), communication takes place via the PROFIBUS Integrated, but is still routed by the SINAMICS Integrated to the relevant CX32-2 via DRIVE-CLiQ.

Communication with the CX32-2 runs in the same cycle (same DP cycle) as communication with the SINAMICS Integrated. Direct communication between two CX32-2 modules or the SINAMICS Integrated and CX32-2 is not possible. Exception: Interconnection of the "Operation" signal of the infeed for the CX32-2. For a description of how to interconnect to the "Operation" signal, refer to Section Interconnecting the infeed "Operation" signal on the CX32-2 (Page 204).
Power-up

The CX32-2 does not require its own CompactFlash card. The firmware and the parameterization are stored centrally on the SIMOTION D CompactFlash card. After a firmware change, the CX32-2 firmware from the CompactFlash card is copied to the CX32-2 at the first power-up and saved there as non-volatile data. For this reason, the first power-up with new firmware takes longer than subsequent power-ups. Copying from RAM to ROM also takes longer, as the devices perform this function one after the other.

How to detect if a power-up has been completed is described in Section CX32-2 configuration information in CX32-2 power-up (Page 204).

Online functions

Since the SINAMICS Integrated routes online functions to the CX32-2 via DRIVE-CLiQ, operational performance is reduced in the case of online functions (e.g. parameter changes or downloads) compared to a similar installation with CU320-2.

Commissioning requirements

To commission a SIMOTION D with CX32-2, all drive components which were configured offline must also be actually available and connected to the correct DRIVE-CLiQ port.

Only when there are no topology errors
• Will the download be successful (where a project created offline is loaded to the target system)
• Will the system startup be successful

To be able to go online on a CX32-2, at least the HW Config configuration must be loaded to the D4x5-2 and the CX32-2 connected "correctly" via the configured DRIVE-CLiQ ports on the D4x5-2.

Loading the SINAMICS Integrated

If the SINAMICS Integrated of a SIMOTION D is loaded, the connected CX32-2 controller extensions go offline as a result of reinitialization.
6.4 Configuring a CX32-2

6.4.3 Preparing for configuration

The following measures are required to enable online or offline configuration of a CX32-2.

1. Create a project and insert a SIMOTION D4x5-2 (in this example, D455-2).
2. In the project navigator, double-click the D4x5-2. The HW Config appears.
3. In the hardware catalog, open the "PROFIBUS DP" entry and select "SINAMICS".
4. Drag a CX32-2 to the PROFIBUS integrated master system of the SIMOTION D module.

The mouse pointer permits the CX32-2 to be inserted on the master system only. The "DP Slave Properties" screen form is displayed with the PROFIBUS address. The PROFIBUS address is assigned automatically. See the table below. Select the relevant DRIVE-CLiQ port by selecting the relevant PROFIBUS address (in this example, PROFIBUS address 15).
5. Click "OK" to confirm your settings.

The CX32-2 is displayed in the project navigator and can be configured there in the same way as a SINAMICS Integrated.

In HW Config, the respective PROFIBUS address of the CX32-2 is displayed in parentheses in the module icon.

![Image: CX32-2 in the project navigator](image.jpg)

Figure 6-28  CX32-2 in the project navigator

6. Save the project.

7. A CX32-2 is configured in the same way as the SINAMICS Integrated on a SIMOTION D4x5-2.

**Using an offline configuration**

Where configuration is being performed offline, configure the drive components (infeed, motor modules, motor, encoder, terminal modules, etc.) by running through the drive wizards for the SINAMICS Integrated or CX32-2. After you have done this, carry out commissioning.

**Automatic commissioning**

During the automatic commissioning, the drive components that are physically connected to a SIMOTION D are determined. I.e. you only require a D4x5-2 project with the CX32-2 modules configured in HW Config.
Assigning DRIVE-CLiQ ports to PROFIBUS addresses

Table 6-3  CX32-2 PROFIBUS addresses (PROFIBUS Integrated)

<table>
<thead>
<tr>
<th>DRIVE-CLiQ port</th>
<th>PROFIBUS address (PROFIBUS Integrated)</th>
</tr>
</thead>
<tbody>
<tr>
<td>X105 (not for D425-2)</td>
<td>15</td>
</tr>
<tr>
<td>X104 (not for D425-2)</td>
<td>14</td>
</tr>
<tr>
<td>X103</td>
<td>13</td>
</tr>
<tr>
<td>X102</td>
<td>12</td>
</tr>
<tr>
<td>X101</td>
<td>11</td>
</tr>
<tr>
<td>X100</td>
<td>10</td>
</tr>
</tbody>
</table>

6.4.4  Displaying the topology

Topology of the SINAMICS Integrated

Because the CX32-2 is connected to the SINAMICS Integrated of a SIMOTION D4x5-2 via DRIVE-CLiQ, it is also displayed in the topology tree of the SINAMICS Integrated.

All inserted CX32-2s are displayed in the SINAMICS Integrated topology without their subtopology.

Figure 6-29  SINAMICS Integrated topology (example of D455-2 DP/PN)
CX32-2 topology

The CX32-2 topology displays the DRIVE-CLiQ port required for connection to the SINAMICS Integrated. The drive objects connected to the CX32-2 are also displayed.

![CX32-2 topology diagram](image)

**Figure 6-30  CX32-2 topology**

**Note**

Topology errors can result in a download or system power-up not being possible.
6.4 Configuring a CX32-2

6.4.5 CX32-2 offline configuration

Options

The following options are available for commissioning a project created offline:

- Loading a project created offline to the target system
- Loading a project created offline to the CompactFlash Card

6.4.5.1 Loading a project created offline to the target system

Requirement

- Your project, including all SINAMICS Integrated and CX32-2 drive components, must have been configured already (see Preparing for configuration (Page 196)).
- The actual topology must correspond with the reference topology.

Note

A step-by-step commissioning with the CX32-2 controller extension is described below.

In a step-by-step procedure, first the D4x5-2, then the SINAMICS Integrated and finally each CX32-2 is commissioned. This step-by-step procedure is not mandatory, but has the advantage that the location and cause of an error are easier to identify.

Procedure

1. Deselect all target devices, with the exception of the SIMOTION D4x5-2, using the "Target system" > "Select target devices" menu command in SCOUT.
2. Go online with the D4x5-2 by clicking "Connect to selected target devices".
3. Select the D4x5-2 in the project tree. Load the configuration to the SIMOTION D4x5-2 with "Download CPU / drive unit to target device".
4. Copy the configuration from RAM to ROM with "Copy RAM to ROM".
5. Select "Connect target device" in the SINAMICS Integrated context menu. You will then be connected to the SINAMICS Integrated online.
6. Load the parameterization by selecting "Target device" > "Download" in the SINAMICS Integrated context menu.
7. Copy the parameterization from RAM to ROM with "Copy RAM to ROM".
8. Then select "Load CPU / drive unit to PG" to load the parameterization from the SINAMICS Integrated back to the programming device in order to back up the SINAMICS parameter calculations.
The SINAMICS Integrated is now ready for operation (RDY LED flashes green at 0.5 Hz). The CX32-2 can be accessed online, although it has not been configured yet (RDY LED flashes green at 0.5 Hz, DP LED is off).

1. Select "Connect online" in the CX32-2 context menu. You will then be connected to the CX32-2 online.
2. Load the parameterization to the CX32-2 and copy the parameterization from RAM to ROM.
3. Then load the parameterization from the CX32-2 back to the programming device in order to back up the SINAMICS parameter calculations.
4. Repeat steps 1 to 3 for each CX32-2.
5. Save the project.

---

**Note**

Topology errors can result in a download or system power-up not being possible.

---

**Result**

The CX32-2 is now also ready for operation (RDY LED is green, DP LED is green (in RUN mode) or flashes green at 0.5 Hz (in STOP mode)).

---

### 6.4.5.2 Loading a project created offline to the CF card

Loading a project created offline to the CF card has the advantage of being faster than a download.

It should be noted, however, that the first system power-up will take longer, as the SINAMICS Integrated and CX32-2 will perform one-off parameter calculations. These are automatically backed up on the CF card.

**Requirement**

- You will need a card reader for the SIMOTION D4x5-2 CF card.
- Your project, including all SINAMICS Integrated and CX32-2 drive components, must have been configured already (see Preparing for configuration (Page 196)).
- The actual topology must correspond with the reference topology.

**Procedure**

1. Select "Load to file system" in the SIMOTION D4x5-2 context menu.
2. Select "Normal save" and click the "Select target" button. Select your card reader's drive and confirm with "OK".
3. If a project has already been saved to the CF card, the message "Memory card file already exists. Do you want overwrite this file?" appears. Confirm the message with "Yes".
4. Once the project has been subsequently transferred to the CF card, insert the card into the disconnected SIMOTION D4x5-2. Switch on the power supply of the D4x5-2 and the connected components.

5. After a successful power-up, the RDY LED of the D4x5-2 and the CX32-2 will be green, as will the DP LED of the CX32-2.

The components' firmware is automatically updated, depending on the FW version on the SINAMICS components and on the CF card. Note the information in Section Upgrading the D4x5-2/CX32-2 (Page 207).

---

**Note**

Topology errors can result in a download or system power-up not being possible.

---

### 6.4.6 Performing an online configuration for the CX32-2

**Requirement**

You need a project which has already been created and which contains the SIMOTION D4x5-2 with SINAMICS Integrated, as well as the CX32-2 controller extension(s).

Additional drive components (line module, motor modules, terminal modules, etc.) are configured using "Automatic commissioning" and must not, therefore, be created offline.

**Procedure**

1. Deselect all target devices, with the exception of the SIMOTION D4x5-2, using the "Target system" > "Select target devices" menu command in SCOUT.

2. Go online with the D4x5-2 by clicking "Connect to selected target devices".

3. Select the D4x5-2 in the project tree. Load the configuration to the SIMOTION D4x5-2 with "Download CPU / drive unit to target device".

4. Copy the configuration from RAM to ROM with "Copy RAM to ROM".

5. Select "Connect target device" in the SINAMICS Integrated context menu. You will then be connected to the SINAMICS Integrated online.

6. Perform "Automatic Configuration" on the SINAMICS Integrated. This may take several minutes, depending on the number of components connected.

   The SINAMICS Integrated is now ready for operation (RDY LED flashes green at 0.5 Hz). The CX32-2 can be accessed online, although it has not been configured yet (RDY LED flashes green at 0.5 Hz, DP LED is off).

7. Select "Connect target device" in the CX32-2 context menu. You will then be connected to the CX32-2 online.

8. Perform the automatic configuration on the CX32-2. The CX32-2 is now also ready for operation (RDY LED is green, DP LED is green (in RUN state) or flashes green at 0.5 Hz (in STOP state)).
9. Repeat steps 7 to 8 for each CX32-2.

10. Copy the parameterization from RAM to ROM with "Copy RAM to ROM".

11. Save the project.

If you run the "automatic configuration" in Step 6 and 8, a check will be made to see if the firmware on the SINAMICS components differs from the firmware on the CompactFlash card. If it does, you will be informed accordingly and the firmware on the SINAMICS components will be upgraded/downgraded automatically.

The update can take several minutes and its progress is tracked by corresponding messages appearing in the alarm window of SIMOTION SCOUT.

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red and green:

- FW update running: RDY LED flashes slowly (0.5 Hz)
- FW update complete: RDY LED flashes quickly (2 Hz)

These flashing patterns are also displayed on the yellow RDY LED on the SIMOTION D/CX32-2 and indicate that a FW update is being carried out on components connected to the SIMOTION D/CX32-2 or that all components have completed the FW update.

Go offline once all the FW updates have been completed.
POWER ON the upgraded/downgraded components.

---

**Note**

Topology errors can result in a download or system power-up not being possible.
6.4 Configuring a CX32-2

6.4.7 CX32-2 configuration information

This section contains configuration tips relating to a number of features which are specific to operating the CX32-2 together with the D4x5-2.

6.4.7.1 CX32-2 power-up

Powerup times

The CX32-2 does not require its own CF card. The firmware and the parameterization are stored centrally on the SIMOTION D CF card. After a firmware change, the CX32-2 firmware from the CF card is copied to the CX32-2 at the first power-up and saved there as non-volatile data. For this reason, the first power-up with new firmware takes longer than subsequent power-ups.

Detecting when the CX32-2 powers up in the user program

The user must wait for the CX32-2 to power up before the drive objects can be accessed by the user program.

One way of checking is to query the status of system variables of the drives on the CX32-2.

- `<axis name>.actormonitoring.cyclicinterface = ACTIVE AND`
- `<axis name>.sensordata[1].state = VALID`

This procedure can also be used to establish when the SINAMICS Integrated drives power up.

6.4.7.2 Interconnecting the infeed "Operation" signal on the CX32-2

Requirement

- Drive line-up with SIMOTION D4x5-2 control unit and line module with DRIVE-CLiQ interface
- One or more CX32-2 controller extensions without a line module of their own (i.e. the motor modules of the D4x5-2 and the CX32-2 modules are supplied by the same DC link)

In this example, the line module must to be connected to the SIMOTION D4x5-2 (not to the CX32-2).
Procedure

When drives are created in Drive system 1, the signal "Closed-loop control operation" r0863.0 from the line module is automatically interconnected with the "Infeed operation" signal from the drives (Drive 1...n) via p0864.

There is an internal communication channel available for the CX32-2 controller extension (drive system 2), via which the following signals from the SIMOTION D4x5-2 control unit can be automatically interconnected to the CX32-2 controller extensions:

- "Closed-loop control operation" of the line module connected to the SIMOTION D4x5-2
- Status of the SIMOTION D4x5-2 onboard digital inputs (X122/X132, DI 0 ... 7 and DI/DO 8 ... 15)

These signals are available on the CX32-2 controller extension; since there is no need to perform any additional configuration steps, it is very easy to make additional interconnections with them within the CX32-2.

Interconnecting the infeed operation signal

The "Closed-loop control operation" signal of the line module connected to the SIMOTION D4x5-2 is available in parameter r8510.0 of the CX32-2. Using the expert list or the drive wizard, interconnect parameter p0864 (drives on CX32-2) to parameter r8510.0 of the CX32-2 controller extension.

![Interconnecting the infeed operation signal](image_url)
Infeed on CX32-2

If the infeed on the CX32-2 is connected and the Ready for operation signal on the SINAMICS Integrated is to be interconnected to another CX32-2 or a CU320-2, proceed as described in Section Using one infeed for several CUS (Page 242).

Terminal state of D4x5-2 onboard digital inputs

The terminal states of the SIMOTION D4x5-2 onboard digital inputs (X122/X132, DI 0 ... 7 and DI/DO 8 ... 15) are available in parameter r8511[0 ... 15] of the CX32-2. These can be interconnected further on the CX32-2.
6.4.7.3 Upgrading the CX32-2

CX32-2 modules are always operated with the same firmware version as the SINAMICS Integrated of a SIMOTION D.

This means no additional measures need to be taken for CX32-2 modules.

If the firmware version of the SIMOTION D is upgraded via HW Config, the SINAMICS Integrated and the connected CX32-2 controller extension are also automatically upgraded.

For instructions on upgrading a SIMOTION D see also Section Adapting a project (Upgrading the project / Replacing the SIMOTION controller) (Page 319).

Note

The components' firmware is upgraded or downgraded automatically based on the FW version on the CompactFlash card and the FW version on the SINAMICS components (DRIVE-CLiQ components, CBE30-2, TB30, PM340, etc.).

The update can take several minutes and its progress is tracked by corresponding messages appearing in the alarm window of SIMOTION SCOUT.

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red and green:

- FW update running: RDY LED flashes slowly (0.5 Hz)
- FW update complete: RDY LED flashes quickly (2 Hz)

These flashing patterns are also displayed on the yellow RDY LED on the SIMOTION D/CX32-2 and indicate that a FW update is being carried out on components connected to the SIMOTION D/CX32-2 or that all components have completed the FW update.

Go offline once all the FW updates have been completed. POWER ON the upgraded/downgraded components.
Replacing the CX32-2

Replacing a module

When used as a spare part, a CX32-2 behaves like other DRIVE-CLiQ components. A module replacement is detected automatically as of SINAMICS V4.5. See Section

- Module replacement (Page 103)
- Backing up / restoring / deleting SINAMICS NVRAM data (Page 217)


Drag-and-drop can be used to carry out a D435-2/D445-2/D455-2 ↔ D425-2 module replacement in HW Config.

Please note that it will not be possible to replace a D435-2/D445-2/D455-2 with a D425-2 if a CX32-2 has been configured with the address 14 or 15. (A D425-2 does not have DRIVE-CLiQ ports X104/X105 and therefore does not have addresses 14 and 15.)
6.5 Additional information on configuring the SINAMICS Integrated

6.5.1 Settings for DP slave properties

Settings in HW Config

Depending on the cycle clock ratios (bus cycle clock, servo cycle clock) and the drives used, it may be necessary to change the properties of the DP slave (SINAMICS Integrated) on the PROFIBUS Integrated.

Open HW Config. Double-click the SINAMICS Integrated to display and, if necessary, change the properties of the DP slave on the "Isochronous mode" tab. Example:

- Synchronizing a drive to the isochronous DP cycle
  SINAMICS Integrated and CX32-2 can only be operated isochronously. For this reason, this option cannot be deactivated.

- Changing the master application cycle (\( T_{\text{MAPC}} \))
  The master application cycle must always be the same as the servo cycle clock set (setting: "Context menu of the D4x5-2" > "Set system cycle clocks" in the project tree). Provided that the DP cycle is not scaled down to the position control cycle clock, the master application cycle will always be the same as the DP cycle.

Note

As of V4.3, a reduction ratio for the DP cycle to the Servo cycle clock is possible. The reduction ratio is only permitted when PROFINET IO with IRT has not been configured.

- Changing the DP cycle (\( T_{\text{DP}} \))
  Depending on the requirements in terms of the quantity structures and the response times, the DP cycle may need to be changed (see also SIMOTION SCOUT Basic Functions Function Manual).

  In addition, the minimum DP cycle for vector drives also depends on the speed controller clock cycle, which in turn depends on the drive quantity structure and the device type used. This means that, particularly in the case of vector drives, the DP cycle must be checked and changed if necessary (see Using vector drives (Page 211)).

Note

After \( T_{\text{DP}} \) has been changed on the PROFIBUS master, the drive system must be switched on (POWER ON).

- Changing the Ti and To times
  A change to Ti/To is required in the case of vector drives, for example, where the Ti/To time depends on the number of vector drives or, with chassis devices, on the device type used.
If you change the settings for the SINAMICS Integrated, you must also change the settings on the CX32-2 modules accordingly. This is easily done by using the Align button to transfer the settings for all the CX32-2 modules.

The times are modified by changing the value in the "Factor" field.

**Additional references**

Further information is available in the following references:

- **SINAMICS S120 Function Manual**
- **SIMOTION SCOUT Basic Functions Function Manual**
6.5.2 **Using vector drives**

Changes need to be made in HW Config when using SINAMICS vector drives. This means, for example, that the \( T_i/T_o \) time and the minimum DP cycle depend on the number of vector drives or, with chassis drives, also on the device type used.

Therefore, we recommend adopting the following procedure when using vector drives with the SIMOTION D4x5-2.

**Scenario 1: Current and speed controller cycle is known**

As long as you know the current and speed controller cycle, you will be able to determine times \( T_{MAPC} \), \( T_{DP} \), \( T_i \), and \( T_o \). Where there are several drives with different cycle clocks, the largest cycle clock must be used for the current and speed controller cycle.

**Procedure**

1. Open HW Config. Double-clicking SINAMICS Integrated allows you to change the properties of the DP slave on the "Isochronous mode" tab.
2. For \( T_i = T_o = \), enter an integer multiple of the current controller cycle.
3. For \( T_{DP} \), enter an integer multiple of the speed controller cycle. For drives on the SINAMICS Integrated, \( T_{DP} \) must always be \( \geq T_o \).
4. Enter \( T_{MAPC} = T_{DP} \) (exception: you are working with cycle clock scaling; i.e. position control cycle clock > DP cycle).
5. Use the "Download project to target system" menu command to load the configuration to the SIMOTION D4x5-2.
6. After the download has successfully completed, you should determine the current and speed controller cycles of the drives from the drives' expert lists, as the cycle clocks are set in the SINAMICS drive unit after a project has been downloaded.

\[
\begin{align*}
T_i & = T_o = \text{at least } 250 \text{ µs} \\
T_{DP} & = 1 \text{ ms (or } 2 \text{ ms, } 3 \text{ ms, ...)} \\
T_{MAPC} & = T_{DP}
\end{align*}
\]
7. If the current and speed controller cycles from the expert lists are different to the cycle clocks used in steps 2 and 3, you will have to repeat the steps with the current values for the current and speed controller cycles.

<table>
<thead>
<tr>
<th>Example</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 3 vector drives</td>
<td>( T_i = T_o = \text{at least } 250 \text{ µs} ) ( T_{DP} = 1 \text{ ms (or } 2 \text{ ms, } 3 \text{ ms, ...)} ) ( T_{MAPC} = T_{DP} )</td>
</tr>
<tr>
<td>4 to 6 vector drives</td>
<td>( T_i = T_o = \text{at least } 500 \text{ µs} ) ( T_{DP} = 2 \text{ ms (or } 4 \text{ ms, } 8 \text{ ms, ...)} ) ( T_{MAPC} = T_{DP} )</td>
</tr>
</tbody>
</table>

Table 6- 4 Example for power units in booksize format (vector drives)
Note

Vector drives in chassis format can also be operated with a current controller sampling time of 400 µs (amongst other settings).

In the SIMOTION context, the following should be considered:

- A current controller sampling time of 400 µs is only possible if control is via a SINAMICS S120 control unit, which is not operated isochronously via PROFIBUS/PROFINET on SIMOTION D.
- If the bus is operated isochronously, only cycle clocks with an integer multiple of 125 µs are possible (i.e. 375 µs or 500 µs instead of 400 µs, for example).
- The PROFIBUS Integrated of a D4x5-2/CX32-2 is always isochronous! This means that a current controller sampling time of 400 µs is not possible.
- With CU parameter p0092 = 1, the sampling times are pre-assigned so that isochronous operation with a controller is possible.

Scenario 2: Current and speed controller cycle is not known

This procedure is especially suitable for devices in chassis format, as the current and speed controller cycle also depends on the relevant device type.

1. To determine which cycle clocks are set in the SINAMICS drive unit after a project has been downloaded, first set reliable values for the cycle clocks in HW Config (see table "Recommended cycle clock settings in HW Config").
2. Use the "Download project to target system" menu command to download the parameterization.
3. After the download has successfully completed, you will be able to determine all the current and speed controller clock cycles of the drives from the drives’ expert lists.
   - p0115[0] current controller cycle clock
   - p0115[1] speed controller cycle clock
4. If required, it is now possible to optimize the \(T_{MAPC}, T_{DP}, T_I,\) and \(T_O\) times in HW Config (see procedure for Scenario 1).

Table 6-5 Recommended cycle clock settings in HW Config

<table>
<thead>
<tr>
<th>Setting</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>(T_{DP} = 3.0)</td>
<td>(T_{DP} = ) DP cycle time</td>
</tr>
<tr>
<td>(T_I = T_O = 1.5)</td>
<td>(T_I = ) time of actual value acquisition       (T_O = ) time of setpoint transfer</td>
</tr>
<tr>
<td>(T_{MAPC} = 3.0)</td>
<td>(T_{MAPC} = ) master application cycle time</td>
</tr>
</tbody>
</table>
Output cams / measuring inputs with vector drives

With vector drives, the cycle clock ratios (current controller cycle clock, speed controller cycle clock, sampling time of the I/Os, etc.) depend on the number of vector drives, or with chassis units also on the device type used.

Note the information in Section Current controller cycle clocks <> 125 µs / use of output cams and measuring inputs (Page 224).

Additional references

Additional information on quantity structures and cycle clock settings can be found in the SINAMICS S120 Function Manual.

6.5.3 Setting the time of day

Time on SIMOTION (real-time clock)

SIMOTION D4x5-2 has an integrated real-time clock. All events on a module (alarms, messages, etc.) are "time-stamped" based on the time shown by this real-time clock.

To set the clock from SIMOTION SCOUT, select the D4x5-2 in the project tree and then select "Target system" > "Set time" in the menu.

Alternatively, the clock can be set using the "rtc" system function block.

SINAMICS system runtime (operating hours counter)

Faults and alarms are "time-stamped" based on the system runtime on SINAMICS Integrated of a SIMOTION D, controller extensions and SINAMICS S120 Control Units. This means that events are recorded by default on the basis of operating hours rather than a particular time of day or date.

System runtime

The entire system runtime is displayed in CU parameter p2114.

- p2114[0] indicates the system runtime in milliseconds. After reaching 86,400,000 ms (24 hours), the value is reset.

- p2114[1] indicates the system runtime in days.

The counter value is saved when the power is switched off. After the drive unit has been switched on, the counter continues to run with the value stored when the power was last switched off.

As a result, the drive displays the system runtime from 00:00:00 on 01/01/1992 in both the alarm window in SIMOTION SCOUT and the diagnostics buffer for entries.

If faults and warnings need to be "time-stamped" based on a time of day, "Time stamp operating hours" needs to be changed to "Time stamp UTC format" as described below.
Requirements

A message frame 39x is required for the time synchronization. If the automatic PROFIdrive message frame setting is selected for the Control Unit, this message frame is used automatically (see Section Calling the drive wizard (Page 160), Standard/Automatic setting).

If the message frames are specified manually, message frame 39x must be set up (see Section Message frame configuration (Page 244)).

So that drive units can be synchronized with the SIMOTION time, they must support message frame 39x and the UTC time format.

The following Control Units support time synchronization:

- SINAMICS Integrated of the SIMOTION D
- CX32/CX32-2 controller extensions
- SINAMICS S120, CU310, CU310-2, CU320, CU320-2 Control Units, connected via PROFIBUS or PROFINET

Synchronizing the SINAMICS clock

Proceed as follows to convert the SINAMICS clock to UTC format and to synchronize this with the SIMOTION clock:

1. Call the D4x5-2 context menu in the project navigator.
2. Select the "Properties..." entry in the context menu.
3. Select the "Perform time synchronization with SINAMICS drive units" option in the "Settings" tab of the "Properties - D4x5-2" dialog box.

Note

This setting is automatically activated for new projects as of V4.2 and applies for all drive units connected to the D4x5-2. The SINAMICS clock is automatically synchronized with the SIMOTION clock for all drive units with configured message frame 39x.

The first time synchronization is performed after the SIMOTION D Control Unit has reached the RUN operating mode.

To compensate for deviations between the SIMOTION and SINAMICS clocks, the time of day is automatically resynchronized at regular intervals.

Via the system variable __driveStates.allClocksSynchronized on the D4x5-2 device, the user program can query whether the automatic time synchronization is activated (=YES) or deactivated (=NO).

Before the first synchronization, alarms and messages are stored with the time stamp valid in the SINAMICS at this time, all subsequent alarms and messages with the synchronized time.

The first time synchronization after switching on is entered with the status of the operating hours counter and the time (UTC time, synchronized with SIMOTION) in the diagnostics buffer of the drive (e.g. SINAMICS Integrated).
Compensation of runtime deviations

To compensate for deviations between the SIMOTION and SINAMICS clocks, the time of day is automatically resynchronized at regular intervals.

The following behavior must be taken into consideration when setting the SIMOTION time:

- "Time/date to be set" is after "Time/date on SINAMICS": Time and date are corrected on the SINAMICS.
- "Time/date to be set" is before "Time/date on SINAMICS": The SINAMICS clock must be stopped until the SINAMICS "Time/date" has caught up with "Time/date to be set".

Adopting this procedure ensures that the sequence of SINAMICS diagnostics buffer entries remains the same, even when the runtime differences are aligned.

The SINAMICS clock operates with a resolution of 1 ms. A synchronization accuracy of 1 ms can be achieved for all bus cycle clocks that can be divided exactly by 1 ms (e.g. 1 ms, 2 ms, 3 ms, etc.).

Due to system considerations, a slightly lower synchronization accuracy is achieved for all bus cycle clocks that cannot be divided exactly by 1 ms (e.g. 1.25 ms).
Resetting the time

Requirement:

- SIMOTION D4x5-2: As of SIMOTION V4.3
- SINAMICS S120: As of SINAMICS V4.5
- SINAMICS S110: Not available (SINAMICS V4.4)

A threshold value is defined via parameter cu.p3109 and is effective as follows:

- In the case of negative time jumps less than the threshold value (p3109), the time is halted (for details, see "Compensation of runtime deviations").
- In the case of negative time jumps greater than the threshold value (p3109), the time is reset.

Default setting: cu.p3109 = 100 ms

This means that in the case of negative time jumps greater than 100 ms, the time is reset.

The default value is configured so that normal runtime deviations (drift of the quartzes) are below the threshold value.

If the SIMOTION clock is reset by more than 100 ms, this is interpreted as a "specific reset of the time" and the time of the drives is also immediately reset.

If the real-time clock is reset by more than 60 seconds, a diagnostics buffer entry is also made in the drive:

Time correction (reset) by <correction value> seconds

After a resynchronization (negative time jump greater than the threshold value)

cu p3107[0..1] the UTC time after synchronization

cu p3107[2..3] the UTC time before synchronization

is displayed in the parameter, whereby [0] and [2] are milliseconds and [1] and [3] are days.

Note

The diagnostics buffer entries are not converted to the new time when the time is changed.
6.5.4 Backing up / restoring / deleting SINAMICS NVRAM data

Requirement

- SINAMICS S120 CU310-2/CU320-2: SINAMICS V4.5
- Other supported SINAMICS CUs: See the SINAMICS manuals

Saving the NVRAM data

The backup of the SINAMICS NVRAM data is performed by setting parameter p7775 to 1.

The following applies:

- Parameter p7775 can also be set to 1 during pulse enable.
- A warm restart is not required.

Note

The consistent backup of the NVRAM data must be ensured by the application.
Make sure that there is no change of the NVRAM contents during the backup.

The greatest possible consistency is achieved when

- Backup is performed during pulse disable or
- The drives are run down to 0 Hz.

The data is stored on the CompactFlash card:

- "....\USER\SINAMICS\NVRAM" for S120 CUs and SINAMICS Integrated
- "....\USER\SINAMICS\NVRAM\xx" for CX32-2 (xx corresponds to the DRIVE-CLiQ port)

The data itself is stored in the PMEMORY.ACX backup file.

For the S120 control units, the data is stored on the CompactFlash card of the S120 control unit.

Similar to the non-volatile SIMOTION data, an already existing PMEMORY.ACX file is first renamed as PMEMORY.BAK and then the PMEMORY.ACX file is generated when you save the SINAMICS data.

If an error occurs during backup, the BAK file can be used to restore the data.

Parameter p7775 is set to 0 at the end of the backup.
Restoring the NVRAM data

The SINAMICS NVRAM data can only be restored when none of the connected drives has a pulse enable.

When restoring, the PMEMORY.ACX file is accessed first. If this is available and is error-free, it is loaded. If no PMEMORY.ACX file is available or is corrupt, the PMEMORY.BAK file is loaded (if available and error-free).

Restoration of the NVRAM data can be performed manually and automatically:

Automatic restoration at module replacement
- SINAMICS detects whether the control unit has been replaced on the basis of the serial number.
- In this case, the NVRAM of the used control unit is deleted first after POWER ON.
  - The following are not deleted:
    - CU operating hours counter
    - CU temperature and
    - Safety logbook

If there is an error-free PMEMORY.ACX or PMEMORY.BAK file on the CompactFlash card, the data is then loaded to the NVRAM.

If no error-free backup file is available, power-up is as for SINAMICS < V4.5. A fault is not issued and any existing "corrupt" backup files are not deleted.

Manual restoration

The manual restoration of the NVRAM data is performed by setting parameter p7775 to 2.

If the backup file (ACX or BAK) is error-free is, a warm restart is performed. The contents of the NVRAM are deleted first and then the data is loaded from the backup file to the NVRAM.

The following are not loaded:
- CU operating hours counter
- CU temperature and
- Safety logbook

Parameter p7775 is set to 0 at the end of the restoration.

If the backup files are corrupt or no backup exists, the job is acknowledged with an error value in parameter p7775.
Deleting the NVRAM data

The SINAMICS NVRAM data can only be deleted when none of the connected drives has a pulse enable.

The deletion of the NVRAM data is performed by setting parameter p7775 to 3.

After setting p7775 to 3, a warm restart is performed automatically.

During the following power-up, first all NVRAM data is deleted on the control unit.

The following are not deleted:

- CU operating hours counter
- CU temperature and
- Safety logbook

At the end of the deletion, the initialization data of the applications is in the NVRAM, similar to as after a device automatic commissioning (with the exception of the above-mentioned data).

Parameter p7775 is set to 0 at the end of the deletion.

Explanations for p7775

The following jobs can be issued via p7775:

1: Backup NVRAM data (on CompactFlash card)
2: Restore NVRAM data (from CompactFlash card)
3: Delete NVRAM data on CU

The acknowledgement of a job is delayed.

- If the job cannot be executed, it is acknowledged negatively.
- If the job can be executed, it is acknowledged with the value 255.

Acknowledgements of the parameter jobs

<table>
<thead>
<tr>
<th>Value</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>Request cannot be executed because of the operating state</td>
</tr>
<tr>
<td>20</td>
<td>Illegal value</td>
</tr>
<tr>
<td>107</td>
<td>Write access is not permitted (cause: At least one DO has a pulse enable). As the SINAMICS has to perform a warm restart when restoring and deleting the data, none of the connected drives must have a pulse enable</td>
</tr>
<tr>
<td>132</td>
<td>Parameter change blocked (see p0300, p0400, p0922, p7760, macro being executed)</td>
</tr>
<tr>
<td>204</td>
<td>Write access not permitted</td>
</tr>
<tr>
<td>255</td>
<td>&quot;OK&quot;: Job being executed</td>
</tr>
</tbody>
</table>
If an error is detected during the execution of a parameter job, the error cause is signaled via the parameter itself (no message via the fault buffer).

**Causes of errors for parameter jobs**

<table>
<thead>
<tr>
<th>Value</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Error occurred while deleting</td>
</tr>
<tr>
<td>11</td>
<td>No backup possible: Memory card is not inserted</td>
</tr>
<tr>
<td>12</td>
<td>No backup possible: Memory card is full</td>
</tr>
<tr>
<td>13</td>
<td>Backup could not be completed (e.g. memory card removed during the backup)</td>
</tr>
<tr>
<td>14</td>
<td>Restoration not possible: Memory card is not inserted</td>
</tr>
<tr>
<td>15</td>
<td>Restoration not possible: Checksum of the NVRAM data backup file is faulty</td>
</tr>
<tr>
<td>16</td>
<td>Restoration not possible: No backup available</td>
</tr>
</tbody>
</table>

**Note**

The memory card must be always remain inserted for SIMOTION D; please refer to the SINAMICS manuals for which SINAMICS control units allow the memory card to be removed.

Parameter p7775 is only reset automatically to 0 after the successful completion of a job.

**Know-how and write protection**

- Parameter p7775 is not part of the know-how protection. I.e. the parameter can be read and written irrespective of the know-how.
- Parameter p7775 is part of the write protection. This means the parameter can only be written by the controller that configured a PZD cyclic communication with the SINAMICS when write protection is activated (p7761 = 1).

All other write jobs are acknowledged negatively, e.g.

- SCOUT/STARTER
- For SINAMICS CUs, BOP, IOP, AOP
- Other masters that only communicate acyclically with the SINAMICS
6.5 Additional information on configuring the SINAMICS Integrated

6.5.5 SINAMICS diagnostic buffer

The diagnostic buffer of the SINAMICS Integrated, the CX32-2 and the SINAMICS S120 control unit can be displayed in SIMOTION SCOUT.

To do this, select the SINAMICS Integrated, the CX32-2 or the SINAMICS S120 control unit in the project tree. Then select "Target system" > "Device diagnostics" in the menu.

In addition, the SINAMICS diagnostic buffer entries are also displayed in the D4x5-2 device diagnostics. All D4x5-2 diagnostics buffer entries are displayed first, followed by those for the SINAMICS Integrated and the CX32-2. The start of the SINAMICS diagnostics buffer entries is identified by the following entry:

>>>>>> Start of SINAMICS Integrated diagnostics buffer, station address = x
<<<<<<

You also have the option of viewing the SIMOTION D4x5-2 and SINAMICS Integrated diagnostics buffers via IT DIAG.

6.5.6 Acyclic communication with the drive

Overview

PROFIdrive drive units are supplied with control signals and setpoints by the controller and return status signals and actual values. These signals are normally transferred cyclically (i.e. continuously) between the controller and the drive.

For the SINAMICS S110/S120, configure the axis message frames for data exchange (see Section Performing the configuration for the D4x5-2 offline (Page 159)).

As well as offering cyclic data exchange, PROFIdrive drive units have an acyclic communication channel. In particular, this is used for reading and writing drive parameters (e.g. error codes, warnings, controller parameters, motor data, etc.).

As a result, data can be transferred on an "acyclic" as opposed to a "cyclic" basis when required. Acyclic reading and writing of parameters for PROFIdrive drives is based on the DP V1 services "Read data set" and "Write data set".

The acyclic DP V1 services are transferred in parallel to the cyclic communication via PROFIBUS or PROFINET. The PROFIdrive profile specifies precisely how these basic mechanisms are used for read/write access to parameters of a PROFIdrive-compliant drive.

The PROFIdrive standard states that "pipelining" of jobs on PROFIdrive drives is not supported. This means:

- Only one "Write/read data set" can be performed at any one time on a drive unit (e.g. SINAMICS S110/S120 control unit or the SINAMICS Integrated of a SIMOTION D).
- However, if several PROFIdrive drive units are connected to a controller, a job can be processed for each of these drive units at the same time. In this case, the maximum total number of jobs will depend on the controller (maximum of eight jobs simultaneously with SIMOTION).
For acyclic data exchange with SINAMICS drives, this means you will have to coordinate the write/read jobs with each other (buffer management). An interlock must be set to prevent the application or different parts of the application from sending overlapping jobs to the same PROFIdrive drive unit.

Additional references

Additional information on how to use DP V1 services can be found in the SIMOTION Communication System Manual.

SIMOTION Utilities & Applications also has a DP V1 library with functions that are capable of performing coordination tasks commonly associated with acyclic communication. The library not only coordinates access to the system functions (_readRecord/_writeRecord/_readDriveParameter/_writeDriveParameter/, etc.), but also expands the range of functions for frequently required tasks, e.g. the reading of faults and alarms from the drive unit.

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.

The following functions are available in the DP V1 library:

- **Buffer management** (coordination of a number of parallel DP V1 services)
- **StartUp** (function for coordinating the power-up of the SINAMICS drive with SIMOTION)
- **TimeSync** (applicative time synchronization: Transfer of SIMOTION time of day to the SINAMICS drives)
- **SetActIn** (activating/deactivating objects in SIMOTION and SINAMICS)
- **RwnPar** (reading and writing of drive parameters)
- **GetFault** (reading errors and warnings from the drive)
6.5.7 Control properties and performance features

With a few exceptions, the integrated drive control of SIMOTION D4x5-2 and CX32-2 has the same control properties and performance features as the SINAMICS S120 CU320-2 control unit.

However, the following points must be particularly observed:

- SINAMICS Integrated and CX32-2 have no basic positioner (EPOS). The EPOS functionality is provided by the SIMOTION technology functions.
- A BOP20 basic operator panel cannot be connected to the SIMOTION D4x5-2.

The following alternative options are available:

- Use of SIMATIC HMI devices (e.g. TP177B, configurable with WinCC flexible)
- Use of SIMOTION IT DIAG: You can use a Web browser to access the standard diagnostics pages of the SIMOTION D4x5-2 (diagnostics and alarm buffers, watch table, read/write SIMOTION variables and drive parameters, access protection, trace function, etc.)
  You also have the option of creating your own Web pages, in order for example to visualize machine states and implement service functions. The SIMOTION D4x5-2 Web pages can be accessed, for example, with a PC or PDA via Ethernet. Wireless access is also possible in conjunction with WLAN.

- The use of the CU parameter p0972 is restricted with SIMOTION D4x5-2. CU parameter p0972 can be used to reset the drive unit. You can use this method, for example, in the context of the implementation of modular machine concepts to force a restart of the CX32-2 controller extension (only required for versions < V4.3). See also the following references:
  - Motion Control, Basic Functions for Modular Machines Description of Functions

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The SINAMICS Integrated of the SIMOTION D4x5-2 does not support a reset via parameter p0972. Use the reset with p0972 only in conjunction with CX32-2 or SINAMICS control units.</td>
</tr>
</tbody>
</table>
6.5.8 Current controller cycle clocks <> 125 µs / use of output cams and measuring inputs

If current controller cycle clocks <> 125 µs are used, the parameter calculations of the drive must be transferred to the PG when using cam outputs on the TM15 / TM17 High Feature or for global measuring inputs, and FastI/O configuration generated again.

A change of the current controller cycle clock may have effects on the sampling times of the inputs/outputs on the drive side (e.g. TM15/TM17 High Feature, p4099 Sampling time of the inputs/outputs).

Sampling times <> 125 µs occur in the following cases:

- For servo drives with manual change of the current controller sampling time (drive parameters p0112 and p0115[0])
- For vector drives depending on the number of vector drives and with chassis units depending on the device type used
- If only an infeed and no drives are connected to the drive unit, then the sampling time is 250 µs

For the cam outputs and the measuring input inputs (only for global measuring inputs) to function correctly, the sampling times must be known to the engineering system.

<table>
<thead>
<tr>
<th>Cam outputs</th>
<th>Current controller cycle clock has no effect on the function</th>
<th>Current controller cycle clock has an effect on the function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measuring input inputs (global measuring inputs)</td>
<td>D4x5-2 (terminal X142)</td>
<td>TM15 / TM17 High Feature / SIMOTION D (except D4x5-2, terminal X142) / Controller extension (CX) / SINAMICS S110/S120 control units</td>
</tr>
</tbody>
</table>

In order that the changed cycle clock ratios are taken into account by the engineering system, proceed as follows:

1. Go online and perform a project download. The SINAMICS performs parameter calculations once. These are automatically backed up on the CompactFlash card.
2. Perform an upload to the PG ("Target system" > Load" > "Load CPU / drive unit to PG").
3. This transfers the parameter calculations of the drive to the PG. The cycle clock ratios are then known in the engineering system.
4. Go offline.
5. Generate the configuration information (Fast IO configuration) again. To do this, select the SIMOTION CPU in the project tree and right-click to open the context menu "Fast IO" > "Create new configuration".

6. Click "Save project and compile all".

7. Go online and download the project to the target system.

SCOUT uses the described procedure to calculate internal system data that is required for outputting/detecting signals with a high level of position accuracy.

---

**Note**

If the cycle clock ratios are not set correctly, an appropriate message is output in the diagnostic buffer.
6.6 Testing a drive with the drive control panel

Introduction

You can test a configured drive with the drive control panel, where you can specify a speed and adjust it with a scaling factor. The drive control panel should only be used for commissioning.

Requirements

- The project has been downloaded to the target system.
- SIMOTION SCOUT is in online mode.
- The drive is not being used by a current project in RUN mode.

⚠️ WARNING

Make sure no one is endangered by the drive test.

Testing a drive with the drive control panel

1. Change to the configured drive in the Project Navigator and open the drive control panel by selecting "Commissioning" > "Control panel". The drive control panel opens in the detail view.

2. To display the control area and axis diagnostics, click the "Show/hide control area" and "Show/hide diagnostics area" buttons.

3. Click "Assume control priority". The "Assume Control Priority" dialog box is opened.
Note

If you are using an infeed without a DRIVE-CLiQ interface, you will have to interconnect the "Infeed operation" signal (drive parameter p0864) yourself. If you are using an infeed with a DRIVE-CLiQ interface, select the infeed for which the control priority is to be assumed under "Infeed" in the "Assume Control Priority" dialog box.

If the infeed signal "Closed-loop control operation" already has a BICO interconnection to the drive, the infeed is permanently specified (infeed selection and checkbox are grayed out).

The infeed must be switched on before the drive can move ("LM" button, switch infeed on/off).

![Assume Control Priority](image)

Figure 6-36  Assume_control_priority

4. Read the notes and confirm these with "Accept".

5. Activate the "Enables" checkbox to enable the drive.

   All enables are now set with the exception of ON/OFF1.

6. Enter the desired setpoint in the entry field, and, as a safety setting, slide the scaling to 0%.
Testing a drive with the drive control panel

7. Click the "Drive On" button. The "Enable is set" LED lights up in green color. If you move the slider to the right, the drive rotates. The current motor speed is displayed in "Actual".

8. Click "Drive Off" to stop the drive after you completed the test.

9. Deactivate the enable and click the "Give up control priority" button to deactivate control from the PG/PC. In this state, you can no longer make the drive rotate.

Figure 6-37  Entering a setpoint
6.7 Creating and testing axes

6.7.1 Overview of SIMOTION engineering

Performing engineering with SIMOTION SCOUT

You use the engineering software to configure the individual axes and define the project sequence by means of programs.

1. First, run through the axis wizard to configure the axes and interconnect to the real drive (e.g. SINAMICS Integrated).

2. Provided you have completed the configuration at the drive end, we strongly recommend for faster working that the SINAMICS Integrated is deactivated via "Target system" ⇒ "Select target device".

3. Complete your SIMOTION application, for example, by creating axis functions and SIMOTION execution programs.

4. Compile the project and download it to the SIMOTION D4x5-2.

6.7.2 Creating an axis with the axis wizard

Overview

The TO axis provides the user with the technological functionality and the interface to the drive/actuator. The TO axis processes the motion control commands from the user program (e.g. MCC) and coordinates the interface to the drives. It executes control and motion commands and indicates statuses and actual values. The TO axis communicates with an actuator (drive or hydraulic valve) via a field bus system (PROFIBUS or PROFINET via PROFIdrive protocol) or via a direct setpoint interface (analog ±10 V or pulse/direction).

When running through the axis wizard, the basic settings are made for the axis and the TO axis interconnected to a drive (e.g. SINAMICS Integrated). Further options are available when "Use symbolic assignment" has been activated:

- A real axis is interconnected to an already configured drive
- A real axis including drive is created via the axis wizard and the drive interconnected to the axis
- A real axis is created without assigning this to a drive (assignment is made later)
6.7 Creating and testing axes

Inserting an axis

1. In the project navigator, double-click the entry "Axis" > "Insert Axis". This will access the axis wizard. Set the required technology and then click "OK".
2. Set an axis type and, if required, configure the units.

![Diagram](image)

**Figure 6-39 Defining the axis type**
3. Create a new drive or make the assignment to an existing drive.

The following setting options are available for the drive assignment:

- **Assign drive**
  Assigning a previously configured drive.

- **Define a subsequent assignment**
  The axis should not be assigned to a drive until a later point in time.

  In this way, the PLC and motion control functions can be completely configured by a programmer even without drive know-how using technology objects (e.g. TO axis) and loaded to the device, the drives can be configured and optimized separately by a drive expert, and the technology objects can be assigned symbolically later to the drive objects via an interconnection dialog box.

- **Create drive**
  From the assignment dialog box, a new drive can be created on an existing drive unit (e.g. S120 CU320-2 or SINAMICS Integrated) and assigned to the axis. This allows the axis, including the drive, to be created in one operation. It is not necessary to configure a drive before creating an axis.
6.7 Creating and testing axes

Set up addresses

The addresses must be set up manually if "Use symbolic assignment" has been deactivated. This corresponds to the previous methods of the drive and axis configuration, available in SCOUT versions < V4.2. This is required, for example, for drive units that do not support symbolic assignment (e.g. SINAMICS S120 with FW version < 2.6.2, MASTERDRIVES, SIMODRIVE, etc.).

The address list in the "All Addresses" view provides an overview of the assignments to all interfaces of the TO axis. From this view, the assignments can also be changed via the interconnection dialog box (button).

Note

The methods of the drive and axis configuration, previously available in SCOUT versions < V4.2, are still available. The symbolic assignment must be deactivated for these methods.

4. Run through the wizard and enter the settings of your system. The required axis message frames as well as the addresses used are automatically specified by the engineering system. Message frames are also extended and interconnections created automatically in the drive depending on the selected TO technology (e.g. SINAMICS Safety Integrated).
5. Click **Finish** to confirm the "Summary" window. The configured real axis is displayed in the project navigator.

![Axis configuration - Axis_1 - Summary](image)

**Note**

During system power-up, reference variables as well as drive and encoder data of the SINAMICS are automatically taken over for the SIMOTION configuration data of the SIMOTION technology objects "TO axis" and "TO externalEncoder".

**Encoder assignment**

With a position axis, encoder 1 is also created on the TO axis (motor encoder) and automatically assigned to the first encoder on the drive.

If encoder 2 (direct encoder) is created at the TO axis, it is assigned to the second encoder of the drive control.
Result

The configured axis will appear in the project navigator.

Save and compile the project and download it to the target system.

On completion of the axis wizard, the symbolic drive assignment is visible:

- Via the "configuration" of the axis
- Via the address list (view all addresses)

The assignment dialog box can be called again from these dialog boxes using the button.

Instead of calling the Assignment dialog, it is also possible to directly edit the input field containing the symbolic name.

Safety data block (SIDB) and technology data block (TDB)

The activation of

- The technology data block (for the cyclic exchange of technology data, e.g. actual torque value) and
- The safety data block (to support the SINAMICS Safety Integrated extended functions by the TO)

can be made in the Configuration of the TO Axis dialog box ("Change..." button below functions).

The assignment is always made to the drive DO of the actuator of the axis. The system automatically generates a message frame extension and the BICO interconnection of the relevant SINAMICS parameters.

Note

The safety data block (SIDB) is automatically configured by the engineering system and interconnected in the drive.

The PROFINet message frame must be configured by the user.

If the activation of the safety functions is to be made using PROFINet, configure the PROFINet communication to the higher-level SIMATIC F-CPU (see SINAMICS S120 Safety Integrated Function Manual).
I/O signals at the TO axis

For the assignment of I/O signals on the TO axis (e.g. the inputs for the homing output cam or hardware limit switches), call the assignment dialog box from the parameterization dialog boxes of the created TOs or from the address list (view of all addresses) by clicking the ...

See also

Downloading a project into the target system (Page 181)

For further information about the symbolic assignment, see the SIMOTION SCOUT Basic Functions Function Manual.

6.7.3 Testing the axis with the axis control panel

Axis control panel

The axis control panel is used exclusively for testing axes. You can use the axis control panel for the following tasks, for example:

- To test each part of the system individually before program-driven axis motions are initiated.
- In the event of an error, to test whether the individual axes and drives can be traversed from the axis control panel
- To traverse the axes for optimization purposes (controller optimization)
- To perform active homing
- To set and remove the axis enable
- To test an axis that has been created

Requirement

The following requirements must be fulfilled for testing:

- The project has been downloaded to the target system.
- SIMOTION SCOUT is in online mode.
- The mode selector switch is at STOPU.

Recommendation: Operate the mode selector switch via SIMOTION SCOUT only ("Target system" > "Control operating state").
Axis test

1. Open the AXES folder in the project navigator and click the "Control Panel" entry below the axis (for example, Axis_1).

   The axis control panel is displayed.

   ![Axis Control Panel](image)

2. To display the control range and axis diagnostics, click the "Show/hide control range" and "Show/hide diagnostics area" buttons.

3. Click "Assume control priority".

   If the CPU is in RUN state, confirm the prompt that appears with "Yes" to set the control to STOPU state.

   **Note**

   In order to move the axis from the PG/PC, you must assume control priority. However, by pressing the SPACER bar, you can stop the axis at any time.

   If you are using the axis control panel for a real axis, you must first activate the infeed for SINAMICS drives before the axis can be moved. The infeed must be activated before you enable the axis.

4. The "Assume Control Priority" dialog box is opened.

   Read the notes and confirm these with "Accept". The activated Service function is displayed via the LEDs (RUN flashes green at 2 Hz and SU/PF flashes yellow at 2 Hz)

5. To enable the axis, click the "Set/remove enable" button. Confirm the "Switch Axis Enable" dialog box with "OK".
6. To traverse the axis, click the "Position-controlled traversing of the axis" button.
7. Enter a velocity and close the dialog box by clicking "OK".
8. Click the "Start motion" button to traverse the axis. You can monitor the traversing motion under velocity and position. Use "Stop motion" to stop axis movement again.
9. To cancel the enable and switch off the infeed, click the "Set/remove enable" button. Confirm the "Remove Axis Enable" dialog box with "OK".
10. Click the "Give up control priority" button to deactivate axis control from the PG/PC. In this operating state, the axes can no longer be controlled from the PG/PC.
6.8 Activating the infeed (line module)

Requirement

Before a drive can be traversed, the infeed (line module) must be switched on and the "Closed-loop control operation" signal of the infeed must be present at the drives.

If this is not taken into account, this can result in a fault state, and in the worst case, damage to the infeed.

How the infeed is controlled and how the drives receive the Ready signal depends on the type of infeed used.

A distinction is made between:

- Infeeds without DRIVE-CLiQ connection
- Infeeds with DRIVE-CLiQ connection

6.8.1 Infeed without DRIVE-CLiQ connection

The infeed is controlled via terminals on the line module, e.g. DO Ready (DC link is precharged and pulse enable is set).

These terminals must be connected to the SIMOTION D4x5-2 (e.g. wire "DO Ready of the infeed" to "X122, DI 0 of the D4x5-2").

The enable signal is queried when the drive is configured and must be interconnected accordingly.
Figure 6-43  Interconnection of the "Infeed in operation" signal
6.8.2 Infeeds with DRIVE-CLiQ connection

The infeed is controlled via DRIVE-CLiQ. The infeed is switched on or off by the SIMOTION D4x5-2 via PROFIdrive message frame 370.

If "Use symbolic assignment" has been activated, message frame 370 is set automatically when setting standard/automatic (see Section Calling the drive wizard (Page 160)).

With message frame 370, the required BICO interconnections to the message frame are created automatically on the drive unit.

If an infeed with DRIVE-CLiQ connection has already been created, the infeed signal "Closed-loop control operation, r863.0" is automatically interconnected to "Infeed operation, p0864" of the drive when drives are inserted (only applies to drives that are attached to the same drive unit as the infeed).

The FB _LineModule_control function block is available on the controller for control and diagnostics of the infeed.

Note

Always create the infeed first so that the infeed "Closed-loop control operation" signal is automatically interconnected to a drive when this is inserted.

Recommendation: If the drive unit has not been configured, use "Configure drive unit" in the project navigator. "Configure drive unit" has the advantage that all basic settings for the drive unit are queried via one wizard.

FB _LineModule_control

The _LineModule_control function block (FB) can be used to switch the infeed on and off and also perform simple diagnostics.

The following infeeds are supported by the _LineModule_control function block:

- Basic Line Modules (BLM)
- Smart Line Modules (SLM)
- Active Line Modules (ALM)

The _LineModule_control FB is part of the command library of the "SIMOTION SCOUT" engineering system. You can find the FB at "Drives" > "SINAMICS".

For detailed information on the _LineModule_control FB, refer to the SIMOTION SCOUT online help or the Standard Function for SINAMICS S120 Line Modules Function Manual.

CX32-2

Further information on how to use line modules with the CX32-2 can be found in Section Interconnecting the infeed "Operation" signal on the CX32-2 (Page 204).

Additional references

For a detailed description of the control words and status words of the PROFIdrive message frames for SINAMICS S120 drives, see the SINAMICS S120 Commissioning Manual.
6.8 Activating the infeed (line module)

6.8.3 Using one infeed for several CUs

If the infeed is controlled from another control unit, then the Ready for operation signal of the infeed (parameter r0863.0) must be connected to parameter p0864 “Infeed operation” of the drive via a digital input/output. If this is not taken into account, the infeed may be damaged.

An interconnection of the Ready for operation signal via PROFIBUS/PROFINET is not recommended because of the delay times (communication, evaluation in controller, etc.).

For a CX32-2, the Ready for operation signal of an infeed on the SINAMICS Integrated can be simply interconnected to the drives of a CX32-2.

Further information on how to use line modules with the CX32-2 can be found in Section Interconnecting the infeed "Operation" signal on the CX32-2 (Page 204).
6.9 Setting up addresses and message frames

Overview

After all SINAMICS components have been configured, addresses must be determined for the process data exchange between the drive and the controller.

This procedure depends on whether symbolic assignments are used:

- With symbolic assignment, the addresses are determined automatically by the engineering system, see Section Setting up communication for symbolic assignment (Page 243).
- Without symbolic assignment, the determination of the addresses must be started manually, see Section Message frame configuration (Page 244).

6.9.1 Setting up communication for symbolic assignment

The communication for symbolic assignment is set up with the following actions:

- In the SCOUT menu (call "Project" > "Set up communication for symbolic assignment")
- At "Download project to target system"
- At "Save project and compile changes"

When setting up the communication, the message frames, BICO interconnections and addresses are set up for the entire project.

See also

Message frame configuration (Page 244)
6.9 Setting up addresses and message frames

6.9.2 Message frame configuration

Requirement

You have configured the drive unit.

On the basis of this configuration, one or more of the following actions should be performed:

- The automatic PROFIdrive message frame setting for a drive object should be activated/deactivated
- The automatic message frame extension for a drive object should be activated/deactivated
- The automatic address adaptation for a drive object should be activated/deactivated
- PROFIdrive message frames should be configured for drive objects
- The addresses should be set up
- Message frames should be extended manually

Procedure

Proceed as follows:

In the project navigator, open the "Communication" > "Message frame configuration" entry under "SINAMICS_Integrated".

The "SINAMICS Integrated - Message Frame Configuration" dialog box is displayed with the PROFIdrive PZD message frames tab.

The dialog box lists all the available drive objects. The possible setting options are described in the following.

When using the symbolic assignment, the default setting does not have to be changed and no configuration performed.
6.9 Setting up addresses and message frames

Figure 6-44  Message frame configuration
### 6.9 Setting up addresses and message frames

#### Table 6-9 Explanation of the figure

<table>
<thead>
<tr>
<th>Number</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| 1      | Selection of a message frame  
- The drive message frames (message frames 1 ... 6 and message frame 1xx) are defined in accordance with the PROFIdrive specification and can be selected based on the required functional scope.  
- You can transfer the signals of the I/Os or the global measuring inputs, for example, via the message frames 39x. Message frame 39x is also required for the time synchronization between SIMOTION and SINAMICS.  
- Free message frame configuration with BICO allows you to define your own message frame.  
- Free message frame configuration with p0915/p0916 (for TM15/17).  
- Message frames 37x for control of the infeed. |
| 2      | The "Standard/automatic" and "User-defined" settings are only visible if "Use symbolic assignment" is activated. Using the setting "Standard/automatic" is generally recommended. The "User-defined" setting allows the automatic message frame setting, message frame extension, and address adaptation to be deactivated or activated.  
- "Automatic PROFIdrive message frame setting" allows the message frame to be set by the system depending on the configured technology (message frame selection, e.g. for infeed, drive, and control unit incl. onboard I/O).  
- "Automatic message frame extension" allows the message frame to be extended by the system depending on the configured technology (e.g. if the technology data block is activated in the axis configuration).  
- "Permit automatic address adaptation" allows addresses to be adapted by the system in the case of address offsets, for example. Address offsets can occur, for example, if a message frame is extended and the adjacent addresses are already occupied by other message frames.  
With TM15/TM17 High Feature, "Automatic PROFIdrive message frame setting", "Automatic message frame extension", and "Automatic address adaptation" cannot be deactivated by design, since for these drive objects the message frame is always set up in accordance with the parameterized terminal functionality (DI, DO, output cam, measuring input) and cannot be extended.  
"Automatic PROFIdrive message frame setting" and "Automatic message frame extension" must be deactivated if the message frames are to be configured manually for TM15 DI/DO, TM31, and TB30 and interconnected with BICO.  
See Section Setting up communication for symbolic assignment (Page 243). |
| 3      | Message frame status  
| 4      | Length: Displays the size of the message frame component.  
Address: Address area in HW Config. The addresses will be displayed only after they have been set up.  
| 5      | Displays the SIMOTION object that is interconnected to the SINAMICS object (e.g. axis or encoder). |
### 6.9 Setting up addresses and message frames

<table>
<thead>
<tr>
<th>Number</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| 6      | Changing the message frame order  
**Note:** Before the alignment, all drive objects without I/O addresses ("---...--") must be moved behind the objects with valid I/O addresses or those still to be aligned ("???.???"). |
| 7      | "Manual" adaptation of the message frame configuration (e.g. when additional data, such as a motor temperature, is to be transferred via the message frame). |
| 8      | Display of the individual control and status words of the associated message frame. |
| 9      | Setting up the addresses (alignment of the addresses with HW Config)  
Only the addresses for the respective drive unit are determined (no automatic determination of message frames / BICO interconnections). |

**Note**

If symbolic assignment is deactivated, the following applies:

If the message frames for drive objects (drives, terminal modules, etc.) change, you must set up the addresses again. The addresses are not updated automatically.
6.10 Linking an additional encoder (optional)

6.10.1 Basic principles

Using encoders

In addition to a motor encoder, additional encoders can be linked and configured:

- Additional encoders on the drive
  - Encoders with DRIVE-CLiQ interface
  - Encoders connected to a CU310/CU310-2 or CUA32 via the onboard encoder interface
  - Encoders connected to SIMOTION D via an SMx module
- Additional encoders on SIMOTION D
  - Encoders connected via PROFIBUS
  - Encoders connected via PROFINET

Configuring additional encoders

The additional encoder can be used in SIMOTION, for example, as:

- Machine encoder (second encoder = direct measuring system)
  A direct measuring system measures the technological parameter directly, i.e. without the interference of influences such as torsion, backlash, slip, etc. This can facilitate improved smoothing of mechanical influences by means of the closed-loop control. If you use a second encoder as a machine encoder, you can work with the encoder changeover function.
- External encoder
  You can use the external encoder to record an external master value, for example.
- Encoder for hydraulic axes
- Encoders for the implementation of cam controllers
6.10.2 Additional encoders on the drive

The following options are available for configuring additional encoders on the drive:

- Configuration of a second encoder on the drive
- Configuration of an encoder as drive object (as of SINAMICS firmware V4.3)

The following options are available for configuring additional encoders on the drive.

Second encoder on the drive

The configuration of a second encoder on the drive is useful when the second encoder value is also to be used for this drive (e.g., motor or machine encoder). Note that only a maximum of two encoder values can be transferred via PROFIdrive message frames.

In principle, the second encoder value can be freely used (e.g. for acquisition of an external master value), however the use of an encoder as a separate drive object (drive object DO encoder) is preferable because of the clear functional separation.

![Image of encoder configuration](Figure 6-45 Configuration of a second encoder on the drive)
Encoder as drive object

The configuration of an encoder as drive object (drive object DO encoder) has the advantage that this encoder can be used independently of a configured drive (e.g. for acquisition of a master value).

The configuration is performed by inserting an encoder via the project navigator.

Note
In the same way as for axes, a "DO encoder" can also be symbolically interconnected to a "TO externalEncoder".

6.10.3 Additional encoders via PROFIBUS/PROFINET

Additional encoders can be connected via PROFIBUS or PROFINET. The following options are available for the encoder integration.

- Encoder interconnection using a PROFIdrive message frame (encoder with message frame type 81 and 83)
- Encoder interface as a direct value in the I/O area.

Additional references
Detailed information is contained in the SIMOTION TO Axis, Electric/Hydraulic, External Encoder Function Manual.
6.11 Symbolic assignment of I/O variables (PROFIdrive message frame / drive parameters)

6.11.1 Symbolic assignment of I/O variables to the PROFIdrive message frame of the TO axis

You can assign I/O variables from the address list which you require for display and diagnostic purposes, for example, to individual components (status word, for example) of the PROFIdrive message frame using the assignment dialog. Only components suitable for the data type of the I/O variable are displayed. If no data type is specified at the I/O variable, this is determined via the assignment partner after the selection.

![Assignment dialog](image)

Figure 6-47 Assignment of I/O variables to the PROFIdrive message frame
6.11 Symbolic assignment of I/O variables (PROFIdrive message frame / drive parameters)

6.11.2 Symbolic assignment of I/O variables to drive parameters

I/O variables from the address list can be assigned to drive parameters using the assignment dialog. Only parameters suitable for the data type of the I/O variable are displayed. If no data type is specified at the I/O variable, this is determined by the parameter selection.

An extension of the standard message frame is created automatically for the transfer of the parameters to/from the drive.

Procedure

1. Open the assignment dialog box from the address list (view of all addresses).
   The assignment dialog opens with the corresponding assignment partners.
2. Click the button in the parameter selection line to open the parameter list.

![Assignment dialog for drive parameters](image)

Figure 6-48 Assignment dialog for drive parameters
3. Select the desired signal source (e.g. DO drive). Then select the required parameter.

![Figure 6-49 Dialog box for the DO and parameter selection](image)

4. Click "OK" to accept the selection.
5. The desired SINAMICS parameter is assigned to the I/O variable in the interconnection dialog box.

![Image: Assigned drive parameters](image)

6. Click "OK" to accept the assignment.

The following table shows the possible types of assignment:

<table>
<thead>
<tr>
<th>Name of the assignment</th>
<th>Data type</th>
<th>Direction</th>
<th>Transferrable BICO parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>BICO_IW.&lt;parameter number&gt;</td>
<td>WORD</td>
<td>Input</td>
<td>All CO parameters (BICO source)</td>
</tr>
<tr>
<td>BICO_QW.&lt;parameter number&gt;</td>
<td>WORD</td>
<td>Output</td>
<td>All CI parameters (BICO sink)</td>
</tr>
<tr>
<td>BICO_ID.&lt;parameter number&gt;</td>
<td>DWORD</td>
<td>Input</td>
<td>All CO parameters (BICO source)</td>
</tr>
<tr>
<td>BICO_QD.&lt;parameter number&gt;</td>
<td>DWORD</td>
<td>Output</td>
<td>All CI parameters (BICO sink)</td>
</tr>
</tbody>
</table>

**Syntax of the assignment names**

- A number of parameters (separated by periods) are specified for outputs (SINAMICS side = received data) which can be interconnected with a number of BICO sinks.
- If the transferred parameter is on another drive object (DO), the DO name precedes the parameter. "#" is used as a separator between the DO name and the parameter.
- Individually transferred bits of a parameter appear in brackets [x].
6.12 Configuring drive-related I/Os (with symbolic assignment)

Overview

SIMOTION D4x5-2, the CX32-2 controller extension as well as the SINAMICS S110/S120 control units and additional components (TB30, TMs) have I/Os that can be used by the drive unit and SIMOTION.

So that I/Os, which were originally assigned to SINAMICS, can be used by SIMOTION, they must be interconnected to a message frame.

Symbolic assignment

As of version V4.2, SIMOTION SCOUT supports the symbolic configuration of I/Os. "Use symbolic assignment" must be activated for this purpose (see also Section Symbolic assignment / adaptation (Page 153)).

The symbolic assignment simplifies the configuration significantly:

<table>
<thead>
<tr>
<th>Table 6-10 Comparison of configuration with/without symbolic assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>With symbolic assignment</strong></td>
</tr>
<tr>
<td>Configuring message frames</td>
</tr>
<tr>
<td>BICO interconnections</td>
</tr>
<tr>
<td>Parameterization of the I/O functionality (e.g. measuring input)</td>
</tr>
<tr>
<td>Handling of I/O addresses</td>
</tr>
<tr>
<td>Setting up addresses</td>
</tr>
</tbody>
</table>

Only the configuration with symbolic assignment is described in the following. For further information on the configuration of drive-related I/Os without symbolic assignment, see Configuration of drive-related I/Os (without symbolic assignment) (Page 373).
Commissioning (software)

6.12 Configuring drive-related I/Os (with symbolic assignment)

Procedure

The configuration of the I/Os is divided into two basic steps:

1. Configuration of the I/O terminals (Page 257). The functionality of an I/O channel is configured (e.g. configuration of a DI/DO as digital output).

2. Configuration of the technology objects and I/O variables. (Page 262)
   The access of technology objects and I/O variables to I/Os is configured.
   The configuration is performed symbolically, whereby only "function-compatible" I/O channels are offered for selection.

   Example:
   For the TO measuringInput, only symbolic assignments of the type MI (measuring input) are offered for selection.

The required message frames and the interconnection are then set automatically by the engineering system.
6.12 Configuring drive-related I/Os (with symbolic assignment)

6.12.1 Configuration of the I/O terminals

The following table provides an overview of the configuration options for the I/O terminals of various modules.

<table>
<thead>
<tr>
<th>Module</th>
<th>Use of the I/Os by</th>
<th>Configuration of the I/O terminals</th>
<th>Supports symbolic assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMOTION D4x5-2</td>
<td>X ¹</td>
<td>• On the drive unit (CU)</td>
<td>As of SIMOTION V4.2</td>
</tr>
<tr>
<td>Terminal X122/X132, Terminal X142</td>
<td>X</td>
<td>• On the D4x5-2 (HW Config)</td>
<td></td>
</tr>
<tr>
<td>SIMOTION D4x5</td>
<td>X ¹</td>
<td>X</td>
<td>On the drive unit (CU)</td>
</tr>
<tr>
<td>CX32-2, CX32</td>
<td>X ¹</td>
<td>X</td>
<td>On the drive unit (CU)</td>
</tr>
<tr>
<td>SINAMICS S110 CU305</td>
<td>X ¹</td>
<td>X</td>
<td>On the drive unit (CU)</td>
</tr>
<tr>
<td>SINAMICS S120</td>
<td>X ¹</td>
<td>X</td>
<td>On the drive unit (CU)</td>
</tr>
<tr>
<td>• CU310</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• CU310-2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• CU320</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• CU320-2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TB30, TM15 DI/DO, TM31</td>
<td>X ¹</td>
<td>X</td>
<td>On the drive unit (TB30 or TM)</td>
</tr>
<tr>
<td>TM41</td>
<td>X ¹</td>
<td>X</td>
<td>On the drive unit (TM41)</td>
</tr>
<tr>
<td>TM15, TM17 High Feature</td>
<td>X</td>
<td>-</td>
<td>On the drive unit (TM15 or TM17)</td>
</tr>
<tr>
<td>TMC1x80 PN</td>
<td>X</td>
<td>-</td>
<td>On the TMC (HW Config)</td>
</tr>
</tbody>
</table>

¹ I/Os are originally assigned to a SINAMICS drive unit and can be assigned to SIMOTION via configuration
² TM41 supports symbolic assignment only for encoder interfaces (not symbolic assignment for DI, DO and AI)

Note

The module hardware for TM15 and TM15 DI/DO is identical. A distinction is only made when inserting the component in the SIMOTION SCOUT project navigator using "Insert I/O component".

I/Os that are originally assigned to the SINAMICS drive unit can also be used by SIMOTION via configuration:

- An output is always only exclusively available for the SINAMICS drive unit or SIMOTION.
- An input used by SIMOTION can also be interconnected on the drive side.
The configuration of the I/O terminals is described in detail in the following:

- Configuration of the D4x5-2 I/Os (terminal X122/X132) (Page 258)
- Configuration of the D4x5-2 I/Os (terminal X142) (Page 260)
- Configuration of the CX32-2/CU3xx/TB30/TMxx I/O terminals (Page 261)
- Configuration of the TMC I/O terminals (Page 261)

### 6.12.1.1 Configuration of the D4x5-2 I/Os (terminal X122/X132)

**Procedure**

The I/Os of terminals X122 and X132 are originally assigned to the drive unit. The configuration is therefore performed via the drive unit ("SINAMICS_Integrated" > "Control_Unit" > "Inputs/outputs").

Using the default settings as basis for further parameterizations, you can assign SIMOTION to all I/Os or SINAMICS to all I/Os.

The properties of the I/O channel can be configured in the parameterization dialog box. With the bidirectional digital I/Os, for example, an I/O channel can be:

- Parameterized as input or output.
- Inverted.
- BICO-interconnected (use as drive I/O).
- Used as digital input for SIMOTION with "DI (SIMOTION)".
- Used as digital output for SIMOTION with "DO (SIMOTION)".
- Used as global measuring input for SIMOTION with "Measuring input (SIMOTION)".

Figure 6-51  Configuration of the D4x5-2 I/Os (terminal X122/X132)
6.12.1.2 Configuration of the D4x5-2 I/Os (terminal X142)

Procedure

The I/Os of terminal X142 are permanently assigned to the SIMOTION D4x5-2. The configuration is therefore performed via the D4x5-2 (“D4x5-2” > “X142 inputs/outputs”). Alternatively, the dialog box can also be called in HW Config by double-clicking the X142 interface.

Addresses tab

The start address for the X142 I/Os can be set in the "Addresses" tab. The address can be specified or automatically assigned by the system.
Channel tab

The function of each individual I/O channel is set in the "Channel 0-7" tab. Possible functions:

- DI
- DO
- Output cam
- Measuring input

All I/O channels can be inverted. A filter time of 1 μs or 125 μs can also be set for digital inputs and measuring inputs.

The displayed logical address of a channel is only required when symbolic assignments are not used.

6.12.1.3 Configuration of the CX32-2/CU3xx/TB30/TMxx I/O terminals

The configuration is performed in a similar way as for the onboard I/Os X122/X132 for the SIMOTION D4x5-2, i.e. the I/Os can be

- BICO-interconnected (use as drive I/O)
- Used by SIMOTION

See also Section Configuration of the D4x5-2 I/Os (terminal X122/X132) (Page 258)

Note

If symbolic assignment is activated retrospectively for a project in which message frames have already been configured and interconnected, these can be changed together with the BICO interconnections.

For this reason, make a backup copy of your project before activating the symbolic assignment.

TB30, TM15 DI/DO and TM31 are especially affected.

See also Section Symbolic assignment / adaptation (Page 153)

6.12.1.4 Configuration of the TMC I/O terminals

The configuration is performed in a similar way as for the onboard I/Os X142 for the SIMOTION D4x5-2.

The functionality of the I/O channels is configured via HW Config.

For details, see

- SIMOTION Terminal Compact Modules Manual
- SIMOTION Terminal Compact Modules Commissioning Manual
6.13 Configuration of the technology objects and I/O variables

6.13.1 Configuration of global measuring inputs

Overview

The type of measuring input must be selected during the configuration of the TO measuringInput. The following measuring input types are available:

Table 6-12 Measuring input types

<table>
<thead>
<tr>
<th>Measuring input types</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard (global measuring input)</td>
<td>Compared with the drive-related local measuring inputs, global measuring inputs have extended functionality and also support a symbolic configuration. They are therefore set as standard.</td>
</tr>
<tr>
<td>Drive-related (local measuring input)</td>
<td>The drive-related local measuring inputs are configured via drive parameters, see Section Configuration of drive-related I/Os (without symbolic assignment) (Page 373) (in the appendix).</td>
</tr>
<tr>
<td>Listening measuring input</td>
<td>Through the configuration of a listening measuring input, measuring can be performed simultaneously on several axes or external encoders with one measuring input. Detailed information can be found in the SIMOTION Motion Control Output Cams and Measuring Inputs Function Manual.</td>
</tr>
</tbody>
</table>

A detailed comparison of "local" and "global" measuring inputs as well as an overview of which modules support local or global measuring inputs can be found in the appendix in Section Configuration of drive-related I/Os (without symbolic assignment) (Page 373).

Procedure

If a global measuring input is selected, it must be assigned a hardware input.

To do this, open the assignment dialog box via \(\text{assignmentDialogBox}\) and select a free (i.e. not yet used) I/O.

Note

Only those I/Os are displayed that have the appropriate measuring input functionality (MI_xx [channel name, terminal number]). If no suitable I/Os are displayed, you must first configure the I/Os (I/O must be configured as "measuring input")
6.13 Configuration of the technology objects and I/O variables

6.13.2 Configuration of local measuring inputs

Local measuring inputs are drive-related measuring inputs. The configuration is performed via drive parameters.

For further details, see:

- Section Configuration of drive-related I/Os (without symbolic assignment) (Page 373) in the appendix
- SIMOTION Output Cams and Measuring Inputs Function Manual
6.13.3 Configuration of output cams / cam tracks

Overview

The type of cam output must be selected during the configuration of the TO outputCam and TO camTrack.

The following output types are available:

<table>
<thead>
<tr>
<th>Cam output on ...</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cam output (CAM)</td>
<td>The cam output is performed on the basis of an internal time stamp. The temporal resolution of the cam output depends on the hardware used.</td>
</tr>
<tr>
<td></td>
<td>Supported hardware:</td>
</tr>
<tr>
<td></td>
<td>• SIMOTION D4x5-2 (terminal X142): Resolution 1 μs</td>
</tr>
<tr>
<td></td>
<td>• TM17 High Feature: Resolution 1 μs</td>
</tr>
<tr>
<td></td>
<td>• TM15: Typical resolution 125 μs (DRIVE-CLiQ cycle clock)</td>
</tr>
<tr>
<td></td>
<td>• D410-2 (DI/DO 8 to 15):</td>
</tr>
<tr>
<td></td>
<td>Typical resolution 125 μs</td>
</tr>
<tr>
<td>High-speed digital output (DO)</td>
<td>The cam output is performed via onboard outputs of the SIMOTION CPU. The output is via a hardware timer and the cam output is achieved with a resolution with respect to time &lt; servo cycle.</td>
</tr>
<tr>
<td></td>
<td>Supported hardware:</td>
</tr>
<tr>
<td></td>
<td>• SIMOTION D4x5 (terminal X122, X132)</td>
</tr>
<tr>
<td></td>
<td>• SIMOTION D410 (terminal X121)</td>
</tr>
<tr>
<td></td>
<td>• SIMOTION C240, C240 PN (terminal X1)</td>
</tr>
<tr>
<td>Standard digital output (DO)</td>
<td>The output cam calculations are performed in the processing cycle (IPO or IPO2 cycle or in the servo cycle).</td>
</tr>
<tr>
<td></td>
<td>The actual cam output is performed in the servo cycle. The resolution with respect to time of the cam output is generally reduced by the output cycle of the I/O used.</td>
</tr>
<tr>
<td></td>
<td>The resolution is therefore dependent as follows:</td>
</tr>
<tr>
<td></td>
<td>• For the standard I/O (e.g. TMC, ET 200), on the cycle time of the bus system (PROFIBUS DP / PROFINET IO)</td>
</tr>
<tr>
<td></td>
<td>• For the TM15 / TM17, on the cycle time of the bus system (PROFIBUS Integrated / PROFIBUS DP / PROFINET IO)</td>
</tr>
<tr>
<td></td>
<td>• For the TM15 DI/DO, TM31, TM41, TB30, on the configured sampling time:</td>
</tr>
<tr>
<td></td>
<td>– cu.p0799 (CU inputs/outputs sampling time) for the TB30 and onboard outputs</td>
</tr>
<tr>
<td></td>
<td>– p4099 (TMxx inputs/outputs sampling time) for TM15 DI/DO, TM31 and TM41</td>
</tr>
<tr>
<td></td>
<td>Supported hardware:</td>
</tr>
<tr>
<td></td>
<td>• Onboard outputs (SIMOTION D, controller extension CX, SINAMICS control unit CU3xx)</td>
</tr>
<tr>
<td></td>
<td>• Centralized I/O (SIMOTION C)</td>
</tr>
<tr>
<td></td>
<td>• Distributed I/O via PROFIBUS DP / PROFINET I/O (e.g. TMC, ET 200, etc.)</td>
</tr>
<tr>
<td></td>
<td>• Drive-related I/O (TM15, TM15 DI/DO, TM17 High Feature, TM31, TM41, TB30)</td>
</tr>
</tbody>
</table>
Procedure

To achieve the best possible output cam resolution on the onboard I/Os of a SIMOTION D4x5-2, activate the output and select "Cam output on cam output (CAM)".

Then assign a hardware output. To do this, open the Assignment dialog box via and select a free (i.e. not yet used) I/O.

Note

Only those I/Os are displayed that have the appropriate output cam functionality (CAM_xx [channel name, terminal number]). If no suitable I/Os are displayed, you must first configure the I/Os (I/O must be configured as "output cam (CAM)")

A maximum of two edges can be output per processing cycle clock of TO outputCam or TO camTrack.

Detailed information on the configuration of the TO outputCam / TO camTrack can be found in the SIMOTION Output Cams and Measuring Inputs Function Manual.
6.13.4 Configuration of the I/Os (variables / TO axis)

You have two ways to assign an I/O variable to I/O terminals:

- Assignment via preferred interconnection (e.g. DI_0 [DI 0, X122.1])
  To do this, you must use the SIMOTION preferred interconnection for the corresponding input/outputs of the SINAMICS DOs. The BICO interconnection is performed automatically.

- Assignment via PZD (e.g. via DI_0_15 or DO_0_15).
  Note that for these signals a message frame of the appropriate length is generated, but the BICO interconnection is not performed.

Interconnection via preferred interconnection

The I/O variables are configured via the address list. Components that support a symbolic assignment can be configured without I/O addresses.

Preferred interconnections are displayed as assignment targets in the Assignment dialog box (e.g. DI_0 [DI 0, X122.1]). The assignment is made by direct selection of the corresponding terminal signal.

Components that do not support symbolic assignment (e.g. standard PROFIBUS I/O) are configured via I/O addresses.

Figure 6-55 Address list
Interconnection via PZD

In principle, an assignment via the PZD is also possible (e.g. via DI_0_15 or DO_0_15). Note that for these signals a message frame of the appropriate length is generated, but the BICO interconnection is not performed.

For this purpose, switch to the "Communication" dialog box of the corresponding SINAMICS DO. You can now see the individual bits of the PZD (e.g. I_Digital or O_Digital) listed there. Interconnect the appropriate bit of the PZD with a signal.

Alternatively, you can assign SIMOTION to an I/O channel during the terminal configuration (e.g. by selecting "DI (SIMOTION)", see Section Configuration of the D4x5-2 I/Os (terminal X122/X132) (Page 258)).

TO axis

The symbolic assignment of I/Os is also supported by the TO axis (e.g. for a HW limit switch).

Substitute values for I/O variables

Substitute values cannot be specified for input variables of the BOOL data type. If you do require substitute values however, proceed as follows:

1. Assign a digital input (e.g. SINAMICS_Integrated.Control_Unit.DI_0 [DI 0, X122.1]) to an input variable of the BOOL type (e.g. sensor).
2. Create a global variable (e.g. all_inputs) (at least data type WORD, e.g. SINAMICS_Integrated.Control_Unit.DI_0_15).
3. Configure the substitute value.
   The appropriate bit of the substitute value must then contain the substitute value for the BOOL variable.
   In the same way, you can assign a substitute value to a BICO parameter.

For various SINAMICS drive objects, higher-level types are available for the assignment of substitute values.

Figure 6-56 Configuration of substitute values
6.14 DMC20/DME20 DRIVE-CLiQ hub

6.14.1 Hub properties

DRIVE-CLiQ hub characteristics

The DMC20 and DME20 DRIVE-CLiQ hub modules are used to implement point-to-point distribution of a DRIVE-CLiQ line. With the DMC20/DME20, an axis grouping can be expanded with four DRIVE-CLiQ sockets for additional subgroups.

- DMC20 is the hub for the control cabinet configuration
- DME20 is the hub for use without a control cabinet (IP67 degree of protection).

The modules are especially suitable for applications which require DRIVE-CLiQ nodes to be removed in groups, without interrupting the DRIVE-CLiQ line and therefore the data exchange.

Application examples

Typical applications of DRIVE-CLiQ hubs are encoder expansion and hot plugging.

- In an encoder expansion, direct measuring systems are connected. For example, these are attached directly to the machine in the control cabinet. Several encoders can be connected to one hub in the cabinet.

- Hot plugging is the option for changing motor modules while in operation. To do so, the motor modules are connected via a DRIVE-CLiQ hub in the form of a point-to-point topology. This means they can be deactivated without impairing downstream components (via cascading).

Note

Cascading is permitted one time only (from hub to hub).

Additional references

Additional information on the DMC20/DME20 DRIVE-CLiQ is contained in the

- SIMOTION D4x5-2 Manual
- SINAMICS S120 Control Units and Supplementary System Components Manual
6.14.2 Creating a DMC20/DME20 DRIVE-CLiQ hub

Introduction
A DMC20/DME20 can be inserted directly in the project navigator. The hub is not wired when you insert the DMC20/DME20 and is displayed in the topology tree in the component storage. The hub has to be wired manually.

Procedure
1. Right-click "Topology" in the project navigator.
2. Select the "Insert new object" > "DRIVE-CLiQ hub" command from the context menu and confirm with "OK".
3. Double-click "Topology" to display the topology tree.
   In the topology tree, the hub is stored in the component archive.
4. Drag-and-drop the hub to the required DRIVE-CLiQ interface.
   The components connected to the hub are displayed in the topology tree.

Result
The added hub is displayed for the "Topology" entry in the project navigator. All components connected to a hub are also displayed during an automatic configuration.
6.15 TM41 terminal module

6.15.1 Overview

The TM41 terminal module can be used to expand the number of digital I/O and of analog inputs within a drive system. TM41 also returns TTL signals which emulate an incremental encoder, for example, for a master control system.

The emulated encoder signal has the signal characteristic of an incremental TTL encoder (A track, B track, R track). The resolution of the encoder signal can be specified in the configuration.

Note

The digital inputs/outputs and the analog input can be interconnected via BICO configuration.

The TM41 encoder interface (incremental encoder representation) can

- Be interconnected with an encoder signal of the control unit by means of parameterization, e.g. sin/cos incremental encoders. For detailed information, see the SINAMICS manuals.
- From the SIMOTION viewpoint, be accessed as axis. This allows you to return the axis position (a master value) as an encoder signal to a second controller, for example. The configuration can be performed symbolically and is described in the following.

Note

TM41 only supports the symbolic assignment for the encoder interface (no symbolic assignment for the DI, DO and AI).

Configuring the TM41 involves the following steps:

- Configuring the TM41 at SINAMICS Integrated
- Configuring the TM41 using the axis wizard
**6.15.2 Configuring TM41 at SINAMICS Integrated**

TM41 can be configured after you completed the configuration of SINAMICS Integrated. Proceed as follows:

1. Double-click "Insert input/output component" at "Input/output component" in the project navigator.
2. Select TM41 from the "Drive object type" field of the "Insert Input/Output Component" dialog box and assign a unique name to the module.
3. Confirm your entry with "OK".
   
   The TM41 is inserted in the project navigator by the name you entered.
4. Double-click "Inputs/outputs". The "Inputs/Outputs" property dialog box of TM41 opens.
5. Set "SIMOTION" as the operating mode on the "Pulse encoder emulation" tab, and make the settings for the emulated sensor signal.
6. Double-click "Configuration" under "SINAMICS_Integrated" in the project navigator and select the "PROFIdrive message frame" tab.
7. Click "Close" to exit the dialog box.

You have now programmed the TM41 and aligned it with HW Config.
6.15.3 Configuring the TM41 using the axis wizard

After configuring the TM41 for a SINAMICS Integrated device in the project navigator, you can interconnect it with an axis using the Axis Wizard. The Wizard implements the TM41 as drive device.

1. Open the Axis Wizard and create a position or following axis (electrical).
2. Step the Axis Wizard forward until the "Drive Assignment" dialog box opens.
3. Select "SINAMICS_Integrated" as the drive device and "TM41" as the drive. TM41 operates as setpoint sink of the axis with this setup.

4. Run through the wizard to the end.

Detailed information on configuring incremental encoder emulation with the TM41 can be found in:

- SIMOTION Utilities & Applications

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.
6.16 Optimizing the drive and controller

6.16.1 Overview of automatic controller setting

Overview

For the controller optimization of the drive, SIMOTION SCOUT offers a wizard for the automatic controller setting.

In the "Automatic Controller Setting" screen form, you can configure an automatic setting for the speed controller and the DSC (dynamic servo control) position controller for SINAMICS drive units. The necessary steps for this calculation can be controlled from this screen form. The parameter values calculated for the speed controller or position controller are displayed; these can then be transferred online to the drive or axis on the controller.

You can set the controller automatically using the menu command "Target system" > "Automatic controller setting".

For a detailed description of the parameters that can be defined, to the SIMOTION SCOUT Online Help.

Requirements

- You have configured a SINAMICS drive.
- The configured drive is operated in the "Servo" drive object type.
- Closed-loop control takes place with the motor encoder.
- There is an online connection to the relevant drive unit.

Procedure

Automatic controller setting involves the following steps:

1. Setting the speed controller
2. Setting the position controller

Note

You can cancel the automatic controller setting by pressing the SPACEBAR.

- The step currently being executed is aborted.
- The drive enable is canceled.
6.16 Optimizing the drive and controller

Additional references

Information on the controller structure can be found in the SIMOTION TO Axis, Electric/Hydraulic, External Encoder Function Manual.

In addition to automatic controller setting, SIMOTION SCOUT also offers the option of optimizing the drive and controller manually by means of measuring functions, trace and function generator (see Sections Measuring functions, trace, and function generator (Page 277) and Manual speed controller optimization (Page 278)).

6.16.2 Automatic speed controller setting

Characteristics

The automatic speed controller setting has the following features:

- Attenuation of resonances in the speed-controlled system
- Automatic setting of the Kp gain factor and the Tn reset time of the speed controller
- The speed setpoint filter and the reference model are not changed.

Procedure

To perform an automatic setting of the speed controller, proceed as follows:

1. Select the "Target system" > "Automatic controller setting" menu command.
2. Select the drive unit and the drive.
3. Select the "Speed controller" from the "Controller Selection".
4. Click "Assume control priority" to assume control priority.
5. Click the "Drive on" button to enable the drive.
   Perform these steps (1 to 4) in automatic mode or as individual steps.
6. Click "Transfer" to transfer the calculated parameter values for the speed controller to the drive.
7. Disable the drive by clicking the "Drive Off" button.
8. Click "Give up control priority" to give up control priority of the PG/PC.
9. Save the online parameters.

You can now transfer the automatically set parameters to the project.
6.16 Optimizing the drive and controller

**Backing up parameters**

Proceed as follows to back up the parameters:

1. In the project navigator, select the SINAMICS unit with the drive for which you want to perform the automatic setting.
2. Select "Target device" > "Copy RAM to ROM" in the context menu.
3. Select "Target device" > "Load CPU / drive unit to PG" in the context menu.

If required, the automatic controller settings can be checked using the measuring functions.

### 6.16.3 Automatic position controller setting

**Introduction**

In the "Automatic Controller Setting" screen form, you can select the SINAMICS drive unit and the drive for which you want to carry out an automatic DSC position controller setting. The necessary steps for this calculation can be performed from this screen form. The calculated Kv value is displayed and can then be accepted online in the configuration data of the axis that is assigned to the drive.

**Requirements**

In addition to the General requirements for the automatic controller setting, the following boundary conditions apply for setting the position controller:

- DSC is required for the position controller setting.
  
  **Tip:**
  
  Activate the project setting "Use symbolic assignment" and select the Standard/Automatic option for the axis-drive communication when configuring the drives. You automatically use DSC for the servo drives with these settings.

- The speed controller has already been configured (e.g. with the automatic speed controller setting).

- At least one axis is connected to the SINAMICS drive (servo).

- An online connection to the SIMOTION device must be established to transfer the results of the automatic position controller setting.

- The balancing filter is not changed.

- For operation without precontrol, the equivalent time constant of the position controller must be adjusted manually by the user (PositionTimeConstant = 1/Kv).

- Vibration on the load side is not taken into account for the position controller setting.
To perform an automatic setting of the position controller, proceed as follows:

1. Select the "Target system" > "Automatic controller setting" menu command.
2. Select the drive unit and the drive (axis).
3. Select the "Position controller (DSC)" from "Controller selection".
4. Click "Assume control priority" to assume control priority.
5. Click the "Drive on" button to enable the drive.
   Perform the steps either in automatic mode or as individual steps.
6. Select the axis data sets to which the Kv factor is to be transferred.
7. Click "Accept values" to transfer the calculated Kv factor to the axis data sets.
8. Disable the drive by clicking the "Drive off" button.
9. Give up the control priority of the PG/PC.
10. Save the online parameters.

You can now transfer the automatically set parameters to the project.

Proceed as follows to back up the parameters:

1. In the project navigator, select the SIMOTION unit with the axis for which you want to perform the automatic setting.
2. Select "Target device" > "Copy current data to RAM" in the context menu.
3. Select "Target device" > "Copy RAM to ROM" in the context menu.
4. Select "Target device" > "Load CPU / drive unit to PG" in the context menu.

If required, the automatic controller settings can be checked using the measuring functions.
6.16 Optimizing the drive and controller

6.16.4 Measuring functions, trace, and function generator

Drive optimization

Drive optimization is part of commissioning and can be performed with SIMOTION SCOUT.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller optimization may only be performed by skilled personnel with control engineering knowledge.</td>
</tr>
</tbody>
</table>

Controller optimization

Various measuring functions are available for controller optimization of the drive. These measuring functions enable the control of the higher-level control loop to be selectively switched off and the dynamic response of individual drives to be analyzed through simple parameter assignment. The function generator and the trace recorder are used.

The control loop is supplied with the ramp-function generator signal at a specific point (e.g. speed setpoint), and the signal from the trace recorder is recorded at another point (e.g. speed actual value).

![Figure 6-58 Optimizing a controller](image)

Depending on the form of controller optimization to be performed, it is possible to define the quality (e.g. signal form, amplitude, transient recovery time) of the disabled signal, the measuring duration for step functions in the time range, or the bandwidth and number of averaging operations in the frequency range for the trace. The analytical and graphical evaluation can then be performed accordingly (FFT diagram, Bode diagram).
The following measuring functions are available:

- Setpoint step-change at current controller
- Reference frequency response at current controller
- Setpoint step-change at speed controller
- Disturbance step-change at speed controller
- Reference frequency response at speed controller
- Disturbance frequency response at speed controller
- Speed-controlled system (input at current setpoint filter)

Additional references

For additional information about drive optimization, consult the *SINAMICS S120 Commissioning Manual.*

Additional information on trace and measuring functions, as well as on the function generator, can be found in the *SIMOTION SCOUT Online Help.*

### 6.16.5 Manual speed controller optimization

**Requirement**

You have already created a project and configured an axis and a drive. You can now optimize the speed controller.

**Procedure**

1. Open the project and go to online mode.
2. Click $\mathbb{F_1}$ to call the "Measuring Functions" dialog.
3. Select the drive unit and the drive.
4. Select "Speed controller setpoint jump". You can change the values in the following fields: "Settling time", "Amplitude", "Offset", "Ramp-up time" and "Measuring time".

![Speed controller measuring function](image)

Figure 6-59 Speed controller measuring function

Four channels can be traced. Certain channels are preassigned, depending on the measuring function.

5. Download the changes to the drive by clicking (Download parameter assignment).

**Starting the measuring function**

1. Click "Assume control priority" to assume control priority.

   Read the notice that appears and click "Accept" to confirm. The activated Service function is displayed via the LEDs (RUN flashes green at 2 Hz and SU/PF flashes yellow at 2 Hz).

2. Click the "Drive on" button to enable the drive.

3. Click (Start measuring function) to start the measuring functions.

   The axis is moved during the measurement. For this reason, a safety message that allows the process to be aborted is displayed.

4. The traced signals are represented on the "Time diagram" tab.
Figure 6-60  Time diagram before parameter change
Adjusting the P-gain

You can adjust the P-gain of the controller to optimize the transient response.

1. In the project navigator under the corresponding drive, for example, Servo_1, use the menu command "Open-loop/closed-loop control" > "Speed controller" to display the "Speed Controller with Encoder" dialog box.

2. Enter an appropriate value in the "P-gain" field and the "Integral time" field.

CAUTION

The values entered take immediate effect.

3. For verification purposes, perform the measurement again.

4. With the modified parameters, the controller displays a much better transient response. If necessary, you can continue changing the value until the transient response is optimal.
6.16 Optimizing the drive and controller

Figure 6-62 Measurement with modified P-gain
6.17 Loading and saving SIMOTION user data

Overview

After commissioning the SIMOTION D4x5-2, we recommend that you back up the user data (programs, configuration data and parameter assignments) on the CompactFlash card.

Loading user data

The menu command "Target system" > "Load" > "Download project to target system" is used to transfer the following data from the SIMOTION SCOUT engineering system to the "non-volatile SIMOTION data" area of the SIMOTION D4x5-2:

- Configuration data
- Programs
- Parameterization
- Technology packages

The hardware configuration of the SIMOTION D4x5-2 and the retain variables are also stored in the "non-volatile SIMOTION data" area.

Note

Using the menu:

- "Target system" > "Load" > "Load project to target system" downloads all of the project data to the target system.
- "Target system" > "Load" > "Download CPU / drive unit to target device" only downloads the data of the selected device / drive element to the target device.

After the SIMOTION D4x5-2 is switched off, the contents of the "volatile SIMOTION data" area are lost.

Additional information on the SIMOTION SCOUT Engineering System can be found in the SIMOTION SCOUT Configuration Manual.

Saving user data

The "Copy RAM to ROM" function is used in SIMOTION SCOUT to save the following data from the RAM to the CompactFlash card:

- Technology packages and user data (units, configuration data, parameter assignments, task configuration) from the "volatile SIMOTION data" area
- Current data values are copied to the "volatile SIMOTION data" area, depending on the settings in SIMOTION SCOUT.

Note

The "Copy RAM to ROM" command cannot be used to save the current values of retain variables to the CompactFlash card.
You have the following options for backing up the current values of retain variables to the CompactFlash card:

- **User program**
  
  Use the **_savePersistentMemoryData** system function in the user program.

- **Backup with the Service selector switch or DIAG button on the SIMOTION D4x5-2 or via IT DIAG**: See Section Backing up diagnostics data and non-volatile SIMOTION data using IT DIAG (Page 370).

With the SCOUT functions "Save variables" and "Restore variables", you also have the option of backing up and restoring data, which was changed during operation and only stored in the runtime system, on your PC.

Execute the "Copy RAM to ROM" function separately for the SINAMICS Integrated. This requires that the drive element has been selected in the project navigator.

**See also**

Properties of the user memory (Page 90)
6.18 Deleting data

6.18.1 Overview of data deletion

The SIMOTION D4x5-2 memory described in the "user memory concept" can be deleted in various graduations. This enables you to determine whether data in your system should be deleted completely or partially.

You have the following options for deleting SIMOTION D4x5-2 data:

- Memory reset of SIMOTION D4x5-2 (Page 285)
- Deleting user data on CompactFlash card (Page 288)
- Setting SINAMICS Integrated to the factory settings (Page 289)
- Setting SIMOTION D4x5-2 to the factory settings (Page 289)
- Deleting/restoring non-volatile SIMOTION data (Page 368)
- Backing up / restoring / deleting SINAMICS NVRAM data (Page 217)

6.18.2 Memory reset of SIMOTION D4x5-2

Introduction

During the memory reset, the memory of the SIMOTION D4x5-2 and the non-volatile SIMOTION data in the NVRAM with the exception of the communication configuration (baud rates, network addresses, etc.), are deleted. The data on the CompactFlash card is retained during the memory reset.

You must perform a memory reset of SIMOTION SIMOTION D4x5-2:

- If you want to undo changes made to user data (programs, configuration data, parameter assignments) which you have not backed up by means of the "Copy RAM to ROM" command.

- If the STOP LED is flashing (slow flashing, yellow) to indicate that the SIMOTION D4x5-2 is requesting a memory reset.

- If the non-volatile SIMOTION data and the project on the CompactFlash card do not match and an error occurs (diagnostic buffer entry).

You can perform the memory reset online via SIMOTION SCOUT or offline via the mode selector switch on the SIMOTION D4x5-2.
Data deleted on memory reset

The following data is deleted during a memory reset:

- User data (units, configuration data, parameter settings, task configuration)
- Technology packages
- Retain TO (absolute encoder adjustment)
- Retain variables

Retain variables are variables in the interface or implementation section of a UNIT that are declared with VAR_GLOBAL RETAIN or global device variables with the RETAIN attribute.

**Note**

Absolute encoder data is deleted during a memory reset and must, therefore, be readjusted after the memory reset.

Data retained during memory reset

The following data is retained during a memory reset:

- TCP/IP parameters and DP parameters
- Diagnostic buffer
- Data saved with the _savePersistentMemoryData, _saveUnitDataSet or _exportUnitDataSet system functions and with the "Copy RAM to ROM" function

If backup files (PMEMORY.XML/PMEMORY.BAK) have been backed up with _savePersistentMemoryData, the data in these files is backed up again to the non-volatile SIMOTION data after the memory reset. Users can therefore force the restoration of non-volatile SIMOTION data by means of memory reset. This also includes the absolute encoder position.

- Licenses
- SINAMICS NVRAM data

The technology packages and user data (configuration data, programs, parameter assignments) that were previously backed up on the CompactFlash card using the "Copy RAM to ROM" menu command will be transferred to the "non-volatile SIMOTION data" area of the SIMOTION D4x5-2 during the next power-up. Thus, an existing configuration on the CompactFlash card is loaded to the SIMOTION device following the memory reset.
Memory reset via SIMOTION SCOUT

You can only perform a memory reset via SIMOTION SCOUT when you are online with the SIMOTION D4x5-2.

1. Select the SIMOTION D4x5-2 in the project navigator of SIMOTION SCOUT.
2. Select "Target device" > "Operating state" in the context menu to open the "D4x5-2: Operating State" dialog box.
3. Select the STOP operating state.
4. Then select MRES operating state to perform the memory reset.

Memory reset with the mode selector switch

You can perform a memory reset with the mode selector switch when you are offline with the SIMOTION D4x5-2.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always use an insulated screwdriver to activate the mode selector switch. Otherwise, static electricity can destroy the switch.</td>
</tr>
</tbody>
</table>

Proceed as follows to reset the memory:

1. Place the mode selector switch in the STOP position (switch setting 2, see figure below).

![Service selector switch](image1)

![Mode selector](image2)

Figure 6-63 Memory reset with the mode selector switch (position 2 = STOP)

2. When the STOP LED is steadily yellow, turn the switch to the MRES position (switch position 3). The STOP LED starts to flash slowly (slow yellow flashing).

   Wait until the STOP LED stops flashing.

3. Turn the selector back to the STOP setting.
4. You must turn the selector back to the MRES position again within 3 seconds. The memory reset will now be performed.

The SIMOTION D4x5-2 has completed the memory reset when the STOP LED is steadily yellow.

Note
If you do not return the mode selector switch to the MRES position (switch position 3) within three seconds, but take longer, then the memory reset may not be performed. You must then repeat the procedure.

5. Now move the mode selector switch back to the required operating mode.

NOTICE
Note that the MRES position (switch position 3) during power-up causes the factory settings to be restored. See Section Setting SIMOTION D4x5-2 to the factory settings (Page 289).

Make sure you do not accidentally switch the power supply OFF/ON in the MRES selector setting, as this restores the factory settings instead of performing the desired memory reset.

6.18.3 Deleting user data on CompactFlash card

Overview
Deletion of the user data from the CompactFlash card is necessary, for instance, if you wish to load another (new) project to the CompactFlash card and therefore find it necessary to delete the existing user data for an old project (e.g. unit data sets) from the CompactFlash card.

You can delete the user data with SIMOTION SCOUT. This requires you to go online on the SIMOTION D4x5-2. The following data is deleted:

- User data from the "volatile data" area
- Non-volatile data, with the exception of IP and DP parameters
- User data on the CompactFlash card (user directories), including the SINAMICS configuration

You can thus continue to go online to the SIMOTION D4x5-2 with your PG/PC. The licenses on the CompactFlash card are retained.
Deleting user data

1. Open the project you want to edit in SIMOTION SCOUT.
2. Go online with the SIMOTION D4x5-2.
3. Select the SIMOTION D4x5-2 in the project navigator and select the "Delete user data on card" option in the "Target system" menu.
4. Confirm the "Delete user data on card" prompt with "OK".
   The user data is deleted and the SINAMICS Integrated goes offline.

6.18.4 Restoring the default settings of SINAMICS Integrated

Requirement
You must be online to SINAMICS Integrated in order to restore its factory settings.

Restoring the factory settings

1. Right-click "SINAMICS_Integrated" in the project navigator.
2. Select the "Target device > Restore factory settings" command from the context menu.
   This restores the delivery state of SINAMICS Integrated.

Note
Use the same procedure for the CX32-2 controller extension and the SINAMIC S120 drive units.

6.18.5 Setting SIMOTION D4x5-2 to the factory settings

Overview
SIMOTION D4x5-2 is supplied with preset parameters, such as the transmission rate or PROFIBUS addresses. You can restore the factory settings with the mode selector switch.

The following data is deleted:

- Non-volatile SIMOTION data in the SIMOTION device
- The backup copy of non-volatile SIMOTION data on the CompactFlash card (PMEMORY.XML/PMEMORY.BAK)
- User data in the "volatile SIMOTION data" area and on the CompactFlash card
- The communication configuration (IP and DP parameters) on the CF card is set to the factory settings.

The licenses on the CompactFlash card are retained.
Commissioning (software)

6.18 Deleting data

Restoring factory settings with the mode selector switch

1. The power supply is switched off.
2. Set the mode selector on the SIMOTION D4x5-2 to MRES (switch position 3).
3. Switch on the power supply.
   The NVRAM and the SIMOTION user data is deleted. The factory settings are loaded.
   SIMOTION D4x5-2 remains in STOP mode.
4. Now use the mode selector switch to change to the desired operating state.

Note
The communication parameters are now reset to the factory settings (PROFIBUS address 2, baud rate of 1.5 Mbit/s). The communication configuration for SIMOTION D4x5-2 must be performed again. The existing IP settings for the CBE30-2 are not restored to the factory settings.
### 6.19 Powering down the system

If you wish to shut the system down, you must ensure that all axes and system parts are set to a safe state. You can set this up by providing a separate motion task, for example.

Once the system is at a standstill, you can switch off the power supply.

**Note**

You must observe the safety notes for SINAMICS components, which you will find in the corresponding SINAMICS manuals.

### 6.20 Configuring Safety Integrated functions

**Integrated safety functions**

When used in conjunction with SIMOTION D, the integrated safety functions of SINAMICS S120 provide highly effective practical protection for personnel and machinery.

Various Safety Integrated functions are available:

**Safety Integrated basic functions**

No encoder and no license are required for Safety Integrated basic functions. The following Safety Integrated basic functions are available:

<table>
<thead>
<tr>
<th>Functions</th>
<th>Abbreviation</th>
<th>Brief description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic functions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Safe Torque Off</td>
<td>STO</td>
<td>Safe torque off</td>
</tr>
<tr>
<td>Safe Stop 1</td>
<td>SS1</td>
<td>Drive-independent shutdown on the quick stop ramp and subsequent activation of STO</td>
</tr>
<tr>
<td>Safe Brake Control</td>
<td>SBC</td>
<td>Safe brake control</td>
</tr>
</tbody>
</table>
Safety Integrated extended functions

Safety Integrated extended functions generally require a license. The following Safety Integrated extended functions are available:

Table 6- 15 Safety Integrated Extended Functions

<table>
<thead>
<tr>
<th>Functions</th>
<th>Abbreviation</th>
<th>With encoder</th>
<th>Without encoder</th>
<th>Brief description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safe Torque Off</td>
<td>STO</td>
<td>Yes</td>
<td>Yes</td>
<td>Safe torque off</td>
</tr>
<tr>
<td>Safe Stop 1</td>
<td>SS1</td>
<td>Yes</td>
<td>Yes</td>
<td>Drive-independent shutdown on the quick stop ramp and subsequent activation of STO</td>
</tr>
<tr>
<td>Safe Brake Control</td>
<td>SBC</td>
<td>Yes</td>
<td>Yes</td>
<td>Safe brake control</td>
</tr>
<tr>
<td>Safe Stop 2</td>
<td>SS2</td>
<td>Yes</td>
<td>No</td>
<td>Drive-independent shutdown on the quick stop ramp and subsequent activation of SOS</td>
</tr>
<tr>
<td>Safe Operating Stop</td>
<td>SOS</td>
<td>Yes</td>
<td>No</td>
<td>Safe monitoring of the standstill</td>
</tr>
<tr>
<td>Safely-Limited Speed</td>
<td>SLS</td>
<td>Yes</td>
<td>Yes</td>
<td>Safe monitoring of the configured velocity limit</td>
</tr>
<tr>
<td>Safe Speed Monitor</td>
<td>SSM</td>
<td>Yes</td>
<td>Yes</td>
<td>Safe feedback when the velocity has fallen below the configured limit value</td>
</tr>
<tr>
<td>Safe Direction</td>
<td>SDI</td>
<td>Yes</td>
<td>Yes</td>
<td>Safe monitoring of the direction of motion</td>
</tr>
</tbody>
</table>

1) Not all supported functions had been finalized when this documentation was published. Current information can be found at [http://support.automation.siemens.com/WW/view/en/27585482](http://support.automation.siemens.com/WW/view/en/27585482).

Note

Details on the Safety Integrated functions, such as information on the configuration of safety functions as well as operating conditions for the encoderless operation can be found in the *SINAMICS S120 Safety Integrated Function Manual*.

Parameterize the desired Safety Integrated functions and the monitoring with or without encoder and activate them in the safety screen forms of the SIMOTION SCOUT engineering system.

If motors are used without an encoder or with an encoder that is not suitable for Safety Integrated Extended Functions, not all Safety Integrated functions can be used.

The safe speed monitoring without encoder also functions at standstill as long as the drive is switched on.
Control

The Safety Integrated functions are completely integrated into the drive system. They can be activated as follows:

- Safety Integrated basic functions are activated via terminals on the device or via a PROFlsafe message frame by means of PROFIBUS or PROFINET
- Safety Integrated extended functions are activated via the TM54F terminal module or via a PROFlsafe message frame by means of PROFIBUS or PROFINET
- The Safety Integrated basic functions via terminals and the Safety Integrated extended functions (via TM54F or PROFlsafe) can be used simultaneously.

**NOTICE**

**PROFlsafe or TM54F**

Using a Control Unit, control is possible either via PROFlsafe or TM54F. Mixed operation is not permitted.

The Safety Integrated functions are implemented electronically and therefore offer short response times in comparison to solutions with externally implemented monitoring functions.

**Note**

Although SIMOTION does not contain any safety-related functionality, it provides support for SINAMICS drives that can perform safety-related functions.

The purpose of this support that SIMOTION provides, depending on the activated the safety-related monitoring functions, is to prevent fault reactions at the drive end by ensuring that the drive does not exit the monitored operating state.

Further information on support of the SINAMICS Safety Integrated functions on the TO axis can be found in the *TO Axis Electric/Hydraulic, External Encoder* function manual.
Commissioning (software)

6.20 Configuring Safety Integrated functions

Required hardware

Where safety functions are controlled via the TM54F or via PROFIBUS/PROFINET with PROFIsafe, at the very least the following hardware versions must be used:

Table 6-16 Required hardware versions

<table>
<thead>
<tr>
<th>Module</th>
<th>Order number</th>
<th>Required product version</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMOTION D425-2 DP</td>
<td>6AU1425-2AA00-0AA0</td>
<td>1)</td>
</tr>
<tr>
<td>SIMOTION D425-2 DP/PN</td>
<td>6AU1425-2AD00-0AA0</td>
<td>1)</td>
</tr>
<tr>
<td>SIMOTION D435-2 DP</td>
<td>6AU1435-2AA00-0AA0</td>
<td>1)</td>
</tr>
<tr>
<td>SIMOTION D435-2 DP/PN</td>
<td>6AU1435-2AD00-0AA0</td>
<td>1)</td>
</tr>
<tr>
<td>SIMOTION D445-2 DP/PN</td>
<td>6AU1445-2AD00-0AA0</td>
<td>C</td>
</tr>
<tr>
<td>SIMOTION D455-2 DP/PN</td>
<td>6AU1455-2AD00-0AA0</td>
<td>C</td>
</tr>
<tr>
<td>SIMOTION CX32-2</td>
<td>6AU1432-2AA00-0AA0</td>
<td>B</td>
</tr>
<tr>
<td>CBE30-2</td>
<td>6FC5312-0FA00-2AA0</td>
<td>1)</td>
</tr>
</tbody>
</table>

1) The information was not available at the time the documentation was published. Current information can be found at [http://support.automation.siemens.com/WW/view/en/27585482](http://support.automation.siemens.com/WW/view/en/27585482).

The hardware requirements of the drive components can be found in the *SINAMICS S120 Safety Integrated* Function Manual.
Quantity structures

The maximum number of servo drives with Safety Integrated functions for each Control Unit is:

<table>
<thead>
<tr>
<th>Control Unit</th>
<th>Maximum number of drives when safety function is activated (servo/vector/V/f)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Via CU/EP terminals (STO, SBC, SS1 only)</td>
</tr>
<tr>
<td>SIMOTION D4x5-2</td>
<td>6 / 6 / 12</td>
</tr>
<tr>
<td>SIMOTION D4x5-2 (with CX32-2)</td>
<td>6 / 6 / 12</td>
</tr>
<tr>
<td>CX32-2</td>
<td>6 / 6 / 12</td>
</tr>
<tr>
<td>CU320-2</td>
<td>6 / 6 / 12</td>
</tr>
</tbody>
</table>

1) PROFIBUS with PROFIsafe:
   If SIMOTION D is operated as an intelligent DP slave on an F-CPU, a maximum of 32 safety slots can be configured for each intelligent DP slave in HW Config. If the Safety Integrated functions are controlled via PROFIBUS with PROFIsafe, one slot in the input area and one slot in the output area are used for each safety axis. This results in a maximum of 16 drives with the Safety Integrated function for each PROFIBUS interface (intelligent DP slave) of the D4x5-2. If with SIMOTION D both PROFIBUS interfaces are operated as an intelligent DP slave on a F-CPU, the quantity structure increases to 2 x 16 drives (sum of the drives on the SINAMICS Integrated, CX32-2 and SINAMICS Control Units). In this case however, no PROFIBUS master interface is available for the connection of I/Os, for example.

2) PROFINET with PROFIsafe:
   The maximum permissible quantity structure for the D4x5-2 is 64 drives (< V4.2 SP1 HF1: 42 drives) with Safety Integrated function (sum of drives on SINAMICS Integrated, CX32-2 and SINAMICS Control Units).

3) 11 or 12 V/f as of SIMOTION V4.3/SINAMICS V4.5

The maximum drive quantity structure depends on other factors. For example with T=125 µs, a maximum of four motor modules may be operated with Safety Integrated extended functions on a DRIVE-CLiQ line. Additional drive components (e.g. line modules, terminal modules, encoders, etc.) can also reduce the maximum drive quantity structure.

Recommendation:
With the SIZER configuration tool, you can easily configure the SINAMICS S110/120 drive family including SIMOTION.

For further information refer to
- SINAMICS S120 Function Manual (FM1), Section Rules for wiring with DRIVE-CLiQ
- SINAMICS S120 Safety Integrated Function Manual
Use of two PROFINET interfaces

An F-CPU can only be connected to one of the two PROFINET interfaces, because fail-safe I/O transfer areas can only be configured either on the I device on the onboard PROFINET interface or on the CBE30-2.

The PROFIsafe message frames are routed to the following drives:

- Drives on the SINAMICS Integrated and CX32-2
- Drives on the onboard PROFINET interface (X150 interface)
- Drives on the CBE30-2 (X1400 interface)

The maximum quantity structure for PROFIsafe on PROFINET is therefore not increased by using a second PROFINET interface.

Safety Integrated functions with TM54F

Safety Integrated functions are activated via fail-safe digital inputs on the TM54F. This means that every drive control (SINAMICS Integrated of SIMOTION D4x5-2, CX32-2, CU320-2, etc.) requires its own TM54F (assuming appropriate safety functions are to be used on the respective Control Unit). Only one TM54F can be connected for each SIMOTION D4x5-2, CX32-2 or SINAMICS S120 Control Unit.

Safety Integrated functions with PROFIsafe (PROFIBUS example)

Safety Integrated functions are activated via "PROFIsafe on PROFIBUS" safe communication. Control (F logic) is based on a SIMATIC F-CPU connected via PROFIBUS with PROFIsafe, e.g. a SIMATIC S7-300 F-CPU (see figure) or an ET 200S IM151-7 F-CPU with PROFIBUS DP master interface module (not shown in the figure).

![Figure 6-64 SIMOTION D, control of F functions via PROFIBUS with PROFIsafe](http://support.automation.siemens.com/WW/view/en/36489289)
Topologies

The topologies that may be used with the SIMOTION D4x5-2 and CX32-2 are listed below. In each case, the description specifies whether the control of Safety Integrated functions is routed through the drives.

- **SIMATIC F-CPU (master), connected via PROFIBUS with PROFIsafe to SIMOTION D4x5-2 (intelligent DP slave)**
  - Routing to SINAMICS Integrated drives of the D4x5-2 and the CX32-2
  - Routing to the drives of a SINAMICS S120 CU connected to the D4x5-2
    The CU is connected as slave via PROFIBUS to the DP master interface of the D4x5-2. Routing to a CU connected via PROFINET is not possible.

- **SIMATIC F-CPU (controller), connected via PROFINET with PROFIsafe to SIMOTION D4x5-2 (I device)**
  - Routing to SINAMICS Integrated drives of the D4x5-2 and the CX32-2
  - Routing to the drives of a SINAMICS S120 CU connected to the D4x5-2
    The CU is connected as device via PROFINET to the PROFINET interface of the D4x5-2 (=controller) or the CU is connected as slave via PROFIBUS to the DP master interface of the D4x5-2.

- **The SIMOTION D4x5-2 is the PROFIBUS master for a fail-safe data exchange broadcast, e.g. between a SIMATIC F-CPU (e.g. ET 200S F-CPU) and a SINAMICS S120 CU.**

**Note**

Control for the Safety Integrated functions cannot be routed to the SINAMICS Integrated of the D4x5-2 or a CX32-2 in this constellation.

**Additional references**

Additional information on configuring Safety Integrated functions can be found in the

- **SINAMICS S120 Safety Integrated Function Manual**
- **TO Axis Electrical/Hydraulic, External Encoder Function Manual**
6.21 Quantity structures

With SIMOTION D, the SIMOTION PLC and motion control functionalities as well as the SINAMICS S120 drive software run on a shared control hardware. The IEC 61131-3-compliant PLC integrated in SIMOTION D means that the system is not just capable of controlling sequences of motions, but the entire machine as well.

- The scaling of the PLC and motion control functionality is performed via control units of various performance classes for SIMOTION D
  - SIMOTION D410-2 is predestined for single-axis solutions and small multi-axis solutions with typically 2-3 axes
  - SIMOTION D425-2 (BASIC performance) for up to 16 axes
  - SIMOTION D435-2 (STANDARD performance) for up to 32 axes
  - SIMOTION D445-2 (HIGH performance) for up to 64 axes
  - SIMOTION D455-2 DP/PN (ULTRA-HIGH performance) for up to 128 axes or applications with very short control cycle clocks

The possible axis quantity structures depend on the required servo and interpolator cycle clocks and apply for electric, hydraulic and virtual axes.

- The scaling of the drive computing performance is performed via SINAMICS drive controls for the SIMOTION D4x5-2. With the SIMOTION D4x5-2, the drive control of a CU320-2 is already integrated (SINAMICS Integrated). These can be extended as follows:
  - SINAMICS S110/S120 control units can be connected via PROFIBUS or PROFINET
  - The CX32-2 controller extension can be connected via DRIVE-CLiQ

SIZER

With the SIZER configuration tool, you can easily configure the SINAMICS S120 drive family including SIMOTION. It provides you with support for selecting and dimensioning the components required for a Motion Control task.

- Dimensioning of the PLC and motion control functionality --> selection of the SIMOTION D control unit
- Dimensioning of the drive computing performance and the required drive components.

Depending on your performance requirements, SIZER determines the possible number of axes and the resulting utilization on the SIMOTION and SINAMICS side.

Drive quantity structure

The following table can be used for a rough estimation of the maximum possible quantity structures on the drive side.

Depending on the functionality used, more or less performance resources are used on the drive control.

The performance points specified in the table can be used for a rough estimation. Maximum 15.5 performance points are available for each drive control (SINAMICS Integrated, CX32-2, CU320-2).
As well as the maximum number of available performance points, the maximum quantity structure of a functionality must also be taken into account (e.g. max. 6 servo drives with 125 µs current controller cycle clock).

**Note**

The following method just serves as a rough estimation of the possible quantity structures. It is not a substitute for dimensioning with the SIZER configuration tool.

Higher utilization can result through the use of SINAMICS function modules (e.g. extended messages/monitoring functions).

### Table 6- 18  Estimation of the possible quantity structure

<table>
<thead>
<tr>
<th>Information on dimensioning</th>
<th>Your dimensioning (example)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functionality</td>
<td>Characteristic 2)</td>
</tr>
<tr>
<td>Line module 5)</td>
<td>ALM/SLM with DRIVE-CLiQ</td>
</tr>
<tr>
<td></td>
<td>BLM</td>
</tr>
<tr>
<td>Servo 1)</td>
<td>125 µs</td>
</tr>
<tr>
<td></td>
<td>250 µs</td>
</tr>
<tr>
<td>2nd encoder</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Vector 1)</td>
<td>250 µs</td>
</tr>
<tr>
<td></td>
<td>500 µs</td>
</tr>
<tr>
<td>V/f</td>
<td>500 µs</td>
</tr>
<tr>
<td>Safety extended function</td>
<td>12 ms</td>
</tr>
<tr>
<td>TB30</td>
<td>Not relevant</td>
</tr>
<tr>
<td>TM15 DI/DO</td>
<td>250 µs / 1 ms 4 ms</td>
</tr>
<tr>
<td>TM31</td>
<td>250 µs / 1 ms 4 ms</td>
</tr>
<tr>
<td>TM41</td>
<td>125 µs / 2 ms 4) 125 µs / 4 ms 4) 250 µs / 4 ms 4)</td>
</tr>
<tr>
<td>TM54F</td>
<td>---</td>
</tr>
<tr>
<td>TM15/TM17</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>
6.21 Quantity structures

<table>
<thead>
<tr>
<th>Information on dimensioning</th>
<th>Your dimensioning (example)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CX32-2 Not relevant</td>
<td>6</td>
</tr>
<tr>
<td>CBE20 (for CU320-2) Not relevant</td>
<td>1</td>
</tr>
<tr>
<td>DCC SINAMICS 2 ms</td>
<td>75 DCC</td>
</tr>
<tr>
<td></td>
<td>50 DCC</td>
</tr>
<tr>
<td>SUM (max. 15.5)</td>
<td>14,8</td>
</tr>
</tbody>
</table>

1) No mixed servo-vector operation possible
2) Used time slice (for drives: Speed controller cycle clock)
3) Max. 8 terminal modules in SUM + 1 TM54F
4) Sampling time for encoder emulation / sampling time for digital and analog I/Os
5) Max. 1 line module, SLM without DRIVE-CLiQ (5 kW and 10 kW) not relevant

The required performance resources depend on further factors. The influence of the functions listed below can be neglected for an estimation using performance points:

- Use of DSC (linear)
- Connection of blocksize power modules via CUA31/32 ⇒ counts as booksize motor modules.

During the drive configuration, note that each CX32-2 on the SINAMICS Integrated generates an additional load. The transfer of a configuration of a CX32-2/CU320-2 on the SINAMICS Integrated is therefore only possible with a connected CX32-2 when the CX32-2/CU320-2 were not fully utilized.

Note

Note also the topology rules of the SINAMICS S120, see SINAMICS S120 Function Manual, Section Rules for wiring with DRIVE-CLiQ.

Mixed operation

Note the following when mixing control types on a drive control:

- A mixture of servo-controlled and vector-controlled drives is not possible
- A mixture of servo-controlled and V/f-controlled drives is possible
- A mixture of vector-controlled and V/f-controlled drives is possible

With regard to the drive quantity structure, the maximum number of servo or vector drives may not be exceeded by drives with V/f control in mixed operation, whereby two drives with V/f control (500 µs) count as one servo or vector drive.
6.22 Migration of SIMOTION D4x5 to SIMOTION D4x5-2

6.22.1 Changeover from SIMOTION D4x5 to SIMOTION D4x5-2

A SIMOTION D4x5-2/CX32-2 not only has a different structure, but also a different functionality to a SIMOTION D4x5/CX32.

This has effects that must be taken into account during a changeover.

Change from D4x5 to D4x5-2 (upgrade)

The change from D4x5 to D4x5-2 is performed via a module replacement in HW Config. That means the change is similar to that of a D425 to D435.

The module replacement is started by dragging the new module to the frame of the module rack with the existing module in HW Config, see Section Device replacement in HW Config (Page 326).

The module replacement is performed automatically. During this operation, the technology packages and the device versions are updated.

Existing configurations of the D4x5 are mostly taken over by the D4x5-2 during the module replacement.

Information on when project adaptations are required or not required when changing from a D4x5 to a D4x5-2 can be found in the following sections (see Table Transfer of existing projects from D4x5 to D4x5-2).

For further information on measures generally required for project adaptations, see Section Service and maintenance (Page 309).

Change from D4x5-2 to D4x5 (downgrade)

As a SINAMICS drive cannot be downgraded, a module replacement of a SIMOTION D4x5-2 (SINAMICS Integrated firmware V4.x) with a SIMOTION D4x5 (SINAMICS Integrated firmware V2.x) is not possible.

However, project data can be transferred by means of an XML export/import.

Transfer of existing projects

Existing configurations of the D4x5 are mostly taken over by the D4x5-2 during the module replacement.

The following table provides information on where project adaptations are required or not required:
### Commissioning (software)

#### 6.22 Migration of SIMOTION D4x5 to SIMOTION D4x5-2

Table 6-19 Transfer of existing projects from D4x5 to D4x5-2

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFINET interface</td>
<td>D4x5 with CBE30 (4 ports) is mapped on D4x5-2 DP/PN onboard PROFINET interface (3 ports):</td>
</tr>
<tr>
<td></td>
<td>• Only the wiring of ports 1 to 3 are taken over</td>
</tr>
<tr>
<td></td>
<td>• Components on port 4 have to be reconnected</td>
</tr>
<tr>
<td></td>
<td>• Communication relations, I/O data, synchronous operation connections, data exchange broadcast data, module addresses and diagnostics addresses are retained</td>
</tr>
<tr>
<td></td>
<td>• Any existing PG/PC assignment is taken over</td>
</tr>
<tr>
<td></td>
<td>Mapping of D4x5 on D4x5-2: X1400 (P1, P2, P3, not P4) → X150 (P1, P2, P3)</td>
</tr>
<tr>
<td>PROFIBUS interfaces</td>
<td>The configurations on the PROFIBUS interfaces including any existing PG/PC assignment are retained.</td>
</tr>
<tr>
<td></td>
<td>Mapping of D4x5 on D4x5-2: X126 DP1 → X126 DP X136 DP2/MPI → X136 DP/MPI</td>
</tr>
<tr>
<td>Reduction ratio of PROFIBUS cycle clock to</td>
<td>As of SIMOTION V4.3, the SIMOTION D4x5-2 supports reduction ratio of PROFIBUS cycle clock to position control cycle clock.</td>
</tr>
<tr>
<td>position control cycle clock</td>
<td>The following applies for V4.2: <strong>PROFIBUS cycle clock: Position control cycle clock = 1:1</strong></td>
</tr>
<tr>
<td></td>
<td>If SIMOTION D4x5 projects have been transferred in which a reduction ratio factor was set,</td>
</tr>
<tr>
<td></td>
<td>• A SIMOTION version ≥ V4.3 must be used, or</td>
</tr>
<tr>
<td></td>
<td>• The cycle clock setting must be adapted for V4.2 projects</td>
</tr>
</tbody>
</table>
**Keyword** | **Explanation**
--- | ---
Ethernet interfaces | The configurations on the Ethernet interfaces including any existing PG/PC assignment are retained.

**Mapping of D4x5 on D4x5-2:**

X120 IE1/OP → X127 P1 PN/IE (interface on the front of the module)
X130 IE2/NET → X130 P1 PN/IE-NET (interface under the front flap)

The X120 P1 PN/IE-OP interface is only available on the D4x5-2 DP. Mapping is never performed on this interface.

The following figure provides an overview of the default addresses as well as the behavior when upgrading a D4x5 to D4x5-2 (assumption: The default addresses have been used for the D4x5).

With SIMOTION D4x5, the Ethernet interfaces of the D4x5 have default addresses in the delivery condition. These addresses are also offered as default addresses in the configuration of SIMOTION SCOUT.

With SIMOTION D4x5-2, only interface X127 P1 has a default address in the delivery condition. Interface X127 P1 is preferable for the PG/PC connection because it is easier to access. The default address is an Automatic Private IP Address (APIPA or Auto IP). In this way, a PG/PC can automatically configure the network interface.

Interfaces X120 P1 and X130 P1 do not have an address in the delivery condition. When configuring the interfaces, the addresses shown in the figure are offered as default addresses.

Message frame configurations | Message frame configurations on the PROFIBUS and PROFINET interfaces are retained. The same applies for the addresses of the slots/subslots.

SINAMICS Integrated / controller extension | The SINAMICS Integrated and controller extension are changed to the new type and its corresponding version. The drive configuration and the assignments of the DRIVE-CLiQ interfaces are retained.
### Configuration of the onboard I/Os

The configuration of the onboard I/Os is retained. Functionality, quantity structure and terminal designations of the onboard I/Os for the D4x5-2/CX32-2 differ from the previous modules because of innovations. Example:

- D4x5-2 has additional technology I/Os on terminal block X142 (e.g. for high-precision cam outputs); a cam output on X122/X132 is no longer supported.
- Terminal blocks X122/X132 have additional digital inputs and therefore the pin assignments on the terminal block have been moved.

### CompactFlash card / firmware

SIMOTION D4x5 and D4x5-2 have different CompactFlash cards and different card mappers (firmware).

1 GB CompactFlash cards of the D4x5 can also be used for the D4x5-2 when a new boot loader is loaded. For details, see Section Boot loader on the CompactFlash card (Page 344).

### Mixture of Control Units of different generations

The firmware version of a controller extension (CX) is always identical to the SINAMICS Integrated. Therefore:

- The CX32 can only be operated on the D4x5.
- The CX32-2 can only be operated on the D4x5-2.

These dependencies do not apply for SINAMICS S120 Control Units. A CU320 can therefore be operated on a D4x5-2.

### Connectable drive components

As for the CU320-2, some older drive components are also no longer supported by the D4x5-2/CX32-2.

For details, see Section Permissible combinations (Page 306).
### Keyword Explanation

#### User program

In principle, a D4x5 user program can run on a D4x5-2, however, adaptations may be required because of innovations in the hardware. Examples:

- The non-volatile data is backed up permanently and maintenance-free for the D4x5-2 (backed-up SRAM for D4x5); a buffer failure signaled via `persistentDataPowerMonitoring.powerFailure = "YES"` therefore only applies to the real-time clock, not for the non-volatile data.

- The runtime behavior of the D4x5-2 modules changes because of the increase in performance. As long as the user program does not contain any "runtime-dependent code", adaptations should not be necessary.

- The D4x5-2 has a double fan module. The user program must be adapted in order to profit from the advantages of a double fan compared with a single fan (identification of required maintenance). See Section Overview of the fan/battery module states (Page 108).

- The user program will have to be modified with respect to detection of the maintenance case for D425-2/D435-2 if D425/D435 was used without a fan/battery module. See Section Overview of states, fan/battery module (Page 108).

- The `batterynecessary` and `fanecessary` system variables have different states depending on the device. See
  - Section Operations and their effect on the user memory (Page 94) and
  - Section Cooling the SIMOTION D4x5-2 (Page 106)

- As of SIMOTION V4.3, the following additional functions are available for the D4x5-2:
  - System variables `rtcFailure` and `retainDataFailure`
  - Backup of the non-volatile SINAMICS data (NVRAM data) via CU parameter p7775
  - Automatic detection of a module replacement on the basis of the serial number of the Control Unit

#### Hardware

The following changes have been made because of the hardware innovations:

- CompactFlash card under a cover (previously open access)
- Additional and slightly differently arranged operator control and display elements
- Modified connectors (larger cable cross-section, screw connection on the 24 V terminal block, etc.)
- D445-2 DP/PN and D455-2 DP/PN have a heat sink so that the spacers (with the exception of external heat dissipation) cannot be disassembled as for the D445-1. See also Section Mounting a SIMOTION D4x5-2 (Page 27).

- A double fan/battery module is always required for D4x5-2 Control Units. See Section Cooling the SIMOTION D4x5-2 (Page 106).

- Controller extensions (CX) for D4x5 can only be used for the D435 and D445/D445-1; with the D4x5-2, all Control Units support the use of CX32-2 controller extensions.
6.22.2 Permissible combinations

DRIVE-CLiQ components

Some "older" DRIVE-CLiQ components can no longer be used with the SIMOTION D4x5-2/CX32-2.

Table 6-20 DRIVE-CLiQ components that cannot be used with the D4x5-2/CX32-2

<table>
<thead>
<tr>
<th>DRIVE-CLiQ components</th>
<th>Information</th>
<th>Ending of the order no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single motor modules (SMM)</td>
<td>6SL31* (all booksize compact motor modules 6SL34* can be used)</td>
<td>≤ 3</td>
</tr>
<tr>
<td>Double motor modules (DMM)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line modules (ALM/SLM)</td>
<td>6SL313* The following can generally be used:</td>
<td>≤ 3</td>
</tr>
<tr>
<td></td>
<td>• All BLM (6SL313*)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SLM (6SL313*) 5 and 10 kW</td>
<td></td>
</tr>
<tr>
<td>Chassis power units</td>
<td></td>
<td>≤ 3</td>
</tr>
<tr>
<td>(line modules, motor modules, power modules)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMC30 sensor modules cabinet</td>
<td></td>
<td>≤ 2</td>
</tr>
<tr>
<td>TM31/TM41 terminal modules</td>
<td></td>
<td>≤ 1</td>
</tr>
<tr>
<td>SME20/25 sensor modules external</td>
<td></td>
<td>≤ 3</td>
</tr>
<tr>
<td>CUA31 Control Unit adapter</td>
<td></td>
<td>≤ 1</td>
</tr>
<tr>
<td>Power modules (chassis)</td>
<td></td>
<td>≤ 3</td>
</tr>
</tbody>
</table>

A detailed, regularly updated list of the DRIVE-CLiQ components approved for use with SIMOTION, as well as notes on their use, can be found on the Internet at [http://support.automation.siemens.com/WW/view/en/11886029](http://support.automation.siemens.com/WW/view/en/11886029).

If incorrect components are used, a topology error is signaled

F01360 Topology: Actual topology not permitted.

CX32-2

The tables below provide an overview of the possible combinations:

Table 6-21 Controller extension combinations

<table>
<thead>
<tr>
<th>Controller extension</th>
<th>Order number</th>
<th>Use in D4x5</th>
<th>Use in D4x5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CX32</td>
<td>6SL3040-0NA00-0AA0</td>
<td>Possible</td>
<td>Not possible</td>
</tr>
<tr>
<td>CX32-2</td>
<td>6AU1432-2AA00-0AA0</td>
<td>Not possible</td>
<td>Possible</td>
</tr>
</tbody>
</table>

Only approved combinations can be configured. If physically an incorrect controller extension is used, a topology error is signaled.

F01360 Topology: Actual topology not permitted
CBE30-2

The tables below provide an overview of the possible combinations:

Table 6-22 Communication board Ethernet combinations

<table>
<thead>
<tr>
<th>Communication board Ethernet</th>
<th>Order number</th>
<th>Use in D4x5</th>
<th>Use in D4x5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBE30</td>
<td>6FC5312-0FA00-0AA0</td>
<td>Possible</td>
<td>Not possible</td>
</tr>
<tr>
<td>CBE30-2</td>
<td>6FC5312-0FA00-2AA0</td>
<td>Not possible</td>
<td></td>
</tr>
</tbody>
</table>

Only approved combinations can be configured. If physically an incorrect Ethernet communication board is used, the CBE cannot be fully inserted into the option slot.

CompactFlash card

A CompactFlash card with D4x5 firmware / drive software cannot run on a D4x5-2. The same applies for the reverse situation.

In case of an error, the six LED displays (RUN to DP/MPI) flash yellow at 2 Hz. An entry is also made in the diagnostic buffer.

Licenses

Licenses purchased for SIMOTION D can be used for both the D4x5 and D4x5-2. Previously used platform-specific "MultiAxes Package for D445/D445-1" licenses can also be used for the D445-2 DP/PN and D455-2 DP/PN.

A new license has not been introduced for the D455-2 DP/PN performance class.
Commissioning (software)

6.22 Migration of SIMOTION D4x5 to SIMOTION D4x5-2
7

7.1 Overview

Introduction

It is possible to distinguish between the following scenarios when replacing and updating components:

- Replacing modules (spare part scenario)
  - Parts replacement for SIMOTION D4x5-2 (Page 313)
  - Removal and replacement of the SIMOTION D4x5-2 (Page 314)
  - Replacing DRIVE-CLiQ components (Page 315)
  - For information on replacing SIMOTION D4x5-2 fans, see Section "Replacing the battery in the fan/battery module" in the SIMOTION D4x5-2 Manual
  - Replacing the CompactFlash card (Page 318)

- Adapting a project (new device type / new device version)
  - The project needs to be adapted if you want to change the type (e.g. D445 ⇒ D445-2 DP/PN) or the version of the SIMOTION device in your existing project.
  - Creating backup copies (project/CF) (Page 319)
  - Backing up user data (backup variables) (Page 320)
  - Upgrading a user project to the new SCOUT version (Page 322)
  - Platform replacement via XML export/import (Page 323)
  - Preparing the device replacement (Page 324)
  - Device replacement in HW Config (Page 326)
  - Upgrading technology packages (Page 327)
  - Upgrading the device version of SINAMICS S120 control units (Page 329)
  - Upgrading a library (Page 330)
  - Save project, compile and check consistency (Page 330)

- Performing a firmware and project update
  - Upgrading the boot loader on the CompactFlash card (Page 331)
  - Upgrade - preparatory measures (Page 331)
  - Upgrade via IT DIAG (Page 332)
  - Upgrade via device update tool (upgrading SIMOTION devices) (Page 333)
Service and maintenance

7.1 Overview

- Update via CompactFlash card
  - Backup of the CompactFlash card data (Page 337)
  - Firmware update via CompactFlash card (Page 339)
  - Upgrading SINAMICS (Page 339)
  - Download project to target system (Page 341)

**Note**
 Updating using the device update tool offers a number of advantages (keeping retain data, option of downgrading, no license key handling, etc.). We would, therefore, recommend using this method for firmware and project updates.

Please also observe the information on handling the CompactFlash card.
- Changing the CompactFlash card (Page 342)
- Writing to a CompactFlash card (Page 342)
- Formatting the CompactFlash card (Page 343)
- Boot loader on the CompactFlash card (Page 344)
- Recommended method of handling CompactFlash cards (Page 345)
- Card reader for CompactFlash cards (Page 345)

**Note**
 This document uses the following terms:
- Upgrade: Denotes upgrading to a higher version of a component/software
- Downgrade: Denotes reverting to a previous version of a component/software
- Update: In general terms, denotes the act of bringing a component/software up to date (or, more specifically, an upgrade or downgrade)

**Overview**

The exact procedure when replacing or updating components depends on various factors. If a project is upgraded, the procedure depends on the scope of change of the versions.
- Change of the SIMOTION main version
- Change of the SIMOTION service pack or hotfix version
- Change of the PROFINET version
- Change of the SINAMICS version
  (There are SIMOTION versions that contains several SINAMICS versions for a device)

If another SIMOTION controller is to be used, then the procedure depends on whether a device or a platform replacement is required.
Examples of upgrade scenarios are listed in the following overview table. They are shown in the columns. The lines list the principle measures that have to be performed. Whether the measure has to be performed in a specific case, must be decided project-specifically. Grayed-out cells mean that a measure is not required.

**Note**

If the version is changed and the SIMOTION controller replaced at the same time, then all measures apply; the measures must be performed in the TOP-DOWN sequence according to the table.
## Overview of upgrade options

<table>
<thead>
<tr>
<th>Action/measure</th>
<th>Upgrading a project</th>
<th>Replacement of the SIMOTION controller</th>
<th>Activity affects</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Main version</td>
<td>Service pack or hotfix version</td>
<td>PROFINET version</td>
</tr>
<tr>
<td>Examples</td>
<td>V4.1</td>
<td>V4.1 SP2</td>
<td>PN2.1.</td>
</tr>
<tr>
<td></td>
<td>V4.2</td>
<td>V4.1 SP4</td>
<td>PN2.2.</td>
</tr>
<tr>
<td>Creating backup copy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(CompactFlash)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backing up user data</td>
<td>only if required</td>
<td></td>
<td>only if required</td>
</tr>
<tr>
<td>(backing up variables)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrading a user project to the new SCOUT version</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Platform replacement via XML export/import</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preparing the device replacement</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device replacement in HW Config</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrading technology packages (TP)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrading device version of SINAMICS S120 CUs</td>
<td></td>
<td>Only as required for external CUs</td>
<td></td>
</tr>
<tr>
<td>Upgrading a library</td>
<td>Libraries are version-dependent</td>
<td>Libraries can be device-dependent</td>
<td>Libraries can be device-dependent</td>
</tr>
<tr>
<td>Save/compile project; check consistency</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run firmware and/or project update</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrading the boot loader on the CompactFlash card</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check whether the new version requires a new boot loader</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check whether a new device requires a new boot loader</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update - preparatory measures</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrade via IT DIAG</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selecting between the three update methods</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>only possible if valid firmware is located on the CompactFlash card</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>only possible if valid firmware is located on the CompactFlash card</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update using the device update tool</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Firmware update using a CompactFlash card</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrading SINAMICS 1)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Downloading project to the target system 1)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Notes

1) Alternative: Load the project to the Compact Flash card using a card reader

2) See SW compatibility list (http://support.automation.siemens.com/WW/view/en/18857317)

3) The versions of SINAMICS Integrated and Controller Extensions are upgraded automatically in the HW Config during device replacement

4) The technology packages are automatically upgraded. If necessary a TP can be specified by the user

5) SINAMICS components are upgraded/downgraded to the component version of the CompactFlash card. Ensure that LED codes are observed. After the upgrade it is necessary to switch the device off and on.

---

Figure 7-1 Overview of upgrade options
7.2 Replacing modules (spare part scenario)

7.2.1 Parts replacement for SIMOTION D4x5-2

**Kernel/firmware ≥ V4.3**

As of SIMOTION V4.3, a module replacement is detected by the controller on the basis of the serial number. This automatically deletes the non-volatile data and transfers the data backed up on the CompactFlash card to the controller. See Section Module replacement (Page 103).

**Kernel/firmware V4.2**

If a used D4x5-2 is used for the module replacement, we recommend that the non-volatile SIMOTION data be deleted on the used D4x5-2.

Two options are available for this.

<table>
<thead>
<tr>
<th>Table 7-1 Options for deleting non-volatile SIMOTION data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>Module memory reset</td>
</tr>
<tr>
<td>Deleting and restoring non-volatile SIMOTION data</td>
</tr>
</tbody>
</table>

**NOTICE**

With a Power OFF/ON, "Restore factory settings" is performed instead of "Memory reset" in switch position "3" (MRES) of the mode selector switch.

Restore factory settings deletes all the project data on the CompactFlash card!

To avoid and unintentional/accidental deletion of the project data on the CompactFlash card, we recommend that the non-volatile SIMOTION data be deleted via the Service selector switch.

See also

Operations and their effect on the user memory (Page 94)
7.2.2 Removal and replacement of the SIMOTION D4x5-2

Removing the control unit

**WARNING**

The control unit can be replaced only when the load power supply has been switched off. Therefore, switch off the power supply now.

Proceed as follows to remove the SIMOTION D4x5-2:

1. Switch off the power supply.
2. Remove the front cover and remove the CompactFlash card from the plug-in slot.
3. Disconnect the terminal block for the power supply.
4. Disconnect the DRIVE-CLiQ connectors to the SINAMICS S120 modules, the connectors of the PROFIBUS DP interfaces (X126 and X136), the Ethernet connectors to the X127, X120 and X130 interfaces (X120 only for D4x5-2 DP) and, if necessary, the connectors on the PROFINET X150 interface (X150 only for D4x5-2 DP/PN).
5. Remove the connectors to the digital I/Os at interfaces X122, X132 and X142.
6. Disconnect any option module which may be inserted (CBE30-2, TB30).
7. Remove the mounting screws of the control unit.

Installing a new module

Proceed as follows to install a new SIMOTION D4x5-2:

1. Remove the front cover from the new control unit.
2. Mount the new control unit.
3. Reconnect all connectors that were removed previously.
4. Connect the terminal block for the power supply.
5. Reattach the designated shielding for all cables.
6. Reinsert the original CompactFlash card into the plug-in slot.
7. Reattach the front cover and close it.
8. Switch on the power supply. The control unit is immediately ready to operate.
SIMOTION D4x5-2 module replacement without PG/PC

To enable a module replacement without a PG/PC, you must back up the current non-volatile SIMOTION and SINAMICS data on the CompactFlash card during operation.

**Note**

Non-volatile SIMOTION and SINAMICS data that is not backed up on the CompactFlash card will be lost if a spare part is installed (in the event of a module defect). (For example, failing to back up the current values of the retain variables will result in them being lost and reset to their initial values.)

If an absolute encoder overflow occurs after `savePersistentMemoryData`, the actual position value is no longer correct after the non-volatile data is restored. In this case, homing (absolute encoder adjustment) must be repeated.

**See also**

Parts replacement for SIMOTION D4x5-2 (Page 313)
Operations and their effect on the user memory (Page 94)
Module replacement (Page 103)

### 7.2.3 Replacing DRIVE-CLiQ components

**Module replacement**

DRIVE-CLiQ components not only support replacement in the switched-off state of the machine/system (Power Off), but also a replacement during operation. For this, the component to be replaced must be at the end of the DRIVE-CLiQ line.

**Requirement**

- The affected components are located at the end of the line.
- If an infeed is affected, the power units supplied by it do not function.

**Procedure for "Removing a component"**

1. Deactivate the affected component or the drive object.
2. Remove the DRIVE-CLiQ connector.
3. Remove the supply voltage for the component and remove the component.
7.2 Replacing modules (spare part scenario)

Procedure for "Installing a component"

1. Install the component and reconnect the supply voltage.
2. Reconnect the DRIVE-CLiq cable at the same location (port). The cable must have the same length as the old one.
3. Activate the affected component or drive object.

Parameters for topology comparator and component replacement

In the expert list, you can use CU parameter p9906 to specify how the electronic rating plates are compared for all the components of a control unit. The type of comparison can be changed for each individual component at a later point in time, using p9907/p9908 or by right-clicking in the topology. All data on the electronic type plate is compared by default.

- If p9909 = 1, the serial number and the hardware version of the new replaced component will be transferred automatically from the actual topology to the target topology and then saved to non-volatile memory.
- For p9909 = 0, serial numbers and hardware versions are not automatically transferred.

The setting p9901 = 1 enables the spare parts/components replacement without tool support to be carried out. The new serial number of the spare part is automatically transferred from the actual topology to the reference topology and saved in the non-volatile memory. Prerequisite is that the replaced components are of the same type and have the same order number, e.g. "6SL3055-0AA00-5BA2". The last or last two digits of the order number (depending on the component type) are not checked, as the HW version, for example, is encoded in these positions. This mechanism is also applied when several components are replaced.

Modified wiring following module replacement

In the default setting for the topology comparator, modified wiring configurations of DRIVE-CLiq components (e.g. cross-exchange) cannot be accepted for safety reasons and a fault is generated.

If a cross-exchange of components is required (i.e. existing components are replaced with other existing components, and no spare parts are used), e.g. for troubleshooting purposes, the topology comparator must be reduced via parameter p9906 or preferably via p9907/p9908; or as an alternative, by right-clicking in the topology.

**NOTICE**

In this case, incorrect insertion of components is no longer monitored.
Automatic upgrading/downgrading (FW update)

When starting up, the system automatically upgrades or downgrades DRIVE-CLiQ components to the version of the component firmware on the CompactFlash card. Components that cannot be downgraded to the component firmware version on the CompactFlash card (e.g. old firmware on the CompactFlash card and new components to which the old firmware cannot be loaded) retain their firmware version. The resulting firmware version combinations are always functional.

**Note**

During an automatic FW update, please read the messages and alarms in the SIMOTION SCOUT detail window.

**Note**

The update can take several minutes and its progress is tracked by corresponding messages appearing in the alarm window of SIMOTION SCOUT.

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red and green:

- FW update running: RDY LED flashes slowly (0.5 Hz)
- FW update complete: RDY LED flashes quickly (2 Hz)

These flashing patterns are also displayed on the yellow RDY LED on the SIMOTION D/CX32-2 and indicate that a FW update is being carried out on components connected to the SIMOTION D/CX32-2 or that all components have completed the FW update.

Go offline once all the FW updates have been completed. POWER ON the upgraded/downgraded components.

The upgrade/downgrade function can be deactivated using the p7826 CU parameter in the expert list.

The component version can be obtained from the CONTENT.TXT file in the main directory of the CompactFlash card.

**Additional references**

You can find further information on this topic:

- In the *SINAMICS S120 Commissioning Manual*
- In the *SINAMICS S120 Function Manual*
7.2 Replacing modules (spare part scenario)

7.2.4 Replacing the CompactFlash Card

If spare parts are being used, you must contact the Technical Support Center to convert the license key of the defective CompactFlash card to the new CompactFlash card. Proceed as described in the following sections to write your project to the new CompactFlash card:

- Changing the CompactFlash card (Page 342)
- Writing to a CompactFlash card (Page 342)

Detailed information about licensing can be found:

- In the *SIMOTION SCOUT* Configuration Manual
7.3 Adapting a project (Upgrading the project / Replacing the SIMOTION controller)

Overview

The project needs to be adapted if you want to replace the type (e.g. D445-2 DP/PN ⇒ D455-2 DP/PN) or version of the SIMOTION device in your existing project.

Procedure

The exact procedure for project adaptations depends on the scope of the target hardware and version changes.

An overview of the different applications can be found in Figure 7-1 Overview of upgrade options (Page 312).

See also

Overview (Page 309)

7.3.1 Creating backup copies (project/CF)

Requirement

Before adapting the project, it is essential that you create the following backup copies:

- A backup copy of the project and
- A backup copy of the contents of the CF card, see Backup of the CompactFlash card data (Page 337)
7.3 Adapting a project (Upgrading the project / Replacing the SIMOTION controller)

7.3.2 Backing up user data (backup variables)

Overview

With the SCOUT functions "Save variables" and "Restore variables", you have the option of backing up and restoring data that was changed during operation and only stored in the runtime system. This is necessary if a SIMOTION platform is changed or a version upgraded, for example.

The "Save variables" function creates XML files which are stored in a folder of your choice.

The following types of data can be backed up:

- Retentive global device variables and unit variables, as well as TO retain data (as of V4.1), located in the SRAM or NVRAM depending on the controller

- Data saved with `_saveUnitDataSet` or `_exportUnitDataSet` and located on the CompactFlash card.

**Note**

When performing an upgrade with a firmware version that is ≥ V4.1, this function is only required for backing up and restoring unit data sets that have been created using `_saveUnitDataSet`.

Retain and unit data (saved with `_exportUnitDataSet`) remains valid even after a version upgrade.

SIMOTION retain data can also be easily backed up to a memory card without the use of SIMOTION SCOUT. For this purpose, use:

- The `_savePersistentMemoryData` function or

- The Service selector switch or DIAG button on the SIMOTION D4x5-2 or IT DIAG

See also Section Backing up diagnostic data and non-volatile SIMOTION data (Page 359).

Procedure

The backup of the user data must be performed **before** the upgrade of the SCOUT project. This is possible for a version upgrade with the "old" SCOUT version or the "new" SCOUT version.
The following is a description of the procedure with a "new" SCOUT.

1. Open the project.
   When opening the project a window appears with a message that the project to be
   opened was created with another SCOUT version, as well as a prompt as to whether the
   upgrade should be performed.

   ![Prompt as to whether the project should be upgraded](image)

   Figure 7-2 Prompt as to whether the project should be upgraded

2. Confirm the prompt with "OK". The project is upgraded.

3. After the conversion another prompt appears as to whether the project should be opened
   write-protected. Confirm this prompt with "Yes" (open write-protected).

   ![Prompt as to whether the project should be opened as write-protected](image)

   Figure 7-3 Prompt as to whether the project should be opened as write-protected

**Open write-protected means:** The project remains consistent. The data is the same in the
controller and in the project. Diagnostic functions (status, trace, etc.) can be executed
directly. The project does not have to be loaded to the controller first.

Go online on the SIMOTION device (in STOP operating state) and execute the *Save
variables* SCOUT function. The retain variables (interface and implementation) and also the
user files (saved with `_saveUnitDataSet` or `_exportUnitDataSet`) are saved to the PG/PC.

The project must then be closed.

If you are using a different PC or PG than that configured for the controller, an online
connection is not possible.

Update the PG/PC assignment for this.

You can go directly to the PG/PC assignment via the button.

The SCOUT project can then be opened again write-protected --- online connection is now
possible.

**Additional references**

For further information, see the *SIMOTION SCOUT* Configuration Manual.
7.3.3 Upgrading a user project to the new SCOUT version

Requirement

It is essential that a backup copy be made of the original project before the upgrade, because the data storage of the project is also upgraded during the upgrade. This ensures that you can always return to the original project if the upgrade fails (power interruptions, unexpected faults, incorrect operation, etc.).

Procedure

1. When opening the project a window appears with a message that the project to be opened was created with another SCOUT version, as well as a prompt as to whether the upgrade should be performed. Confirm the prompt with "OK".

![Figure 7-4 Prompt as to whether the project should be upgraded](image)

2. After the conversion another prompt appears as to whether the project should be opened write-protected. Confirm this prompt with "No" for a version upgrade (do not open write-protected).

![Figure 7-5 Prompt as to whether the project should be opened as write-protected](image)

Do not open as write-protected:

The project can be edited. The data in the controller and in the project is not consistent after going online. Diagnostic functions cannot be executed directly. The project must be loaded to the controller first.
### Open write-protected:

The project remains consistent. The data is the same in the controller and in the project. Diagnostic functions (status, trace, etc.) can be executed directly. The project does not have to be loaded to the controller first.

---

**Note**

A project that was last edited with a higher SCOUT version cannot be opened by a SCOUT with a lower version. However, the project with the more current SCOUT version can first be converted to the required software version (command: "Project" > "Old project format" > "Save in old project format"). The project can then be opened with the lower SCOUT version. However, debug information (e.g. for program status) is no longer available.

---

#### 7.3.4 Platform replacement via XML export/import

**Overview**

A platform replacement is always required when an existing project is to be used for another SIMOTION platform. The platform replacement is always performed via an XML export/import.

The following devices can be interchanged via a platform replacement:

- Replacement between SIMOTION C, P and D (e.g. C240 → D445-2 DP/PN)
- Replacement between D410 and D4x5/D4x5-2 (e.g. D410-2 → D445-2 DP/PN)
- Replacement between SIMOTION D (SINAMICS S120 Integrated) → SIMOTION D (SINAMICS SM150 Integrated)

Platform replacement during project downgrades:

It is not possible to downgrade to a lower SINAMICS version. However, it is possible to transfer project data by means of an XML export/import.

**Preparations**

Before the platform replacement can be performed, preliminary work may be necessary in the existing project.

If a D4x5-2 is to be imported into a D410-2, then only the permitted quantity structure of the D410-2 may be configured in the D4x5-2. This applies for all components, e.g. not only an infeed, but also the permissible power units.

A D4x5-2 with CU adapter and PM340 can be imported into a D410-2 when the CU adapter is connected to port 0. Otherwise, the topology will be destroyed.

Generally, the success of an import always also depends on the specific configurations of the drive units, and whether the configuration is possible for the device to which the import is to be performed. Also note any error messages that may occur.
### 7.3.5 Preparing the device replacement

#### Overview

The device replacement process differs from the platform replacement process in that it is really easy to accept project data during device replacement. The device replacement is performed via **HW Config**, whereas an **XML export/import** is required for a platform replacement.

A device replacement is only possible within SIMOTION D.

The following devices can be interchanged:

- Replacement between different performance classes (e.g. D445-2 DP/PN ⇔ D455-2 DP/PN)
- Replacement between generations (D4x5 ⇒ D4x5-2)
- Replacement between variants (D425-2 DP ⇔ D425-2 DP/PN)
- Replacement between SIMOTION, SINAMICS and/or PROFINET version (e.g. D425 V4.1 - PN V2.1 SINAMICS S120 V2.5 ⇒ D425 V4.2 - PN V2.2 SINAMICS S120 V2.6.2).

One SIMOTION D can only be replaced with another SIMOTION D if the SINAMICS version involved is the same or higher. It is not possible to downgrade to a lower SINAMICS version.
Preparation

Before the device replacement can be performed, it is recommended that preliminary work be performed in the existing project. The existing project must be adapted so that it can be mapped to the new device during the device replacement.

Examples:

1. Number of DRIVE-CLiQ interfaces
   If the replacement is to a device with fewer DRIVE-CLiQ interfaces, then the ports that are no longer available must be rewired before the device replacement (double-click "Topology" in the project navigator). Components on DRIVE-CLiQ ports that are no longer available are moved to the component archive during the device replacement.
   Example:
   Replacement of D445-2 DP/PN (six DRIVE-CLiQ ports) with D425-2 DP/PN (four DRIVE-CLiQ ports)
   → ports X104 and X105 are no longer available.

2. Number of CX32-2s
   If the replacement is with a D4x5-2 that only supports a small number of CX32-2 modules, then a device replacement in HW Config is not possible.
   In this case, the CX32-2 must be replaced by a SINAMICS S120 CU320-2.

3. PROFINET interface
   If a D4x5 with CBE30 is replaced by a D4x5-2 DP/PN with onboard PROFINET interface, then the number of PROFINET ports is reduced from four to three.
   Components on port 4 have to be rewired

TIP for synchronous grouping

If you use device-dependent ST libraries, then the upgrade can be accelerated through the following procedure:

1. Upgrade the device version for all devices that participate in the synchronous grouping in the ST libraries
   (example: Change D445 V4.1 to D445-2 V4.2).
   See also Section Upgrading a library (Page 330).

2. Save the project and close it in SIMOTION SCOUT.

3. Perform the module replacement for all devices of the synchronous grouping in HW Config for this project and then save.

4. Open the project in SIMOTION SCOUT.
   The entire synchronous grouping is now completely upgraded.
7.3 Adapting a project (Upgrading the project / Replacing the SIMOTION controller)

7.3.6 Device replacement in HW Config

Procedure

1. Double-click the SIMOTION device to be replaced in the project navigator in SIMOTION SCOUT. HW Config opens.
2. Open the "SIMOTION Drive-based" folder in the hardware catalog.

**Note**

SIMOTION D is modeled as a compact device in HW Config. When modules are being replaced, this means the new module must be moved to the header of the module rack shown and **not to slot 2**. Please make sure that you do not delete the D4x5-2 rack!

When you move the new module to the rack header using drag-and-drop, the old module will be replaced. Alternatively, you can:

- Select the rack header and double-click the new module in the module catalog to replace the previous module, or:
- Right-click the rack header and select "Replace Object"

3. Move the new module to the top field of the module rack using drag-and-drop.
4. Confirm the dialog box that appears with "Yes" if you want to replace the SIMOTION device. The module is replaced.
5. Accept the changes made to the hardware configuration with "Station" > "Save and compile".

**Note**

During the module replacement, the following actions are performed automatically by the engineering system (if required):

- Update of the technology packages (TPs)
- Automatic upgrade of the SINAMICS Integrated
- Automatic upgrade of all connected CX32-2

The updated data is transferred to the project and the entire project saved.

If the module hardware changes (e.g. a D445-2 DP/PN is replaced with a D455-2 DP/PN), proceed as described in Section Removal and replacement of the SIMOTION D4x5-2 (Page 314).
7.3.7 Upgrading technology packages

Overview

The SIMOTION technology packages (e.g. TP CAM, TP PATH, DCBlib) are available in various versions.

You can only use the functions of the technology objects selected if the technology objects are available in the target system. You can select the technology packages and their version for each SIMOTION device. Each version of SIMOTION SCOUT has a kernel (FW version) for the SIMOTION CPU and an appropriate technology package.

TPs during upgrades

Device replacement (in HW Config), platform replacement (XML export/import), or even upgrades may cause versions of SIMOTION technology packages (TPs), which are assigned to individual technology objects (TOs), to change.

- The TP version may change when the main version is changed. The TP version depends on the relevant main version in all cases; it may, however, remain unchanged through a number of main versions.

- If service packs and hotfixes are installed, there may even be a selection of TP product versions available for the same TP version.

During device replacement (in HW Config) the TP version is automatically updated. If the TP version is changed and more than one version of the new TP version is available, the latest version is automatically installed. If another product version is preferred, this must be set manually (e.g. selection of V4.1.5.3).

With a platform replacement (XML export/import), the required technology package along with the TP version and, if necessary, the product version have to be selected manually after the import.

When a SIMOTION CPU is inserted, the TP CAM (latest TP version and product version) is preset per default.

Special displays in the "Product version" field:

- "Select" means that no TP product version has been selected; this state occurs when older projects, in which the selection of a specific product version was not supported, are upgraded. If the project is loaded to the CPU without making a selection, the latest available technology package is loaded automatically.

- "---" means that no version can be determined (e.g. for the TP DCBlib or for older CPU versions < V4.1). If no version can be determined, you must select "---".
Selecting the TP product version

The desired technology package is selected with fine granularity in SIMOTION SCOUT at "Target device" > "Select technology packages ...".

![Select Technology Packages](image)

Figure 7-6 Select technology packages (example: D445-1)

**Note**

Device diagnostics can provide information on which technology package product version has been loaded to a CPU.

Loading technology packages to the target device

Technology packages are only loaded to the target device if no technology package has been loaded so far or if "Load to file system" is executed.

If a technology package version changes, the technology package must be explicitly reloaded to the target device. To do this, proceed as follows:

1. Select "Download project to target system" in SIMOTION SCOUT.
2. Select the "Replace product versions of the technology packages" option at "Additional CPU options" and confirm with OK.

For further information, please refer to the online help for SIMOTION SCOUT.
7.3.8 Upgrading the device version of SINAMICS S120 control units

Overview

You can upgrade the device versions of SINAMICS S120 control units that are connected to the SIMOTION D via PROFIBUS or PROFINET in the SIMOTION SCOUT. The SINAMICS version can only ever be upgraded in a project; it cannot be downgraded.

Note

During the device replacement in HW Config, the SINAMICS version
• Of the SINAMICS Integrated of the SIMOTION D4x5-2 as well as
• The connected CX32-2 controller extensions
are also upgraded automatically.

A CX32-2 always has the same SINAMICS version as the SINAMICS Integrated. During the module replacement in HW Config, the SIMOTION and the SINAMICS version is always defined with the selection of a D4x5-2 module.

If a SINAMICS S120 control unit is connected via PROFIBUS or PROFINET, the SINAMICS version can be selected independently of the SINAMICS Integrated version.

Procedure

To upgrade a SINAMICS drive unit:
1. Right-click the relevant device, e.g. the SINAMICS S120 CU320-2 DP.
2. Select "Target device" > "Upgrade device version/characteristic" in the context menu.
   The "Upgrade Device Version/Characteristic" dialog box is displayed. It lists all available firmware versions.

   ![Upgrade Device Version/Characteristic](image)

   Figure 7-7 Upgrading the device version

3. Select the desired device version/characteristic and click "Upgrade".
   This upgrades the SINAMICS S120 control unit.
7.3 Adapting a project (Upgrading the project / Replacing the SIMOTION controller)

7.3.9 Upgrading a library

Depending on the configured properties of the libraries used in the project (device-dependent or device-independent), an upgrade of the libraries may be required if the SIMOTION device or the device version changes.

1. Open the LIBRARIES directory in the project navigator.
2. Select a library, right-click to open the context menu, and select "Properties...."
3. Select the "TPs/TOs" tab in the "Properties" window.
4. Select the SIMOTION device and the technology packages for which the library is to be valid.
5. Close the dialog box with "OK".

Note
Please also observe the information on device-dependencies in the SIMOTION SCOUT online help.

7.3.10 Save project, compile and check consistency

Procedure

1. Execute "Save and recompile all" ("Project" > "Save and recompile all" menu).
2. Then perform a consistency check ("Project" > "Check consistency" menu).
3. If error messages occur, correct these and repeat the operation.

Note
Note the difference between
• "Save and recompile all" and
• "Save and compile changes"

Save and recompile all

All sources of the entire project are recompiled with this command.
The command is suitable if you are quite sure that all the old data from older SCOUT versions should be removed and replaced with new compilation results.

Use this command if you specifically want to convert a project from an earlier SCOUT version to a newer version. In this way, you take over all error corrections and optimizations.

Save and compile changes

On this command, the whole project is searched for changes. Therefore only the changes are compiled. Use this command for day-to-day operations within a SCOUT version.
7.4 Performing a firmware and project update

7.4.1 Upgrading the boot loader on the CompactFlash card

The boot loader may have to be upgraded in the following cases:

- Upgrade of the SIMOTION D
- If a D4x5 CompactFlash card is to be used for a D4x5-2 (or vice versa).
- Error corrections and optimizations

Generally, we recommend that the latest boot loader available for the respective CompactFlash card be used.

Detailed information on the compatibility relationships for the CompactFlash card, boot loader version, SIMOTION D hardware and SIMOTION firmware version can be found in the software compatibility list. This list is available both in the documentation supplied on the SIMOTION SCOUT DVD (\_Important\English\Compatibility\...) and on the Internet at (http://support.automation.siemens.com/WW/view/en/18857317).

See also

Bootloader on the CompactFlash card (Page 344)

7.4.2 Update - preparatory measures

Upgrading the SIMOTION D

The actions described in this section also apply to downgrading to an older version.

Various options are available for performing a firmware and/or project upgrade on the SIMOTION D.

- Upgrade via IT DIAG (Page 332)
- Upgrade via device update tool (upgrading SIMOTION devices) (Page 333)
- Update via CompactFlash card (Page 337)

Note

Upgrading using the device update tool offers a number of advantages (keeping retain data, option of downgrading, no license key handling, etc.).

We therefore recommend using this method for firmware and/or project upgrades.
7.4 Performing a firmware and project update

Requirement (firmware update)

You can find the latest firmware for SIMOTION D:

- On the SIMOTION SCOUT DVDs (e.g. at ...\3_D4xx\Firmware\V4.2\...).
- At the following Internet address

Upgrading the SIMOTION D automatically updates the firmware of all connected SINAMICS DRIVE-CLiQ components.

Note

Observe the information in the the Readme files and the upgrade instructions included in the scope of delivery of new SIMOTION versions.

Use only CompactFlash cards that have been released for SIMOTION D and have an appropriate and correct boot loader version.

You can find the compatibility relationships in the SIMOTION SCOUT Add-Ons "Software products" compatibility list, as well as at the following Internet address

NOTICE

The upgrade operation deletes all project data and parameters from the CompactFlash card!

Requirement (project update)

You have upgraded your project and, if necessary, adapted the device type and device version, see Section Adapting a project (Upgrading the project / Replacing the SIMOTION controller) (Page 319).

7.4.3 Upgrade via IT DIAG

The SIMOTION D features an integrated Web server.

In addition to customized Web pages and comprehensive device/diagnostic information, one of the options that IT DIAG offers is performing firmware and project upgrades using a standard PC with Internet Explorer.

As of firmware version V4.2, it is no longer necessary to purchase licenses for SIMOTION IT DIAG and SIMOTION IT OPC XML-DA.

Detailed information can be found in the SIMOTION IT Ethernet-Based HMI and Diagnostic Functions Diagnostics Manual.

See also

Upgrade via device update tool (upgrading SIMOTION devices) (Page 333)
7.4.4 Upgrade via device update tool (upgrading SIMOTION devices)

Overview

SIMOTION D control units and projects can be upgraded using previously created upgrade data.

Note
This functionality is available for D4x5-2 as of SIMOTION V4.3.

Performing an upgrade using upgrade data has the following advantages:

- User-friendly creation of upgrade data via SIMOTION SCOUT with the aid of a wizard (at the machine manufacturer's site)
- SIMOTION devices can be upgraded by the machine operator without the SIMOTION SCOUT Engineering System
- The machine manufacturer can conveniently send upgrade data via e-mail or post to the machine operator
- There is no need to use license keys, as licenses are retained
- Retain data and unit data are retained when upgrades are performed, even across versions
- An upgrade which has been imported can be discarded again, and the previous configuration restored
- You can upgrade either a single SIMOTION device or multiple devices from one or more SIMOTION projects
- It is possible to upgrade parts of a configuration only (e.g. Technology Packages only, firmware only, project only, etc.)

Handling

Upgrade data is created by the application engineer at the machine manufacturer's premises using SIMOTION SCOUT. The upgrade data can then be handled flexibly depending on both the SIMOTION device (SIMOTION C, D, or P) and the customer requirements:

- Creating upgrade data and then copying it to a storage or upgrade medium:
  - CompactFlash card
  - USB stick or
  - IT DIAG file
- Alternatively, the upgrade data can be created and stored in an archive on the PC, with a view to importing it to an upgrade medium suitable for SIMOTION devices at a later point.
Service and maintenance

7.4 Performing a firmware and project update

The process of importing the data to an upgrade medium can be performed at the machine manufacturer's premises; alternatively, if the upgrade archive has been transferred to the machine operator, the service engineer can do this on site.

The service engineer imports the upgrade data on an operator-guided basis (without any involvement by the application engineer) to the SIMOTION device(s), and upgrades the SIMOTION devices in the process (SIMOTION SCOUT is not required on-site).

The following describes how to upgrade a SIMOTION D with a USB stick. This assumes you have a USB stick containing the appropriate upgrade data.

**Requirement**

You have a USB stick containing the upgrade data.

**Procedure**

When using a USB stick to perform an upgrade, proceed as follows:

1. Check the position of the Service selector switch (upper rotary switch SVC/NCK). The switch position must be at "0".
2. Insert the USB stick in one of the two USB interfaces of the activated D4x5-2 (only one USB stick may be inserted).
3. Switch the device OFF/ON or reset it using the RESET button.
4. SIMOTION D4x5-2 will now begin copying the data from the USB stick to the CompactFlash card. The copying procedure begins with some LED status changes until finally a yellow/green flashing RDY LED is displayed (0.5 Hz). In the end phase of the upgrade, the RDY LED has longer steady green or yellow phases (< 10 s).
   Once copying is complete, the RDY LED will change to:
   - "Steady green" if the procedure has been completed successfully (the copying procedure has been completed successfully when the RDY LED is constantly green > 10 s)
   - "Steady red" if copying was not successful
5. Switch the D4x5-2 off and remove the USB stick.
6. Switch the D4x5-2 on again. The D4x5-2 now begins with the actual upgrade. The SF LED flashes green (0.5 Hz) during the upgrade. The procedure can take several minutes.
7. Observe the green flashing of the SF LED.
   - As soon as the upgrade procedure has been completed successfully, the SF LED goes out. The device then boots up automatically in the upgraded configuration (SF LED display then depends on the operating state of the device).
   - If the upgrade procedure was not successful, the SF LED flickers red (10 Hz).

If the upgrade has not been successful "from the point of view of the application" (for example, the machine is not behaving as desired), it can be undone as follows:

1. Switch the D4x5-2 off.
2. Turn the upper rotary switch (SVC/NCK) to position "B".
3. Switch the D4x5-2 on again.
   The system restores the data that was backed up during the upgrade. The data from the upgrade process will be deleted.

4. The restore procedure is indicated by a green flashing SF LED (0.5 Hz) and can take several minutes.
   Reset the Service selector switch immediately to "0" after the flashing code is displayed.

5. Observe the flashing of the SF LED.
   - As soon as the restore procedure has been completed successfully, the SF LED goes out.
     The device then boots up automatically in the restored configuration. (SF LED display then depends on the respective operating state of the device.)
   - If the restore procedure was not successful, the SF LED flickers red (10 Hz).

Note
If the Service selector switch is not reset or not reset in good time to "0", this results in fault state "Service selector switch is still set to restore" (SF LED flickers red at 10 Hz). In this case, switch the D4x5-2 off, reset the Service selector switch and switch the D4x5-2 on again. If the restoration was otherwise successful, the D4x5-2 boots up with the restored configuration.

Note
In the case of a CPU upgrade via USB stick the SIMOTION D4x5-2 is booted from the USB stick. A bootable USB stick must therefore be used. Due to the rapid developments within the market for USB sticks, it is not possible to recommend any specific devices. SIMATIC USB sticks are an exception. Information on this is available on the Internet at (http://support.automation.siemens.com/WW/view/en/32580863).
Note
If the firmware for SIMOTION D is being upgraded or downgraded, the component firmware will also be upgraded or downgraded automatically depending on the firmware version on the CompactFlash card and the firmware version on the SINAMICS components (DRIVE-CLiQ components, CBE30-2, TB30, PM340, etc.). The upgrade procedure can take several minutes and is indicated by LED displays.

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red and green:

- FW update running: RDY LED flashes slowly (0.5 Hz)
- FW update complete: RDY LED flashes quickly (2 Hz)

These flashing patterns are also displayed on the yellow RDY LED on the SIMOTION D/CX32-2 and indicate that a FW update is being carried out on components connected to the SIMOTION D/CX32-2 or that all components have completed the FW update.

Once the firmware update is complete on all components, the components that have been upgraded/downgraded must be powered up.

CBE30-2 option board:

During the firmware update, the OPT LED of the SIMOTION D module and the SYNC LED of the CBE30-2 flash green.

Additional references

Detailed information on "upgrading devices" can be found in the Upgrading SIMOTION Devices Operating Instructions.
7.4.5 Update via CompactFlash card

7.4.5.1 Backup of the CompactFlash card data

Backing up licenses, retain data, and user data

Prior to upgrading/downgrading, as a precaution we recommend backing up the entire contents of the CompactFlash card to the PG/PC using the card adapter and Windows Explorer.

How you should proceed when it comes to backing up and subsequently restoring data on the CompactFlash card depends on whether licenses and/or other retain data and user data which will be required again after the upgrade/downgrade are located on the CompactFlash card.

Case 1: If the CompactFlash card contains no licenses and no retain data or user data which will be required after the upgrade/downgrade.

You do not need to take any steps in this case. Delete the contents of the CompactFlash card and install the firmware as described.

Case 2: If the CompactFlash card contains licenses (e.g. axis licenses)

Before loading the new firmware, back up the "KEYS" directory to your PC. This can then be copied back to the CompactFlash card once you have installed the new firmware.

Note

The license key is stored in the "KEYS" directory on the CompactFlash card. When the SIMOTION device starts up for the first time, the license key is saved in the boot sector of the CompactFlash card.

A license key saved in the boot sector cannot be deleted by means of a user operation; nor can it be deleted by formatting the CompactFlash card or rewriting the boot loader.

If the Keys.txt file is no longer present on the CompactFlash card (because the "KEYS" directory has been deleted, for example), it will be written again from the boot sector to the "KEYS" directory while the SIMOTION device is starting up. The license key can be changed at any time (by relicensing, for example). When the device is next started up, the license key will be saved in the boot sector again.

In the event of the loss of a license key, a copy can be obtained via the Web License Manager at the following Internet address (http://www.siemens.com/automation/license). You will need the HW serial number printed on the CompactFlash card. In the Web License Manager, you have the option of displaying the associated license key.
Case 3: The CompactFlash card contains retain data / user data which is still required

If you are using your application to back up data to the CompactFlash card, you must back this up before installing the new firmware.

Example:
- Backup of the retain data
  - user\simotion\pmemory.xml
    For non-volatile SIMOTION data backed up with _savePersistentMemoryData
  - user\sinamics\nvram\pmemory.acx or \nvram\xx\pmemory.acx
    For non-volatile SINAMICS data (Integrated or CX32-2) backed up with p7775
- Backing up IT DIAG user files, settings (e.g. trace.xml), task trace data, log files, and Java files (classes, archives, user file system, etc.), stored in the following directories:
  - user\simotion\hmicfg
  - user\simotion\hmi
- Backing up configuration data for modular machines in conjunction with the _activateConfiguration system function, stored in the following directory:
  - install\simotion
- Backing up unit data (data saved on the CompactFlash card using _saveUnitDataSet/_exportUnitDataSet), stored in the following directory:
  - user\simotion\user dir\<unitname>

Note

When a version is changed, you must use the "Save variables" function to back up data saved using _saveUnitDataSet or _exportUnitDataSet in a way that is not dependent on the version. You then have the option of restoring them using "Restore variables".

When performing an upgrade with a firmware version that is ≥ V4.1, these two functions are only required for backing up and restoring unit data sets that have been created using _saveUnitDataSet.

Retain and unit data (saved with _exportUnitDataSet) remains valid even after a version upgrade.
7.4.5.2 Firmware update via CompactFlash card

Procedure

Proceed as follows to perform the upgrade:

1. Switch off the power supply to the D4x5-2.
2. Remove the CompactFlash card from the SIMOTION D4x5-2 and insert it into the CompactFlash card adapter on your PC.
3. Open Windows Explorer. The CompactFlash card must be visible as a removable data carrier in the Windows Explorer under an arbitrary drive letter.
4. If necessary, back up the licenses, retain data, and user data on the CompactFlash card to your PC (see Section Backup of the CompactFlash card data (Page 337)).
5. Delete all the data from the CompactFlash card.
6. Unzip the firmware file to the CompactFlash card using a ZIP file utility such as WinZip. Always maintain the file structure when setting up the unpacking tool.
7. Copy the data saved in step 4 back to the appropriate folder structure on the CompactFlash card.
8. Remove the CompactFlash card from the CompactFlash card adapter on your PG/PC.
9. Insert the CompactFlash card into the D4x5-2.
10. Switch on the power supply for the D4x5-2. The new firmware is loaded from the CompactFlash card to the SIMOTION D4x5-2.

7.4.5.3 Upgrading SINAMICS

Depending on the settings, the SINAMICS components are also automatically upgraded to the component version of the CompactFlash card with a firmware upgrade of the SIMOTION D.

The component version can be obtained from the CONTENT.TXT file in the main directory of the CompactFlash card.

Updating the firmware of SINAMICS components automatically

When starting up, the system automatically upgrades or downgrades all DRIVE-CLiQ components to the version of the component firmware on the CompactFlash card. Components that cannot be downgraded to the component firmware version on the CompactFlash card (for example, old firmware on the CompactFlash card and new components to which the old firmware cannot be loaded) retain their firmware version. The resulting firmware version combinations are always functional.
7.4 Performing a firmware and project update

**Note**

The components' firmware is upgraded or downgraded automatically based on the FW version on the CompactFlash card and the FW version on the SINAMICS components (DRIVE-CLiQ components, CBE30-2, TB30, PM340, etc.).

The update can take several minutes and its progress is tracked by corresponding messages appearing in the alarm window of SIMOTION SCOUT.

A firmware update on DRIVE-CLiQ components is indicated by the RDY LED flashing red and green:
- FW update running: RDY LED flashes slowly (0.5 Hz)
- FW update complete: RDY LED flashes quickly (2 Hz)

These flashing patterns are also displayed on the yellow RDY LED on the SIMOTION D/CX32-2 and indicate that a FW update is being carried out on components connected to the SIMOTION D/CX32-2 or that all components have completed the FW update.

Go offline once all the FW updates have been completed. POWER ON the upgraded/downgraded components.

CBE30-2 option board:

During the firmware update, the OPT LED of the SIMOTION D module and the SYNC LED of the CBE30-2 flash green.

---

**Updating the firmware of the SINAMICS components manually**

The SINAMICS components' firmware is updated automatically, depending on the setting of parameter p7826.

- p7826 = 0: Upgrade/downgrade deactivated (factory setting)
- p7826 = 1: Upgrade and downgrade
- p7826 = 2: Upgrade only

**CAUTION**

The automatic FW update via p7826 = 1 (upgrade and downgrade) must not be deactivated when using Safety Integrated.

If you are updating the firmware manually, proceed as follows:

1. Select the SINAMICS component in the project navigator, e.g. SINAMICS Integrated.
2. Double-click "Overview" in the project navigator.
   - The "SINAMICS_Integrated - Overview" dialog box opens with a list of available drive objects.
3. Click "Version overview" to open the list of connected SINAMICS components.
4. Go online and select the devices whose firmware you wish to update.
   The list displays the current firmware version of the devices.
5. Click "Firmware update" to download the new firmware to the devices. To do so, you
   must select all components whose firmware is to be updated.
6. When the firmware update is complete, switch the 24 V power supply off and on again.
   The device is now ready for operation.

Note
The SINAMICS components must be configured for a firmware update to take place. The
firmware cannot be updated if the components have not been configured.
You can also update the firmware via the expert list. See the SINAMICS S120
Commissioning Manual for a description of how to do this.

7.4.5.4 Download project to target system
Once all the changes required for upgrading your project have been made, you must
download the project to the SIMOTION D4x5-2.

Requirement
The firmware required is located on the CompactFlash card; for information, refer to the
section titled Firmware update via CompactFlash card (Page 339).
You have recompiled the project and checked it for consistency. See Section Save project,
compile and check consistency (Page 330).

Procedure
1. Save the project.
2. Click "Connect to selected target systems" to establish a connection to the target system.
3. Execute "Download project to target system" and then "Copy RAM to ROM" to download
   the upgraded project to the CompactFlash card as well.
4. Because of the automatic follow-up configuration in the SINAMICS Integrated drive, you
   must now execute "Load CPU / drive unit to PG".
5. Save the project.

Note
When upgrading SINAMICS drive units (e.g. SINAMICS Integrated) only the p
parameters (setting parameters) are loaded into the upgraded project. The r parameters
(monitoring parameters) are not loaded. The r parameters in the drive unit are derived or
calculated from an automatic subsequent parameterization and must therefore be
uploaded to the project. To do this, execute "Load CPU/drive unit to PG". If the upload is
not performed, this can lead to inconsistencies in the drive parameterization dialog boxes.
7.5 SIMOTION CompactFlash card

7.5.1 Changing the CompactFlash card

Requirement

⚠️ CAUTION

The CompactFlash card may only be inserted or removed when the system is de-energized. The SIMOTION D4x5-2 is in a de-energized state when all the LEDs are off.

Procedure

To change the CompactFlash card, proceed as follows:

1. Switch off the power supply.
2. Remove the CompactFlash card from the plug-in slot of the control unit.
3. Gently insert the new CompactFlash card into the empty plug-in slot until it clicks into place. The direction of insertion of the CompactFlash card is indicated by an arrow located on both the plug-in slot and the CompactFlash card.
   - When properly installed, the card does not extend beyond the housing of the SIMOTION D4x5-2.
4. Switch the power supply on again.

7.5.2 Writing to the CompactFlash card

Overview

You can write to the CF card by:

- Writing to the CF card inserted into a SIMOTION D
  - This function requires the connection to be established between the PG/PC and the module.
- Writing to the CF card without a SIMOTION D module
  - For this function, you need a CF card adapter.

Note

The CF card always comes formatted. It contains the SIMOTION Kernel (SIMOTION D firmware).

To ensure that the CF card functions properly, the card must not be repartitioned.
Writing to the CF card inserted into a SIMOTION D

The CF card can be used to store technology packages and user data (programs, configuration data and parameter assignments) from the "volatile data" area on the CF card. Proceed as follows:

1. Establish the connection between the SIMOTION D and the PG/PC.
2. In SIMOTION SCOUT, the CF card is written to by means of the "Copy RAM to ROM" menu command.

Writing to the CF card without a SIMOTION D module

With a suitable memory card adapter, you can write to the CF card directly via a PG/PC. Writing to the CF card using the PG/PC is required, for example, when you want to upgrade the SIMOTION firmware.

Note

Files that have been written to the CF card with "Copy RAM to ROM" in SIMOTION SCOUT must not be modified or deleted with Windows. This can corrupt the project.

7.5.3 Formatting the CompactFlash card

You can format a faulty CompactFlash card, for example. Before formatting the CompactFlash card, please note the information provided in Section Backup of the CompactFlash card data (Page 337).

Proceed as follows to format the CompactFlash card:

1. Insert the CompactFlash card into a CompactFlash Card adapter connected to your PG/PC.
2. Format the CompactFlash card in Windows (FAT, FAT16 or FAT32 file system).
3. If the boot sector of the CompactFlash card is also defective, you will have to rewrite the boot loader.

NOTICE

The CompactFlash card may not formatted with NTFS.

The following formats are permitted:

- For D410-2/D4x5-2: FAT, FAT16 and FAT32
- For D410/D4x5: FAT and FAT16

Because of the improved memory utilization on the CompactFlash card, FAT32 formatting is preferable for the D410-2 and D4x5-2. As of Kernel/firmware V4.3, D410-2 and D4x5-2 CompactFlash cards supplied as standard with FAT32 formatting. FAT32 requires at least the boot loader version V3.02.
7.5.4 Bootloader on the CompactFlash card

Writing a boot loader

A boot loader may need to be written in the following situations:

- When a new boot loader is required for the SIMOTION D firmware version used
- When a new boot loader is required for the SIMOTION D hardware version used
- The boot loader is defective.

The boot loader version can be read out using the SIMOTION SCOUT device diagnostics. If this is not possible, the boot loader version may be incorrect.

Possible error profile: All ten LEDs light up yellow.

In this case, replace the boot loader version with the current version.

Use the "Options > Write boot sector..." function to write the boot loader version in SIMOTION SCOUT to the CompactFlash card.

---

**Note**

You require PG/PC administrator rights to write to the boot sector. If you do not have administrator rights on your PG/PC, an administrator can enter an administrator login for you to use this function under "Options" > "Settings" > "Rights".

Detailed information on the compatibility relationships for the CompactFlash card, boot loader version, SIMOTION D hardware and SIMOTION firmware version can be found in the software compatibility list. This list is available both in the documentation supplied on the SIMOTION SCOUT DVD (\1_Important\English\Compatibility\...) and also on the Internet at [http://support.automation.siemens.com/WW/view/en/18857317](http://support.automation.siemens.com/WW/view/en/18857317).

---

**NOTICE**

Note that the CompactFlash cards for SIMOTION D410-2 and D4xx have a different boot loader!
7.5.5 Recommended method of handling CompactFlash cards

Handling CompactFlash cards correctly

Please note the following when handling the CompactFlash card:

- The CompactFlash card may only be inserted or removed when the system is de-energized.
- CompactFlash cards are not designed to be rewritten an unlimited number of times.

With this in mind, you should avoid writing user data from the application to the CompactFlash card cyclically. Depending on the system, a write operation from the application may trigger one or more write operations on the CompactFlash card. Therefore, we recommend you adopt a conservative approach in terms of the number of writing processes. In other words, do not perform more than 100,000 write access instances from the user program over the estimated service life of the application.

- Switching off the SIMOTION D control unit during write accesses to the CompactFlash card must be avoided at all costs (examples of write accesses to the CompactFlash card: "Copy RAM to ROM", savePersistentMemoryData, _saveUnitDataSet, _exportUnitDataSet, backup of SINAMICS NVRAM data via p7775). In the worst case scenario, switching off the SIMOTION D control unit during write access can damage the file system on the CompactFlash card. In this case, the CompactFlash card must be reformatted and the firmware/user data reloaded. During this process the licenses remain on the CompactFlash card.

7.5.6 Card reader for CF cards

Because of the quickly changing market and the large differences in the quality of card readers, no specific recommendation can be made (except for the following card reader).

If problems occur identifying the CF card, this may be due to an incorrect power up of the card reader.

Card reader for CF/SD memory media, with USB connection
Order number: 6FC5 335-0AA00-0AA0
Service and maintenance

7.5 SIMOTION CompactFlash card
8.1 Diagnostics via LED displays

Arrangement of LED displays
The front side of the SIMOTION D4x5-2 has ten LED displays arranged vertically in a row. There is also a 7-segment display below the blanking cover.

LED status key
The LED displays indicate the different operating modes and any errors occurring on the SIMOTION D4x5-2. They do so by illuminating, flashing, or flickering in different colors.

The following tables provide an overview of all occurring LED display combinations.

Symbols in the tables for states of the LEDs:
- 1 = LED on
- 0 = LED off
- 0.5/1 = flashing LED (0.5 Hz)
- 2/1 = flashing LED (2 Hz)
- ∆ = flickering LED
- X = LED can light up
8.1 Diagnostics via LED displays

8.1.1 SIMOTION D4x5-2 and SINAMICS Integrated displays

LED displays

Every LED can illuminate in yellow, red, or green. In the following table, the color of the LED is indicated along with the illumination status.

<table>
<thead>
<tr>
<th>Meaning</th>
<th>LED display</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power-up</strong></td>
<td>RDY: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>RUN: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>STOP: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>SF: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>PN: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>OPT: 1 (yellow)</td>
</tr>
<tr>
<td><strong>Power-up of the D4x5-2 without CompactFlash card or with</strong></td>
<td>RDY: 1 (yellow)</td>
</tr>
<tr>
<td><strong>CompactFlash card without valid operating system (the boot loader</strong></td>
<td>RUN: 1 (yellow)</td>
</tr>
<tr>
<td><strong>may be defective).</strong></td>
<td>STOP: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>SF: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>PN: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>OPT: 1 (yellow)</td>
</tr>
<tr>
<td><strong>Incorrect firmware</strong> (e.g. D4x5)</td>
<td>RDY: 0.5/1 (red)</td>
</tr>
<tr>
<td></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 0</td>
</tr>
<tr>
<td></td>
<td>SF: 0</td>
</tr>
<tr>
<td></td>
<td>DP: 0</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>CompactFlash card has begun to boot, however, an error has occurred</strong></td>
<td>RDY: 1 (green)</td>
</tr>
<tr>
<td><strong>(faulty FW).</strong></td>
<td>RUN: x</td>
</tr>
<tr>
<td></td>
<td>STOP: x</td>
</tr>
<tr>
<td></td>
<td>SU/PF: x</td>
</tr>
<tr>
<td></td>
<td>SF: x</td>
</tr>
<tr>
<td></td>
<td>DP: x</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: x</td>
</tr>
<tr>
<td></td>
<td>PN: x</td>
</tr>
<tr>
<td></td>
<td>SY/MT: x</td>
</tr>
<tr>
<td></td>
<td>OPT: x</td>
</tr>
<tr>
<td><strong>D4x5-2 ready for operation: SIMOTION task system is running, and</strong></td>
<td>RDY: 1 (green)</td>
</tr>
<tr>
<td><strong>SINAMICS Integrated is ready to operate</strong></td>
<td>RUN: x</td>
</tr>
<tr>
<td></td>
<td>STOP: x</td>
</tr>
<tr>
<td></td>
<td>SU/PF: x</td>
</tr>
<tr>
<td></td>
<td>SF: x</td>
</tr>
<tr>
<td></td>
<td>DP: x</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: x</td>
</tr>
<tr>
<td></td>
<td>PN: x</td>
</tr>
<tr>
<td></td>
<td>SY/MT: x</td>
</tr>
<tr>
<td></td>
<td>OPT: x</td>
</tr>
<tr>
<td><strong>Read or write access to CompactFlash card</strong></td>
<td>RDY: A (yellow)</td>
</tr>
<tr>
<td></td>
<td>RUN: x</td>
</tr>
<tr>
<td></td>
<td>STOP: x</td>
</tr>
<tr>
<td></td>
<td>SU/PF: x</td>
</tr>
<tr>
<td></td>
<td>SF: x</td>
</tr>
<tr>
<td></td>
<td>DP: x</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: x</td>
</tr>
<tr>
<td></td>
<td>PN: x</td>
</tr>
<tr>
<td></td>
<td>SY/MT: x</td>
</tr>
<tr>
<td></td>
<td>OPT: x</td>
</tr>
<tr>
<td><strong>RUN</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 1 (green)</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 0</td>
</tr>
<tr>
<td></td>
<td>SF: 0</td>
</tr>
<tr>
<td></td>
<td>DP: 0</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>Transition from RUN - STOP</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 1 (green)</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 2/1</td>
</tr>
<tr>
<td></td>
<td>SF: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>Transition from STOPU - RUN</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 2/1 (green)</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 1</td>
</tr>
<tr>
<td></td>
<td>SF: x</td>
</tr>
<tr>
<td></td>
<td>DP: x</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: x</td>
</tr>
<tr>
<td></td>
<td>PN: x</td>
</tr>
<tr>
<td></td>
<td>SY/MT: x</td>
</tr>
<tr>
<td></td>
<td>OPT: x</td>
</tr>
<tr>
<td><strong>STOPU</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 0</td>
</tr>
<tr>
<td></td>
<td>SF: 0</td>
</tr>
<tr>
<td></td>
<td>DP: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>Service operating state (axis control panel / measuring function)</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 2/1</td>
</tr>
<tr>
<td></td>
<td>SF: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>Transition from STOPU - STOP</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 2/1</td>
</tr>
<tr>
<td></td>
<td>SF: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP: 0</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>STOP</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 0</td>
</tr>
<tr>
<td></td>
<td>SF: 0</td>
</tr>
<tr>
<td></td>
<td>DP: 0</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>Transition from STOP - STOPU</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 0</td>
</tr>
<tr>
<td></td>
<td>SF: 0</td>
</tr>
<tr>
<td></td>
<td>DP: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 1 (yellow)</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>Request for memory reset by the D4x5-2 itself or via the mode</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td><strong>selector switch</strong></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 0</td>
</tr>
<tr>
<td></td>
<td>SF: 0</td>
</tr>
<tr>
<td></td>
<td>DP: 0</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>Overall reset in progress active 1)</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 0</td>
</tr>
<tr>
<td></td>
<td>SF: 0</td>
</tr>
<tr>
<td></td>
<td>DP: 0</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
<tr>
<td><strong>Memory reset completed</strong></td>
<td>RDY: x</td>
</tr>
<tr>
<td></td>
<td>RUN: 0</td>
</tr>
<tr>
<td></td>
<td>STOP: 0</td>
</tr>
<tr>
<td></td>
<td>SU/PF: 0</td>
</tr>
<tr>
<td></td>
<td>SF: 0</td>
</tr>
<tr>
<td></td>
<td>DP: 0</td>
</tr>
<tr>
<td></td>
<td>DP/MPI: 0</td>
</tr>
<tr>
<td></td>
<td>PN: 0</td>
</tr>
<tr>
<td></td>
<td>SY/MT: 0</td>
</tr>
<tr>
<td></td>
<td>OPT: 0</td>
</tr>
</tbody>
</table>
# 8.1 Diagnostics via LED displays

<table>
<thead>
<tr>
<th>Meaning</th>
<th>LED display</th>
</tr>
</thead>
<tbody>
<tr>
<td>An interrupt that can be acknowledged (alarm, message, note) is pending</td>
<td>RDY RUN STOP SU/PF SF DP DP/MPI PN SY/MT OPT</td>
</tr>
<tr>
<td>&quot;FAULT&quot; state (7-segment display shows &quot;F&quot;)</td>
<td>(\Lambda)  (\Lambda) (\Lambda) (\Lambda) (\Lambda) (\Lambda) (\Lambda) (\Lambda) (\Lambda) (\Lambda)</td>
</tr>
<tr>
<td>For details, see &quot;7-segment display&quot; and &quot;Special operating modes&quot;</td>
<td></td>
</tr>
<tr>
<td>HOLD state SIMOTION switches to HOLD state as soon as the program</td>
<td>x 0.5/1 (green) 1 (yellow) 1 (yellow) x x x x x x</td>
</tr>
<tr>
<td>comes to a breakpoint. When the program leaves the breakpoint,</td>
<td></td>
</tr>
<tr>
<td>SIMOTION switches out of HOLD state</td>
<td></td>
</tr>
<tr>
<td>&quot;RESET&quot; state (7-segment display shows &quot;8&quot;)</td>
<td>2/1 (red/yellow) x x x x x x x x x</td>
</tr>
<tr>
<td>For details, see &quot;7-segment display&quot; and &quot;Special operating modes&quot;</td>
<td></td>
</tr>
<tr>
<td>DCP flashing (for interface X120, X127, X130, X150, X1400)</td>
<td>x x x x x x 2/1 (red) x x x x x x x x</td>
</tr>
<tr>
<td>Incompatible hardware; SIMOTION Kernel is no longer operating with</td>
<td>1 (yellow) x x x x x x x x x</td>
</tr>
<tr>
<td>complete functionality on the hardware being used</td>
<td></td>
</tr>
<tr>
<td>Underlicensing of technology/option objects</td>
<td>x x x x 0.5/1 (red) x x x x x x</td>
</tr>
</tbody>
</table>

## SINAMICS Integrated

| Initialization of SINAMICS firmware                                  | 1 (yellow) x x x x x x x x 0 |
| Component detection via LED is activated (p0124[0]) \(p^3\)         | 2/1 (green-yellow or red-yellow) x x x x x x x x x |
| Commissioning/reset                                                  | 0.5/1 (green) x x x x x x x x 0 |
| SINAMICS Integrated is ready for operation and cyclic DRIVE-CLiQ    | 1 (green) x x x x x x x x x |
| communication is taking place.                                      |             |
| General SINAMICS Integrated error (check parameterization/configuration)| 2/1 (red) x x x x x x x x x |
| SINAMICS Integrated has not powered up (SINAMICS firmware not        | 1 (red) x x x x 0 0 x x x |
| available or faulty), or a fault has occurred.                      |             |
| Read or write access to CompactFlash card                            | \(\Lambda\) (yellow) x x x x x x x x x |
# Diagnostics via LED displays

## Meaning

<table>
<thead>
<tr>
<th>LED display</th>
<th>RDY</th>
<th>RUN</th>
<th>STOP</th>
<th>SU/PF</th>
<th>SF</th>
<th>DP</th>
<th>DP/MPI</th>
<th>PN</th>
<th>SY/MT</th>
<th>OPT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade/downgrade of DRIVE-CLiQ components running</td>
<td>0.5/1 (yellow)</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>The upgrade/downgrade of DRIVE-CLiQ components is completed (power OFF/ON of the upgraded/downgraded devices is necessary)</td>
<td>2/1 (yellow)</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

## PROFIBUS DP interfaces as master

| No parameter assignment available | x | x | x | x | x | 0 | 0 | x | x | x |
| At least one slave is missing | x | x | x | x | x | 1 (red) | 1 (red) | x | x | x |
| Bus status "Clear" | x | x | x | x | x | 0.5/1 (green) | 0.5/1 (green) | x | x | x |
| Bus status "Operate" | x | x | x | x | x | 1 (green) | 1 (green) | x | x | x |

## PROFIBUS DP interfaces as i-slave

| No parameter assignment available | x | x | x | x | x | 0 | 0 | x | x | x |
| No parameter assignment master available | x | x | x | x | x | 1 (red) | 1 (red) | x | x | x |
| Bus status "Clear" | x | x | x | x | x | 0.5/1 (green) | 0.5/1 (green) | x | x | x |
| Bus status "Operate" | x | x | x | x | x | 1 (green) | 1 (green) | x | x | x |

## Upgrading SIMOTION devices (device update tool)

| Upgrade/downgrade running | x | x | x | x | 0.5/1 (green) | x | x | x | x | x |
| Upgrade/downgrade completed with error | x | x | x | x | Λ (red) | x | x | x | x | x |
| Upgrade/downgrade completed without error 4) | x | x | x | x | 0 5) | x | x | x | x | x |
| Upgrade data is being copied from USB stick to CompactFlash card 0.5/1 (yellow/green) | x | x | x | x | x | x | x | x | x | x |
| Booting is not possible from the used USB stick 0.5/1 (yellow) min. 10 s | x | x | x | x | x | x | x | x | x | x |
| Upgrade data copying from USB stick to CompactFlash card completed with error Λ (red) | x | x | x | x | x | x | x | x | x | x |
| Upgrade data copying from USB stick to CompactFlash card completed without error 1 (green), min. 10 s 2) | x | x | x | x | x | x | x | x | x | x |
### Diagnostics via LED displays

#### Meanings LED display

<table>
<thead>
<tr>
<th>Meaning</th>
<th>LED display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing up diagnostic data and non-volatile data</td>
<td></td>
</tr>
<tr>
<td>Backing up diagnostic data and non-volatile data (backup running)</td>
<td>x x Λ (yellow) Λ (yellow) x x x x x x</td>
</tr>
<tr>
<td>Backing up diagnostic data and non-volatile data (backup completed)</td>
<td>x Λ (green) x x x x x x x x</td>
</tr>
<tr>
<td>PROFINET IO interface for D4x5-2 DP/PN (onboard interface, X150)</td>
<td></td>
</tr>
<tr>
<td>Onboard PROFINET interface is operating without error; the data exchange to all configured I/O devices is running</td>
<td>x x x x x x x 0 x x</td>
</tr>
<tr>
<td>Bus error</td>
<td>x x x x x x x x 1 (red) x x</td>
</tr>
<tr>
<td>Failure of a connected IO device</td>
<td>x x x x x x x x 2/1 (red) x x</td>
</tr>
<tr>
<td>The PROFINET interface has not yet synchronized with the send cycle clock of PROFINET IO with IRT, or PROFINET IO with IRT has not been configured</td>
<td>x x x x x x x x 0 x</td>
</tr>
<tr>
<td>The PROFINET interface has synchronized to the send cycle clock of PROFINET IO with IRT</td>
<td>x x x x x x x x 1 (green) x</td>
</tr>
<tr>
<td>The PROFINET interface has synchronized to the send cycle clock of PROFINET IO with IRT. (SINAMICS Integrated and ext. DP interfaces have not synchronized yet)</td>
<td>x x x x x x x x 2/1 (green) x</td>
</tr>
</tbody>
</table>
### Diagnostics

#### 8.1 Diagnostics via LED displays

<table>
<thead>
<tr>
<th>Meaning</th>
<th>LED display</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFINET IO interface (CBE30-2, X1400)</td>
<td></td>
</tr>
<tr>
<td>No CBE30-2 inserted</td>
<td>x x x x x x x x x 0</td>
</tr>
<tr>
<td>CBE30-2 runs error-free</td>
<td>x x x x x x x x x 1 (green)</td>
</tr>
<tr>
<td>Bus error (CBE30-2):</td>
<td></td>
</tr>
<tr>
<td>• Failure of a connected IO device</td>
<td>x x x x x x x x x</td>
</tr>
<tr>
<td>• At least one of the assigned IO devices cannot be addressed</td>
<td></td>
</tr>
<tr>
<td>• Incorrect or no configuration</td>
<td></td>
</tr>
<tr>
<td>Firmware downloaded</td>
<td>x x x x x x x x x 2/1 (red)</td>
</tr>
<tr>
<td>Firmware download faulty</td>
<td>x x x x x x x x x 0.5/1 (red)</td>
</tr>
</tbody>
</table>

1) The LED state appears only very briefly due to the speed at which the “overall reset” is completed. The module then powers up (the STOP LED flashes yellow at 2 Hz).

2) The copying procedure is completed when the SF LED is steady green for at least 10 s.

3) Both options depend on the LED state when activated via p0124[0] = 1.

4) The upgrade or downgrade is complete when the SF LED goes out. The device then boots up automatically in the upgraded or downgraded configuration (SF LED display then depends on the operating mode of the device).

#### See also

For detailed information on the LED states, see Section LED displays of the PROFINET interface (Page 354).

#### Additional references

Further references can be found in the *Upgrading SIMOTION Devices* Operating Instructions.
7-segment display

The 7-segment display provides further status information in addition to the LED displays.

Table 8-2 States of the 7-segment display

<table>
<thead>
<tr>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Module in the RESET state (RESET button pressed; overtemperature; faulty/disconnected fan/battery module)</td>
</tr>
<tr>
<td>8.</td>
<td>Power-up of the SIMOTION D4x5-2 has failed Possible cause: Incorrect boot loader on the CompactFlash card</td>
</tr>
<tr>
<td>F</td>
<td>F state (FAULT) In the F state, the CPU of the D4x5-2 is in HOLD state, i.e. no software is running (D4x5-2 operating system is stopped)</td>
</tr>
<tr>
<td>6</td>
<td>SIMOTION D has powered up</td>
</tr>
<tr>
<td>Flashing point</td>
<td>Communication is taking place between SIMOTION and SINAMICS Integrated</td>
</tr>
</tbody>
</table>

Special operating modes

The following "special operating modes" are displayed via the status LEDs and the 7-segment display.

F state (FAULT)

In the F state, the CPU of the D4x5-2 is in HOLD state, i.e. no software is running (D4x5-2 operating system is stopped).

The state occurs with faults to which the D4x5-2 operating system cannot respond.

The state is displayed as follows:

- All LEDs flicker red and
- The 7-segment display shows "F"

Possible measures:

- Check the CompactFlash card.
- Perform a commissioning again.
- Correct any overtemperature.
- Replace the D4x5-2.

The state can only be exited by switching the D4x5-2 off and on.

RESET state (permanent RESET)

In the RESET state, the CPU of the D4x5-2 is in a permanent RESET, i.e.

- No software is running (D4x5-2 operating system is stopped) and
- The hardware is in a state that produces less power loss

This state occurs, for example, if the max. module temperature has been greatly exceeded.
The state is displayed as follows:
- The RDY LED flashes red/yellow at 2 Hz
- The 7-segment display shows "8"

Possible measures:
- Correct the causes of any overtemperature.
- Ensure that the 24 V supply is stable without any power dips.
- Insert the fan/battery module.

The state can only be exited by switching the D4x5-2 off and on.

8.1.2 LED displays of the PROFINET interface

Position of the onboard PN interface (X150)

The following figure contains information on the PROFINET interface of the SIMOTION D4x5-2 DP/PN control unit. Position of the interface, labeling of the ports and the associated displays are described.

<table>
<thead>
<tr>
<th>Display</th>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINK</td>
<td>green</td>
<td>Transfer rate 10 or 100 Mbit/s</td>
</tr>
<tr>
<td>Off</td>
<td></td>
<td>No or faulty connection</td>
</tr>
<tr>
<td>ACT</td>
<td>yellow</td>
<td>Data exchange</td>
</tr>
<tr>
<td>Off</td>
<td></td>
<td>No data exchange</td>
</tr>
</tbody>
</table>

Figure 8-2 Position of the PROFINET interface X150
Note
The 3rd port of the PROFINET IO interface X150 P3 is also designated as X120 PN/IE OP. This designation is not relevant for SIMOTION D.

Position of the PN interface of the CBE30-2 (X1400)

Figure 8-3  CBE30-2 front view
### LED displays for PROFINET

Table 8-3  Meaning of the LED displays for the D4x5-2 DP/PN and CBE30-2

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINK</td>
<td>Green</td>
<td>On</td>
<td>A different device is connected to port x and a physical connection exists.</td>
</tr>
<tr>
<td>ACT</td>
<td>Yellow</td>
<td>Flashing</td>
<td>Data is being received or sent at port x.</td>
</tr>
<tr>
<td>D4x5-2: PN</td>
<td>Red</td>
<td>Off</td>
<td>PROFINET interface is operating without error; the data exchange to all configured I/O devices is running.</td>
</tr>
<tr>
<td>CBE30-2: FAULT</td>
<td></td>
<td></td>
<td>PROFINET interface bus fault</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On</td>
<td>No physical connection to a subnet/switch.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Incorrect transmission rate</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Full duplex transmission is not activated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashing (2 Hz)</td>
<td>Failure of a connected I/O device</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>At least one of the assigned I/O devices cannot be addressed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Incorrect or no configuration</td>
</tr>
<tr>
<td>D4x5-2: SY/MT</td>
<td>Green</td>
<td>Off</td>
<td>The PROFINET interface has not synchronized yet to the send cycle clock of PROFINET IO with IRT, or PROFINET IO with IRT has not been configured (e.g. only PROFINET IO with RT or TCP/IP communication).</td>
</tr>
<tr>
<td>CBE30-2: SYNC</td>
<td></td>
<td></td>
<td>The PROFINET interface has synchronized to the send cycle clock of PROFINET IO with IRT.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On</td>
<td>The PROFINET interface has synchronized to the send cycle clock of PROFINET IO with IRT.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashing (2 Hz)</td>
<td>The PROFINET interface has synchronized to the send cycle clock of PROFINET IO with IRT.</td>
</tr>
</tbody>
</table>

1) If no IRT has been configured, then generally no synchronization will be made to the send cycle clock. LED is off.
8.1.3 **LED displays of the Ethernet interface**

The Ethernet ports are equipped with LEDs to display Link and Activity.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINK (upper LED)</td>
<td>OFF</td>
<td>No or faulty connection</td>
</tr>
<tr>
<td></td>
<td>Lights up green</td>
<td>Transfer rate 10 or 100 Mbit/s: A different device is connected to port x and a physical connection exists</td>
</tr>
<tr>
<td></td>
<td>Lights up yellow</td>
<td>Transfer rate 1,000 Mbit/s: A different device is connected to port x and a physical connection exists</td>
</tr>
<tr>
<td>ACT (lower LED)</td>
<td>OFF</td>
<td>No data exchange</td>
</tr>
<tr>
<td></td>
<td>Flickers yellow</td>
<td>Data exchange: Data is being received or sent at port x</td>
</tr>
</tbody>
</table>

8.1.4 **LED displays of the CX32-2 controller extension**

The different states that occur during power-up are indicated by the LEDs on the CX32-2 controller extension.

- The duration of the individual states varies.
- If an error occurs, the power-up is terminated and the cause is indicated accordingly via the LEDs.
- At the end of an error-free power-up, all LEDs are switched off briefly.
- After power-up, the LEDs are controlled via the loaded software.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDY</td>
<td>DP</td>
<td></td>
</tr>
<tr>
<td>Yellow</td>
<td>Yellow</td>
<td>Hardware reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All other LEDs light up yellow</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>BIOS loaded</td>
</tr>
<tr>
<td>Red 2 Hz</td>
<td>Red</td>
<td>BIOS error</td>
</tr>
<tr>
<td>Red 2 Hz</td>
<td>Red 2 Hz</td>
<td>File error</td>
</tr>
<tr>
<td>Red</td>
<td>Yellow (flashing)</td>
<td>FW loading</td>
</tr>
<tr>
<td>Red</td>
<td>Off</td>
<td>FW loaded</td>
</tr>
<tr>
<td>Off</td>
<td>Red</td>
<td>FW checked (no CRC error)</td>
</tr>
<tr>
<td>Red 0.5 Hz</td>
<td>Red 0.5 Hz</td>
<td>CRC invalid</td>
</tr>
</tbody>
</table>
### Diagnostics

#### 8.1 Diagnostics via LED displays

**Table 8-6  Firmware**

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>Not relevant</td>
</tr>
<tr>
<td></td>
<td>Alternating</td>
<td>Initializing</td>
</tr>
<tr>
<td>DP</td>
<td></td>
<td>Running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See the table below</td>
</tr>
</tbody>
</table>

**Table 8-7  CX32-2 – Description of the LEDs after ramp-up**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description, cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDY (READY) Off</td>
<td>Electronic power supply is missing or outside the permissible tolerance range.</td>
<td>Check power supply</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green Continuous light</td>
<td>The component is ready for operation and cyclic DRIVE-CLiQ communication is taking place.</td>
<td>–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flashing 0.5 Hz</td>
<td>Commissioning/reset</td>
<td>–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flashing 2 Hz</td>
<td>Writing to the memory card</td>
<td>–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Flashing 2 Hz</td>
<td>General errors</td>
<td>Check parameterization/configuration data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red/ green Flashing 0.5 Hz</td>
<td>CX32-2 is ready for operation. However, software licenses are missing.</td>
<td>Obtain licenses</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yellow Flashing 0.5 Hz</td>
<td>Firmware update of the connected DRIVE-CLiQ components running</td>
<td>–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flashing 2 Hz</td>
<td>DRIVE-CLiQ component firmware update complete. Wait for POWER ON for the components in question.</td>
<td>Perform POWER ON for the respective component</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green/ yellow or red/yellow Flashing 2 Hz</td>
<td>Component detection via LED is activated (p0124[0]). <strong>Note:</strong> Both options depend on the LED state when component detection is activated via p0124[0] = 1.</td>
<td>–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DP (PROFIdrive cyclic operation) Off</td>
<td>Cyclic communication has not (yet) taken place. <strong>Note:</strong> The PROFIdrive is ready to communicate when the CX32-2 is ready for operation (see RDY LED).</td>
<td>–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green Continuous light</td>
<td>Cyclic communication is taking place.</td>
<td>–</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Flashing 0.5 Hz   | Full cyclic communication has not yet taken place. Possible causes:  
- D4x5-2 does not transfer any setpoints.  
- During isochronous operation, no global control (GC) or a faulty global control (GC) is transferred by the controller. | – |
| Red Flashing 0.5 Hz | D4x5-2 sends faulty parameterization/configuration. | Adapt configuration between D4x5-2 and CX32-2 |
| Flashing 2 Hz     | Cyclic bus communication has been interrupted or could not be established. | Correct fault |
| RDY and DP Red Flashing 2 Hz | Bus error - communication has been interrupted. | Correct fault |
8.2 Diagnostic data and non-volatile SIMOTION data

8.2.1 Overview

With simple operation actions (e.g. by setting the switch position) and without the need for the SCOUT engineering system, you can:

- Back up diagnostic data, including non-volatile SIMOTION data (retain data) to the CompactFlash card; for information, see Section Backing up diagnostics data and non-volatile SIMOTION data (Page 359).
- Back up HTML pages (including the most up-to-date content) to the CompactFlash card for diagnostic purposes; for information, see Section Diagnostics via HTML pages (Page 367).
- Restore backed-up non-volatile SIMOTION data (retain data); for information, see Section Deleting/restoring non-volatile SIMOTION data (Page 368).

8.2.2 Backup of diagnostic data and non-volatile SIMOTION data

8.2.2.1 Diagnostic data

Following a fault on a SIMOTION device, diagnostics data (e.g. diagnostic buffer content, up-to-date content of HTML pages, etc.) can provide important information on the cause of the fault. For this purpose, data can be backed up to the CF card via a "simple operator action" (e.g. via Service selector switch or DIAG button on the D4x5-2).

You then have the following options for the diagnostics data:

- You can retrieve it from the CF card using a card reader
- You can download it using IT DIAG or FTP

You can also use it for diagnostic purposes or provide it to technical support for evaluation purposes.
Various options are available to you for backing up diagnostics data:

- Backing up during operation (in STOP/STOPU/RUN mode); see Section Procedure for backing up during operation (Page 361)
  - With IT DIAG; IT DIAG also offers the option of retrieving diagnostics data online
  - Via the DIAG button
  - Via the Service selector switch
- Backing up while the module is starting up; for details, see Section Procedure for backing up during startup (Page 363).
  - Via the DIAG button
  - Via the Service selector switch
  - Control of the diagnostics data creation using an INI file stored on the CF card

### 8.2.2.2 Non-volatile SIMOTION data (retain data)

In addition to the diagnostic data, non-volatile SIMOTION data (retain data) is also saved on the CompactFlash card. You can use these in situations where the non-volatile SIMOTION data has not been saved on the CompactFlash card using the \_savePersistantMemoryData\_ system function, and you wish to restore the non-volatile SIMOTION data after a CPU has been replaced.

**Note**

While the non-volatile SIMOTION data is stored as a "PMEMORY.XML" backup file in the "/...USER\SIMOTION" directory using the \_savePersistantMemoryData\_ system function, backing up diagnostic data and non-volatile SIMOTION data stores the data in the "...\USER\SIMOTION\HMI\SYSLOG\DIAG directory."
8.2.2.3 Procedure for backing up during operation

Procedure

The advantage of backing up diagnostics data and non-volatile SIMOTION data during operation is that enhanced diagnostic information via HTML pages and TO alarm information is available.

Data is backed up:

- With IT DIAG by selecting "Diagnostics > Diagnostics files"; see Section "Backing up diagnostics data and non-volatile SIMOTION data via IT DIAG.
- Via the DIAG button (see the description below).
- Via the Service selector switch (see the description below).

Note

In addition to the Service selector switch, SIMOTION D4x5-2 modules also have a DIAG button.

If the diagnostics data is to be backed up "during operation", simply press the DIAG button. The DIAG button is therefore preferable to switch position "D" of the Service selection switch.

DIAG button (preferred solution)

To back up diagnostics data and non-volatile SIMOTION data via the DIAG button, proceed as follows:

1. Press the DIAG button.
   The diagnostics data and non-volatile SIMOTION data can be created in STOP, STOPU and RUN states.
2. The diagnostic data and non-volatile SIMOTION data is backed up to the CompactFlash card.
   The backup procedure is displayed via the status LEDs as in the table below:
3. Once the backup is complete, switch the D4x5-2 off.
4. Remove the CompactFlash card.

Table 8-8 LED displays during backup procedure

<table>
<thead>
<tr>
<th>Status</th>
<th>LED displays on the D4x5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup in progress</td>
<td>STOP LED and SU/PF LED flicker yellow</td>
</tr>
<tr>
<td>Backup complete</td>
<td>RUN LED flickers green</td>
</tr>
</tbody>
</table>
Service selector switch (alternative)

To back up diagnostics data and non-volatile SIMOTION data using a Service selector switch, proceed as follows:

1. Set the Service selector switch to "Diagnostics" (position "D").
   The positions of the mode selector switch are not relevant (i.e. the set operating mode remains unchanged).
   The diagnostics data and non-volatile SIMOTION data can be created in STOP, STOPU and RUN states.

2. The diagnostics data and non-volatile SIMOTION data is backed up to the CompactFlash card.
   The backup procedure is displayed via the status LEDs as in the table below.

3. Once the backup is complete, switch the D4x5-2 off.

4. Remove the CompactFlash card and reset the Service selector switch to its original setting.

Table 8-9 LED displays during backup procedure

<table>
<thead>
<tr>
<th>Status</th>
<th>LED displays on the D4x5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup in progress</td>
<td>STOP LED and SU/PF LED flicker yellow</td>
</tr>
<tr>
<td>Backup complete</td>
<td>RUN LED flickers green</td>
</tr>
</tbody>
</table>
8.2.2.4 Procedure for backing up during startup

Procedure

Backing up diagnostics data and non-volatile SIMOTION data "during power-up" provides you with diagnostic information **without HTML pages / TO alarm information**.

Backing up during startup is particularly advisable for SIMOTION devices that cannot run or have crashed.

Diagnostics data and non-volatile SIMOTION data is backed up

- Via the Service selector switch
- Via the DIAG button or
- Using an INI file saved on the CompactFlash card.

The procedure for each is described below.

Note

In addition to the Service selector switch, SIMOTION D4x5-2 modules also have a DIAG button.

As an alternative to setting the Service selector switch to the "D" position, you have the option of backing up diagnostics data and non-volatile SIMOTION data by pressing the DIAG button. When backing up data during power-up, the DIAG button must be held down until the backup is completed. As this can easily take 20-30 seconds, it is better to use position "D" in this case.
8.2 Diagnostic data and non-volatile SIMOTION data

Service selector switch (preferred solution)

Data is backed up using a Service selector switch as follows:
1. Set the Service selector switch to "Diagnostics" (position D).
   The positions of the mode selector switch are not relevant (i.e. the set operating mode remains unchanged).

![Service selector switch and mode selector switch, Service switch in position "D"

2. Switch the D4x5-2 off and back on again.
3. Wait for the device to start up.
   The diagnostics data and non-volatile SIMOTION data is backed up to the CompactFlash card during power-up, provided that this is still possible and is not prevented by HW defects, for example.
4. Once the backup is complete, switch the D4x5-2 off.
5. Remove the CompactFlash card and reset the Service selector switch to its original setting.

Table 8-10 LED displays during backup procedure

<table>
<thead>
<tr>
<th>Status</th>
<th>LED displays on the D4x5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup in progress</td>
<td>STOP LED and SU/PF LED flicker yellow</td>
</tr>
<tr>
<td>Backup complete</td>
<td>RUN LED flickers green</td>
</tr>
</tbody>
</table>

DIAG button (alternative)

To back up data via the DIAG button, proceed as follows:
1. Switch the D4x5-2 off.
2. Press the DIAG button and hold it down. Switch the D4x5-2 on.
3. Wait for the device to ramp up.
   The diagnostics data and non-volatile SIMOTION data is backed up to the CompactFlash card during power-up, provided that this is still possible and is not prevented by HW defects, for example.
4. Once the backup is complete, you can release the button and switch off the D4x5-2.
5. Remove the CompactFlash card.

Table 8-11 LED displays during backup procedure

<table>
<thead>
<tr>
<th>Status</th>
<th>LED displays on the D4x5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup in progress</td>
<td>STOP LED and SU/PF LED flicker yellow</td>
</tr>
<tr>
<td>Backup complete</td>
<td>RUN LED flickers green</td>
</tr>
</tbody>
</table>

INI file in the CompactFlash card main directory

1. Use a text editor (such as Notepad) to create a file called `simotion.ini`
2. Add the following text: `DIAG_FILES=1`
   You must use a text editor and may not use any formatting in the text.
3. Copy the simotion.ini file to the CompactFlash card main directory.
4. Insert the CompactFlash card into the switched-off module.
5. Switch the D4x5-2 on and allow the SIMOTION device to power up.
   The diagnostics data and the non-volatile SIMOTION data will be backed up to the data carrier during power-up, provided that this is still possible and is not prevented by HW defects, for example.
6. Once the backup is complete, switch off the SIMOTION device.
7. Remove the CompactFlash card.

**NOTICE**

To suppress startup in diagnostics mode again, you must delete the `simotion.ini` file from the CompactFlash card.

Table 8-12 LED displays during backup procedure

<table>
<thead>
<tr>
<th>Status</th>
<th>LED displays on the D4x5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup in progress</td>
<td>STOP LED and SU/PF LED flicker yellow</td>
</tr>
<tr>
<td>Backup complete</td>
<td>RUN LED flickers green</td>
</tr>
</tbody>
</table>
8.2 Diagnostic data and non-volatile SIMOTION data

8.2.2.5 Storing data

Storing diagnostics data and non-volatile SIMOTION data

You can find diagnostics data and non-volatile SIMOTION data on the CompactFlash card in the \USER\SIMOTION\HMI\SYSLOG\DIAG directory.

Copy this data and transfer it to technical support on request. A standard card reader can be used to transfer the diagnostics data from the CompactFlash card via standard IT DIAG pages or via FTP.

The following data is stored:

<table>
<thead>
<tr>
<th>File</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIAGBUF.TXT</td>
<td>Diagnostic buffer in a simple text format:</td>
</tr>
<tr>
<td></td>
<td>Numerical values; no specific plain text. A text editor is used for evaluation purposes.</td>
</tr>
<tr>
<td>PMEMORY.XML</td>
<td>Non-volatile data (retain data)</td>
</tr>
<tr>
<td></td>
<td>You can restore the backed up non-volatile SIMOTION data &quot;via an operator action&quot; after a CPU has been replaced. (See Section Deleting/restoring non-volatile SIMOTION data (Page 368).)</td>
</tr>
<tr>
<td>TOALARMS.TXT</td>
<td>Text file containing the pending TO alarms. Only TO IDs, alarm numbers, and associated HEX values.</td>
</tr>
<tr>
<td></td>
<td>Note: The TO alarms are only created if diagnostics data has been created during operation (STOP/STOPU/RUN).</td>
</tr>
<tr>
<td>HTML page</td>
<td>If the diagnostics data is backed up, the URLs are requested from the text file (DIAGURLS.TXT) and stored as HTML pages together with their contents. (See Section Diagnostics via websites (Page 367).)</td>
</tr>
<tr>
<td></td>
<td>Note: The HTML pages are only stored if diagnostics data is created during operation (STOP/STOPU/RUN).</td>
</tr>
<tr>
<td>Other files</td>
<td>All other files stored in the directory are only of relevance to technical support.</td>
</tr>
</tbody>
</table>

Note

Use HTML pages if you wish to back up diagnostics data in plain-text format. HTML pages enable user-friendly diagnostics. In addition to the standard IT DIAG diagnostics pages, you have the option of creating your own HTML pages (e.g. for the axis status or for machine diagnostics). Customized diagnostics pages are particularly suitable for application problems, as you can define the contents yourself.
8.2.3 Diagnostics via websites

In the "DIAGURLS.TXT" text file, found in the ...\USER\SIMOTION\HMI\SYSLOG\DIAG directory, you can specify HTML files whose current contents are to be stored on the CompactFlash card when diagnostic data is created during operation. (For example, "devinfo.mcs" must be entered for the "devinfo.htm" HTML page.)

Since the pages in question are stored together with their most up-to-date contents, this enables the latest status information regarding the SIMOTION device, as well as the machine/system, from the point at which diagnostics data was created (e.g. when the Service selector switch was activated) to be archived.

In addition to the standard IT DIAG diagnostics pages, it is possible to store customized pages. Information on creating pages of this type can be found, for example, in an FAQ of the Utilities & Applications.

The following points must be noted for the DIAGURLS.TXT file:

- A DIAGURLS.TXT file containing the standard IT DIAG pages is automatically created if you have not stored your own DIAGURLS.TXT file.
- Standard IT DIAG pages are entered "without" a path specification (e.g. "devinfo.mcs" for the standard IT DIAG page "devinfo.htm").
- Customized IT DIAG pages (such as "user.htm") in the \USER\SIMOTION\HMI\FILES directory on the CompactFlash card must contain the FILES/ path specification.
- If you have created subfolders (e.g. "myfolder" in the FILES directory), these must also appear in the path.
- Only one file name may be used per line.

Figure 8-6 Diagnostic buffer with generated diagnostics data
8.2 Diagnostic data and non-volatile SIMOTION data

- Empty lines are not permitted (an empty line will be interpreted as the end of the list).
- No distinction is made between upper-case and lower-case letters.
- It does not matter whether you use "\" or "/" in the path name.

![Figure 8-7 Depiction of DIAGURLS.TXT editor](image)

Additional references

For detailed information about IT DIAG device and diagnostic information, see the *SIMOTION IT Ethernet-Based HMI and Diagnostic Functions Diagnostics Manual*.

8.2.4 Deleting/restoring non-volatile SIMOTION data

**Requirement**

The diagnostic data and non-volatile SIMOTION data has been backed up to the CompactFlash card, see Section Backup of diagnostic data and non-volatile SIMOTION data (Page 359).

**Procedure**

As of V4.3, the non-volatile SIMOTION data is restored automatically during a module replacement (see Section Module replacement (Page 103)). To restore the non-volatile data manually (via an operator action), proceed as follows:

1. Insert the CompactFlash card into the new D4x5-2 (which must be switched off).
2. Set the Service selector switch to the "Delete/restore non-volatile SIMOTION data" setting (switch position "1").
   - The positions of the mode selector switch are not relevant (i.e. the set operating mode remains unchanged).
Figure 8-8 Switch position 1 for deleting/restoring non-volatile data

3. Allow the D4x5-2 to power up; the non-volatile SIMOTION data is first deleted and then restored while this is taking place.
   If there is a file called "PMEMORY.XML" in the "USER\SIMOTION" directory on the CompactFlash card, this will be restored (rather than the "PMEMORY.XML" file saved via "Back up diagnostic data and non-volatile SIMOTION data" in directory "\USER\SIMOTION\HMI\SYSLOG\DIAG").
   The order of priority for restoration is as follows:
   - /USER/SIMOTION/PMEMORY.XML
   - /USER/SIMOTION/PMEMORY.BAK
   - /USER/SIMOTION/HMI/SYSLOG/DIAG/PMEMORY.XML
   If, for example, you want to restore data backed up via the switch / button / IT DIAG, you may have to delete existing PMEMORY.XML and PMEMORY.BAK backup files in the \USER\SIMOTION\ directory on the CompactFlash card.

   **Note**
   When the "Delete/restore non-volatile SIMOTION data" switch position is selected, the non-volatile SIMOTION data of the D4x5-2 is first deleted and then restored by means of the PMEMORY backup file.

4. Once the D4x5-2 has powered up, switch it off.
5. Reset the Service selector switch to its original setting.
6. Switch the D4x5-2 on again.
8.2.5 Backing up diagnostics data and non-volatile SIMOTION data using IT DIAG

SIMOTION devices feature pre-configured, standard IT DIAG pages. These pages can be displayed via Ethernet using a commercially available browser. Additionally, you have the option of creating your own HTML pages and incorporating service and diagnostic information.

You can also use IT DIAG to back up diagnostics data and non-volatile SIMOTION data. IT DIAG is opened by entering the IP address of the SIMOTION device in the address bar of the browser; e.g. http://169.254.11.22

This opens the IT DIAG start screen. To back up diagnostic data and non-volatile SIMOTION data, call the "Diagnostic files" page from the "Diagnostics" menu.

![IT DIAG](image)

Figure 8-9 IT DIAG
### 8.2 Diagnostic data and non-volatile SIMOTION data

You can find diagnostic data and non-volatile SIMOTION data on the CompactFlash card in the following directory:

\USER\SIMOTION\HMI\SYSLOG\DIAG

#### Additional references

For detailed information, refer to the *SIMOTION IT Ethernet-Based HMI and Diagnostic Functions* Diagnostics Manual.
8.3 Additional service and diagnostics options

8.3.1 SIMOTION Task Profiler application

The SIMOTION Task Profiler is a dedicated application installed parallel to SIMOTION SCOUT during SIMOTION SCOUT setup. The Task Profiler can be called in online mode using device diagnostics in SIMOTION SCOUT or the Windows application. In the event of a malfunction or error, the Task Trace data can be written to a directory or the CompactFlash Card. They can then be processed using the Task Trace Viewer.

Additional references
For detailed information, refer to the SIMOTION Task Trace Function Manual.

8.3.2 Diagnostics using IT DIAG

The SIMOTION D features an integrated web server.

In addition to customized websites and the option of performing firmware and project updates, IT DIAG provides comprehensive device and diagnostic information that can be called using a standard PC with Internet Explorer.

As of firmware version V4.2, it is no longer necessary to purchase licenses for SIMOTION IT DIAG and SIMOTION IT OPC XML-DA.

Additional references
Detailed information can be found in the SIMOTION IT Ethernet-Based HMI and Diagnostic Functions Diagnostics Manual.
Configuration of drive-related I/Os (without symbolic assignment)

A.1 Overview

The configuration of local measuring inputs is fundamentally different to the configuration of global measuring inputs. The assignment of the local measuring inputs is permanently related to the hardware of the control unit and is performed

- On the drive side via the drive expert list and
- During the configuration of the TO measuringInput via the measuring input number.

Local and global measuring inputs have different properties. Detailed information on the differences can be found in the appendix, in Section Local and global measuring inputs (Page 374).

Information about the configuration can be found

- For global measuring inputs (with symbolic assignment) in Section Configuration of global measuring inputs (Page 262).
- For local measuring inputs in the appendix, in Section Configuration of local measuring inputs (Page 376)

Additional references

Further information and programming examples for configuring drive-related I/Os without symbolic assignment can be found

- At the following Internet address
- In SIMOTION Utilities & Applications

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.
A.2 Local and global measuring inputs

Local and global measuring inputs

Depending on the used hardware platform, the following local and global measuring inputs are available for the measuring tasks:

- **Local measuring inputs** are axis-related and implemented in the SINAMICS drive. The actual position value is measured.

- **Global measuring inputs** can be freely assigned to the axes and add an internal time stamp to the measurement result for more precise determination of the axis positions. The term "central measuring input" is also used within the context of drives.

<table>
<thead>
<tr>
<th>Hardware supported</th>
<th>Local measuring input</th>
<th>Global measuring input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware supported</td>
<td>D410, D410-2, D4x5, D4x5-2 (terminal X122/X132), CX32, CX32-2, CU310, CU310-2, CU320, CU320-2</td>
<td>TM15, TM17 High Feature, D410, D410-2, D4x5, D4x5-2 (terminal X122, X132, X142), CX32, CX32-2, CU310, CU310-2, CU320, CU320-2</td>
</tr>
</tbody>
</table>

| Measurement procedure | With a signal edge at the relevant input, the current actual values of an encoder connected to a control unit are measured with positioning accuracy to determine lengths and distances. | With a signal edge at the relevant input, the current actual values of one or more encoders are measured using time stamp functionality with positioning accuracy in order to provide information for determining lengths and distances (possible with any encoders included in the project). |

| Configuration of the measuring input TO in SIMOTION SCOUT | The assignment of inputs is always permanent depending on the hardware of the Control Unit and is performed during the configuration of the TO measuringInput using the measuring input number. | The assignment of inputs is not fixed depending on the hardware and is performed during the configuration of the TO measuringInput by means of symbolic assignment or the hardware address. |

| Measuring input TO setting: Single measurement (Measurement jobs must be issued individually for each measurement. Several interpolation cycle clocks lie between two measurements.) | Yes | Yes |
### A.2 Local and global measuring inputs

<table>
<thead>
<tr>
<th>Measuring input TO setting: Cyclical measurement (The measurement is activated just once and runs cyclically until deactivated.)</th>
<th>Local measuring input</th>
<th>Global measuring input</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No</td>
<td>Yes D410, D410-2, D4x5, D4x5-2 (terminal X122, X132), CX32, CX32-2, CU310, CU310-2, CU320, CU320-2: The minimum interval between two measurements is three servo cycle clocks (max. two edges per measurement). D4x5-2 (terminal X142), TM17 High Feature: The minimum interval between two measurements is 1 position control cycle clock (max. 2 edges per measurement). TM15: No cyclic measurement available</td>
</tr>
</tbody>
</table>

Use of multiple measuring input TOs on one axis/encoder. They can be active concurrently | No | Yes |

Listening TO measuringInput | No | Yes |

Measuring on virtual axes | No | Yes |

Measuring on axes attached to a different drive unit | No | Yes |

**SIMOTION Utilities & Applications** includes, for example, a tool to estimate:

- The time between a measurement job being initiated and it being effective in the drive
- The minimum time between two measurement jobs.

**SIMOTION Utilities & Applications** is part of the scope of delivery of SIMOTION SCOUT.

### Table A-2 Measuring inputs - overview of quantity structures and functionality

<table>
<thead>
<tr>
<th>Maximum available quantity structure</th>
<th>D410, CU310, CX32</th>
<th>D4x5, CU320</th>
<th>CX32-2</th>
<th>D410-2, CU310-2</th>
<th>D4x5-2 - X122/X132 - X142</th>
<th>TM15</th>
<th>TM17 High Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. number of measuring input inputs</td>
<td>3</td>
<td>6</td>
<td>4</td>
<td>8</td>
<td>- 8</td>
<td>- 8</td>
<td>24</td>
</tr>
<tr>
<td>Can be configured as a local measuring input</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>- 8</td>
<td>- 0</td>
<td>-</td>
</tr>
<tr>
<td>Can be configured as a global measuring input</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>- 8</td>
<td>- 8</td>
<td>x</td>
</tr>
</tbody>
</table>

**SIMOTION D4x5-2**

Commissioning and Hardware Installation Manual, 02/2012
A.3 Configuring local measuring inputs

Properties

Local measuring inputs are always permanently assigned to an axis (drive). They are configured separately for each drive. The drive and the measuring input must always be located on the same control unit. The measurement results are transferred using the axis message frame in accordance with the PROFIdrive profile. Message frame 39x does not need to be configured for local measuring inputs.

The settings for the use of the local measuring inputs must be made in the expert list.

Procedure

In order to use an I/O terminal on a D4x5-2, CX32-2 or SINAMICS control unit as measuring input input, proceed as follows:

1. Double-click the "Inputs/outputs" entry below the control unit in the project navigator.
2. Click the "Bidirectional digital I/Os" tab.
3. In this tab, configure the required I/O terminal as input. The configuration can also be set channel-granular on the p0728 parameter using the expert list of the control unit.

Specification of the measuring input input terminal must be made in the expert list of the respective drive for local measuring inputs.

<table>
<thead>
<tr>
<th>Specification of the input terminal of the measuring input in the expert list of the drive</th>
<th>Parameterization as</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>D4x5-2, CU320-2</td>
</tr>
<tr>
<td>p0488[0] (measuring input 1 input terminal, encoder 1)</td>
<td>DI/DO 8 or DI/DO 9 or DI/DO 10 or DI/DO 11 or DI/DO 12 or DI/DO 13 or DI/DO 14 or DI/DO 15</td>
</tr>
<tr>
<td>p0488[1] (measuring input 1 input terminal, encoder 2)</td>
<td></td>
</tr>
<tr>
<td>p0488[2] (measuring input 1 input terminal, encoder 3)</td>
<td></td>
</tr>
<tr>
<td>p0489[0] (measuring input 2 input terminal, encoder 1)</td>
<td></td>
</tr>
<tr>
<td>p0489[1] (measuring input 2 input terminal, encoder 2)</td>
<td></td>
</tr>
<tr>
<td>p0489[2] (measuring input 2 input terminal, encoder 3)</td>
<td></td>
</tr>
</tbody>
</table>

As a maximum of three encoders can be assigned to a drive, the index [0..2] specifies whether the measurement applies to encoder 1, 2, or 3.

The following must be taken into account:

- Only two TO measuringInputs can be configured per TO axis or TO externalEncoder
- Only one TO measuringInput can be active on a TO axis or TO externalEncoder.
**Table A-4  Local measuring inputs, configuration of the TO measuring input**

<table>
<thead>
<tr>
<th>Axis measuring system no.</th>
<th>Under axis measuring system number, enter the number of the used encoder system (namely, encoder 1, 2 or 3). Encoder system 1 is the default setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive-related (local measuring input)</td>
<td>Activate the checkbox when a local measuring input is used.</td>
</tr>
<tr>
<td>Measuring input number</td>
<td>Enter here which measuring input is used (namely, 1 or 2). Input 1 is the default setting.</td>
</tr>
</tbody>
</table>

Detailed information can be found in the *SIMOTION Motion Control Output Cams and Measuring Inputs* Function Manual.
Configuration of drive-related I/Os (without symbolic assignment)

A.3 Configuring local measuring inputs
Standards and approvals

B.1 General rules

CE marking

Our products satisfy the requirements and protection objectives of the EC Directives and comply with the harmonized European standards (EN).

Electromagnetic compatibility

Standards for EMC are satisfied, if the EMC Installation Guideline is observed.

SIMOTION products are designed for industrial use in accordance with product standard DIN EN 61800-3, Category C2.

cULus Approval

Listed component mark for United States and the Canada Underwriters Laboratories (UL) according to Standard UL 508, File E164110, File E115352, File E85972.

EMC

<table>
<thead>
<tr>
<th>USA</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal Communications Commission Radio Frequency Interference Statement</td>
<td>This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.</td>
</tr>
<tr>
<td>Shielded Cables</td>
<td>Shielded cables must be used with this equipment to maintain compliance with FCC regulations.</td>
</tr>
</tbody>
</table>
Standards and approvals

B.1 General rules

USA

<table>
<thead>
<tr>
<th>Modifications</th>
<th>Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions of Operations</td>
<td>This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.</td>
</tr>
</tbody>
</table>

CANADA

<table>
<thead>
<tr>
<th>Canadian Notice</th>
<th>This Class B digital apparatus complies with Canadian ICES-003.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avis Canadien</td>
<td>Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.</td>
</tr>
</tbody>
</table>

SOUTH KOREA

이 기기는 업무용(A급) 전자파전력지역기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.

For sellers or other user, please keep in mind that this device in an A-grade electromagnetic wave device. This device is intended to be used in areas other than home.

The EMC limit values to be observed for Korea correspond to the limit values of the EMC product standard for variable-speed electric drives EN 61800-3 of category C2 or the limit value class A, Group 1 to EN55011. By implementing appropriate additional measures, the limit values according to category C2 or limit value class A, Group 1, are observed. For this purpose, additional measures, such as the use of an additional RFI suppression filter (EMC filter) may be necessary. In addition, measures for EMC-compliant configuration of the plant are described in this Manual and/or the Configuration Manual "EMC Installation Guideline". Please note that ultimately it is always the label on the device that provides the decisive information on the compliance with standards.

Declaration of conformity

Standards and approvals

B.2 SIMOTION D4x5 device-specific notes

General warning information

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is a risk of injury or of damage to assets. In hazardous areas, personal injury or damage to assets can occur if plug-in connections are disconnected during operation. Make sure that your system is always de-energized before disconnecting plug-in connections in hazardous areas.</td>
</tr>
</tbody>
</table>

C-Tick

<table>
<thead>
<tr>
<th>AUSTRALIA</th>
</tr>
</thead>
</table>

B.2 SIMOTION D4x5 device-specific notes

Note regarding SIMOTION D

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The product standard EN 61800-3 describes the EMC requirements placed on &quot;Variable-speed drive systems&quot;. As such, it defines different limits depending on the location of the drive system.</td>
</tr>
<tr>
<td>SINAMICS S120 power units are designed for use in the second environment. The term second environment refers to all locations outside residential areas. These are basically industrial areas which are supplied from the medium-voltage line supply via their own transformers.</td>
</tr>
<tr>
<td>The same installation instructions apply for the SIMOTION D4x5/CX32 Control Units as for the SINAMICS S120 CU320 Control Units with regard to EMC.</td>
</tr>
<tr>
<td>It is essential to follow the installation instructions in the SINAMICS S120 Manuals in order to ensure compliance with emitted interference and immunity values.</td>
</tr>
<tr>
<td>For more information on this topic also refer to Catalog PM21 as well as the SINAMICS Function Manuals.</td>
</tr>
</tbody>
</table>
B.3 Safety of electronic controllers

Introduction

The following remarks relate to fundamental criteria and apply irrespective of the type of controller and the manufacturer.

Risk

A higher degree of safety standard applies to all applications and situations where there is a risk of material damage or injury to persons if there is a failure. Special regulations specific to the system apply to such applications. These must be taken into account for configuration of the controller (e.g. VDE 0116 for furnaces).

For electronic controllers with safety responsibility, the measures required for preventing or controlling faults depend on the hazard inherent in the plant. In this respect, the basic measures listed above are no longer adequate once the hazard exceeds a certain potential. Additional measures (e.g. double redundancy, tests, checksums, etc.) for the controller must implemented and certified (DIN VDE 0801).

The residual risk

When assessing his machine's risk in accordance with the EC Machinery Directive, the machine manufacturer must take into account the following residual risks emanating from the control and drive components:

1. Unintentional movements of driven machine components during commissioning, operation, maintenance, and repairs caused by, for example:
   - Hardware defects and/or software errors in the sensors, controllers, actuators, and connection technology
   - Response times of the controller and drive
   - Operating and/or ambient conditions not within the scope of the specification
   - Parameterization, programming, cabling, and installation errors
   - Use of radio devices / cellular phones in the immediate vicinity of the controller
   - External influences / damage

2. Exceptional temperatures as well as emissions of light, noise, particles, or gas caused by, for example:
   - Component malfunctions
   - Software errors
   - Operating and/or ambient conditions not within the scope of the specification
   - External influences / damage
3. Hazardous shock voltages caused by, for example:
   - Component malfunctions
   - Influence of electrostatic charging
   - Induction of voltages in moving motors
   - Operating and/or ambient conditions not within the scope of the specification
   - Condensation / conductive contamination
   - External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are too close

5. Release of environmental pollutants or emissions as a result of improper operation of the system and/or failure to dispose of components safely and correctly
Standards and approvals

B.3 Safety of electronic controllers
ESD guidelines

C.1 ESD definition

What does ESD mean?

All electronic modules are equipped with highly integrated modules or components. Because of the technology used, these electronic components are very sensitive to overvoltages and thus to discharge of static electricity.

The acronym ESD has become the established designation for such Electrostatic Sensitive Devices. The ESD designation is used internationally to refer to Electrostatic Sensitive devices.

Electrostatic sensitive devices are identified by the following symbol:

![Symbol for identification of electrostatic sensitive devices](image)

Figure C-1  Symbol for identification of electrostatic sensitive devices

⚠️ CAUTION

Electrostatic sensitive devices can be irreparably damaged by voltages that are far lower than anything a person can perceive. These voltages occur if you touch a component or the electrical connection of a module without having previously discharged any static from your body. Any damage that occurs to a module as a result of overvoltage is generally not recognized immediately and only comes to light after the equipment has been operating for some time.
C.2 Electrostatic charging of individuals

Any person who is not conductively connected to the electrical potential of the environment can accumulate an electrostatic charge.

This figure indicates the maximum electrostatic charges that can accumulate on an operator when he comes into contact with the indicated materials. These values comply with the specifications in IEC 801-2.

Figure C-2 Electrostatic voltage that can accumulate on operating personnel
C.3 Basic measures for protection against discharge of static electricity

Ensure sufficient grounding

When working with electrostatic sensitive devices, make sure that the you, your workstation, and the packaging are properly grounded. This prevents the accumulation of static electricity.

Avoid direct contact

You should only touch ESD components if unavoidable (for example, during maintenance work). When you touch modules, make sure that you do not touch either the pins on the modules or the printed conductors. If you follow these instructions, electrostatic discharge cannot reach or damage sensitive components.

If you have to take measurements on a module, make sure that you first discharge any static that may have accumulated in your body. To do this, touch a grounded metal object. Only use grounded measuring instruments.
ESD guidelines

C.3 Basic measures for protection against discharge of static electricity
Index

A
Active setting
PG/PC, 130
Automatic configuration
Drive unit, 188
Automatic controller setting
Position controller, 275
Speed controller, 274
Axis
Creating with axis wizard, 229
Testing with the axis control panel, 237
Axis grouping, 15
DRIVE-CLIQ components, 16
SIMOTION D, 16
SINAMICS infeed, 16
SINAMICS power unit, 16

B
Boot loader, 344
Reading, 344
Writing, 344
Bus connector, 64
MPI, 70
Setting the terminating resistor, 66

C
CE marking, 379
Combinations
Licenses, 307
Of different generations, 306, 307
CompactFlash card
Changing, 92
Content, 92
Formatting, 343
Inserting, 84
Properties, 84
Writing to, 342
Configuration
Global measuring inputs D4x5-2, 374
Local measuring inputs D4x5-2, 374
Control unit mounting
For external cooling, 32
On the side of the line module, 35
With spacers, 29
Controller optimization, 277
Automatic position controller setting, 275
Automatic speed controller setting, 274
Function generator, 277
Measuring functions, 277
Trace, 277
cULus Approval, 379
CX32-2
Engineering Information, 204
Offline configuration, 200
Online configuration, 202
CX32-2 configuration
Offline configuration, 200
Online configuration, 202
Overview, 194
Requirement, 196
topology, 198
CX32-2 mounting
Next to control unit, 37
Cycle clock scaling
external/internal PROFIBUS, 126

D
D4x5-2
Replacing, 309
Upgrading, 309
D4x5-2 measuring inputs
Local/global measuring inputs, 374
Data
Deleting, 285
Data storage
Diagnostics data, 366
Declaration of conformity, 380
Diagnostics
7-segment display of the D4x5-2, 353
CX32-2 LED displays, 357
IT DIAG, 372
LED displays, 347
SIMOTION Task Profiler, 372
Via HTML, 367
Diagnostics data
Back up, 359
Backing up, 370
Backing up during operation, 361
Backing up during startup, 363
Index

Back up using IT DIAG, 370
Back up via IT DIAG button, 361, 363
Data storage, 366

Digital I/O
  Wiring, 58

Distributed I/O systems, 19
DMC20/DME20
  Creating, 269
  Properties, 268
DP cycle, 125
  PROFINET, 145
Drive optimization, 277
Drive wizard
  Calling, 160
DRIVE-CLiQ
  Advantages, 21
  Components, 21
  Rules for wiring, 52
  Version that can be combined with D4x5-2, 306

Electromagnetic compatibility, 379
EMC directives, 49, 379
EMERGENCY STOP concept, 49
Equipment
  open, 27
  Equipotential bonding, 45
ESD guideline, 385
Ethernet
  Configuring addresses, 136
  Interfaces, 135
  Properties, 132

Fan/battery module, 106
  Fan control, 106
  Fan faults, 106
  For D445-2 DP/PN and D455-2 DP/PN, 107
  Max. permissible supply air temperature, 106
Firmware
  Updating automatically, 339
  Updating manually, 340
  Upgrading, 332
  Firmware downgrade, 340
Firmware update
  IT DIAG, 332
  Performing, 332

G
  Global measuring inputs D4x5-2, 374
  Guideline
    ESD, 385

H
  Hardware
    Configuring, 192
  Hardware commissioning
    Requirements, 83

I
  I/O systems
    PROFIBUS, 19
    PROFINET, 20
    Released, 22
  Input/output
    Connecting cables, 58
  Installing
    CBE30-2, 34
    CX32-2, 35
    D4x5-2, 27
    TB30, 33
  Integrated drive
    Downloading a configuration, 192
    SINAMICS S120, 160
IT DIAG
  Diagnostics, 372
  FW update, 332

L
  LED display
    Backing up data, 351
    CBE30-2 option module, 352
    CX32-2, 357
    CX32-2 after ramp-up, 358
    Diagnostics for D4x5, 347
    Ethernet interface, 357
    Onboard PROFINET, 351
    PROFINET interface, 356
    SINAMICS Integrated, 349
    Upgrading SIMOTION, 350
  License
    Backing up, 337
    Protection against deletion, 288
    Undervoltage indicator, 348
  Loading
Project, 181
To file system, 183
To the target system, 341
Local measuring inputs D4x5-2, 374
Parameters, 376

M
Maintenance
Overview, 309
Measuring input
Configuration, 373
Global for D4x5-2, 262
Local for D4x5-2, 263
Overview of D4x5-2, 262
Memory model, 89
Memory reset, 285
via SIMOTION SCOUT, 287
with mode selector switch, 287
Migration
D4x5 to D4x5-2, 301
Module replacement
DRIVE-CLiQ components, 315
SIMOTION, 103
SINAMICS, 105
Spare parts replacement for SIMOTION D4x5-2, 313
Modules
Permissible combinations, 306
MPI bus
Bus connector, 70
Connection rules, 70
Interface, 131
Parameters, 131

N
Non-volatile SIMOTION data
Backing up, 360
Backing up / reloading, 96
Backing up during operation, 361
Backing up during startup, 363
Backing up via IT DIAG, 370
Restoring, 368
Saving to CompactFlash card, 92
Non-volatile SINAMICS data
Backing up / reloading, 97
Saving to CompactFlash card, 92
NVRAM data
Backing up, 217
Deleting, 219
Restoring, 218

O
Offline configuration
Overview, 159
Procedure, 159
Requirement, 159
Onboard I/Os of the D4x5-2
Configuration overview, 257
Overview, 255
Online configuration
Overview, 186
Procedure, 186
Requirement, 186
Output cam
Configuration for the D4x5-2, 265
Overview
D4x5-2 diagnostics data, 359
Upgrading and downgrading, 331
Overview of connections, 42

P
PG/PC connection
enabling the active setting, 130
via Ethernet, 118
via PROFIBUS, 116
Power failure, 97
Power supply
Connecting, 51
Rules for the line voltage, 50
Safety rules, 49
Switching on, 86
VDE guideline, 50
Power-up
Control Unit, 87
PROFIBUS address, 124
PROFIBUS cable
Baud rate, 65
Cable length, 65
Connecting, 66
Properties, 64
removing, 67
Rules for cabling, 65
PROFIBUS DP
As MPI interface,
Creating a new subnet,
Definitions, 121
DP cycle, 125
Interfaces,
Index

Transmission rate, 129
PROFINET
  Cable types, 76
  Cabling, 74
  Diagnostics via LED displays, 347
  DP cycle, 145
PROFINET IO
  Definitions, 138
  Using a second interface, 149
Project
  archiving on CompactFlash card, 185
  Creating, 114
  Loading, 341
Project update
  IT DIAG, 332
Protection against external electrical interference, 51
Protective conductor connection, 43

R
Real-time clock
  Resetting the time, 216
  Set time, 213
  Synchronizing the SINAMICS clock, 214
References, 4
Reliability
  Risk, 382
Residual risk, 382
Restoring
  Non-volatile SIMOTION data, 368
Restoring the factory settings
  SIMOTION D4x5, 289
  SINAMICS Integrated, 289
Retain data and user data
  Backing up, 320, 337
Routing, 77

S
Safety information, 26
Safety Integrated
  Basic functions, 291
  Configuration, 291
  Extended functions, 292
Safety of electronic controllers, 382
Service selector switch
  S5 switch position, 368
Servicing
  Overview, 309
Shield connection
  Using, 59
SIMOTION D
  System overview, 13
SIMOTION D4x5-2
  Hardware components, 15
  Installing, 27
  Possible applications, 14
  Removal and installation, 314
  Software components, 17
  User memory concept, 89
  Variants, 14
SIMOTION SCOUT
  Documentation, 24
  engineering, 229
  Installing, 113
SIMOTION Task Profiler, 372
SINAMICS Integrated
  Backing up / restoring / deleting NVRAM data, 217
  Restoring the factory settings, 289
Software commissioning
  Downloading project to CompactFlash card, 183
  Individual steps, 157
  Load to file system, 183
  Requirements, 153
Speed controller
  Adjusting the P-gain, 281
  Optimum, 278
  Starting the measuring function, 279
Standard IE cable types, 75
Subnet
  Connection components, 63
  Connection rules, 67
  Segment, 63
  Terminating resistor, 63
System
  Powering down, 291
  System components, 18
System cycle clock, 125
  Bus cycle clock, 125
  DP cycle, 145
  IPO cycle clock, 125, 145
  Ratios of system cycle clocks, 125
  Servo cycle clock, 125
System function
  _savePersistentMemoryData, 96

T
Task Profiler, 372
Terminating resistor, 63
Testing the drive, 226
TM41 terminal module, 270
  Configuring, 271
Transmission rate
Adapting, 129

U
UL certification, 379
Unit data
    Backing up, 320
Upgrading
    Overview of the options, 311
User data
    Deleting, 288
    Loading, 283
User memory concept, 89
    Backup time, 91
    Fan/battery module, 91
    Non-volatile data, 90
    Volatile data, 93

V
Variables
    Backing up, 320
    Volatile data, 93